Important Regulatory and Safety Notices to Service Personnel

Before using this product and any associated equipment, refer to the “Important Safety Instructions” listed below to avoid personnel injury and to prevent product damage.

Product may require specific equipment, and/or installation procedures to be carried out to satisfy certain regulatory compliance requirements. Notices have been included in this publication to call attention to these specific requirements.

Symbol Meanings

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="symbol.png" alt="Protective Earth" /></td>
<td>Protective Earth terminal, which is provided for connection of the supply system’s protective earth (green or green/yellow) conductor.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Warning" /></td>
<td>Important operating and maintenance (servicing) instructions within the Product Manual Documentation. Failure to heed this information may present a major risk of damage or injury to persons or equipment.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Warning" /></td>
<td>The symbol with the word “Warning” within the equipment manual indicates a potentially hazardous situation, which if not avoided, could result in death or serious injury.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Caution" /></td>
<td>The symbol with the word “Caution” within the equipment manual indicates a potentially hazardous situation, which if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Notice" /></td>
<td>The symbol with the word “Notice” within the equipment manual indicates a situation, which if not avoided, may result in major or minor equipment damage or a situation, which could place the equipment in a non-compliant operating state.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="Warning Hazardous Voltages" /></td>
<td>This symbol is intended to alert the user to the presence of uninsulated “dangerous voltage” within the product enclosure that may be of sufficient magnitude to constitute a risk of shock to persons.</td>
</tr>
<tr>
<td><img src="symbol.png" alt="ESD Susceptibility" /></td>
<td>This symbol is used to alert the user that an electrical or electronic device or assembly is susceptible to damage from an ESD event.</td>
</tr>
</tbody>
</table>

Important Safety Instructions

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this apparatus near water.
6) Clean only with a dry cloth.
7) Do not block any ventilation openings. Install in accordance with manufacturer’s instructions.
8) Do not install near heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The third prong is provided for your safety. If the provided plug does not fit in to your outlet, consult an electrician for replacement of the obsolete outlet.

10) Protect the power cord from being walked on or pinched, particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.

11) Only use attachments/accessories specified by the manufacturer.

12) Unplug this apparatus during lightning storms or when unused for long periods of time.

13) Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as when the power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.

14) Do not exposure this apparatus to dripping or splashing, and ensure that no objects filled with liquids, such as vases, are placed on the apparatus.

15) To completely disconnect this apparatus from the AC Mains, disconnect the power supply cord plug from the AC receptacle.

16) The mains plug of the power supply cord shall remain readily operable.

17) The SD (Video Production Switcher) chassis is to be rack mounted only.

18) **Warning: Indoor Use:** WARNING: To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.

19) The safe operation of this product requires that a protective earth connection be provided. A grounding conductor in the equipment's supply cord provides this protective earth. To reduce the risk of electrical shock to the operator and service personnel, this ground conductor must be connected to an earthed ground.

20) **WARNING:** This apparatus, when equipped with multiple power supplies, can generate high leakage currents. To reduce the risk of electric shock, ensure that each individual supply cord is connected to its own separate branch circuit with an earth connection.

21) **CAUTION:** These service instructions are for use by qualified service personnel only. To reduce the risk of electric shock, do not perform any servicing other than that contained in the operating instructions unless you are qualified to do so. (Installation Guide only.)

22) **Caution:** This apparatus contains a Lithium battery, which if replaced incorrectly, or with an incorrect type, may cause an explosion. Replace only with the same type. Dispose of used batteries according to the manufacturer's instruction.

23) Service barriers within this product are intended to protect the operator and service personnel from hazardous voltages. For continued safety, replace all barriers after servicing.

24) Certain parts of this equipment still present a safety hazard with the power switch in the OFF position. To avoid electrical shock, disconnect all A/C power cords from the chassis' rear appliance connectors before servicing.

25) This product contains safety critical parts, which, if incorrectly replaced, may present a risk of fire or electrical shock. Components contained within the product's power supplies and power supply area are not intended to be customer-serviced and should be returned to the factory for repair.

26) To reduce the risk of fire, replacement fuses must be the same type and rating.
27) Use only power cords specified for this product and certified for the country of use. Refer to the Product Power Cord Requirement section that follows.

28) The safe operation of this equipment requires that the User heed and adhere to all installation and servicing instruction contained within the equipment’s manuals.

**Product Power Cord Requirements**

**North American Line Voltages 100 - 120 Volt**

This product is supplied with certified 10A/125V SVT type supply cords. Conductors are color coded white (neutral), black (line) and green or green/yellow (ground).

Operation of this equipment at line voltages exceeding 130V requires that alternative supply cords with appropriate voltage and current ratings be used.

**International Line Voltages 200 - 240 Volts**

This product has been designed for use with certified IEC 320- C13 10A/250V - H03 VV-F3G 1.00mm² type line cord.

International product orders are supplied with a certified 10A/250V line cords, utilizing a molded 3-pin IEC 320-C13 type connector at one end and stripped conductors on the other. One line cord is provided. Conductors are CEE color coded; blue (neutral), brown (line), and green/yellow (ground).

Installation by a qualified electrician, of an appropriately approved A/C wall plug certified for the country of use, is required.

Alternatively, other IEC 320 C-13 type power cords may be used, provided that they meet the necessary safety certification requirements for the country in which they are to be used. Refer to the correctly specified line cord above.

**EMC Notices**

**United States of America**

**FCC Part 15**

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

**Notice**

Changes or modifications to this equipment not expressly approved by Ross Video Limited could void the user’s authority to operate this equipment.

**CANADA**

This Class “A” digital apparatus complies with Canadian ICES-003.

Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.
EUROPE
This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 93/68/EEC.

INTERNATIONAL
This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002, and found to comply with the limits for a Class A Digital device.

Notice
This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

General Handling Guidelines
• Careful handling, using proper ESD precautions, must be observed.
• Power down the system before PCB removal.

A Word About Static Discharge
Throughout the many procedures in this guide, please observe all static discharge precautions.

Notice
Avoid handling the switcher circuit boards in high static environments such as carpeted areas, and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from the frame, and exercise proper grounding precautions when working on circuit boards.
Warranty and Repair Policy

Ross Video Limited (Ross) warrants its switchers and related options, to be free from defects under normal use and service for a period of THREE YEARS from the date of shipment. Fader handle assemblies are warranted for the life of the product. If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

Software upgrades for switchers may occur from time to time, and are determined by Ross Video. The upgrades are posted on the Ross Video website, and are free of charge for the life of the switcher.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.
Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.
# Company Address

<table>
<thead>
<tr>
<th>Ross Video Limited</th>
<th>Ross Video Incorporated</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 John Street</td>
<td>P.O. Box 880</td>
</tr>
<tr>
<td>Iroquois, Ontario, K0E 1K0</td>
<td>Ogdensburg, New York</td>
</tr>
<tr>
<td>Canada</td>
<td>USA 13669-0880</td>
</tr>
</tbody>
</table>

- **General Business Office:** (+1) 613 • 652 • 4886
- **Fax:** (+1) 613 • 652 • 4425
- **Technical Support:** (+1) 613 • 652 • 4886
- **After hours emergency:** (+1) 613 • 349 • 0006

- **E-mail (Technical Support):** techsupport@rossvideo.com
- **E-mail (General Information):** solutions@rossvideo.com
- **Website:** http://www.rossvideo.com
## Contents

### Volume I

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Installation</td>
<td>2</td>
</tr>
<tr>
<td>Preliminary Cabling and Check</td>
<td>3</td>
</tr>
<tr>
<td>Preliminary Video Installation</td>
<td>4</td>
</tr>
<tr>
<td>Using the Menu System</td>
<td>5</td>
</tr>
<tr>
<td>BNC Configuration and Check</td>
<td>6</td>
</tr>
<tr>
<td>Basic Communications Setup</td>
<td>7</td>
</tr>
<tr>
<td>Custom Controls Basics</td>
<td>8</td>
</tr>
<tr>
<td>Additional Installation Setups</td>
<td>9</td>
</tr>
<tr>
<td>Completing Setup</td>
<td>10</td>
</tr>
<tr>
<td>Still Stores</td>
<td>11</td>
</tr>
<tr>
<td>Editors/OverDrive</td>
<td>12</td>
</tr>
<tr>
<td>External DVEs</td>
<td>13</td>
</tr>
<tr>
<td>Glossary of Terms</td>
<td>GL</td>
</tr>
<tr>
<td>Index</td>
<td>IX</td>
</tr>
</tbody>
</table>
Volume II

Routers 14

In This Chapter ................................................................. 14-1
Supported Routing Switchers ........................................... 14-2
Communications Connections .......................................... 14-3
  Router Interface Cable Pinouts ........................................ 14-5
Communications Setup .................................................... 14-19
  Setting up the Switcher .................................................. 14-19
  Setting up the Router ..................................................... 14-22
Setting up Router BNCs .................................................... 14-34
Router Custom Controls ................................................. 14-37
  Source/BNC Crosspoint Pair .......................................... 14-37
  Fire a Router Salvo ....................................................... 14-39

Character Generators 15

In This Chapter ................................................................. 15-1
Supported Character Generators ....................................... 15-2
Communications Connections .......................................... 15-3
  Character Generator Interface Cable Pinouts .................. 15-4
Communications Setup .................................................... 15-7
  Setting up the Switcher .................................................. 15-7
  Setting up the Character Generator ............................... 15-10
Setting up Character Generator BNCs ............................... 15-14
Character Generator Custom Controls ............................... 15-18

VTRs (Betacam) 16

In This Chapter ................................................................. 16-1
Supported VTRs ............................................................... 16-2
Communications Connections .......................................... 16-3
  VTR Interface Cable Pinouts .......................................... 16-4
Communications Setup .................................................... 16-7
  Setting up the Switcher .................................................. 16-7
  Setting up the VTR ....................................................... 16-11
Setting up VTR BNCs ....................................................... 16-13
Roll VTR Setup ............................................................... 16-15
VTR Custom Controls .................................................... 16-17
  Programming Transport Commands .............................. 16-17
  Programming the Roll VTR Mode .................................. 16-19
VTR Clip Setup ............................................................... 16-21
  Programming VTR Clips ............................................... 16-21
  Grabbing a Timecode .................................................... 16-23

Audio Servers 17

In This Chapter ................................................................. 17-1
Supported Audio Servers ................................................. 17-2
Communications Connections .......................................... 17-3
  Audio Server Interface Cable Pinouts .............................. 17-4
## Video Servers (VDCP)

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>In This Chapter</td>
<td>18-1</td>
</tr>
<tr>
<td>Supported Video Servers</td>
<td>18-2</td>
</tr>
<tr>
<td>Communications Connections</td>
<td>18-3</td>
</tr>
<tr>
<td>Video Server Interface Cable Pinouts</td>
<td>18-5</td>
</tr>
<tr>
<td>Communications Setup</td>
<td>18-7</td>
</tr>
<tr>
<td>Setting up the Switcher</td>
<td>18-7</td>
</tr>
<tr>
<td>Setting up the Video Server</td>
<td>18-14</td>
</tr>
<tr>
<td>Setting up Video Server BNCs</td>
<td>18-32</td>
</tr>
<tr>
<td>Roll VTR Setup</td>
<td>18-35</td>
</tr>
<tr>
<td>Video Server Custom Controls</td>
<td>18-37</td>
</tr>
<tr>
<td>Roll VTR Mode</td>
<td>18-39</td>
</tr>
<tr>
<td>Video Server Clip Setup</td>
<td>18-41</td>
</tr>
<tr>
<td>Programming Video Server Clips</td>
<td>18-41</td>
</tr>
<tr>
<td>Grabbing a Timecode</td>
<td>18-45</td>
</tr>
</tbody>
</table>

## Robotic Cameras

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>In This Chapter</td>
<td>19-1</td>
</tr>
<tr>
<td>Supported Robotic Cameras</td>
<td>19-2</td>
</tr>
<tr>
<td>Communications Connections</td>
<td>19-3</td>
</tr>
<tr>
<td>Robotic Camera Interface Cable Pinouts</td>
<td>19-4</td>
</tr>
<tr>
<td>Communications Setup</td>
<td>19-11</td>
</tr>
<tr>
<td>Setting up the Switcher</td>
<td>19-11</td>
</tr>
<tr>
<td>Setting up the Robotic Camera</td>
<td>19-17</td>
</tr>
<tr>
<td>Setting up Robotic Camera BNCs</td>
<td>19-22</td>
</tr>
<tr>
<td>Robotic Camera Custom Controls</td>
<td>19-24</td>
</tr>
<tr>
<td>Recall Camera</td>
<td>19-24</td>
</tr>
<tr>
<td>Recall a Shot</td>
<td>19-26</td>
</tr>
</tbody>
</table>

## Monitor Walls

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>In This Chapter</td>
<td>20-1</td>
</tr>
<tr>
<td>Supported Monitor Walls</td>
<td>20-2</td>
</tr>
<tr>
<td>Communications Connections</td>
<td>20-3</td>
</tr>
<tr>
<td>Monitor Wall Interface Cable Pinouts</td>
<td>20-4</td>
</tr>
<tr>
<td>Communications Setup</td>
<td>20-5</td>
</tr>
<tr>
<td>Setting up the Switcher</td>
<td>20-5</td>
</tr>
<tr>
<td>Setting up the Monitor Wall</td>
<td>20-8</td>
</tr>
<tr>
<td>Monitor Wall Under Monitor Display</td>
<td>20-12</td>
</tr>
<tr>
<td>Monitor Wall UMD Interface Cable Pinouts</td>
<td>20-12</td>
</tr>
<tr>
<td>Monitor Wall UMD Communications Setup</td>
<td>20-13</td>
</tr>
</tbody>
</table>
Audio Mixers

In This Chapter ................................................................. 21-1
Supported Remote Audio Mixers ........................................ 21-2
Communication Connections ........................................... 21-3
Connecting to a Remote Audio Mixer without a MIDIator .... 21-3
Connecting to a Remote Audio Mixer with a MIDIator ....... 21-5
Connecting Multiple Remote Audio Mixers .................... 21-7
Remote Audio Mixer Interface Cable Pinouts ..................... 21-10
Setting up the Switcher .................................................... 21-13
Setting up the Switcher .................................................... 21-13
Setting up the Remote Audio Mixer ................................ 21-17
Yamaha 01V .................................................................... 21-17
Yamaha 01V96 ................................................................. 21-18
Yamaha 02R96 ................................................................. 21-19
Yamaha DM2000 ............................................................. 21-20
Yamaha DM1000 ............................................................. 21-21
Yamaha PM5D ................................................................. 21-22
Yamaha M7CL-48 ............................................................. 21-23
Calrec Sigma Digital Audio Mixing System ....................... 21-24
Studer On-Air Audio Mixers ............................................. 21-24
Audio Channel/Group Setup ........................................... 21-26
Setting Up Audio Sources .............................................. 21-26
Setting Up Audio Channels ............................................ 21-27
Setting Up Audio Groups ............................................... 21-28
Audio Channel Assignment ............................................ 21-29
Assigning Audio Channels to a BNC ................................ 21-29
Audio Personality Setup ................................................. 21-30
Audio Transition MLE Assignment .................................. 21-30
Audio Cut Only .............................................................. 21-30
Audio Override Setup .................................................... 21-32
Audio Custom Control Bank Setup ................................. 21-32
Audio Custom Controls ................................................ 21-33
Audio Modes ................................................................. 21-45
Audio-Follow-Video Mode .............................................. 21-45
Override Mode ............................................................. 21-45
Editor Mode ................................................................. 21-45
Operation Overview ...................................................... 21-46
Audio Transitions ......................................................... 21-46
Audio Specific Functions ............................................... 21-47
Audio Only Transitions ................................................. 21-47
Audio Levels and Pan Settings ....................................... 21-47
Appendix A. Specifications

In this Appendix ........................................................................................................................................22-1
Standard Components .............................................................................................................................22-2
Physical Characteristics ..........................................................................................................................22-3
  General Specifications .........................................................................................................................22-3
  Control Panel Specifications ..............................................................................................................22-3
  Rack Frame .......................................................................................................................................22-3
  Rack Frame Connector Types ..............................................................................................................22-4
  Control Panel Connector Types .........................................................................................................22-4
  Power Consumption ............................................................................................................................22-4
  Power Rating - Tallies .........................................................................................................................22-5
  Environmental ...................................................................................................................................22-5
Video Characteristics ............................................................................................................................22-6
  Video Processing ...............................................................................................................................22-6
  System Timing ....................................................................................................................................22-6
  Video Inputs .......................................................................................................................................22-6
  Video Outputs .....................................................................................................................................22-7
  Output Characteristics .........................................................................................................................22-7
Pinouts ....................................................................................................................................................22-8
  Frame Pinouts .....................................................................................................................................22-8
  Control Panel Pinouts ........................................................................................................................22-11
  Remote Aux Panel Pinouts ...............................................................................................................22-16
Aux Panel Programming Mode Summary .............................................................................................22-18

Appendix B. Diagnostics

In this Appendix ........................................................................................................................................23-1
Synergy Diagnostic Tools .......................................................................................................................23-2
  Displaying Panel Information ............................................................................................................23-2
  Potentiometer Test ...............................................................................................................................23-3
  Fader Test ..........................................................................................................................................23-4
  Joystick Test .......................................................................................................................................23-6
  Button Test .........................................................................................................................................23-7
  Lamp Test ..........................................................................................................................................23-7
  Memory Test .......................................................................................................................................23-8
  Display Test .........................................................................................................................................23-8
  Disk Test .............................................................................................................................................23-9
  TX/RX Test .........................................................................................................................................23-9
  Tally Test ..........................................................................................................................................23-11
  DIP/Jump Test ....................................................................................................................................23-12
Frame Diagnostic Tools ..........................................................................................................................23-13
  TX/RX Test .........................................................................................................................................23-13
  DIP/Jump Test ....................................................................................................................................23-15
  GPI Test .............................................................................................................................................23-15
  Internal Video Test .............................................................................................................................23-16

Appendix C. Hardware Options

In This Appendix .........................................................................................................................................24-1
Hardware Option Overview .......................................................................................................................24-2
Clean Feed Installation .............................................................................................................................24-3
Dual Aspectizer Option and Overview .....................................................................................................24-4
  Dual Aspect Ratio Production Overview ............................................................................................24-4
Dual Aspectizer Mode Descriptions ................................................................. 24-6
Single Output Production – Input Mode ......................................................... 24-6
Single Output Production – Bus Mode ............................................................. 24-7
Dual Output Production – Downstream Mode ................................................ 24-7
Dual Output Production – With Extra Content ................................................ 24-8
Dual Aspectizer Mode Comparisons ............................................................... 24-9
Input Mode .................................................................................................. 24-9
Bus Mode ................................................................................................. 24-10
Downstream Mode ..................................................................................... 24-11
Dual Aspectizer Board Installation ............................................................... 24-12
Upgrading Dual Aspectizer Boards .............................................................. 24-13
Upgrading the Dual Aspectizer Software ...................................................... 24-14
Dual Aspectizer Setup .................................................................................. 24-16
Aspectizer Setup Menu .............................................................................. 24-16
Dual Aspectizer Mode Setups ........................................................................ 24-17
Input Mode Setup ..................................................................................... 24-17
Bus Mode Setup ....................................................................................... 24-18
Downstream Mode Setup ........................................................................... 24-22
Dual Border Generator Installation ............................................................... 24-26
DVE Send Installation ................................................................................. 24-27
Input Carrier Board Installation ................................................................. 24-29
Installing an Input Carrier Board ............................................................... 24-29
Mnemonics Display Installation ................................................................. 24-30
Removing Cover Plates ............................................................................. 24-30
Installing Mnemonics Display Modules ..................................................... 24-31
Installing Mnemonic Controller Board(s) ................................................... 24-32
Squeeze & Tease 2D Installation ................................................................. 24-34
Squeeze & Tease 3D Installation ................................................................. 24-36
Timed Aux Bus Installation ........................................................................ 24-37
Remote Port Expander Cabling (BSS4) ......................................................... 24-39
Ultimatte Insider Option ........................................................................... 24-41
Ultimatte Carrier Mode Overview ............................................................... 24-41
Ultimatte Bus Mode Overview ..................................................................... 24-42
Ultimatte Insider Board Installation .......................................................... 24-43
Verifying the Ultimatte Insider Board ......................................................... 24-44
Ultimatte Insider Setup – Carrier Mode ..................................................... 24-45
Ultimatte Insider Setup – Bus Mode ........................................................... 24-46
Ultimatte Auto Select Key Setup .................................................................. 24-50

Appendix D. Frame Modification ............................................................... 25
In This Appendix ........................................................................................ 25-1
Frame CPU Modification ............................................................................. 25-2
Instructions .............................................................................................. 25-2

Appendix E. Switcher Installation Worksheets ............................................ 26
In This Appendix ........................................................................................ 26-1
Input Worksheet ....................................................................................... 26-2
Primary Output Worksheet ......................................................................... 26-5
Auxiliary Output Worksheet ....................................................................... 26-6
Special Output Worksheet ......................................................................... 26-7
Remote Control Worksheet ........................................................................ 26-8
Standard GPI Input Worksheet ................................................................... 26-10
In This Chapter

This chapter provides instructions for connecting, and setting up a Router with your Synergy switcher. Before you begin, ensure that the Routing Switcher Interface option is installed. If not, contact Ross Video for details. Refer to the section “Installed Options Menus” on page 2–37 for instructions on verifying the status of installed options.

The following topics are discussed:

- Supported Routing Switchers
- Communications Connections
- Communications Setup
- Setting up Router BNCs
- Router Custom Controls
**Supported Routing Switchers**

The Synergy Series Switcher has been tested with a number of Routers to ensure the highest standard for compatibility and reliability. The following Routers are currently supported by your Synergy switcher:

- **Codan Kondor** (using the Codan ASCII protocol)
- **Codan Kondor EOS-2000 Router** (using the Geneos protocol)
- **Codan NK Router** (using the Codan ASCII protocol)
- **Extron Router** (using the Extron RS-232 protocol)
- **GVG Encore Control System** (using the GVG Native protocol)
- **GVG SMS 7000 Router** (using the GVG Native protocol)
- **Network VikinX V3232 Router** (using the Network RS232 protocol)
- **NVISION Router** (using the NVISION Serial protocol)
- **NVISION 9000 Router** (using the NVISION Serial protocol)
- **Leitch VIA32 Router** (using the XY protocol)
- **PESA Cougar Router** (using the CPU-Link protocol)
- **Philips Jupiter Router** (using the ESswitch protocol)
- **Pro-Bel Freeway Router** (using the General Remote Communication protocol)
- **Pro-Bel Halo Router** (using the General Remote Communication protocol)
- **Sierra Yosemite Router** (using the Native protocol)
- **Utah Scientific Router** (using the Utah RCP-1 protocol)
Communications Connections

You can connect a number of Routers to your Synergy switcher. The procedure for connecting the Router will depend on the type of Router you have. This section will provide general instructions for connecting the Router to one of the Remote Ports on the back of the Synergy Control Panel.

**Note**

These instructions are provided as a guide, for specific information on the Router you are connecting to the Synergy switcher, refer to the documentation provided with the Router.

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **Routing Switcher Interface** — This is the software option from Ross Video that allows your Synergy switcher to control a Router.

- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your Router. Refer to the section “Router Interface Cable Pinouts” on page 14–5 for information on the pin-outs and connector required for your Router. Ross Video does not supply this cable.

**Note**

If you are connecting a Codan NK Router or a GVG Encore Control System to your Synergy switcher, a DB9 to RJ45 adapter must be used on the Remote Port of the control panel to connect to the CAT5 cable from the Router. Refer to the section “Codan NK Router Cabling” on page 14–13 or the section “GVG Encore Control System Cabling” on page 14–11, for special instruction on connecting these devices.

Use the following procedure to connect a Router to your Synergy switcher:

1. Connect and secure the 9-Pin, Male, end of the Interface Cable to one of the Remote Ports on the back of the Synergy control panel.

2. Connect and secure the other end of the cable to the appropriate port on the Router. The suggested port for each supported Router is listed below:

   - **Philips Jupiter Router** — Connect the Interface cable to an odd numbered (1, 3, 5, 7) serial port on the rear of the Jupiter chassis. Refer to the section “Philips Jupiter Router Cabling” on page 14–5 for more information on the cabling for this Router.

   - **PESA Cougar Router** — Connect the Interface cable to the PESA port on the External Controller for the PESA Cougar Router. Refer to the section “PESA Cougar Router Cabling” on page 14–5 for more information on the cabling for this Router.
• **Pro-Bel Freeway Router** — Connect the Interface cable to the RS-485-2 port on the rear of the Chyron Freeway chassis. Refer to the section “Chyron (Pro-Bel) Freeway Router Cabling” on page 14–6 for more information on the cabling for this Router.

• **Pro-Bel Halo Router** — Connect the Interface cable to the CTRL 2 port on the rear of the Pro-Bel Halo chassis. Refer to the section “Pro-Bel Halo Router Cabling” on page 14–7 for more information on the cabling for this Router.

• **Codan Kondor EOS-2000 Router** — Connect the Interface cable to the PC Port on the Codan Kondor chassis, or the Device port on the CPU Port Expander. Refer to the section “Codan Kondor EOS-2000 Router Cabling” on page 14–7 for more information on the cabling for this Router.

• **Leitch VIA32 Router** — Connect the Interface cable to the Serial Control port on the VIA 32 chassis. Refer to the section “Leitch VIA 32 Router Cabling” on page 14–9 for more information on the cabling for this Router.

• **GVG SMS 7000 Router** — Connect the Interface cable to the ASYNC RS-232 port or the ASYNC RS-422-3 port on the rear of the SMS 7000 chassis. Refer to the section “Grass Valley SMS 7000 Router Cabling” on page 14–10 for more information on the cabling for this Router.

• **GVG Encore Control System** — Connect the Interface cable to the one of the RS-422/RS-485 SIO ports (5-8) on the rear of the GVG Encore Control System chassis. Refer to the section “GVG Encore Control System Cabling” on page 14–11 for more information on the cabling for this device.

• **Codan Kondor Router** — Connect the Interface cable to the AUX com port on the Kondor chassis. Refer to the section “Codan Kondor Cabling” on page 14–13 for more information on the cabling for this Router.

• **Codan NK Router** — Connect the Interface cable to the T-Bus port on the Codan NK Router. Refer to the section “Codan NK Router Cabling” on page 14–13 for more information on the cabling for this Router.

• **Sierra Yosemite Router** — Connect the Interface cable to the Host Port (RS232/422 Port 2) on the Sierra Yosemite chassis. Refer to the section “Sierra Yosemite Router Cabling” on page 14–14 for more information on the cabling for this Router.

• **NVISION Routers** — Connect the Interface cable to the PRI CTRL port on the NVISION chassis. Refer to the section “NVISION Router Cabling” on page 14–15 for more information on the cabling for these Routers.

• **NVISION 9000 Router** — Connect the Interface cable to the PRI CTRL port on the NVISION 9000 chassis. Refer to the section “NVISION 9000 Router” on page 14–15 for more information on the cabling for this Router.

• **Extron Router** — Connect the Interface cable to the RS-232 connector port on the Extron Router chassis. Refer to the section “Extron Router Cabling” on page 14–16 for more information on the cabling for this Router.

• **Utah Scientific Router** — Connect the Interface cable to an odd numbered (1, 3, or 5) connector port on the Utah Scientific chassis. Refer to the section “Utah Scientific Router Cabling” on page 14–17 for more information on the cabling for this Router.

• **Network VikinX V3232 Router** — Connect the Interface cable to the RS-232 port on the VikinX chassis. Refer to the section “Network VikinX V3232 Cabling” on page 14–18 for more information on the cabling for this Router.
This completes the procedure for connecting a Router to the Synergy switcher. Refer to the section “Communications Setup” on page 14–19 for instructions on how to set up communications protocols on the switcher, as well as on the Router.

**Router Interface Cable Pinouts**

Use the information in this section to connect the Interface Cable from the Synergy control panel to the Router.

**Philips Jupiter Router Cabling**

The Synergy control panel connects to the Jupiter Router via the remote ports on the Synergy control panel, and an odd numbered (1, 3, 5, 7) serial port on the rear of the Jupiter chassis.

Cable connections in the following table refer only to those between the Synergy control panel and the Philips Jupiter Router. Other cable connections present on the Jupiter Router can be found in the Philips Jupiter documentation.

**Synergy-to-Philips Jupiter Wiring Chart**

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Philips Jupiter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

**PESA Cougar Router Cabling**

The Synergy control panel connects to the PESA Cougar Router via the remote ports on the Synergy control panel, and the External Controller for the Cougar chassis.

In order to use the RS-422 communications protocol, you may have to use an External Controller to interface between the Cougar and the Synergy switcher. Refer to your PESA Cougar documentation for more information on controlling your Router remotely.

Cable connections in the following table refer only to those between the Synergy control panel and the Pesa Cougar Router. Other cable connections present on the Cougar chassis can be found in the Pesa Cougar documentation.
Chyron (Pro-Bel) Freeway Router Cabling

The Synergy control panel connects to the Chyron Freeway Router via the remote ports on the Synergy control panel and the RS-485-2 port on the rear of the Chyron Freeway chassis.

Important

The Freeway must be configured to allow it to be controlled using the RS-485-2 port. For information concerning this set up, refer to your Chyron (Pro-Bel) Freeway documentation or contact your sales representative at Chyron (Pro-Bel).

Cable connections in the following table refer only to those between the Synergy control panel and the Chyron Freeway Router. Other cable connections present on the Freeway Router can be found in the Chyron Freeway documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>PESA Cougar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

Synergy-to-Chyron Freeway Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Chyron Freeway</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
**Pro-Bel Halo Router Cabling**

The Synergy control panel connects to the Pro-Bel Halo Router via the remote ports on the Synergy control panel and the CTRL 2 port on the rear of the Pro-Bel Halo chassis.

**Important**

The Pro-Bel Halo must be configured to allow it to be controlled using the CTRL 2 port. For information concerning this setup, refer to your Pro-Bel documentation.

Cable connections in the following table refer only to those between the Synergy control panel and the Pro-Bel Halo Router. Other cable connections present on the Router can be found in the Pro-Bel documentation.

![Synergy-to-Pro-Bel Halo Wiring Chart](chart)

**Codan Kondor EOS-2000 Router Cabling**

The Codan Kondor Router can be interface with the Synergy switcher directly, or through a CPU Port Expander. The pinouts are provided for both options.

**With CPU Port Expander**

The Synergy control panel connects to the Codan Router via the remote ports on the Synergy control panel, and the device ports on the CPU Port Expander of the Codan Kondor Router.

Cable connections in the following table refer only to those between the Synergy control panel and the Codan Kondor (Geneos) Router. Other cable connections present on the Kondor rack frame can be found in the Kondor documentation.
**Direct Connection**

The Synergy control panel connects to the Codan Router via the remote ports (1-8) on the Synergy control panel, and the PC Port of the Codan Kondor Router.

Cable connections in the following table refer only to those between the Synergy control panel and the Codan Router. Other cable connections present on the Kondor rack frame can be found in the Router documentation.

---

**Synergy-to-Codan (Geneos) Wiring Chart for RS-232**

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Codan Geneos Rack Frame</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

**Synergy-to-Codan (Geneos) Wiring Chart for RS-422-485**

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Codan Geneos Rack Frame</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

* Pins 1, 5 and 9 are tied.
Leitch VIA 32 Router Cabling

The Synergy control panel connects to the Leitch VIA 32 Router via the remote ports on the Synergy control panel and the Serial Control port on the VIA 32 chassis using the XY protocol. The Leitch VIA 32 can be connected to your Synergy switcher using either a RS-422 or RS-232 cable. Both methods are described below.

Important

The Leitch VIA 32 Router must be equipped with the optional internal serial transmit/receive hardware to allow RS-422 access. Refer to your Leitch VIA 32 documentation for information on obtaining and installing this option.

Cable connections in the following table refer only to those between the Synergy control panel and the Leitch VIA 32 Router. Other cable connections present on the VIA 32 Router can be found in the Leitch VIA 32 documentation.
Grass Valley SMS 7000 Router Cabling

The Synergy control panel connects to the GVG SMS 7000 Router via the remote ports on the Synergy control panel and either the ASYNC RS-232 port or the ASYNC RS-422-3 port on the rear of the SMS 7000 chassis.

Cable connections in the following table refer only to those between the Synergy control panel and the GVG SMS 7000 Router. Other cable connections present on the SMS 7000 Router can be found in the Grass Valley documentation.

**Important**
The port on the SMS 7000 is labeled RS-232, however it must be set to run in RS-422 mode.

**Synergy-to-Leitch VIA 32 RS–422 Wiring Chart**

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Leitch VIA 32</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

**Synergy-to-GVG SMS 7000 ASYNC RS–232 Wiring Chart**

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>GVG SMS 7000</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
The Synergy control panel connects to the GVG Encore Control System via the remote ports on the
Synergy control panel and one of the RS-422/RS-485 SIO ports (5-8) on the rear of the GVG Encore
Control System chassis.

To construct the cabling between the Synergy control panel and the GVG Encore Control System,
Ross Video recommends the following:

- Use an RJ-45 Female to DB-9 male adaptor to connect directly to the Synergy control
  panel; and
- Use a CAT 5e Ethernet patch (pin-to-pin) type cable to connect the GVG Encore Control
  System chassis to the RJ-45 to DB-9 adaptor.

Note that there are two different models of the GVG Encore Control System: 6101000xx and
6100884xx. Cabling for both models are provided in the sections below.

### Synergy-to-GVG 7000 ASYNC RS–422 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>GVG SMS 7000</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
<td><strong>ASYNC 422-3 Port</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
<td>→</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
<td>→</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
<td>→</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
<td>→</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
</tr>
</tbody>
</table>

GVG Encore Control System Cabling

The Synergy control panel connects to the GVG Encore Control System via the remote ports on the
Synergy control panel and one of the RS-422/RS-485 SIO ports (5-8) on the rear of the GVG Encore
Control System chassis.

**Note**

While you can use one of the RS-232 SIO ports (1-4) on the GVG
Encore Control System, Ross Video recommends using the
RS-422/RS-485 ports.

To construct the cabling between the Synergy control panel and the GVG Encore Control System,
Ross Video recommends the following:

- Use an RJ-45 Female to DB-9 male adaptor to connect directly to the Synergy control
  panel; and
- Use a CAT 5e Ethernet patch (pin-to-pin) type cable to connect the GVG Encore Control
  System chassis to the RJ-45 to DB-9 adaptor.

Note that there are two different models of the GVG Encore Control System: 6101000xx and
6100884xx. Cabling for both models are provided in the sections below.

**Note**

If you have a Redundant System setup, refer to your GVG
documentation for cabling information.

GVG Encore Control System (6101000xx)

Cable connections in the following table refer only to those between the Synergy control panel and the
GVG Encore Control System model 6101000xx. Other cable connections present on the GVG Encore
Control System can be found in the GVG documentation.
### Synergy-to-GVG Encore Control System (6101000xx) Wiring Chart

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>COM Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)→</td>
<td>2</td>
<td>Tx-</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)→</td>
<td>8</td>
<td>Rx+</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)→</td>
<td>1</td>
<td>Tx+</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)→</td>
<td>7</td>
<td>Rx-</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td>n/c</td>
<td></td>
</tr>
</tbody>
</table>

### GVG Encore Control System (6100884xx)

Cable connections in the following table refer only to those between the Synergy control panel and the GVG Encore Control System model 6100884xx. Other cable connections present on the GVG Encore Control System can be found in the GVG documentation.

### Synergy-to-GVG Encore Control System (6100884xx) Wiring Chart

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>COM Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)→</td>
<td>8</td>
<td>Tx-</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)→</td>
<td>1</td>
<td>Rx+</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)→</td>
<td>3</td>
<td>Tx+</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)→</td>
<td>6</td>
<td>Rx-</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td>n/c</td>
<td></td>
</tr>
</tbody>
</table>
**Codan Kondor Cabling**

The Synergy control panel connects to the Codan Kondor Router via the remote ports on the Synergy control panel and the 25-Pin, D-Type, AUX com port on the Codan Kondor chassis.

**Note**  
A DB9 to DB25 adapter may be required to connect the Interface Cable to the Codan Kondor Router.

Cable connections in the following table refer only to those between the Synergy control panel and the Codan Kondor Router. Other cable connections present on the Kondor Router can be found in the Router documentation.

**Synergy-to-Codan Kondor (ASCII) RS–422 Wiring Chart**

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Codan Kondor (ASCII)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

**Codan NK Router Cabling**

The Synergy control panel connects to the Codan NK Router via the remote ports on the Synergy control panel and the T-Bus port on the Codan NK Router.

Use the following procedure to connect a Codan NK Router to your Synergy switcher:

1. Connect and secure the 9-Pin, Male, end of the **DB9 to RJ-45 Adapter (Codan NK-SCP/A)** to one of the **Remote Ports** on the back of the Synergy control panel.
2. Connect and secure one end of the **CAT5** cable to the **DB9 to RJ-45 Adapter**.
3. Connect and secure the other end of the cable to the **T-Bus Port** on the **NK Router**.

This completes the procedure for connecting a Router to the Synergy switcher. Refer to the section “**Communications Setup**” on page 14–19 for instructions on how to set up communications protocols on the switcher, as well as on the Router.

Cable connections in the following table refer only to those between the Synergy control panel and the Codan NK Router. Other cable connections present on the NK Router can be found in the Router documentation.
Sierra Yosemite Router Cabling

The Synergy control panel connects to the Sierra Yosemite Router via the remote ports on the Synergy control panel, and the Host Port (RS232/422 Port 2) on the rear of the Sierra Router.

### Important

The default settings for the **Sierra Yosemite** Router is **RS-232** and **9600** Baud; however, Ross Video recommends that you use **RS-422** and **38400** Baud. Refer to your Sierra Video Systems Yosemite Router documentation for information on changing the configuration.

Cable connections in the following table refer only to those between the Synergy control panel and the Sierra Yosemite Router. Other cable connections present on the Yosemite chassis can be found in the Sierra Yosemite documentation.

### Synergy-to-Sierra Yosemite RS-232 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Sienna Yosemite</th>
<th>Remote Port</th>
<th>Signal</th>
<th>Host Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td>2</td>
<td>Tx</td>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>2</td>
<td>Chassis</td>
<td>3</td>
<td>Rx</td>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Chassis</td>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Chassis</td>
<td>5</td>
<td>Ground</td>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>5</td>
<td>Chassis</td>
<td>6</td>
<td>Ground</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Chassis</td>
<td>7</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Chassis</td>
<td>8</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Chassis</td>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The Synergy control panel connects to an NVISION Router via the remote ports on the Synergy control panel, and the PRI CTRL port on the rear of the NVISION Router.

Cable connections in the following table refer only to those between the Synergy control panel and the NVISION Router. Other cable connections present on the NVISION chassis can be found in the NVISION documentation.

### NVISION 9000 Router

The Synergy control panel connects to an NVISION 9000 Router via the remote ports on the Synergy control panel, and the PRI CTRL port on the rear of the NVISION 9000 Router. You may need to connect using RS-422 or RS-232 cabling depending on the model of NVISION 9000 router.

---

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>Host Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)→</td>
<td>2</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)→</td>
<td>3</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)→</td>
<td>7</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)→</td>
<td>8</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Connecting to the RS-422 Serial Ports

Cable connections in the following table refer only to those between the Synergy control panel and the NVISION 9000 Router with RS-422 serial ports. Other cable connections present on the NVISION chassis can be found in the NVISION documentation.

### Synergy-to-NVISION 9000 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>NVISION 9000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis (Ground)</td>
</tr>
<tr>
<td>2</td>
<td>Rx-</td>
</tr>
<tr>
<td>3</td>
<td>Tx+</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>Rx+</td>
</tr>
<tr>
<td>8</td>
<td>Tx-</td>
</tr>
<tr>
<td>9</td>
<td>Chassis (Ground)</td>
</tr>
</tbody>
</table>

Connecting to the RS-232 Serial Ports

Cable connections in the following table refer only to those between the Synergy control panel and the NVISION 9000 Router with RS-232 serial ports. Other cable connections present on the NVISION chassis can be found in the NVISION documentation.

### Synergy-to-NVISION 9000 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>NVISION 9000</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis (Ground)</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis (Ground)</td>
</tr>
</tbody>
</table>

Extron Router Cabling

The Synergy control panel connects to an Extron System 8/10 Router via the remote ports on the Synergy control panel, and the RS-232 connector port on the rear of the Extron Router.
Cable connections in the following table refer only to those between the Synergy control panel and the Extron System 8/10 Router. Other cable connections present on the Router can be found in the Extron documentation.

### Synergy-to-Extron Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Extron System 8/10</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

**Utah Scientific Router Cabling**

The Synergy control panel connects to an Utah Scientific Router via the remote ports on the Synergy control panel, and an odd numbered (1, 3 or 5) connector port on the rear of the Utah Scientific Router.

**Note**

The Utah Scientific Router can be set to use a RS-422 or RS-232 serial connection; however, Ross Video recommends that you use a RS-232 connection. Refer to your Utah Scientific documentation for information on verifying the configuration of your router.

Cable connections in the table on page 14–17 refer only to those between the Synergy switcher and the Utah Scientific Router. Other cable connections present on the Router can be found in the Utah Scientific documentation.

### Synergy-to-Utah Scientific RS–232 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Utah Scientific</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
Network VikinX V3232 Cabling

The Synergy control panel connects to a Network VikinX V3232 Router via the remote ports on the Synergy control panel, and the RS-232 connector port on the rear of the VikinX Router.

Cable connections in the following table refer only to those between the Synergy switcher and the VikinX Router. Other cable connections present on the Router can be found in the Network documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>RS-232 Port</th>
<th>Network VikinX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
<td>→</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
<td>→</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>→</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
</tr>
</tbody>
</table>
Communications Setup

This section will provide instructions for setting up the Router to communicate and accept commands from the Synergy switcher.

The following topics are discussed in this section:

- Setting up the Switcher
- Setting up the Router

Setting up the Switcher

In order to have the Synergy switcher communicate with a Router, the remote port on the control panel that the Router is connected to must be set up to communicate with the particular Router you have connected.

Use the following procedure to configure a Remote port on the control panel to connect with a Router:

1. Navigate to the **Communications Menu 1-2** as follows:
   
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.
2. Press **Type** to display the **Type Menu**.
   
   ![Type Menu]

   **Communications — Type Menu**

3. Assign a remote port to Router as follows:
   
   - Use the **Com Port** knob to select the remote port on the Synergy switcher that is connected to the Router.
   - Use the **Device** knob to select **Router**.
4. Press **Select Device** to display the **Select Device Menu**.
   
   ![Select Device Menu]

   **Communications — Select Device Menu**
5. **Assign a specific Router to the remote com port as follows:**

- Use the **Com Port** knob to select the remote com port that the desired Router is connected to.
- Use the **Device** knob to select the type of Router that is connected to the port. You can select between the following:
  - **NONE** — Use this option to not assign a Router to the selected com port.
  - **Jupiter** — Use this option to assign a **Philips Jupiter Router** to the selected com port using the ESSwitch protocol. Refer to the section “Philips Jupiter” on page 14–23 for details.
  - **Pesa** — Use this option to assign a **PESA Cougar Router** to the selected com port using the CPU-Link protocol. Refer to the section “PESA Cougar” on page 14–24 for details.
  - **Pro-Bel** — Use this option to assign a **Chyron (Pro-Bel) Freeway Router** or a **Pro-Bel Halo Router** to the selected com port using the General Remote Communication (SW-P-08) protocol. Refer to the section “Pro-Bel Freeway” on page 14–24 for details on setting up a Chyron Freeway Router. For setup information on the **Pro-Bel Halo Router**, refer to the section “Pro-Bel Halo” on page 14–25.
  - **Codan EOS** — Use this option to assign a **Codan Kondor EOS-2000 Router** to the selected com port using the Geneos protocol. Refer to the section “Codan Kondor (Geneos)” on page 14–25 for details.
  - **Via 32** — Use this option to assign a **Leitch VIA32 Router** to the selected com port using the XY protocol. Refer to the section “Leitch VIA 32” on page 14–27 for details.
  - **GVG NP** — Use this option to assign a **Grass Valley SMS 7000 Router** or the **GVG Encore Control System** to the selected com port using the Grass Valley Native protocol on the desired chassis port. Refer to the section “GVG SMS 7000” on page 14–27 for details on setting up a SMS 7000 router. For information on the GVG Encore Control System, refer to the section “GVG Encore Control System” on page 14–28.
  - **CodanASCII** — Use this option to assign a **Codan Kondor** or **Codan NK Router** to the selected com port using the Codan ASCII protocol. Refer to the section “Codan (ASCII)” on page 14–28 for details.
  - **Yosemite** — Use this option to assign a **Sierra Yosemite Router** to the selected com port using the Native protocol. Refer to the section “Sierra Yosemite” on page 14–29 for details.
  - **NVSP** — Use this option to assign an **NVISION Router** to the selected com port using the NVISION Serial protocol. Refer to the section “NVISION (NVSP)” on page 14–29 for details.

**Note**

If the Codan Router does not have a port expander, and a PC is required to be connected to the Router at all time, the Codan ASCII protocol will have to be used to allow the switcher to control the Router.

**Note**

The Codan ASCII protocol does not support Mnemonics.
~ **Extron** — Use this option to assign an **Extron Router** to the selected com port using the Extron RS-232 protocol. Refer to the section “**Extron System 8/10 Plus Router**” on page 14–32 for details.

~ **Utah** — Use this option to assign an **Utah Scientific Router** to the selected com port using the Utah RCP-1 protocol. Refer to the section “**Utah Scientific Router**” on page 14–33 for details.

**Note**
The Utah RCP-1 protocol does not support Mnemonics.

~ **VikinX** — Use this option to assign a **Network VikinX** to the selected com port using the Network RS232 protocol. Refer to the section “**Network VikinX V3232 Router**” on page 14–33 for details.

6. Press **Com Settings** to display the **Com Settings Menu**.

7. Set the communications protocols for the Router as follows:
   - Use the **Com Port** knob to select the Router you are setting the communications settings for.
   - Use the **Baud** knob to select the baud rate for the Router. Refer to the section “Setting up the Router” on page 14–22 for the specific settings for your Router.
   - Use the **Parity** knob to select the parity, for the specific Router. Refer to the section “Setting up the Router” on page 14–22 for the specific settings for your Router.

**Note**
Some of the communications settings are Fixed, or locked. These settings have been preset for the selected Router and do not need to be changed.

8. Press **Com Type** to display the **Com Type Menu**.
9. Select the type of serial communication that will be used to communicate with the Router as follows:
   - Use the **Com Port** knob to select the Router you want to set the communication type for.
   - Use the **Type** knob to select the type of serial communications for the selected port. Refer to the section “Setting up the Router” on page 14–22 for the specific settings for your Router.

10. Select the number of sources for your Router as follows:
   - **Note**
     This Extra Option is not available for the Codan Kondor E0S-2000, GVG SMS 7000, and the NVISION 9000 Routers.
   - Press **Extra Options** to display the **Extra Options Menu**.

     ![Communications Extra Options Menu]

     - Use the **Com Port** knob to select the remote port that the Router is connected to.
     - Use the **Option** knob to select **Xpts**.
     - Use the **Value** knob to select the number of crosspoints on the Router.

11. Press **HOME** to display the **Installation Change Confirmation Screen**.

12. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the communications with the Router, next you will have to finish setting up the Router to communicate with the Synergy switcher, and then set up the BNC inputs that you have connected to the Router.

You can also set up a Router to provide Audio Follow Video for an Aux Bus. Refer to the section “Assigning Router Follow” on page 11–10 for more information.

**Setting up the Router**

In order to have the Synergy switcher communicate with a Router, the Router you are connecting to the switcher must be set up to communicate and accept commands from the switcher.
**Philips Jupiter**

Use the following information to configure and connect your Philips Jupiter Router, using the ESswitch protocol, to your Synergy switcher:

- Use the following communications setting when connecting the Philips Jupiter to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

- The Configuration Set must be configured with the following (using Philips Configuration Editor Software — valid as of version 5.1.0):
  ~ In the Configure\Serial Protocol Menu, configure the ports to use ESswitch (ESW) protocol and the appropriate Baud rate setting. Repeat for all port(s) connected to Synergy.
  ~ In the Configure\MPK Devices Menu, set up a device with the “type” as Serial and set to use the port connected to the Synergy.
  ~ The Input Set, Output Set and Level Set must be set to the appropriate “sets” configured in the Configure\Control Panel Sets Sub-menu. Each Synergy to be attached must be configured as a separate MPK Device on the appropriate port.
  ~ For more information concerning the configuration of a Set and downloading the Set to the controller, refer to the Jupiter documentation.

**Configuring the Base Extra Option**

If you are having trouble controlling a Jupiter router from your Synergy switcher, you may need to change the Base Extra Option to 0 on the Synergy control panel.

Use the following procedure to change the Base Extra Option for the Jupiter router on the Synergy control panel:

1. Navigate to the Extra Options Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications ⇒ Extra Options.
2. Use the Com Port knob to select the remote port on the Synergy switcher that is connected to the Jupiter router.
3. Use the Option knob to select Base.
4. Use the Value knob to select 0.

This completes the procedure to set up the Extra Options for a Jupiter router.
**PESA Cougar**

Use the following information to configure and connect your PESA Cougar Router, using the **CPU-Link protocol**, to your Synergy switcher:

- Use the following communications setting when connecting the PESA Cougar to the Synergy switcher:

<table>
<thead>
<tr>
<th>Synergy-to-PESA Cougar Communication Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting</td>
</tr>
<tr>
<td>--------------------------</td>
</tr>
<tr>
<td>Transmission Standard</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
</tbody>
</table>

- The **Cougar Configuration** must be configured to allow **CPU-Link Protocol** control on the port connected to Synergy. To accomplish this, follow the directions below using the Win3500Plus Control Software (valid as of version 1.2):
  ~ Open the configuration to be used on the Pesa (File\Open Configuration…).
  ~ Open the Configuration\CPU Link… menu.
  ~ Select an **RS-422** port.
  ~ Configure this RS-422 port for the CPU Link Protocol using the following:
    - Baud — 9600
    - Parity — NONE
    - Data Bits — 8
    - Stop Bits — 2
  ~ Exit this dialog box and save the configuration (File\Save Configuration…).
  ~ Download the configuration to the controller by selecting System\Download Configuration to Controller.
  ~ For more information concerning the set up and downloading of a Configuration, refer to the Pesa documentation for the Controller.

**Pro-Bel Freeway**

Use the following communications setting when connecting the Pro-Bel Freeway to the Synergy switcher:

<table>
<thead>
<tr>
<th>Synergy-to-Pro-Bel Freeway Communication Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting</td>
</tr>
<tr>
<td>--------------------------</td>
</tr>
<tr>
<td>Transmission Standard</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
</tbody>
</table>
Pro-Bel Halo

Use the following information to setup your Pro-Bel Halo Router, using the General Remote Communications protocol (SW-P-08), to your Synergy switcher:

- Use the following communications settings when connecting the Pro-Bel Halo Router to your Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

Note: The Synergy switcher does not support the Pro-Bel General Switcher Protocol (SW-P-88).

- Ensure the DIP Switch on the Pro-Bel Halo is set to CTRL2 to enable serial control from the Synergy switcher.

Codan Kondor (Geneos)

Use the following information to configure and connect your Codan Kondor EOS-2000 Router, using the Geneos (EOS) protocol, to your Synergy switcher. The Codan Kondor can be connected to your Synergy switcher either using the CPU Port Expander on the Codan Kondor Router or not. Both methods are listed below.

With CPU Port Expander

Use the following communications setting when connecting the Codan Kondor to your Synergy switcher using the CPU Port Expander on the Codan Kondor:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value 1</th>
<th>Value 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
<td>RS-422/485</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>57600</td>
<td>57600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Note: The Codan Kondor can support both RS-232 and RS-422/485 with the CPU Port Expander. Settings for both are described here.
• The Codan CPU Port Expander device port must be configured as RS-422 and allow “Specified Dst Stat” to pass through. The Port Expander’s “CPU” port connects to the Geneos Rack Frame’s “PC” port.

• Codan Routing Systems Routers do not output source or destination names to the Synergy switcher. Therefore, Synergy menus display:

  ~ “Src #” values (0-255) which represent the virtual input number of Level 1 on the Codan Router.

  ~ “Output #” values (1-256) which represent the virtual output number of Level 1 on the Codan Router.

**Important**

Ross Video recommends that you keep the virtual input#/output# selections consistent with the physical input#/output# selections in the Codan Routing Systems Router’s Physical Map. Refer to the Router documentation for further details.

• The Synergy switcher controls the Codan Router using the Router’s virtual input to virtual output using its breakaway function. The breakaway number corresponds to the selected level in the **BNC Menu 2-2 — Router Other Menu**. Synergy supports levels 1-8. Refer to the section “Setting up Router BNCs” on page 14–34 for information.

**Without CPU Port Expander**

Use the following communications settings when connecting the Codan Kondor to your Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>57600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

• Codan Routing Systems do not output source or destination names to the Synergy switcher. Therefore, Synergy menus display:

  ~ “Src #” values (0-255) which represent the virtual input number of Level 1 on the Codan Routing Systems.

  ~ “Output #” values (1-256) which represent the virtual output number of Level 1 on the Codan Routing Systems.

**Important**

Ross Video recommends that you keep the virtual input#/output# selections consistent with the physical input#/output# selections in the Physical Map of the Codan Routing System. Refer to the Router documentation for further details.

• The Synergy switcher controls the Codan Router using the Router’s virtual input to virtual output using its breakaway function. The breakaway number corresponds to the
selected level in the BNC Menu 2-3 — Router Other Menu. Synergy supports levels 1-8.

For information concerning Codan Router cable assembly, AUX port, virtual input/output, and breakaway setup, please refer to your Codan Routing Systems manuals.

**Leitch VIA 32**

Use the following information to configure and connect your Leitch VIA 32 Router, using the XY protocol, to your Synergy switcher. The Leitch VIA 32 can be connected to your Synergy switcher using either a RS-422 or RS-232 cable. Both methods are described below.

*Important*

The Leitch VIA 32 Router must be equipped with the optional internal serial transmit/receive hardware to allow RS-422 access. Refer to your Leitch VIA 32 documentation for information on obtaining and installing this option.

- Use the following communications settings when connecting the Leitch VIA 32 to the Synergy switcher:

  **Synergy-to-Leitch VIA 32 Communications Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value 1</th>
<th>Value 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

*Note*

Use DIP switch SW2 on the front of the VIA 32 panel to set the port as required.

**GVG SMS 7000**

Use the following communications settings when connecting your Grass Valley Group (GVG) Signal Management System (SMS) 7000 Router, using the GVG Native protocol, to your Synergy switcher:

*Note*

Use the SMS 7000 configuration tool to set the port (port number depends on the socket that the AMEZI is installed) as required.
GVG Encore Control System

Use the following information to configure and connect your GVG Encore Control System, using the GVG Native Protocol, to your Synergy switcher:

- Use the following communications setting when connecting the GVG Encore Control System to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

- Ensure that your GVG Encore Control System is configured to use the GVG Native Protocol on the desired chassis port. Refer to your GVG documentation for details on setting up your device.

Codan (ASCII)

Use the following information to configure and connect your Codan Kondor or Codan NK Router, using the ASCII protocol, to your Synergy switcher:

Note

The Codan ASCII protocol does not support mnemonics.

- Set up the communications on the Router as follows:
  ~ For the Codan Kondor Router, you must use the Geneos software on your PC, to set the AUX Comm Port Baud Rate, on the CPU tab, to 38.4k.
  ~ For the Codan NK Router, you must use the Codan IPS interface on your PC to set the Baud rate to 38400.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Kondor</th>
<th>NK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>
Sierra Yosemite

Use the following communications settings to configure and connect your Sierra Yosemite Router to your Synergy switcher:

**Important** The default settings for the Sierra Yosemite Router is RS-232 and 9600 Baud; however, Ross Video recommends that you use RS-422 and 38400 Baud. Refer to your Sierra Video Systems Yosemite Router documentation for information on changing the configuration.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Default Value</th>
<th>Recommended Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

NVISION (NVSP)

Use the following communications settings to configure and connect your NVISION Router to your Synergy switcher using the NVISION Serial Protocol:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

NVISION 9000 Router

Use the following information to configure and connect your NVISION 9000 Router to your Synergy switcher using the NVISION Serial Protocol:

Use the following communications settings when connecting an NVISION Router to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422/RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
</tbody>
</table>
**Mnemonics Setup**

On the NVISION 9000 Router, all Sources, Destinations and Levels have an associated and unique ID Number. The Synergy switcher uses this ID Number to obtain the mnemonic information from the NVISION 9000 Router.

This section provides instructions for creating an ID Table using a Text Editor program, such as Microsoft® Notepad, to include all the ID Numbers for your NVISION 9000 Router. You will then recall the ID Table on the Synergy switcher. This will enable the Synergy switcher to identify and obtain the mnemonic information from the NVISION 9000 Router.

**Important**

You must recall an ID Table to ensure the mnemonics of the Synergy switcher display the correct ID Numbers for your NVISION 9000 Router.

Note

If you do not supply Levels in the ID Table, ensure you set up a Level 1 physical connection on your NVISION 9000. Refer to the NVISION documentation for setup information.

Use the figure below for reference when creating your Table ID entries.

<table>
<thead>
<tr>
<th>Crosspoint Number</th>
<th>ID Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1,23</td>
<td></td>
</tr>
</tbody>
</table>

Each Table ID entry must include the following five values in the order listed:

1. An **ID Value** with *one* of the following characters in uppercase:
   - D — This value is for a **Destination** (output) crosspoint on the router.
   - S — This value is for a **Source** (input) crosspoint on the router.
   - L — This value is for a **Level** on the router. A Level ID is only required if you wish to control crosspoints on a virtual level. If no Level IDs are supplied, then the selected Level on the Synergy control panel will be associated with the NV9000 physical Level IDs.

2. The physical **Crosspoint Number** on the router. In the example above, the Table ID entry includes an ID Value of D and a Crosspoint Number of 1 (**Destination 1**).

3. A **comma** is used to identify the end of the crosspoint number and the beginning of an associated ID number.

4. An **ID Number** that is unique to that Destination, Source, or Level. In the example above, the Table ID entry includes an **ID Number** of 23.

5. A **semicolon** terminates the ID Number and signals the end of the ID Table entry.

The following sections include procedures for creating the ID Table using a Text Editor program and then recalling it on the Synergy switcher.
Creating the ID Table

Use the following procedure to create the ID Table text file for your NVISION 9000 router sources:

1. From the Desktop, open the Text Editor program on your computer.
2. Create a new Blank file.
3. Enter each ID entry as described in the previous section, using the figure above for reference. Ross Video suggests that each ID entry be on a separate line as illustrated in the following figure.

```
D1,16;
D2,23;
S5,9;
S7,2;
L2,4;
L3,3;
```

Sample of a Series of ID Entries

4. Once you have entered each required Source, Destination and/or Level, save the file as NV9000.CFG to a storage device, such as a floppy disk or USB key.

```
D1,16;
D2,23;
S5,9;
S7,2;
L2,4;
L3,3;
```

Note
Refer to your NVISION 9000 documentation or contact NVISION Technical Support to determine the ID numbers for your router.

5. Click the Close button to exit.
6. Eject the storage device from your computer.

This completes the procedure to create the ID Table text file for your NVISION 9000 router sources. Next you will recall the ID Table on the Synergy switcher.

Recalling the ID Table on the Synergy Switcher

Use the following procedure to recall the ID Table text file for your NVISION 9000 Router:

1. Insert the storage device with the ID Table text file into the floppy drive or USB port of the Synergy switcher.
2. Navigate to the Disk Recall Menu 2-2 on the Synergy switcher as follows:
   - Press HOME ⇒ Disk ⇒ Recall ⇒ MORE.
3. Press NV9000 ID Table to recall the ID Table text file from your storage device.

The router sources are now saved to the Flash memory of the Synergy switcher with the Installation Registers. Refer to the section “About the Synergy File Storage System” for information on register categories.

This completes the procedure to recall the ID Table text file for your NVISION 9000 Router. Refer to the section “Setting Up Mnemonics Displays for BNC Names” for information on customizing the appearance of the display.

**Extron System 8/10 Plus Router**

Use the following information to configure and connect your Extron System 8/10 Router to your Synergy switcher using the Extron RS232 Protocol:

- Use the following communications settings when connecting an Extron System 8/10 switcher Router to the Synergy switcher:

  **Synergy-to-Extron Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

- The Synergy switcher controls the Extron System 8/10 Router using its breakaway function. The breakaway number corresponds to the selected level in the Synergy Router Other Menu. Synergy supports levels 1-4.

- When assigning a particular output from the Extron System 8/10 Router to a BNC input on the Synergy switcher, you must select Output 001 from the Synergy Router Setup Menu. Refer to the section “Setting up Router BNCs” on page 14–34 for more information on assigning Router outputs.
**Utah Scientific Router**

Use the following information to configure and connect your Utah Scientific Router to your Synergy switcher using the Utah RCP-1 protocol:

*Note*  
The Utah RCP-1 protocol does not support mnemonics.

### Synergy-to-Utah Scientific Communication Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

**Network VikinX V3232 Router**

Use the following information to configure and connect your Network VikinX V3232 Router to your Synergy switcher using the Network RS232 protocol:

### Synergy-to-Network Communication Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>19200</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

- When you change the router levels using the Synergy switcher menus, the configuration of the VikinX switches 1-4 must also change. You must then power down and power up the VikinX Router to update the settings. Refer to the Configuration section of your VikinX manual for more information.
Setting up Router BNCs

The **Router Setup Menu** allows you to associate a Router BNC input with a particular Router communication port. In addition, you can select which one of the outputs of the Router is feeding the input BNC on the Synergy SD frame.

The **Router Other Setup Menu** allows you to set the levels, or breakaways, on the Router that will be switched when a new input source is selected. Refer to your Router documentation for more information on setting up the level matrix.

**Important**  
You must have a Router set up on the Synergy switcher before you can assign a BNC to that device. Refer to the section “**Setting up the Switcher**” on page 14–19 for more information on setting up router communications.

Use the following procedure to assign the Router to a specific BNC input:

**Note**  
On the **Codan Routers** the matrix is controlled by breakaways that have the different levels assigned to them. Refer to your Router documentation for information on assigning different levels to a breakaway.

1. Navigate to the **BNC Menu 1-3** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.
2. Press **BNC Type** to display the **BNC Type Menu**.

![BNC Type Menu](image)

**BNC — Type Menu**

3. Assign a BNC to a Router as follows:
   - Use the **BNC** knob to select the BNC that the Router is connected to.
   - Use the **Type** knob to select **Router**.
   - Use the **Asp Ratio** knob to select the video aspect ratio of the Router output.
4. Navigate to the **Router Setup Menu** as follows:
   - Press MORE ⇒ Router Setup.
5. Assign a specific Router to the Router BNC as follows:
   - Use the **BNC** knob to select the BNC you want to assign the specific Router to.
   - **Note** When you assign a remote device to a BNC crosspoint, pressing that crosspoint button will display the corresponding device control menus. If it is on a Key bus, pressing the button will cycle through the device control menus and the **Key Type Menu**.
   - Use the **Router** knob to select the Router you want to assign to the BNC.
   - Use the **BNC Out** knob to select the Output source on the Router that is feeding the BNC on the Synergy switcher. Refer to the section “Setting up the Switcher” on page 14–19 for more information.

   **Note** You must select **O/P 0001** for the Router output when using an **Extron System 8/10 Plus Router**.

6. Press **Router Other** to display the **Router Other Menu**.

7. Select the Router levels that will be switched for the Router connected to the specific BNC as follows:
   - Use the **BNC** knob to select the Router you want to set the levels for.
   - Use the **Level** knob to configure the Router level(s), or breakaways, that will be switched on the Router when a new input is selected. Choices are dependent upon the type of Router connected, and include:
     ~ **All** — Select this option when you want to switch all levels when you select a new input source.
     ~ **0-127** — Any one level (numbered from 0 to 127). Zero (0) corresponds to the first level on the Router, possibly numbered as 1 on the Router.
~ On the Extron System 8/10 Plus Routers, you can only select from 1 through 4.

~ On the Codan Routing Systems this is the Breakaway knob and you can only select from 1 through 8.

**Note**

When you change the VikinX Router levels using the Synergy switcher menus, the configuration of the VikinX switches 1-4 must also change. You must then power down and power up the VikinX Router to update the settings. Refer to the Configuration section of your VikinX manual for more information.

8. Press HOME to display the Installation Change Confirmation Screen.

9. Accept or reject the changes you have made as follows:
   - Press Confirm to accept the changes.
   - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up a Routing switcher to a BNC on the Synergy switcher.
Router Custom Controls

A custom control button can be programmed to set a specific source/BNC crosspoint pair or fire a salvo (run a pre-programmed macro) on a Router.

Note

You must have the Router Control option installed in order to control a Router from the Synergy switcher. Refer to the section “Setting up the Switcher” on page 14–19 for information on setting up a Router.

The following Custom Controls are covered in this section:

- Source/BNC Crosspoint Pair
- Fire a Router Salvo

Source/BNC Crosspoint Pair

The Source/BNC Crosspoint Pair custom control macro allows you to change the source on the Router that is assigned to the BNC input on the switcher. The Crosspoint Connect Menu displays the following elements of the Router setup:

- **Source #** — This element indicates the currently selected source on the Router.
- **BNC #** — This element indicates the currently selected BNC on the Synergy switcher that the source on the Router is connected to.
- **Dest #** — This element indicates the BNC on the Router that is being used to connect the Router to the Synergy switcher.

Use the following procedure to add a Source/BNC crosspoint pair to a custom control:

1. Navigate to the Custom Controls Menu as follows:
   - Press **HOME ⇒ Custom Controls**.

   ![Custom Controls Menu](image)

2. Select the custom control button you want to record to as follows:
   - Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   - Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

   ![Operating Tip](image)

   As a recommendation, keep special functions grouped together on your physical custom control buttons.
3. Navigate to the **Insert Router Control Menu** as follows:

- Press **Start Recording ➔ Insert Special ➔ MORE ➔ Router.**

4. Select the Router you want to apply the **Crosspoint Connect** custom control to as follows:

- Use the **Com Port** knob to select the remote port that the Router is connected to. Refer to the section “Communications Setup” on page 14–19 for more information.
- Use the middle knob to select **Xpt Connect**.

5. Select the source on the Router you want to set to a different output as follows:

- Press **Set Src** to display the **Router Source Menu**.

- Use the keypad in the **Global Memory System Group** to enter the number of the source you want to select.
- Press **ENTER**.

6. Select the BNC on the Synergy switcher you want to assign the Router source to as follows:

- Press **Set BNC** to display the **Router BNC Menu**.
• Use the keypad in the **Global Memory System Group** to enter the number of the BNC you want to select.

• Press **ENTER**.

**Note**

If you enter a BNC number that is not assigned to the selected Router, the Set BNC value will default to the first BNC assigned to the selected Router.

7. Press **Insert** to add this macro into the custom control and display the **Insert Special Menu 1-2**.

8. Press **UP ONE** to display the **Recording Menu**.

9. Press **Finish Recording**, or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for inserting a Source/BNC crosspoint pair into a custom control. Once your custom control buttons have been programmed, be sure to properly name them. Refer to the section “**Naming Custom Controls**” for more information on naming custom control buttons.

### Fire a Router Salvo

The Fire Router Salvo custom control macro allows you to fire a salvo on the Router. You will have to program your salvos on the Router itself in order to be able to fire them. Refer to your Router documentation for information on storing a salvo on your Router.

Only the following Routers support salvos:

- Codan Kondor EOS-2000
- Sierra Yosemite
- Leitch VIA32
- Grass Valley SMS 7000
- Grass Valley Encore Control System
- Chyron (Pro-Bel) Freeway
- Pro-Bel Halo
- PESA Cougar

Use the following procedure to fire a Router Salvo from the selected Router:

1. Navigate to the **Custom Controls Menu** as follows:

   • Press **HOME ⇒ Custom Controls**.
2. Select the custom control button you want to record to as follows:
   • Use the Bank knob to select the custom control bank you want to record the custom control to.
   • Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) in the list have already been programmed.

   ![Operating Tip]
   As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Navigate to the Insert Router Control Menu as follows:
   • Press Start Recording ⇒ Insert Special ⇒ MORE ⇒ Router.

4. Select the Router you want to apply the Fire Salvo custom control to as follows:
   • Use the Com Port knob to select the remote port that the Router is connected to. Refer to the section “Communications Setup” on page 14–19 for more information.
   • Use the Selection knob to select Fire Salvo to display the Fire Salvo Menu.

5. Use the Salvo # knob to select the salvo on the selected Router you want to fire.

   ![Operating Tip]
   You can also use the keypad in the Global Memory System Group to enter the number of the salvo.

6. Press Insert to add this macro into the custom control.
7. Press UP ONE to display the Recording Menu.
8. Press Finish Recording, or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for inserting a fire Router salvo into a custom control. Once your custom control buttons have been programmed, be sure to properly name them. Refer to the section “Naming Custom Controls” for more information on naming custom control buttons.
Character Generators

In This Chapter

This chapter provides instructions for connecting and setting up a Character Generator with your Synergy switcher. Before you begin, ensure that the Character Generator Interface option is installed. If not, contact Ross Video for details. Refer to the section “Installed Options Menus” on page 2–37 for instructions on verifying the status of installed options.

The following topics are discussed:

- Supported Character Generators
- Communications Connections
- Communications Setup
- Setting up Character Generator BNCs
- Character Generator Custom Controls
 Supported Character Generators

The Synergy Series Switcher has been tested with a number of Character Generators to ensure the highest standard for compatibility and reliability. The following Character Generators are currently supported by your Synergy switcher:

- Avid (Pinnacle) FXDeko II Character Generator
- Chyron Duet LEX Character Generator (using Lyric software version 5.23)
- Chyron HyperX Character Generator (using Lyric software version 5.22)
- Leitch (Inscriber) Inca Character Generator
- Vizrt Viz|Trio Character Generator (Trio client version 2.5)
Communications Connections

You can connect a number of Character Generators to your Synergy switcher. The procedure for connecting the Character Generator will depend on the type of Character Generator you have. This section will provide general instructions for connecting the Character Generator to one of the Remote Ports on the back of the Synergy Control Panel.

Note

These instruction are provided as a guide, for specific information on the Character Generator you are connecting to the Synergy switcher, refer to the documentation provided with your Character Generator.

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **Character Generator Interface** — This is the software option from Ross Video that allows your Synergy switcher to control a Character Generator.

- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your Character Generator. Refer to the section “Character Generator Interface Cable Pinouts” on page 15–4 for information on the pin-outs and connector required for your Character Generator. Ross Video does not supply this cable.

Use the following procedure to connect a Character Generator to your Synergy switcher:

1. Connect and secure the 9-Pin, Male, end of the Interface Cable to one of the Remote Ports on the back of the Synergy control panel.

2. Connect and secure the other end of the cable to the appropriate port on the Character Generator. The suggested port for each supported Character Generator is listed below:

   - **Leitch (Inscriber) Inca** — Connect the Interface cable to the COM port on the rear of the Inca Character Generator chassis. Refer to the section “Leitch (Inscriber) Inca Character Generator” on page 15–4 for more information on the cabling for this device.

   - **Chyron Duet LEX** — Connect the Interface cable to the COM 1 port on the rear of the Duet LEX Character Generator chassis. Refer to the section “Chyron Character Generators” on page 15–4 for more information on the cabling for this device.

   - **Chyron HyperX** — Connect the Interface cable to the COM 1 port on the rear of the Chyron HyperX Character Generator chassis. Refer to the section “Chyron Character Generators” on page 15–4 for more information on the cabling for this device.
• **Avid (Pinnacle) FXDeko II** — Connect the Interface cable to the COM port on the rear of the FXDeko II Character Generator chassis. Refer to the section “Avid (Pinnacle) FXDeko II Character Generator” on page 15–5 for more information on the cabling for this device.

• **Vizrt Viz/Trio Character Generator** — Connect the Interface cable to the COM port on the rear of the Trio client system. Refer to the section “Vizrt Viz/Trio Character Generator” on page 15–6 for more information on the cabling for this device.

This completes the procedure for connecting a Character Generator to the Synergy switcher. Refer to the section “Communications Setup” on page 15–7 for instructions on how to set up communications protocols on the switcher, as well as on the Character Generator.

### Character Generator Interface Cable Pinouts

Use the information in this section to connect the Interface Cable from the Synergy switcher to the Character Generator.

#### Leitch (Inscriber) Inca Character Generator

The Synergy control panel connects to the Inca Character Generator via the remote port on the Synergy control panel, and the COM port on the rear of the Leitch Inca Character Generator chassis.

Cable connections in the following table refer only to those between the Synergy control panel and the Leitch (Inscriber) Inca Character Generator. Other cable connections present on the Inca Character Generator can be found in the Leitch (Inscriber) documentation.

<table>
<thead>
<tr>
<th><strong>Synergy-to-Inscriber Inca CG Wiring Chart</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Synergy Control Panel</strong></td>
</tr>
<tr>
<td>Remote Port</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
</tbody>
</table>

#### Chyron Character Generators

The Synergy control panel connects to the Chyron Duet LEX and the HyperX CG via the remote port on the Synergy control panel, and the COM 1 port on the rear of the Chyron chassis.

Cable connections in the following table refer only to those between the Synergy control panel and the Chyron CG. Other cable connections present on the Chyron CG can be found in the Chyron documentation.
Avid (Pinnacle) FXDeko II Character Generator

The Synergy control panel connects to the FXDeko II Character Generator via the remote port on the Synergy control panel, and the COM port on the rear of the FXDeko II chassis. This information is current for Synergy software version 17, or higher, used in conjunction with FXDeko II software version 3.05.

Cable connections in the following table refer only to those between the Synergy control panel and the FXDeko II Character Generator. Other cable connections present on the FXDeko II can be found in the Avid documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Chyron CG</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>R</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>FXDeko II CG</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>R</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
**Vizrt Viz|Trio Character Generator**

The Synergy control panel connects to the Vizrt Viz|Trio Character Generator via the remote port on the Synergy control panel, and the COM port on the rear of the Viz|Trio Client system.

Cable connections in the following table refer only to those between the Synergy control panel and the Viz|Trio Client system. Other cable connections present on the Vizrt Viz|Trio Character Generator, or the Viz|Trio Client system, can be found in the Vizrt documentation.

| Synergy Control Panel | Viz|Trio Client system |
|-----------------------|---------------------|
| **Remote Port**       | **Signal**          | **COM Port**     | **Signal** |
| 1                     | Chassis             |                 |            |
| 2                     | Tx                  | 2               | Rx         |
| 3                     | Rx                  | 3               | Tx         |
| 4                     | n/c                 |                 |            |
| 5                     | Ground              | 5               | Ground     |
| 6                     | Ground              |                 |            |
| 7                     | n/c                 |                 |            |
| 8                     | n/c                 |                 |            |
| 9                     | Chassis             |                 |            |
Communications Setup

This section will provide instructions for setting up the Character Generator to communicate with the Synergy switcher.

The following topics are discussed in this section:

- Setting up the Switcher
- Setting up the Character Generator

Setting up the Switcher

In order to have the Synergy switcher communicate with a Character Generator, the remote port on the control panel that the Character Generator is connected to must be set up to communicate with the particular Character Generator you have connected.

Use the following procedure to configure a Remote port on the control panel to connect with a Character Generator:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.
2. Press Type to display the Type Menu.

3. Assign a remote port to the Character Generator as follows:
   - Use the Com Port knob to select the remote port on the Synergy switcher that is connected to the Character Generator.
   - Use the Device knob to select CharGen.
4. Press Select Device to display the Select Device Menu.
5. Assign a specific Character Generator to the remote port as follows:

- Use the **Com Port** knob to select the remote port that the desired Character Generator is connected to.
- Use the **Device** knob to select the type of Character Generator that is connected to the port. You can select between the following:
  - **NONE** — Use this option to not assign a Character Generator to the selected com port.
  - **Inscriber** — Use this option to assign a Leitch (Inscriber) Inca Character Generator to the selected com port. Refer to the section “Leitch (Inscriber) Inca Character Generator” on page 15–4 for details.
  - **Chyron** — Use this option to assign a Chyron Character Generator to the selected com port. Refer to the section “Chyron Character Generators” on page 15–11 for details.
  - **Deko** — Use this option to assign an Avid (Pinnacle) FXDeko II Character Generator to the selected com port. Refer to the section “Avid (Pinnacle) FXDeko II Character Generator” on page 15–12 for details.
  - **Vizrt** — Use this option to assign a Vizrt Viz|Trio Character Generator to the selected com port. Refer to the section “Vizrt Viz|Trio Character Generator” on page 15–13 for details.

6. Press **Com Settings** to display the **Com Settings Menu**.

7. Set the communications protocols for the Character Generator as follows:

- Use the **Com Port** knob to select the Character Generator you are setting the communications settings for.
- Use the **Baud** knob to select the baud rate for the Character Generator. Refer to the section “Setting up the Character Generator” on page 15–10 for the specific settings for your Character Generator.
- Use the **Parity** knob to select the parity for the specific Character Generator. Refer to the section “Setting up the Character Generator” on page 15–10 for the specific settings for your Character Generator.
8. Press **Com Type** to display the **Com Type Menu**.

   ![Com Type Menu](image)

   **Communications — Com Type Menu**

9. Select the type of serial communication that will be used to communicate with the Character Generator as follows:

   - Use the **Com Port** knob to select the Character Generator you want to set the communication type for.
   - Use the **Type** knob to select the type of serial communications for the selected port. Refer to the section “Setting up the Character Generator” on page 15–10 for the specific settings for your Character Generator.

   **Note**
   
   If you are not setting up a Chyron Character Generator, proceed to step Step (11.).

10. Press **Extra Options** to display the **Extra Options Menu**.

   - If you are setting up a **Chyron Duet LEX Character Generator**, there are extra options that you will have to set up. Refer to the section “Chyron Extra Options” on page 15–11 for more information.
   - If you are setting up a **Chyron HyperX Character Generator**, there are extra options that you will have to set up. Refer to the section “Chyron Extra Options” on page 15–11 for more information.

11. Press **HOME** to display the **Installation Change Confirmation Screen**.

12. Accept or reject the changes you have made as follows:

   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the communications with the Character Generator. Next you will set up the Character Generator to communicate and accept commands from the switcher.
Setting up the Character Generator

In order to have the Synergy switcher communicate with a Character Generator, the Character Generator you are connecting to the switcher must be set up to communicate and accept commands from the Synergy switcher.

**Leitch (Inscriber) Inca Character Generator**

Use the following information to configure and connect your Leitch (Inscriber) Inca Character Generator to your Synergy switcher:

- Use the following communications settings when connecting the Leitch (Inscriber) Inca Character Generator to the Synergy switcher:

<table>
<thead>
<tr>
<th>Synergy-to-Inscriber Inca CG Communication Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Setting</strong></td>
</tr>
<tr>
<td>---------------------</td>
</tr>
<tr>
<td>Transmission Standard</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
</tbody>
</table>

Use the following procedure to configure the **Inscriber AutoCG** software:

1. Click the **Preference** button in the AutoCG window to display the **Preferences Window**.
2. Click on the **General Tab**.
3. Select the **Serial Port** option in the **Receive Command From Area**.
4. Configure the serial port as follows:
   - **Com Port** — This must be set to the COM port that is connected to the Synergy switcher.
   - **Baud Rate** — This must be set to **38400**.
   - **Data Bits** — This must be set to **8**.
   - **Parity** — This must be set to **None**.
   - **Stop Bits** — This must be set to **1**.

**Important**

You can have only one INS template file per folder on your Inscriber computer. If you have more than one, the system will ignore the newest INS file(s).

5. Configure the **Strata Layers** as follows:
   - Layer 1: Quartz
   - Layer 2: IncaCG
   - Layer 3: Automation CG Max (AutoCG)
   - Layer 4: Automation CG Max (AutoCG)

**Note**

Refer to your Leitch (Inscriber) documentation for additional information.
Chyron Character Generators

Use the following information to configure and connect your Chyron Duet LEX or HyperX Character Generator to your Synergy switcher:

- Use the following communications settings when connecting a Chyron Character Generator to the Synergy switcher:

  Synergy-to-Chyron CG Communication Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

Chyron Extra Options

The Playtime Extra Option enables you to set a duration for animation playout for a Chyron Character Generator. This will prevent the Synergy switcher from timing-out while an animation is playing.

Use the following procedure to set up the Extra Options for a Chyron Character Generator:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME (to display the Main Menu 1-2).
   - MORE (to display the Main Menu 2-2).
   - Setup (to display the Setup Menu).
   - Installation (to display the Installation Menu).
   - Communications (to display the Communications Menu 1-2).

2. Press Extra Options to display the Extra Options Menu.

3. Assign a target machine as follows:
   - Use the top Com Port knob to select the remote port that the Chyron Character Generator is connected to.
   - Use the middle knob to select TargetMachine.
   - Use the bottom Value knob to select Duet.

4. Assign a Playtime Duration as follows:
   - Use the top Com Port knob to select the remote port that the Chyron Character Generator is connected to.
   - Use the middle knob to select Playtime.
   - Use the bottom Value knob to set a maximum duration for playing an animation in seconds.

  Note

  You can set a playtime between 10 and 120 seconds.

This concludes the procedure to set up the Extra Options for a Chyron Character Generator.
**Chyron Software Setup**

The Synergy switcher communicates with the Chyron Character Generator using Chyron Lyric™ software and the Ross Video-II Translator plug-in. The plug-in intercepts all commands from the serial port and passes the data to the Lyric software for processing.

This information is current for Synergy software version 17, or higher, used in conjunction with the Chyron Duet LEX and Lyric software version 5.23 and the Chyron HyperX with Lyric software version 5.22. Refer to your Chyron documentation for additional setup information.

Use the following procedure to set up the Chyron Character Generator software for the Ross Video-II Translator plug-in:

1. Ensure that the Ross Video-II Translator plug-in file **II Translator.ocx** is copied to the Plug-ins folder located in the Lyric main directory.
2. Ross Video recommends selecting **Air Channel** for each video processing board installed:
   - Click **Config** from the Lyric menu bar.
   - Select the **Duet Configuration** option.
   - Select the **Configure Board Use** tab.
   - Select **Air Channel** for each video processing board.
   - Click **OK**.
3. Ensure the Telnet option is enabled for the Ross Video-II Translator plug-in to communicate with the Lyric software and the Synergy switcher:
   - Select **Config** from the Lyric menu bar.
   - Select the **Intelligent Interface Setup** option.
   - Select **Enable Telnet** from the **Intelligent Interface Setup** dialog.
   - Click **OK**.
4. Enable the Ross Video-II Translator plug-in as follows:
   - Select **File** from the Lyric menu bar.
   - Select **Ross Video - II translator** from the file list.
   - Click **Run**.

This concludes the procedure to set up the Chyron Character Generator software for the Ross Video-II Translator plug-in.

**Avid (Pinnacle) FXDeko II Character Generator**

Use the following information to configure and connect your FXDeko II Character Generator to your Synergy switcher:

- Ensure that the **Automation** feature is set up for your FXDeko II Character Generator to enable communication with the Synergy switcher. Refer to your Avid documentation for details on enabling this feature.
- Ensure that the **Unicode** check box is cleared on the FXDeko II Character Generator. This check box may be automatically selected when a Newsroom automation system is used with the FXDeko II Character Generator.
Use the following communications settings to configure and connect the Viz|Trio Client system to the Synergy switcher:

**Vizrt Viz|Trio Character Generator**

Use the following communications settings to configure and connect the Viz|Trio Client system to the Synergy switcher:

**Synergy-to-Vizrt Viz|Trio CG Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

The Synergy switcher communicates with the Vizrt Viz|Trio Character Generator using the Viz|Trio Client system and the **Intelligent Interface**.

This information is current for Synergy software version 18, or higher, used in conjunction with the Viz|Trio Client system software version 2.5. Refer to your Vizrt Viz|Trio documentation for additional setup information.

Use the following procedure to set up the **Intelligent Interface** for the Viz|Trio Client system to communicate with the Synergy switcher:

1. Ensure the Vizrt Viz|Trio Character Generator is set up.
2. In the Vizrt Viz|Trio software, navigate to the **Configuration Menu**.
3. From the **Configuration Menu**, select **External Interfaces** to display the **External Interfaces** dialog.
4. Select the **Intelligent Interface** tab.
5. Set the communication settings as follows:
   - **Com Port** — Select the Com Port on the Viz|Trio Client system that is connected to the Synergy control panel.
   - **Baud Rate** — Select 9600 for the baud rate.
   - **Show Path** — Select the folder the Synergy switcher will load from the Remote Control and Custom Control Menus.
6. Save your changes.

This concludes the procedure to set up the **Intelligent Interface** for the Viz|Trio Client system to communicate with the Synergy switcher.
Setting up Character Generator BNCs

The CG Setup Menu allows you to associate a Character Generator input with a particular Character Generator communication port.

**Important**

You must have a Character Generator set up on the Synergy switcher before you can assign a BNC to that device. Refer to the section “Setting up the Switcher” on page 15–7 for more information on setting up Character Generator communications.

Use the following procedure to assign the Character Generator to a specific BNC input:

1. Navigate to the BNC Menu 1-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.
2. Press BNC Type to display the BNC Type Menu.

3. Assign a BNC to the Character Generator Video, or Fill, signal as follows:
   - Use the BNC knob to select the BNC that the Video, or Fill, from the Character Generator is connected to.
   - Use the Type knob to select CharGen.
   - Use the Asp Ratio knob to select the video aspect ratio of the Character Generator output.

4. Navigate to the CG Setup Menu as follows:
   - Press MORE ⇒ Still/CG Setup.
5. Assign a specific Character Generator to the CharGen BNC as follows:

For the Leitch Inca, Video and Alpha signals are fed from the **SDI** and **SDI Key** BNCs in the **Video Outputs** area on the Inca CG to the BNC inputs on the Synergy frame.

- Use the **BNC** knob to select the BNC you want to assign the specific Character Generator to.
- Use the **CharGen** knob to select the Character Generator you want to assign to the BNC.
- Use the **Frame Buf** knob to select the channel output of the Character Generator.
  ~ For the **Chyron Duet LEX** and **HyperX**, you must ensure the frame buffer matches the video processing board (VPB) for the Chyron CG connected to the selected BNC. Refer to your Chyron documentation for more information.
  ~ For the **Avid (Pinnacle) FXDeko II**, this knob is labeled as **Channel**. Only channels defined as Program channels on the Character Generator should be selected.
  ~ For the **Vizrt Viz|Trio**, this knob is labeled as **Channel** and is fixed to Channel 1.

Note

The **Frame Buf** option is not available for the Leitch Inca Character Generator. Instead, you must set the channel output using a Custom Control. Refer to the section "**Character Generator Custom Controls**" on page 15–18 for more information on programming custom controls for your CG.

6. Navigate to the **BNC Type Menu** as follows:

- Press **MORE ⇒ MORE ⇒ BNC Type**.

### BNC Type Menu

<table>
<thead>
<tr>
<th>BNC (L39)</th>
<th>BNC Type</th>
<th>Tally</th>
<th>Alpha</th>
<th>Ratio</th>
<th>Key</th>
<th>Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC Names</td>
<td>BNC Type</td>
<td>Tally</td>
<td>Alpha</td>
<td>Ratio</td>
<td>Key</td>
<td>Panel</td>
</tr>
</tbody>
</table>

7. Assign a BNC to the Character Generator Alpha signal as follows:

- Use the **BNC** knob to select the BNC that the Alpha from the Character Generator is connected to.
- Use the **Type** knob to select **Alpha**.
- Use the **Asp Ratio** knob to select the video aspect ratio of the Character Generator output.
8. Press **Alpha** to display the **Alpha Menu**.

<table>
<thead>
<tr>
<th>BNC</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC</td>
<td>Alpha</td>
</tr>
<tr>
<td>BNC 4 (4)</td>
<td>Alpha 4</td>
</tr>
<tr>
<td>BNC 4</td>
<td>Unshaped</td>
</tr>
<tr>
<td>BNC</td>
<td>Shaped</td>
</tr>
</tbody>
</table>

9. Define the Character Generator Alpha as shaped or unshaped as follows:

- Use the **Alpha** knob to select the BNC that the Alpha from the Character Generator is connected to.
- Use the **Mode** knob to select the desired Alpha mode. You can choose between the following:

  **Unshaped** — Select **Unshaped** to have the switcher perform a *multiplicative Key*. With an unshaped Alpha, the hole is cut based on the gradient values of the Alpha. Shades of gray are translated into transparency levels, giving the Character Generator video a soft edge. Unshaped Alphas can also be considered true Linear Alphas.

  **Shaped** — Select **Shaped** to have the switcher perform an *additive Key*. With a shaped Alpha, the hole is cut based on the monochrome value of the Alpha. Shades of gray are translated into either white or black, giving the Character Generator video a hard edge.

10. Press **Auto Key Setup** to display the **Auto Key Setup Menu**.

<table>
<thead>
<tr>
<th>BNC</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC</td>
<td>Alpha</td>
</tr>
<tr>
<td>BNC 2 (3)</td>
<td>Alpha 3</td>
</tr>
<tr>
<td>BNC 4</td>
<td>BLACK</td>
</tr>
</tbody>
</table>

11. Associate the Character Generator Video with the Alpha as follows:

- Use the **BNC** knob to select the BNC that is assigned to the Video of the Character Generator.
- Use the **Alpha** knob to select the BNC that is assigned to the Alpha of the Character Generator.
12. Press **HOME** to display the **Installation Change Confirmation Screen**.

13. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for assigning a Character Generator to a BNC on the Synergy switcher.
Character Generator Custom Controls

A custom control button can be programmed with a macro that:

- changes a folder, tag or field
- recalls a Character Generator (CG) page
- selects a Character Generator (CG) effect file
- runs an effect
- changes the assignment tag in the Character Generator page

Note

Some commands may not be available for all Character Generators.

You must have the Character Generator Control option installed in order to control a Character Generator from the Synergy switcher. Refer to the section “Communications Setup” on page 15–7 for information on setting up a Character Generator.

Use the following procedure to create a custom control macro that will modify the Character Generator templates:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

   Operating Tip

As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Navigate to the Insert CharGen Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ CharGen.
4. Assign a command to a Character Generator for the custom control as follows:

- Use the top knob to select the Character Generator on the Synergy control panel remote port that you want to create a custom control for.

- Use the middle knob to select the command you want sent to the Character Generator. You can select between the following:
  - **Change Folder** — Select this option to assign a new directory path or folder to the Character Generator. You will have to use the keyboard to enter the new path in the Path/Folder line. A standard keyboard can be attached to the PS/2 port at the back on the Synergy control panel. This option is not available for the Vizrt Viz|Trio Character Generator.
  
  - **Recall CG** — Select this option to recall a CG template. The Event option will allow you select whether the Character Generator template is recalled to the PGM or PV output of the Character Generator. Use the keypad in the Global Memory System Group to select which template you want to recall.

- **Run Effect** — Select this option to move the next Character Generator template listed in the PV to the PGM of the Character Generator. This option is not available for the Vizrt Viz|Trio Character Generator.
  - This option is labeled as **Play Animatn** if you are using a Chyron Character Generator.
  - This option is labeled as **Swap** if you are using a Pinnacle FXDeko II Character Generator.

- **Change Tag** — Select this option to change the current text of a tag. The Event option allows you to select whether the tag you are changing is on the PGM or PV output of the Character Generator. Note that this option is labeled as **Change Field** for the Avid (Pinnacle) FXDeko II Character Generator. This option is not available for the Vizrt Viz|Trio Character Generator.
  - Use the knob to select the tag you want to change (Tag #1 to Tag #6).
  - Use a standard PS/2 keyboard connected to the Synergy switcher to enter the new tag text.

- **CG Resume** — Select this option to recall a Character Generator template.
  - The Event option will allow you select whether the Character Generator template is recalled to the program (PGM) or preview (PV) output of the character generator.

**Important**

You will only be able to recall Character Generator pages that have been stored with numerical names using the keypad.
- Use the keypad on the **Global Memory System Group** to select the template you want to recall.

5. If you have a **Leitch Inscriber Character Generator**, you can toggle the **Mode** softkey to set the mode that the Character Generator will operate in when the custom control is run. You can select between the following:
   - **Seq.** — Select this option to have the Character Generator operate in **Sequence Mode** (.INS files).
   - **Man.** — Select this option to have the Character Generator operate in **Manual Mode** (.ICG files).

6. If you have a **Leitch Inscriber Character Generator**, you can toggle the **Channel** softkey to set the channel from the Character Generator that you want the custom control to be applied to. Refer to the section “**Setting up Character Generator BNCs**” on page 15–14 for information on setting the channel output for other Character Generators. You can select between the following:
   - **A** — Select this option to have the custom control command applied to the **Channel A** output of the Character Generator.
   - **B** — Select this option to have the custom control command applied to the **Channel B** output of the Character Generator.

7. Toggle the **Event** softkey to set whether the changes will be applied to the **PV** or the **PGM** of the Character Generator when the custom control is run. You can select between the following:
   - **PV** — Select this option to have the custom control command applied to the **PV** output of the Character Generator. This option is not available for the Vizrt Viz|Trio Character Generator.
   - **PGM** — Select this option to have the custom control command applied to the **PGM** output of the Character Generator.

8. Press **Insert** to enter the Character Generator command into your custom control macro.

9. Press **UP ONE** to return to the **Custom Controls Recording Menu**.

10. Press **Finish Recording**, or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for creating a custom control macro that will modify the Character Generator templates. Once your custom control buttons have been programmed, be sure to properly name them. Refer to the section “**Naming Custom Controls**” on page 8–42 for more information on naming custom control buttons.

To play back your macro, exit the **Custom Controls Menu** and press the custom control button on the control panel that you recorded the custom control macro to. Any recorded custom control can be edited. Refer to the section “**Editing Custom Control Macros**” on page 8–47 for details.
In This Chapter

This chapter provides instructions for connecting, and setting up a VTR, DDR, or Video Server using the Sony Betacam protocol, with your Synergy switcher. Before you begin, ensure that the VTR Remote Control option is installed. If not, contact Ross Video for details. Refer to the section “Installed Options Menus” on page 2–37 for instructions on verifying the status of installed options.

Note

The VTR Remote Control option is required for any VTR, DDR, or Video Server that uses the Sony Betacam Protocol. This group of devices will be referred to as VTRs for this chapter.

The following topics are discussed:

• Supported VTRs
• Communications Connections
• Communications Setup
• Setting up VTR BNCs
• Roll VTR Setup
• VTR Custom Controls
• VTR Clip Setup
Supported VTRs

The Synergy Series Switcher has been tested with a number of VTRs (VTRs, DDRs and Video Servers), using the Betacam Protocol, to ensure the highest standard for compatibility and reliability. The following devices are currently supported by your Synergy switcher:

- Accom APR Clipstore (using the Betacam protocol)
- Alcorn McBride Digital Video Machine 2 (using the Betacam protocol)
- BitCentral Précis (using the Betacam protocol)
- Fast Forward Video Omega Digital Recorder (using the Betacam protocol)

Note: The Synergy switcher will support any VTR that uses the Generic Sony Betacam Protocol. Refer to the section “Generic VTR Cabling” on page 16–6 for more information.
Communications Connections

You can connect a number of VTRs to your Synergy switcher. The procedure for connecting the VTR will depend on the type of VTR you have. This section will provide general instructions for connecting the VTR to one of the Remote Ports on the back of the Synergy control panel.

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **VTR Remote Control** — This is the software option from Ross Video that allows your Synergy switcher to control a VTR.

- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your VTR. Refer to the section “**VTR Interface Cable Pinouts**” on page 16–4 for information on the pin-outs and connector required for your VTR. Ross Video does not supply this cable.

Use the following procedure to connect a VTR to your Synergy switcher:

1. Connect and secure the 9-Pin, Male, end of the Interface Cable to one of the Remote Ports on the back of the Synergy control panel.

2. Connect and secure the other end of the cable to the appropriate port on the VTR. The suggested port for each supported VTR is listed below:

   - **Fast Forward Video Omega Digital Recorder** — Connect the Interface cable to the RS-422 port on the Omega chassis. Refer to the section “**Fast Forward Video Omega Digital Recorder VTR Cabling**” on page 16–4 for more information on the cabling for this device.

   - **Alcorn McBride Digital Video Machine 2** — Connect the Interface cable to the RS-422 port on the Alcorn McBride DVM2 chassis. Refer to the section “**Alcorn McBride Digital Video Machine 2 VTR Cabling**” on page 16–4 for more information on the cabling for this device.

   - **Accom APR Clipstore** — Connect the Interface cable to the RS422 Master Port on the Accom APR chassis. Refer to the section “**Accom APR Clipstore VTR Cabling**” on page 16–5 for more information on the cabling for this device.

   - **BitCentral Précis** — Connect the Interface cable to the RS-422 Port on the BitCentral Précis chassis. Refer to the section “**BitCentral Précis Cabling**” on page 16–5 for more information on the cabling for this device.
• **Generic** — Connect the Interface cable to the communications port on the chassis of the VTR. Refer to the section “**Generic VTR Cabling**” on page 16–6 for more information on general VTR cabling.

This completes the procedure for connecting a VTR to the Synergy switcher. Refer to the section “**Communications Setup**” on page 16–7 for instructions on how to set up communications protocols on the switcher, as well as on the VTR.

**VTR Interface Cable Pinouts**

Use the information in this section to connect the Interface Cable from the Synergy switcher to the VTR.

**Fast Forward Video Omega Digital Recorder VTR Cabling**

The Synergy control panel connects to the Fast Forward Video Omega via the remote ports on the Synergy switcher, and the RS-422 port on the Fast Forward Video Omega.

Cable connections in the following table refer only to those between the Synergy control panel and the Fast Forward Video Omega. Other cable connections present on the Fast Forward Omega can be found in the Fast Forward Video documentation.

**Synergy-to-Fast Forward Video Omega Wiring Chart**

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Fast Forward Video Omega</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

**Alcorn McBride Digital Video Machine 2 VTR Cabling**

The Synergy control panel connects to the Alcorn McBride DVM2 via the remote ports on the Synergy switcher, and the RS-422 port on the Alcorn McBride DVM2.

Cable connections in the following table refer only to those between the Synergy control panel and the Alcorn McBride DVM2. Other cable connections present on the Alcorn McBride DVM2 can be found in the Alcorn McBride documentation.
Accom APR Clipstore VTR Cabling

The Synergy control panel connects to the Accom APR via the remote ports on the Synergy switcher, and the RS422 Master Port on the Accom APR.

Cable connections in the following table refer only to those between the Synergy control panel and the Accom APR. Other cable connections present on the Accom APR can be found in the Accom APR documentation.

### Synergy-to-Accom APR Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel Remote Port</th>
<th>Signal</th>
<th>Accom APR Clipstore RS422 Master Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
<td></td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

BitCentral Précis Cabling

The Synergy control panel connects to the BitCentral Précis via the remote ports on the Synergy switcher, and the RS-422 Port on the BitCentral Précis.

Cable connections in the following table refer only to those between the Synergy control panel and the BitCentral Précis. Other cable connections present on the BitCentral Précis can be found in the BitCentral documentation.
### Generic VTR Cabling

The Synergy control panel connects to a VTR via the remote ports on the Synergy switcher.

#### Synergy-to-BitCentral Précis Wiring Chart

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>BitCentral Précis</th>
<th>RS-422 Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
<td>→</td>
<td>2</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
<td>→</td>
<td>3</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td>→</td>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
<td>→</td>
<td>7</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
<td>→</td>
<td>8</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Refer to the documentation that accompanied your VTR, for specific port and pinout information.
Communications Setup

This section will provide instructions for setting up the VTR to communicate with the Synergy switcher.

The following topics are discussed in this section:

- Setting up the Switcher
- Setting up the VTR

Setting up the Switcher

In order to have the Synergy switcher communicate with a VTR, the remote port on the control panel that the VTR is connected to must be set up to communicate with the particular VTR you have connected.

Use the following procedure to configure a Remote port on the control panel to connect with a VTR:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.
2. Press Type to display the Type Menu.

3. Assign a Remote Com Port to the VTR as follows:
   - Use the Com Port knob to select the remote port on the Synergy switcher that is connected to the VTR.
   - Use the Device knob to select VTR (CLIP).
4. Press Select Device to display the Select Device Menu.
5. Select the device you want to assign to the VTR communications port as follows:

- Use the **Com Port** knob to select the communications port you want to assign a specific VTR to.
- Use the **Device** knob to select **Betacam**.

**Note**

You can setup a custom device using the **CUSTOM 1** and **CUSTOM 2** options. Use these options, in conjunction with the **Custom Devices** button, to manually configure the communications protocol for your particular device. Refer to the section “**Custom Devices – Uses and Limitations**” on page 27–2 for more information.

- Use the **VTR Preroll** knob to select the preroll interval (in frames).

**Note**

Preroll is applied when the **ROLL VTR** button is “armed” and the device is taken to air with a cut or auto-transition. When the transition is performed, the system will wait the selected preroll interval, and then roll the VTR. Refer to the section “**Roll VTR Setup**” on page 16–15 for more information.

6. Press **Com Settings** to display the **Com Settings Menu**.

![Com Settings Menu](image)

**Communications — Com Settings Menu**

7. Set the communications protocols for the VTR as follows:

- Use the **Com Port** knob to select the VTR port you are setting the communications settings for.
- Use the **Baud** knob to select the baud rate for the VTR. Refer to the section “**Setting up the VTR**” on page 16–11 for the specific settings for your VTR.
- Use the **Parity** knob to select the parity for the VTR. Refer to the section “**Setting up the VTR**” on page 16–11 for the specific settings for your VTR.

8. Press **Com Type** to display the **Com Type Menu**.

![Com Type Menu](image)

**Communications — Com Type Menu**
9. Select the type of serial communications that will be used to communicate with the VTR as follows:
   - Use the **Com Port** knob to select the VTR port you want to set the communications type for.
   - Use the **Type** knob to select the type of serial communications for the selected port. Refer to the section “Setting up the VTR” on page 16–11 for the specific settings for your VTR.

10. Press **Extra Options** to display the **Extra Options Menu**.

<table>
<thead>
<tr>
<th>Communications (1-2)</th>
<th>Protocol: Betacam</th>
</tr>
</thead>
<tbody>
<tr>
<td>Com Port</td>
<td>Betacam (05)</td>
</tr>
<tr>
<td></td>
<td>Remshow (11)</td>
</tr>
<tr>
<td>Equipment connected to (e.g. FFV Omega)</td>
<td>Option: TargetMachine</td>
</tr>
<tr>
<td></td>
<td>Decode NAKs</td>
</tr>
<tr>
<td></td>
<td>Value</td>
</tr>
</tbody>
</table>

   11. Assign a particular VTR to the selected com port as follows:
   - Use the **Com Port** knob to select the VTR port you want to assign a specific VTR to.
   - Use the **Option** knob to select **TargetMachine**.
   - Use the **Value** knob to select the VTR you want to assign to the selected com port. You can choose between the following:
     - **Generic** — Select this option to set up a device not specified in the list.
     - **FFV Omega** — Select this option to set up a Fast Forward Video Omega Digital Disk Recorder.
     - **DVM 2** — Select this option to set up an Alcorn McBride DVM2.
     - **Accom APR** — Select this option to set up an Accom APR Clipstore.
     - **BC Precis** — Select this option to set up a BitCentral Précis.

12. Set up the Decode NAKs (Not Acknowledgement) as follows:

   **Important**

   The Decode NAKs feature is enabled by default. The settings should only be modified if you encounter problems using the Play commands with your device or as advised by Ross Video Technical Support.
• Use the **Com Port** knob to select the VTR you want to enable the Decode NAKs feature for.

• Use the **Option** knob to select **Decode NAKs**.

• Use the **Value** knob to select Yes or No as follows:
  ~ **Yes** — Select this option to enable the Decode NAKs feature. This is the default setting.

  ~ **No** — Select this option to disable the Decode NAKs feature.

13. Set the number of fields the switcher will wait before assuming the last Play command failed, or was not received, as follows:

• Use the **Com Port** knob to select the VTR you want to set up Decode NAKs for.

• Use the **Option** knob to select **Wait nFields**.

![Communications — Extra Options (Wait nFields) Menu](image1.png)

• Use the **Value** knob to select the number of fields you want the switcher to wait before resending a NAK by default. The default value is 0.

14. Set the number of Play command retries the switcher will attempt to send to the VTR as follows:

• Use the **Com Port** knob to select the VTR you want to set up Decode NAKs for.

• Use the **Option** knob to select **NPlayRetries**.

![Communications — Extra Options (NPlayRetries) Menu](image2.png)

• Use the **Value** knob to select the number of Play command retries that the switcher will attempt to send to the VTR. The default value is 4.
• Use the Value knob to select the number times the switcher will attempt to send a Play command to the VTR. The default value is 4.

15. Press HOME to display the Installation Change Confirmation Screen.

16. Accept or reject the changes you have made as follows:
   • Press Confirm to accept the changes.
   • Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the communications with the VTR, next you will have finish setting up the VTR to communicate with the Synergy switcher.

Setting up the VTR

In order to have the Synergy switcher communicate with a VTR, the VTR you are connecting to the switcher must be set up to communicate and accept commands from the switcher.

Fast Forward Video Omega Digital Recorder

This section describes the proper installation configuration required for a Synergy switcher to interface with a Fast Forward Video Omega Digital Recorder.

Use the following information to connect a Fast Forward Omega to your Synergy switcher:

• Use the following communications settings when connecting the Fast Forward Omega to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

Alcorn McBride Digital Video Machine 2

This section describes the proper installation configuration required for a Synergy system to interface with an Alcorn McBride Digital Video Machine 2 (DVM2).

Use the following information to connect an Alcorn McBride DVM2 to your Synergy switcher:
• Use the following communications settings when connecting the Alcorn McBride DVM2 to the Synergy switcher:

**Synergy-to-Alcorn McBride DVM2 Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

**Accom APR Clipstore**

This section describes the proper installation configuration required for a Synergy system to interface with an Accom APR Clipstore.

Use the following information to connect an Accom APR Clipstore to your Synergy switcher:

• Use the following communications settings when connecting the Accom APR Clipstore to the Synergy switcher:

**Synergy-to-Accom APR Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

**BitCentral Précis**

This section describes the proper installation configuration required for a Synergy system to interface with a BitCentral Précis.

Use the following information to connect a BitCentral Précis to your Synergy switcher:

• Use the following communications settings when connecting the BitCentral Précis to the Synergy switcher:

**Synergy-to-BitCentral Précis Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>
Setting up VTR BNCs

The VTR Setup Menu allows you to associate a VTR BNC input with a particular VTR communication port.

Use the following procedure to assign the VTR to a specific BNC input:

1. Navigate to the BNC Menu 1-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.
2. Press BNC Type to display the BNC Type Menu.

3. Assign a BNC to VTR as follows:
   - Use the BNC knob to select the BNC that the VTR is connected to.
   - Use the Type knob to select VTR.
   - Use the Asp Ratio knob to select the video aspect ratio of the VTR output.

4. Navigate to the BNC Menu 3-3 as follows:
   - Press MORE ⇒ MORE.

5. Assign a BNC Input to your VTR as follows:
   - Press VTR/VDCP Xpts to display the VTR/VDCP Xpts Menu.

   Note: If you select NONE, the BNC will not be assigned to a VTR nor will it be displayed in other Synergy menus associated with VTR control.
6. Press **HOME** to display the **Installation Change Confirmation Screen**.

7. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up a VTR to a BNC on the Synergy switcher. Next you must set up the **Roll VTR Mode** on the Synergy switcher.
Roll VTR Setup

The Roll VTR Mode determines how the ROLL VTR button behaves when a VTR is selected. When you set the Roll VTR Mode, the setting affects all ROLL VTR buttons in all MLEs. You can also program a custom control macro to change the Roll VTR Mode. Refer to the section “VTR Custom Controls” on page 16–17 for information on programming custom controls for VTRs.

Use the following procedure to configure the Roll VTR Mode:

1. Navigate to the Personality Menu 1-4 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Press Roll VTR Mode to display the Roll VTR Mode Menu.

<table>
<thead>
<tr>
<th>Personality (1-4)</th>
<th>Roll VTR Mode</th>
<th>Play</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Arm</td>
<td>Arm</td>
</tr>
<tr>
<td></td>
<td>Armed Always</td>
<td></td>
</tr>
</tbody>
</table>

Roll VTR Mode Menu

3. Use the Roll VTR Mode knob to select a mode for the Roll VTR button. You can select between the following:

   • **Play Mode** — Selecting this mode allows you to play a VTR clip directly by pressing the ROLL VTR button. Once pressed, the clip will start to play and will have to be taken on-air manually with the Fader, a Cut or Auto Transition. This is the default setting.

   • **Arm Mode** — Selecting this mode allows you to have a VTR clip play with the next transition that takes the MLE on-air by pressing the ROLL VTR button. This can be used to roll multiple VTRs if they are re-entered. Once pressed, the clip will only start to play when it is taken on-air with a Cut, Auto Transition, or if you double-press the assigned crosspoint button.

   • **Armed Always** — Selecting this mode allows you to have a VTR clip play with the next transition that takes the MLE on-air when you press the assigned crosspoint button.

   **Important**
   When the OverDrive production controller system is connected to the Synergy switcher, activating the Editor button turns on all the Roll VTR buttons and sets the Roll VTR Mode to Arm, disabling the Roll VTR Mode selection in the Personality Menu.

   • **Note**
   If an Auto Transition is performed with the ROLL VTR active, and in Arm or Armed Always Mode, the switcher will apply the Pre-Roll time for the VTR before it takes the VTR on-air.
This completes the procedure for configuring the Roll VTR Mode.

**Notes on Selecting the Play Mode**

When the ROLL VTR button is in the Play Mode:

- Pressing the button immediately rolls the serial device selected on the PST bus (one device per bus, including one device from a re-entered MLE).
- The transition that brings the device to air must be initiated by the operator with the fader, CUT, or AUTO TRANS buttons.
- The button is momentary. It is lit only when pressed.

**Notes on Selecting the Arm or Armed Always Modes**

When the ROLL VTR button is in the Arm Mode or Armed Always Mode:

- Pressing the button arms the switcher to roll the selected serial device (one device per bus, including one device from a re-entered MLE) on the PST bus in the next transition.
- When the transition is performed by pressing the crosspoint on the PGM bus, CUT, or AUTO TRANS, the device rolls, and goes to air after the preroll interval has elapsed.
- During preroll, moving the fader, pressing CUT, or double-pressing the crosspoint on the PGM bus will override the preroll time and take the VTR to air immediately.
- On a re-entered MLE, ROLL VTR activates only the first VTR it finds that is about to be brought on-air. The search order is: re-entered MLE BKGD (including its own re-entry, if necessary), then re-entered MLE PST, then Key 1, then Key 2 – each, if necessary, with its own re-entry checked.
- If the mode is set to Arm, the button is latching. It remains lit until it is pressed again.
- If the mode is set to Armed Always, the button is always lit. Pressing the Roll VTR button does not disable it. Instead, you must configure the Roll VTR mode in the Personality Menu or in a custom control macro.
VTR Custom Controls

The **Custom Control** function allows you to program sequences of keystrokes (called “macros”) and other special switcher functions — and store them in dedicated buttons in the **Custom Control** group. Once programmed, a macro can be played back simply by pressing **one button** in the **Custom Control** group.

**Note**

You must have the **VTR Remote Control** option installed in order to control a VTR from the Synergy switcher. Refer to the section “Setting up the Switcher” on page 16–7 for information on setting up a VTR with the Synergy switcher.

**Programming Transport Commands**

A custom control button can be programmed with the transport functions that are located on the **VTR Clips Menu** and the **Remote Control Menu**. This allows for quick access to these functions, or you can string a number of these functions together in a single custom control. Examples of transport functions are Play, Pause, Fast Forward, and Stop.

Use the following procedure to program custom control buttons that include special transport functions for VTRs:

1. Navigate to the **Custom Controls Menu** as follows:
   - Press **HOME ⇒ Custom Controls**.

   ![Custom Controls Menu]

   **Custom Controls Menu**

<table>
<thead>
<tr>
<th>Start Recording</th>
<th>Modify Name</th>
<th>Start Relative Recording</th>
<th>Default All Names</th>
<th>Delete Macro</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button 1 Custom</td>
<td>Button 2 Custom</td>
<td>Button 3 Custom</td>
<td>Button 4 Custom</td>
<td>Button 5 Custom</td>
</tr>
</tbody>
</table>

2. Select the custom control button you want to record to as follows:
   - Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   - Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

   **Operating Tip**

   As a recommendation, keep transport control functions for similar devices grouped together on your **physical** custom control buttons.
3. Navigate to the **Insert VTR Menu** as follows:
   - Press **Start Recording** ⇒ **Insert Special** ⇒ **VTR**.

**Note**
If an error message is displayed stating that there are no communications ports assigned to VTRs, ensure that the VTR you are trying to control has been properly set up. Refer to the section “Communications Setup” on page 16–7 for setup information.

4. Select a VTR function to insert as follows:
   - Use the top knob to select the VTR that you want to assign the custom control to.
   - Use the middle knob to select the transport control function that you want to assign to the selected VTR. You can choose between the following:

**Note**
If you are using a BitCentral Précis, you can only choose between the **Play**, **Stop**, and **Fast Forward (FFwd)** commands. The **Fast Forward** command advances the VTR to the next clip in the BitCentral Précis rundown.

   - **Fast Forward** — Select this command to have the VTR go into full fast forward mode.
   - **Frame Advance** — Select this command to have the VTR move (jog) the video one frame forward.
   - **Frame Reverse** — Select this command to have the VTR move (jog) the video one frame reverse.
   - **Go to Clip** — Select this command to have the VTR cue to a selected clip.

**Note**
When you select **Go To Clip**, the bottom **Go To Clip** knob appears, allowing you to select the number (00-99) for the clip you want to cue up.

   - **Rewind** — Select this command to have the VTR go into full fast rewind mode.
   - **Stop** — Select this command to have the VTR stop.
   - **Record** — Select this command to have the VTR go into record mode.
   - **Play** — Select this command to have the VTR go into play mode, or 1× forward.
   - **Pause** — Select this command to have the VTR to into pause mode.
Operating Tip

Transport control functions can be strung together (while in programming mode), allowing one custom control button to perform *multiple functions* when it is pressed. For example, you can have the *Go To Clip* function followed by the *Play* function, allowing a single custom control macro to go to a clip and then run it.

6. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

7. Press **UP ONE** to display the **Recording Menu**.

8. Press **Finish Recording** or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for programming custom control buttons that include special transport functions for VTRs.

Once your custom control buttons have been programmed, be sure to properly name them. Refer to the section “*Naming Custom Controls*” on page 8–42 for more information on naming custom control buttons. Any recorded custom control can be edited. Refer to the section “*Editing Custom Control Macros*” on page 8–47 for details.

### Programming the Roll VTR Mode

The **Roll VTR Mode** determines how the **ROLL VTR** button behaves when a VTR is selected. When you set the **Roll VTR Mode**, the setting affects all **ROLL VTR** buttons in all MLEs.

**Important** A custom control macro that changes the **Roll VTR Mode** state will disable the Roll VTR Mode selection in the **Personality Menu**.

Use the following procedure to change the **Roll VTR Mode** with a custom control macro:

1. Navigate to the **Custom Controls Menu** as follows:
   - Press **HOME ⇒ Custom Controls**.

   ![Custom Controls Menu](image)

   *Custom Controls Menu*

   2. Select the custom control button you want to record to as follows:
• Use the **Bank** knob to select the custom control bank you want to record the custom control to.

• Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) in the list have already been programmed.

### Operating Tip

As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Navigate to the **Special Menu** as follows:

   • Press **Start Recording** ⇒ **Insert Special** ⇒ **Special**.

   ![Insert Special — Special Menu]

4. Change the Roll VTR Mode as follows:

   • Use the top knob to select **Roll VTR Mode**.

   • Use the **Roll VTR Mode** knob to select a **Roll VTR Mode**. You can choose between the following:

     - **Play** — Select this option to issue a Play command to the serial device when the **Roll VTR** button is selected in the PST Bus. This is the default setting.

     - **Arm** — Select this option to enable the Synergy switcher to automatically transition the device to air after the preroll interval has lapsed.

     - **Armed Always** — Select this option to have the **ROLL VTR** always active, the button is always lit. The clip will play when it is taken on-air when you press the assigned crosspoint button.

   ![Note]

   If an Auto Transition is performed with the **ROLL VTR** active, and in **Arm** or **Armed Always Mode**, the switcher will apply the **Pre-Roll** time for the device before it takes the device on-air.

   ~ **Play** — Select this option to issue a Play command to the serial device when the **Roll VTR** button is selected in the PST Bus. This is the default setting.

   ~ **Arm** — Select this option to enable the Synergy switcher to automatically transition the device to air after the preroll interval has lapsed.

   ~ **Armed Always** — Select this option to have the **ROLL VTR** always active, the button is always lit. The clip will play when it is taken on-air when you press the assigned crosspoint button.

5. Press **Insert** to enter the change in Roll VTR Mode into your custom control macro.

6. Press **UP ONE** to return to the **Custom Controls Recording Menu**.

7. Press **Finish Recording** or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure to change the **Roll VTR Mode** with a custom control. Any recorded custom control can be edited. Refer to the section “**Editing Custom Control Macros**” for details.
VTR Clip Setup

In order to easily recall clips on the VTR from the Synergy switcher, you will have to store the clips you want to use to Clip Registers on the switcher. These Clip Registers store the location, or timecode, on the VTR for the clip, and the name of the clip.

The VTR Clips Menu allows you to perform the following functions:

- Select a VTR and a clip number.
- Grab or enter a timecode (and other device-specific data), name the clip, and store it in a clip register. Up to 100 clips can be stored (using registers 00 to 99).
- Cue and preview each clip.

Programming VTR Clips

Use the following procedure to program a VTR clip:

1. Navigate to the VTR Clips Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Clips ⇒ VTR Clips.
2. Press Clip Type to display the Clip Type Menu.
3. Select the Clip Register you want to store a VTR Clip to as follows:
   - Use the Clip knob to select the Clip Register that you want to program (00-99).
   - Use the Device knob to select the remote port for the VTR you want to store the clip information for.
   - Use the Enable/Disable knob to select if you want the clip to be displayed in the Remote Control Menu (for on-air use), or to be disabled for use later.
4. Press Name Clip to display the Clip Name Menu.

   The VTR Clip name is the one that is displayed for the Clip Register on the display in the Global Memory System Group and on the Remote Control Menu.
Use the **Horizontal** and **Vertical** knobs (in conjunction with the editing softkeys) to enter the desired clip name.

A standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the System Control buttons and knobs. Refer to the section, “Using The Keyboard” in the Synergy Series Operation Guide for details.

---

**Important**

Do not enter a space as the first or last character of a clip name.

---

Press **Accept New Name** to complete the naming procedure and return to VTR Clips Menu 1-2. The new name is now shown in the status area and as one of the options for the **Clip** knob.

---

5. Select the Timecode to be stored in the **Clip Register** as follows:

---

**Note**

If you do not know the timecode for the clip you want to store to the Clip Register, you can manually preview the VTR video using the command on the VTR Clips Menu 2-2 and grab the timecode. Refer to the section “Grabbing a Timecode” on page 16–23 for information on grabbing a timecode.

---

Press **Hours Minutes** to display the Hours Minutes Menu.
Synergy Series Installation Guide (v18)  VTRs (Betacam)  • 16–23

As you adjust the Hours, Minutes, Seconds and Frames values, the corresponding fields of the timecode are updated. These timecode fields are as follows: `(hours):(minutes):(seconds):(frames)`.

- Use the **Hours** knob to adjust the value in the hours field of the **Timecode**.
- Use the **Minutes** knob to adjust the value in the minutes field of the **Timecode**.
- Press **Seconds Frames** to display the **Seconds Frames Menu**.

Use the **Seconds** knob to adjust the value in the seconds field of the **Timecode**.
- Use the **Frames** knob to adjust the value in the frames field of the **Timecode**.

You can preview the Timecode location by selecting the VTR on the PST Bus and pressing **Cue to Timecode**.

- Press **Grab Timecode** to use the new timecode value for the Clip Register.

6. Press **HOME** to store your settings.

This completes the procedure for programming VTR clips.

**Grabbing a Timecode**

If you do not know the timecode for the clip you want to store, you can manually scan the VTR video using the commands on the **VTR Clips Menu 2-2** and grab the timecode.

Use the following procedure to grab a timecode:

1. Navigate to the **VTR Clips Menu 1-2** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Clips** ⇒ **VTR Clips**.
2. Select the Clip Register and VTR that you want to store. Refer to the section “Programming VTR Clips” on page 16–21 for more information on programming VTR Clips.

3. Grab a timecode as follows:
   - Press MORE to display VTR Clips Menu 2-2.

   ![VTR Clips Menu 2-2](image)

   VTR Clips Menu 2-2 — VTR Transport Controls
   - Cue the VTR to the desired clip location using the transport controls: Rewind, Back Frame, Pause, Play, Ahead Frame and Fast Forward.
   - Press Pause to hold the VTR at the desired timecode.
   - Press MORE to display the VTR Clips Menu 1-2.

   ![VTR Clips Menu 1-2](image)

   VTR Clips Menu 1-2
   - Press Grab Timecode to grab the current timecode and display it in the Timecode field.

4. Press HOME to store your settings.

This completes the procedure for grabbing a VTR timecode.
Audio Servers

In This Chapter

This chapter provides instructions for connecting, and setting up an Audio Server, with your Synergy switcher. Before you begin, ensure that the Audio Server Remote Control option is installed. If not, contact Ross Video for details. Refer to the section “Installed Options Menus” on page 2-37 for instructions on verifying the status of installed options.

The following topics are discussed:

• Supported Audio Servers
• Communications Connections
• Communications Setup
• Setting Up Audio Server BNCs
• Previewing Audio Server Clips
• Audio Server Custom Controls
• Audio Server Clip Setup
Supported Audio Servers

The Synergy switcher has been tested with a number of Audio Servers to ensure the highest standard for compatibility and reliability. The following devices are currently supported by your Synergy switcher:

- 360 Systems DigiCart Audio Recorder
- 360 Systems DigiCart/E Audio Recorder
- Enco Digital Audio Delivery System (using the DAD Command Language)
- Sony MiniDisc MDS-B4P MD Player (using the Sony MiniDisc ASCII protocol)
Communications Connections

You can connect a number of Audio Servers to your Synergy switcher. The procedure for connecting the Audio Server depends on the type of Audio Server you have. This section provides general instructions for connecting the Audio Server to one of the Remote Ports on the back of the Synergy control panel.

Note

These instructions are provided as a guide. For specific information on the Audio Server you are connecting to the Synergy switcher, refer to the documentation provided with the Audio Server.

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **Audio Server Control** — This is the software option from Ross Video that allows your Synergy switcher to control an Audio Server.
- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your Audio Server. Refer to the section “Audio Server Interface Cable Pinouts” on page 17–4 for information on the pin-outs and connector required for your Audio Server. Ross Video does not supply this cable.

Use the following procedure to connect an Audio Server to your Synergy switcher:

1. Connect and secure the 9-Pin, Male, end of the Interface Cable to one of the Remote Ports on the back of the Synergy control panel.

   Important

   You cannot control a **360 Systems DigiCart Audio Server** nor a **360 Systems DigiCart/E Audio Server** from a remote port on a BSS4. If you want to connect a DigiCart to the Synergy switcher, you will have to use a standard Remote Port.

2. Connect and secure the other end of the cable to the appropriate port on the Audio Server. The suggested port for each supported Audio Server is listed below:

   - **360 Systems DigiCart Audio Recorder** — Connect the Interface cable to the Serial Port 2 on the DigiCart. Refer to the section “360 Systems DigiCart Cabling” on page 17–4 for more information on the cabling for this device.
   - **360 Systems DigiCart/E Audio Recorder** — Connect the Interface cable to the AUX Serial Port on the DigiCart/E. Refer to the section “360 Systems DigiCart/E Cabling” on page 17–4 for more information on the cabling for this device.
• **Sony MiniDisc MD Player** — Connect the Interface cable to the RS232C port on the Sony MiniDisc. Refer to the section “Sony MiniDisc MDS-B4P Cabling” on page 17–5 for more information on the cabling for this device.

• **Enco Digital Audio Delivery System** — Connect the Interface cable to the remote port configured for external automation on the Enco Digital Audio Delivery System. Refer to the section “Enco Digital Audio Delivery System Cabling” on page 17–6 for more information on the cabling for this device.

This completes the procedure for connecting an Audio Server to the Synergy switcher. Refer to the section “Communications Setup” on page 17–7 for instructions on how to set up communications protocols on the switcher, as well as on the Audio Server.

### Audio Server Interface Cable Pinouts

Use the information in this section to connect the Interface Cable from the Synergy switcher to the Audio Server.

#### 360 Systems DigiCart Cabling

The Synergy control panel connects to the DigiCart Audio Server via the remote ports on the Synergy switcher, and the Serial Port 2 on the DigiCart.

Cable connections in the following table refer only to those between the Synergy control panel and the DigiCart Audio Server. Other cable connections present on the DigiCart can be found in the DigiCart Audio Server documentation.

**Important**

Do not connect any signals to **Pin 2** of the DigiCart.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>DigiCart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1 Chassis</td>
<td>Do not connect</td>
</tr>
<tr>
<td>2 RxA (Rx-)</td>
<td>→ 5 TxA (Tx-)</td>
</tr>
<tr>
<td>3 TxB (Tx+)</td>
<td>→ 8 RxB (Rx+)</td>
</tr>
<tr>
<td>4 n/c</td>
<td></td>
</tr>
<tr>
<td>5 Ground</td>
<td></td>
</tr>
<tr>
<td>6 Ground</td>
<td>→ 1 Signal Ground</td>
</tr>
<tr>
<td>7 RxB (Rx+)</td>
<td>→ 4 TxB (Tx+)</td>
</tr>
<tr>
<td>8 TxA (Tx-)</td>
<td>→ 9 RxA (Rx-)</td>
</tr>
<tr>
<td>9 Chassis</td>
<td>Do not connect</td>
</tr>
</tbody>
</table>

#### 360 Systems DigiCart/E Cabling

The Synergy control panel connects to the DigiCart/E Audio Server via the remote ports on the Synergy switcher, and the AUX Serial Port on the DigiCart/E.

Cable connections in the following table refer only to those between the Synergy control panel and the DigiCart/E Audio Recorder. Other cable connections present on the DigiCart/E can be found in the 360 Systems documentation.
* Pins 4 and 6 are tied.

Sony MiniDisc MDS-B4P Cabling

The Synergy control panel connects to the Sony MiniDisc MD Player via the remote ports on the Synergy switcher, and the RS232C Port on the MiniDisc.

Cable connections in the following table refer only to those between the Synergy control panel and the Sony MiniDisc MD Player using the ASCII protocol. Other cable connections present on the Sony MiniDisc can be found in the Sony documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>DigiCart/E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

* Pins 4 and 6 are tied.

Sony MiniDisc MDS-B4P Cabling

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Sony MiniDisc</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

* Ports 4 and 6 are tied
† Ports 7 and 8 are tied.
Enco Digital Audio Delivery System Cabling

The Synergy control panel connects to the Enco Digital Audio Delivery System via the remote ports on the Synergy switcher, and a remote port configured for external automation on the Enco.

Cable connections in the following table refer only to those between the Synergy control panel and the Enco Digital Audio Delivery System. Other cable connections present on the Enco Digital Audio Delivery System can be found in the Enco documentation.

### Synergy-to-Enco Digital Audio Delivery System Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Enco Digital Audio Delivery System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
Communications Setup

This section will provide instructions for setting up the Audio Server to communicate with the Synergy switcher.

The following topics are discussed in this section:

- Setting up the Switcher
- Setting up the Audio Server

Setting up the Switcher

In order to have the Synergy switcher communicate with an Audio Server, the remote port on the control panel that the Audio Server is connected to must be set up to communicate with the particular Audio Server you have connected.

Use the following procedure to configure a Remote port on the control panel to connect with an Audio Server:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME ➔ MORE ➔ Setup ➔ Installation ➔ Communications.
2. Press Type to display the Type Menu.

   **Communications — Type Menu**

3. Assign a Remote Com Port to the Audio Server as follows:
   - Use the Com Port knob to select the remote port on the Synergy switcher that is connected to the Audio Server.
   - Use the Device knob to select Audio Server.
4. Press Select Device to select the Select Device Menu.

   **Communications — Select Device Menu**
5. Select the device you want to assign to the Synergy communications port as follows:

- Use the **Com Port** knob to select the communications port you want to assign a specific Audio Server to.
- Use the **Device** knob to select the device. You can select between the following:
  - **DigiCart** — Select this option to assign an 360 Systems DigiCart to the communications port.
  - **MiniDisc** — Select this option to assign a Sony MiniDisc to the communications port.
  - **EncoDAD** — Select this option to assign an Enco Digital Audio Delivery System to the communications port.

6. Press **Com Settings** to display the **Com Settings Menu**.

7. Set the communications protocols for the Audio Server as follows:

- Use the **Com Port** knob to select the Audio Server you want to set the communications settings for.
- Use the **Baud** knob to select the baud rate for the Audio Server. Refer to the section “**Setting up the Audio Server**” on page 17–10 for the specific settings for your Audio Server.
- Use the **Parity** knob to select the parity for the specific Audio Server. Refer to the section “**Setting up the Audio Server**” on page 17–10 for the specific settings for your Audio Server.

8. Press **Com Type** to display the **Com Type Menu**.

---

**Note**

You can setup a custom device using the **CUSTOM 1** and **CUSTOM 2** options. Use these options, in conjunction with the **Custom Devices** button, to manually configure the communications protocol for your particular device. Refer to the section “**Custom Devices – Uses and Limitations**” on page 27–2 for more information.
9. Select the type of serial communications that will be used to communicate with the Audio Server as follows:
   • Use the **Com Port** knob to select the Audio Server you want to set the communications type for.
   • Use the **Type** knob to select the type of serial communications for the selected port. Refer to the section “Setting up the Audio Server” on page 17–10 for the specific settings for your Audio Server.

10. Select the Remote Address for your Audio Server as follows:

    **Note**
    This Extra Option is not available for the Sony MiniDisc MD Player or the Enco Digital Audio Delivery System.

    • Press **Extra Options** to display the Extra Options Menu.

    ![Extra Options Menu](image)

    • Use the **Com Port** knob to select the remote port that the Audio Server is connected to.
    • Use the **Option** knob to select **RemoteAddress**.
    • Use the **Value** knob to select the Remote Address of the Audio Server. You can select a value between 1 and 32. The default value is 2.

11. Press **HOME** to display the Installation Change Confirmation Screen.

12. Accept or reject the changes you have made as follows:
   • Press **Confirm** to accept the changes.
   • Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the communications with the Audio Server, next you will have finish setting up the Audio Server to communicate with the Synergy switcher.
Setting up the Audio Server

In order to have the Synergy switcher communicate with an Audio Server, the Audio Server you are connecting to the switcher must be set up to communicate and accept commands from the switcher.

360 Systems DigiCart

Use the following communications settings when connecting the DigiCart Audio Server to the Synergy switcher:

### Synergy-to-DigiCart Communication Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

**Important**

During operation (from the Synergy panel), the DigiCart must be enabled for remote control as per its manual.

360 Systems DigiCart/E

This section describes the proper installation configuration required for a Synergy switcher to interface with an 360 Systems DigiCart/E Audio Recorder.

Use the following information to connect an Enco Digital Audio Delivery System to your Synergy switcher:

- Use the following communications settings to connect a DigiCart/E Audio Recorder to your Synergy switcher:

### Synergy-to-DigiCart/E Communication Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Even</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

- On the 360 Systems DigiCart/E Audio Recorder, you must set up the communications parameters to allow it to properly connect to the Synergy switcher. Refer to your 360 Systems documentation for further communication set up instructions.

**Important**

During operation (from the Synergy panel), the DigiCart/E must be enabled for remote control as per its manual. Ensure the REMOTE CONTROL ADDRESS on the DigiCart/E is set to 02.
Use the following procedure to set up the 360 Systems DigiCart/E:

1. On the SETUP Menu, select SET AUX PROTOCOL.
2. Select ES-BUS to set the Aux Bus Protocol.
3. Press ENTER.

This completes the set up of the 360 Systems DigiCart/E Audio Recorder.

**Sony MiniDisc MDS-B4P**

Use the following communications settings to connect a Sony MiniDisc MD Player using the ASCII protocol to your Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

**Enco Digital Audio Delivery System**

This section describes the proper installation configuration required for a Synergy switcher to interface with an Enco Digital Audio Delivery System.

Use the following information to connect an Enco Digital Audio Delivery System to your Synergy switcher:

- Use the following communications settings when connecting the Enco Digital Audio Delivery System to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>None</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

- You must configure a remote port on the Enco Digital Audio Delivery System for external automation using the DAD Command Language (DCL). Refer to your Enco documentation for setup and configuration information.

- You must create a blank Playlist on the Enco Digital Audio Delivery System, and name the Playlist “SYNERGY”. This Playlist enables the Synergy switcher to communicate with the Enco Digital Audio Delivery System.
Setting Up Audio Server BNCs

The Audio Server Setup Menu allows you to associate an Audio Server BNC input with a particular Audio Server communication port. It is not necessary to assign the Audio Server to a BNC to enable control over the Audio Server, unless you are setting up Audio Server Clip Registers as outlined in the section “Audio Server Clip Setup” on page 17–20. Custom controls can also be used to cue and play clips on the Audio Server. Refer to the section “Audio Server Custom Controls” on page 17–16 for more information.

Setting Up Audio Server BNCs

Use the following procedure to assign the Audio Server to a specific BNC input:

1. Navigate to the BNC Menu 1-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.
2. Press BNC Type to display the BNC Type Menu.
3. Assign a BNC to Audio Server as follows:
   - Use the BNC knob to select the BNC that the Audio Server is connected to.
   - Use the Type knob to select VTR.
   - Use the Asp Ratio knob to select the video aspect ratio of the Audio Server output.
4. Navigate to the BNC Menu 3-3 as follows:
   - Press MORE ⇒ MORE.
5. Assign a BNC Input to your Audio Server as follows:
   - Press VTR/VDCP Xpts to display the VTR/VDCP Xpts Menu.
   - Use the BNC knob to select the BNC to assign to your Audio Server.
• Use the **Controller** knob to select the remote port that the Audio Server is connected to. You can select from a list of remote ports assigned to an Audio Server.

**Note**

If you select **NONE**, the BNC will not be assigned to an Audio Server nor will it be displayed in other Synergy menus associated with VTRs or Audio Server control.

6. Press **HOME** to display the **Installation Change Confirmation Screen**.

7. Accept or reject the changes you have made as follows:

• Press **Confirm** to accept the changes.
• Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up an Audio Server to a BNC on the Synergy switcher. Next you will have to set up the communications between the Audio Server and the Synergy switcher.
Previewing Audio Server Clips

The Audio Server Clip Menu allows you to preview your audio clips. You can verify any changes made on the device before creating Custom Controls or Clip Registers on the Synergy switcher. Note that this is a preview function only, and you must create Custom Controls or Clip Registers in order to recall Audio Server clips for use during on-air production. Refer to the section “Programming Audio Server Custom Controls” on page 17–16 for information on Custom Controls for your Audio Server.

The Audio Server Clip Menu identifies the Audio Server clip and the specific Audio Server you are controlling by the Remote Port that it is connected to. Below the title are three rows: Cut ID, Cut Name, and Cut Time.

- **Cut ID** — This row displays the current Drive, Directory, and Cut that has been selected. These fields are as follows \((\text{Drive})\.00(\text{Directory})00(\text{Cut})\). If you are using an Enco Digital Audio Delivery System, the fields are as follows: \((\text{Playlist Name})\.00000(\text{Cut})\).

- **Cut Name** — This row displays the name of the cut on the Audio Server.

- **Cut Time** — This row displays the time, or length, of the cut on the Audio Server. If you are using an Enco Digital Audio Delivery System, this row displays the current playout time on the Enco DAD for the selected clip.

---

**Note**

If you have a Sony MiniDisc, the rows will be labeled as **Track ID**, **Track Name**, and **Track Time**.

---

Previewing Audio Server Clips

Use the following procedure to preview an Audio Server clip:

1. Navigate to the Audio Server Clip Menu as follows:
   - Press HOME ⇒ MORE ⇒ Clips ⇒ Audio Clips.
2. Select the device you want to preview as follows:
   - Press Device to display the Device Menu.

   ![Device Menu](image)

   **Audio Server — Device Menu**

   - Use the Device knob to select the Audio Server you want to preview the clip information for.
     - If you are using an Enco Digital Audio Delivery System, this knob is labeled as **Machine** and is used to select the Machine or Player that the cut is stored on.
3. Select the clip you want to preview as follows:
• Press **Cut ID** to display the **Cut ID Menu**.

The **Audio Server Clip Menu** displays the last selected clip/track until a new one is selected.

---

**Audio Server Clip Menu**

<table>
<thead>
<tr>
<th>Device: DigiCart (RD)</th>
<th>Drive</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut ID: 000000</td>
<td></td>
</tr>
<tr>
<td>Cut Menu:</td>
<td></td>
</tr>
<tr>
<td>Cut Time: 00:00:00</td>
<td></td>
</tr>
</tbody>
</table>

---

4. Preview the selected audio clip as follows:

• Press **Play** to play the Audio Server clip from the selected device.
• Press **Pause** to pause the clip.
• Press **Stop** to stop the clip playout.

This completes the procedure to preview an Audio Server clip. Next you can program custom controls to play clips from your Audio Server, or setup Clip Registers for your Audio Server on the Synergy switcher.
Audio Server Custom Controls

A custom control button can be programmed with the transport functions that are located on the Audio Server Clips Menu. This allows for quick access to these functions, or you can string a number of these functions together in a single custom control.

Note

You must have the Audio Server Control option installed in order to control an Audio Server from the Synergy switcher. Refer to the section “Setting up the Switcher” on page 17–7 for information on setting up an Audio Server.

The Audio Server Clips Menu identifies the Audio Server Clip you are using, and the specific Audio Server you are controlling by the Remote Port that it is connected to. Below the title are three rows: Cut ID, Cut Name, and Cut Time.

Note

If you have a Sony MiniDisc, the rows will be labeled as Track ID, Track Name, and Track Time respectively.

- **Cut ID** — This row displays the current Drive, Directory, and Cut that has been selected. These fields are as follows 00(Drive).00(Directory).00(Cut). If you are using an Enco Digital Audio Delivery System, the fields are as follows: 00(Playlist Name).00000(Cut).
- **Cut Name** — This row displays the name of the cut on the Audio Server.
- **Cut Time** — This row displays the time, or length, of the cut on the Audio Server. If you are using an Enco Digital Audio Delivery System, this row displays the current playout time on the Enco DAD for the selected clip.

Programming Audio Server Custom Controls

Use the following procedure to program custom control buttons that include special transport functions for Audio Servers:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.

   ![Custom Controls Menu](image)

   Custom Controls Menu

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the
control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

### Operating Tip

As a recommendation, keep transport control functions for similar devices grouped together on your physical custom control buttons.

3. Navigate to the **Insert Audio Server Menu** as follows:

- Press **Start Recording** ⇒ **Insert Special** ⇒ **MORE** ⇒ **Audio Server**.

   This menu allows you to choose specific transport control functions to assign to the button.

### Note

If an error message is displayed stating that there are no communications ports assigned to Audio Server, ensure that the Audio Server you are trying to control has been properly set up. Refer to the section “Communications Setup” on page 17–7 for setup information.

4. Select a drive on the Audio Server as follows:

- Press **Drive** to display the **Drive Menu**. This button is labeled as **Disc** when using a Sony MiniDisc, and as **Machine** when using an Enco DAD.

   - Use the **Device** knob to select the Audio Server that the cut is stored on.
   - Use the **Drive** knob to select the drive on the Audio Server that the cut is stored on.

     ~ If you are using a Sony MiniDisc, this knob is labeled as **Disc**.
     ~ If you are using an Enco Digital Audio Delivery System, this knob is labeled as **Machine** and is used to select the Machine or Player that the cut is stored on.

5. Select a directory on the Audio Server as follows:

### Note

This function is unavailable if you are using an Enco Digital Audio Delivery System.

- Press **Directory** to display the **Directory Menu**.
6. Select a cut on the Audio Server as follows:
   • Press **Cut** to display the **Cut Menu**. Note that this button is labeled as **Track** when using a Sony MiniDisc.

7. Select an Audio Server function to insert as follows:
   • Ensure the Audio Server and the clip are selected.
   • Use the **Command** knob to select the transport control function that you want to assign to the selected Audio Server. You can choose between the following:
     ~ **Go to Cut** — Select this command to have the Audio Server cue to a selected cut or track.
     ~ **Play** — Select this command to have the Audio Server go into play mode, or 1× forward.
     ~ **Pause** — Select this command to have the Audio Server go into pause mode.
     ~ **Stop** — Select this command to have the Audio Server stop.

### Operating Tip
You can also enter the Cut Number using the keypad in the **Global Memory System Group** and pressing **ENTER**.
8. Press **Insert** to insert the selected command into the custom control and display the **Insert Special Menu 1-2**.

![Operating Tip](Operating_Tip.png)

**Operating Tip**

Transport control functions can be strung together (while in programming mode), allowing one custom control button to perform *multiple functions* when it is pressed. For example, you can have the **Go To Cut** function followed by the **Play** function, allowing a single custom control macro to go to a cut or track and then run it.

9. Insert additional commands if needed.

10. Press **UP ONE** to display the **Recording Menu**.

11. Press **Finish Recording** or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for programming custom control buttons that include special transport functions for Audio Servers.

Once your custom control buttons have been programmed, be sure to properly name them. Refer to the section “**Naming Custom Controls**” on page 8–42 for more information on naming custom control buttons. Any recorded custom control can be edited. Refer to the section “**Editing Custom Control Macros**” on page 8–47 for details.
Audio Server Clip Setup

In order to easily recall clips on the Audio Server from the Synergy switcher, you can store the clips you want to use to Clip Registers on the switcher. These Clip Registers store the location, or cut, on the Audio Server for the clip, and the name of the clip.

The VTR Clips Menu allows you to perform the following functions:

- Select an Audio Server and a clip number.
- Name the clip and store it in a Clip Register. Up to 100 clips can be stored using registers 00 to 99.
- Cue each clip.

The VTR Clips Menu identifies the Audio Server Clip Register you are using and the name of the clip register the specific Audio Server you are controlling by the BNC that it is connected to.

Programming Audio Server Clips

Use the following procedure to program an Audio Server clip:

1. Navigate to the VTR Clips Menu as follows:
   - Press HOME ⇒ MORE ⇒ Clips ⇒ VTR Clips.
2. Press Clip Type to display the Clip Type Menu.

<table>
<thead>
<tr>
<th>Clip Type Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip: 00  Clip Name: &quot;VTR Clip&quot;</td>
</tr>
<tr>
<td>Device: Digicart (16)</td>
</tr>
<tr>
<td>Cut Id: 0.0000  Cut Time: Unknown</td>
</tr>
<tr>
<td>Cut Start: 00:00:00</td>
</tr>
</tbody>
</table>

3. Select the Clip Register you want to store an Audio Server clip to as follows:
   - Use the Clip knob to select the Clip Register that you want to program.
   - Use the Device knob to select the remote port for the Audio Server you want to store the clip information for.
   - Use the bottom knob to select if you want the clip to be displayed in the Remote Control Menu (for on air use), or to be disabled for use later.

   **Note**
   If a clip is set to Clip Disabled, it will not be displayed on the Remote Control Menu, but you can still enter all required clip parameters. This can also be used to enable a clip that is already programmed.

4. Press Name Clip to display the Clip Name Menu.

   The Audio Server Clip name is the one that is displayed for the Clip Register on the Global Memory System Group display and on the Remote Control Menu.
• Use the **Horizontal** and **Vertical** knobs, in conjunction with the editing softkeys, to enter the desired clip name.

• A standard PS/2 keyboard can also be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs. Refer to the section “Using the **Keyboard**” in the *Synergy Series Operation Guide* for details.

**Important**

Do not enter a space as the first or last character of a clip name.

• Press **Accept New Name** to complete the naming procedure and return to the **VTR Clips Menu**. The new name is now displayed in the status area and as one of the options for the **Clip knob**.

5. Press **Cut Index** to display the **Cut Index Menu**.

6. Select a cut on the Audio Server as follows:
   • Use the **Drive** knob to select the drive on the Audio Server that the cut is stored on.
   • Use the **Directory** knob to select the directory on the Audio Server that cut is stored on. If you are using an
   • Use the **Cut** knob to select the specific cut on the Audio Server that you want to store in the Clip Register.
7. Press **HOME** to store your settings.

**Note**

Audio Server clips are saved in memory *only* upon exit of the **VTR Clips Menu**, but you can also save them to a USB key.

This completes the procedure to program an Audio Server clip.
Video Servers (VDCP)

In This Chapter

This chapter provides instructions for connecting, and setting up a VTR, DDR, or Video Server using the VDCP protocol, with your Synergy switcher. Before you begin, ensure that the Video Server Control option is installed. If not, contact Ross Video for details. Refer to the section “Installed Options Menus” on page 2–37 for instructions on verifying the status of installed options.

The following topics are discussed:

• Supported Video Servers
• Communications Connections
• Communications Setup
• Setting up Video Server BNCs
• Roll VTR Setup
• Video Server Custom Controls
• Video Server Clip Setup
Supported Video Servers

The Synergy Series Switcher has been tested with a number of Video Servers (DDRs and Video Servers), using the VDCP Protocol, to ensure the highest standard for compatibility and reliability. The following devices are currently supported by your Synergy switcher:

• 360 Systems Image Server 2000 (using the VDCP protocol)
• Abekas 6000 MultiFlex DTV Production Server (using the VDCP protocol)
• Avid AirSpace Video Server (using the Generic VDCP protocol)
• Avid AirSpeed Video Server (using the VDCP protocol)
• EVS Broadcasting Equipment maXS Video Server (using the VDCP protocol)
• Gee Broadcast Systems Geevs Video Server (using the VDCP protocol)
• GVG M-Series iVDR Video Server (using the VDCP protocol)
• GVG Profile Video File Server (using the VDCP protocol)
• GVG Turbo iDDR (using the VDCP protocol)
• Leitch ASC VR300 Video Server (using either version 2 or 2.7 Leitch software and the VDCP protocol)
• Leitch Nexio Video Server (using the VDCP protocol)
• Leitch VR440 Video Server (using the VDCP protocol)
• Omneon Video Server (using the Generic VDCP protocol)
• Pinnacle Systems Thunder (using the VDCP protocol)
• Pinnacle Systems ThunderLT Video Server (using the VDCP protocol)
• Pinnacle Systems ThunderMX Video Server (using the VDCP protocol)
• Ross Video SoftMetal Video Server (using the VDCP protocol)
• Spencer Technologies Video Server (using the VDCP protocol)

Note

The Synergy switcher will support any Video Server that uses the Generic VDCP Protocol. Refer to the section “Generic Video Server Cabling” on page 18–13 for more information.
Communications Connections

You can connect a number of Video Servers to your Synergy switcher. The procedure for connecting the Video Server depends on the type of Video Server you have. This section provides general instructions for connecting the Video Server to one of the Remote Ports on the back of the Synergy control panel.

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **Video Server Control** — This is the software option from Ross Video that allows your Synergy switcher to control a Video Server.

- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your Video Server. Refer to the section “Video Server Interface Cable Pinouts” on page 18–5 for information on the pin-outs and connector required for your Video Server. Ross Video does not supply this cable.

Use the following procedure to connect a Video Server to your Synergy switcher:

1. Connect and secure the **9-Pin, Male** end of the **Interface Cable** to one of the **Remote Ports** on the back of the Synergy control panel.

2. Connect and secure the other end of the cable to the appropriate port on the Video Server. The suggested port for each supported Video Server is listed below:

   - **Avid AirSpace Video Server** — Connect the Interface cable to the com port on the AirSpace chassis. Refer to the section “Avid AirSpace Cabling” on page 18–5 for more information on the cabling for this Video Server.

   - **Leitch ASC VR300 Video Server** — Connect the Interface cable to the com port on the ASC VR300 chassis. Refer to the section “Leitch Video Server Cabling” on page 18–5 for more information on the cabling for this Video Server.

   - **Leitch VR440 Video Server** — Connect the Interface cable to the com port on the VR440 chassis. Refer to the section “Leitch VR440 Video Server” on page 18–22 for more information on the cabling for this Video Server.

   - **Leitch Nexio Video Server** — Connect the Interface cable to the rear panel port on the Nexio chassis for the channel you want to control. Refer to the section “Leitch Nexio Video Server Cabling” on page 18–12 for more information on the cabling for this Video Server.

Note: These instructions are provided as a guide. For specific information on the Video Server you are connecting to the Synergy switcher, refer to the documentation provided with the Video Server.
• **Pinnacle Systems Thunder Video Servers** — Connect the Interface cable to the com port on the Thunder, ThunderLT, or ThunderMX chassis. Refer to the section “Pinnacle Systems Thunder Video Servers Cabling” on page 18–6 for more information on the cabling for these Video Servers.

• **Spencer Technologies Video Server** — Connect the Interface cable to the com port on the Video Server. Refer to the section “Spencer Technologies Video Server Cabling” on page 18–7 for more information on the cabling for this Video Server.

• **Gee Broadcast Systems Geevs Video Server** — Connect the Interface cable to the com port on the Geevs chassis. Refer to the section “Gee Broadcast Systems Geevs Video Server Cabling” on page 18–7 for more information on the cabling for this Video Server.


• **EVS Broadcasting Equipment maXS Video Server** — Connect the Interface cable to the RS422 Ports (Remote), Port 1 on the maXS. Refer to the section “EVS Broadcasting Equipment maXS Video Server Cabling” on page 18–8 for more information on the cabling for this Video Server.

• **Avid AirSpeed Video Server** — Connect the Interface cable to the com port on the AirSpeed chassis. Refer to the section “Avid AirSpeed Video Server Cabling” on page 18–9 for more information on the cabling for this Video Server.

• **Omneon Video Server** — Connect the Interface cable to the com port on the Omneon chassis. Refer to the section “Omneon Video Server Cabling” on page 18–9 for more information on the cabling for this Video Server.

• **Ross Video SoftMetal Video Server** — Connect the Interface cable to the com port on the SoftMetal chassis. Refer to the section “Ross Video SoftMetal Video Server Cabling” on page 18–10 for more information on the cabling for this Video Server.

• **GVG M-Series iVDR Video Server** — Connect the Interface cable to the com port on the M-Series chassis. Refer to the section “GVG M-Series iVDR Video Server Cabling” on page 18–10 for more information on the cabling for this Video Server.

• **GVG Profile Video File Server** — Connect the Interface cable to a RS-422 Communications Port on the GVG RS-422 Connector Panel. Refer to the section “GVG Profile Video File Server Cabling” on page 18–11 for more information on the cabling for this Video Server.

• **GVG Turbo iDDR** — Connect the Interface cable to an RS422 com port on the Turbo chassis. Refer to the section “GVG Turbo iDDR Cabling” on page 18–11 for more information on the cabling for this Video Server.

• **Abekas6000 MultiFlex DTV Production Server** — Connect the Interface cable to the RS422 Serial Control Port on the Abekas chassis. Refer to the section “Abekas6000 MultiFlex DTV Production Server Cabling” on page 18–12 for more information on the cabling for this Video Server.

• **Generic** — Connect the Interface cable to the communications port on the chassis of the Video Server. Refer to the section “Generic Video Server Cabling” on page 18–13 for more information on general Video Server cabling.

This completes the procedure for connecting a Video Server to the Synergy switcher. Refer to the section “Communications Setup” on page 18–14 for instructions on how to set up communications protocols on the switcher, as well as on the Video Server.
Video Server Interface Cable Pinouts

Use the information in this section to connect the Interface Cable from the Synergy switcher to the Video Server.

**Avid AirSpace Cabling**

The Synergy control panel connects to the AirSpace Video Server via the remote ports on the Synergy switcher, and the com port on the AirSpace.

Cable connections in the following table refer only to those between the Synergy control panel and the AirSpace Video Server. Other cable connections present on the AirSpace can be found in the Avid AirSpace documentation.

<table>
<thead>
<tr>
<th>Synergy-to-Avid AirSpace Wiring Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synergy Control Panel</td>
</tr>
<tr>
<td>Remote Port</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
</tbody>
</table>

**Leitch Video Server Cabling**

The Synergy control panel connects to the Leitch ASC VR300 and VR440 Video Servers via the remote ports on the Synergy switcher.

<table>
<thead>
<tr>
<th>Synergy RS-422 Wiring Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synergy Control Panel</td>
</tr>
<tr>
<td>Remote Port</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
</tbody>
</table>

Refer to the documentation that came with your Video Server for port and pinout information for your specific Video Server.
**Pinnacle Systems Thunder Video Servers Cabling**

The Synergy control panel connects to the Pinnacle Systems Thunder, ThunderLT, and ThunderMX Video Servers via the remote ports on the Synergy switcher, and the RS-422 com ports (5-12) on the Thunders.

Cable connections in the following table refer only to those between the Synergy control panel and the RS-422 com ports (5-12) on the Thunder Video Servers. This table is for use only with devices that have com ports labelled 5-12. Other cable connections present on the Thunder can be found in the Pinnacle Thunder documentation.

### Synergy-to-Pinnacle Thunder Wiring Chart

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>Pinnacle Thunder v5.5</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>RS-422 Com Ports</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>(5-12)</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
<td>→ 8 TxA (Tx-)</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
<td>→ 7 RxB (Rx+)</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td>→ 4 Power Ground</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
<td>→ 3 TxB (Tx+)</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
<td>→ 2 RxA (Rx-)</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Cable connections in the following table refer only to those between the Synergy control panel and the RS-422 com ports (3-8) on the Thunder Video Servers. This table is for use only with newer devices that have com ports labelled 3-8. Other cable connections present on the Thunder can be found in the Pinnacle Thunder documentation.

### Synergy-to-Pinnacle Thunder Wiring Chart

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>Pinnacle Thunder v6.1</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>RS-422 Com Ports</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>(3-8)</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
<td>→ 2 TxA (Tx-)</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
<td>→ 3 RxB (Rx+)</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td>→ 6 Ground</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
<td>→ 7 TxB (Tx+)</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
<td>→ 8 RxA (Rx-)</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Spencer Technologies Video Server Cabling**

The Synergy control panel connects to the Leitch ASC VR300 Video Server via the remote ports on the Synergy switcher.

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

Refer to the documentation that came with your Video Server for port and pinout information for your specific Video Server.

**Gee Broadcast Systems Geevs Video Server Cabling**

The Synergy control panel connects to the Leitch ASC VR300 Video Server via the remote ports on the Synergy switcher.

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

Refer to the documentation that came with your Video Server for port and pinout information for your specific Video Server.
360 Systems Image Server 2000 Cabling


Cable connections in the following table refer only to those between the Synergy control panel and the Image Server 2000. Other cable connections present on the Image Server 2000 can be found in the 360 Systems Image Server 2000 documentation.

### Synergy-to-Image Server 2000 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Remote Port</th>
<th>Signal</th>
<th>Image Server 2000</th>
<th>RS-422 Serial Control Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>Chassis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>RxA (Rx-)</td>
<td>→</td>
<td>2</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>TxB (Tx+)</td>
<td>→</td>
<td>3</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Ground</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>Ground</td>
<td>→</td>
<td>6</td>
<td>Power Ground</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>RxB (Rx+)</td>
<td>→</td>
<td>7</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>TxA (Tx-)</td>
<td>→</td>
<td>8</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

EVS Broadcasting Equipment maXS Video Server Cabling

The Synergy control panel connects to the EVS maXS Video Server via the remote ports on the Synergy switcher, and the RS422 Ports (Remote), Port 1 on the maXS.

**Important**

You can only use RS-422 Port 1 on the maXS to connect to the Synergy switcher.

Cable connections in the following table refer only to those between the Synergy control panel and the maXS. Other cable connections present on the maXS can be found in the EVS maXS documentation.
The Synergy control panel connects to the AirSpeed Video Server via the remote ports on the Synergy switcher, and the com port on the AirSpeed.

Cable connections in the following table refer only to those between the Synergy control panel and the AirSpeed Video Server. Other cable connections present on the AirSpeed can be found in the Avid AirSpeed documentation.

### Omneon Video Server Cabling

The Synergy control panel connects to the Omneon Video Server via the remote ports on the Synergy switcher.

Cable connections in the following table refer only to those between the Synergy control panel and the Omneon Video Server. Other cable connections present on the Omneon Video Server can be found in the Omneon documentation.
Ross Video SoftMetal Video Server Cabling

The Synergy control panel connects to the SoftMetal Ross Video SoftMetal Video Server via the remote ports on the Synergy SD switcher, and the com port on the SoftMetal Video Server. Cable connections in the following table refer only to those between the Synergy control panel and the Ross Video SoftMetal Video Server. Other cable connections can be found in the SoftMetal Video Server documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>SoftMetal Video Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

GVG M-Series iVDR Video Server Cabling

The Synergy control panel connects to the SoftMetal GVG M-Series iVDR Video Server via the remote ports on the Synergy SD switcher, and the com port on the GVG M-Series iVDR Video Server. Cable connections in the following table refer only to those between the Synergy control panel and the GVG M-Series iVDR Video Server. Other cable connections can be found in the GVG M-Series documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>SoftMetal Video Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
GVG Profile Video File Server Cabling

The Synergy control panel connects to the GVG Profile via the remote ports on the Synergy switcher, and a RS-422 Communications Port on the GVG RS-422 Connector Panel.

Cable connections in the following table refer only to those between the Synergy control panel and the GVG Profile. Other cable connections can be found in the GVG documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>GVG M-Series iVDR Video Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

GVG Turbo iDDR Cabling

The Synergy control panel connects to the GVG Turbo via the remote ports on the Synergy switcher, and a RS422 Communications Port on the GVG Turbo.

Cable connections in the following table refer only to those between the Synergy control panel and the GVG Turbo. Other cable connections can be found in the GVG documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>GVG RS-422 Connector Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
Abekas6000 MultiFlex DTV Production Server Cabling

The Synergy control panel connects to the Abekas6000 MultiFlex DTV Production Server via the remote ports on the Synergy switcher, and the com port on the Abekas6000.

Cable connections in the following table refer only to those between the Synergy control panel and the Abekas6000. Other cable connections can be found in the Abekas6000 documentation.

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>GVG Turbo iDDR</th>
<th>RS422 Com Ports</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)→</td>
<td>2</td>
<td>TxA (Tx-)</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)→</td>
<td>3</td>
<td>RxB (Rx+)</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground→</td>
<td>4</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)→</td>
<td>7</td>
<td>TxB (Tx+)</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)→</td>
<td>8</td>
<td>RxA (Rx-)</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Leitch Nexio Video Server Cabling

The Synergy control panel connects to the Leitch Nexio Video Server via the remote ports on the Synergy switcher, and the rear panel ports on the Leitch Nexio Video Server.

Cable connections in the following table refer only to those between the Synergy control panel and the Leitch Nexio Video Server. Other cable connections can be found in the Leitch documentation.
Generic Video Server Cabling

The Synergy control panel connects to a Video Server via the remote ports on the Synergy switcher.

### Synergy-to-Leitch Nexio Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Leitch Nexio RS422 Com Ports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

### Synergy RS-422 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

Refer to the documentation that came with your Video Server for port and pinout information for your specific Video Server.
Communications Setup

This section provides instructions for setting up the Video Server to communicate with the Synergy switcher.

The following topics are discussed in this section:

- Setting up the Switcher
- Setting up the Video Server

Setting up the Switcher

In order to have the Synergy switcher communicate with a Video Server, the remote port on the control panel that the Video Server is connected to must be set up to communicate with the particular Video Server you have connected.

Use the following procedure to configure a Remote port on the Synergy control panel to connect with a Video Server:

1. Navigate to the **Communications Menu 1-2** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.

2. Press **Type** to display the **Type Menu**.

3. Assign a Remote Com Port to the Video Server as follows:
   - Use the **Com Port** knob to select the remote port on the Synergy switcher that is connected to the Video Server.
   - Use the **Device** knob to select VTR (CLIP).

4. Press **Select Device** to display the **Select Device Menu**.
5. Select the device you want to assign to the VTR communications port as follows:
   - Use the **Com Port** knob to select the communications port you want to assign a specific Video Server to.
   - Use the **Device** knob to select **VDCP**.

   **Note**
   You can setup a custom device using the **CUSTOM 1** and **CUSTOM 2** options. Use these options, in conjunction with the **Custom Devices** button, to manually configure the communications protocol for your particular device. Refer to Appendix F, “**Custom Device Serial Protocol**” for more information.

   - Use the **VTR Preroll** knob to select the preroll interval (in frames).

   **Note**
   Preroll is applied when the **ROLL VTR** button is “armed” and the device is taken to air with a cut or auto-transition. When the transition is performed, the system will wait the selected preroll interval, and then roll the Video Server. Refer to the section “**Roll VTR Setup**” on page 18–35 for more information.

6. Press **Com Settings** to display the **Com Settings Menu**.

7. Set the communications protocols for the Video Server as follows:
   - Use the **Com Port** knob to select the Video Server you want to set the communications settings for.
   - Use the **Baud** knob to select the baud rate for the Video Server. Refer to the section “**Setting up the Video Server**” on page 18–21 for the specific settings for your Video Server.
   - Use the **Parity** knob to select the parity for the specific Video Server. Refer to the section “**Setting up the Video Server**” on page 18–21 for the specific settings for your Video Server.

8. Press **Com Type** to display the **Com Type Menu**.
Communications — Com Type Menu

9. Select the type of serial communications that will be used to communicate with the Video Server as follows:
   - Use the Com Port knob to select the Video Server you want to set the communications type for.
   - Use the Type knob to select the type of serial communications for the selected port. Refer to the section “Setting up the Video Server” on page 18–21 for the specific settings for your Video Server.

10. Press Extra Options to display the Extra Options Menu.

Communications — Extra Options Menu

11. Assign a Target Machine to the Video Server port as follows:
   - Use the Com Port knob to select the Video Server you want to set the Target Machine for.
   - Use the Option knob to select TargetMachine.
   - Use the Value knob to select the target machine that you are using. Refer to the table on on page 18–17 for information on selecting a target machine

   **Important**
   For some Video Servers listed in the table “Target Machine Default Values” on page 18–17, once the TargetMachine has been set, the remaining settings will automatically be adjusted to those shown in the table. You should not have to adjust these settings.
12. Assign a Media ID Length for the selected device as follows:

<table>
<thead>
<tr>
<th>Target Machine Option</th>
<th>Media ID Length</th>
<th>Timeout (fields)</th>
<th>Send Tries</th>
<th>Cmd Queueing</th>
<th>Record Time</th>
<th>Playback Mode</th>
<th>Port Cmds</th>
<th>Extended Char</th>
<th>LoopRecueTime</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generic</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB/EE</td>
<td>No</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>VR300 V2</td>
<td>ShortIDs</td>
<td>25</td>
<td>2</td>
<td>Relaxed</td>
<td>60</td>
<td>PB/EE</td>
<td>No</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>VR300 V2.7</td>
<td>LongIDs</td>
<td>25</td>
<td>2</td>
<td>Relaxed</td>
<td>60</td>
<td>PB/EE</td>
<td>No</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>PinnacleThund</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB/EE</td>
<td>No</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>Spencer</td>
<td>ShortIDs</td>
<td>50</td>
<td>2</td>
<td>Relaxed</td>
<td>60</td>
<td>PB/EE</td>
<td>No</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>GeeVS</td>
<td>LongIDs</td>
<td>15</td>
<td>15</td>
<td>Relaxed</td>
<td>60</td>
<td>PB/EE</td>
<td>No</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>360Sys IS2000</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB/EE</td>
<td>Yes</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>EVS MaxS</td>
<td>ShortIDs</td>
<td>6</td>
<td>3</td>
<td>Strict</td>
<td>60</td>
<td>PB/EE</td>
<td>No</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>AirSpeed</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB/EE</td>
<td>Yes</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>GVG M-Series</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB/EE</td>
<td>Yes</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>Ross SMS</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB</td>
<td>Yes</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>Ross SMS 1.5</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB</td>
<td>Yes</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>ThunderMXe</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB/EE</td>
<td>Yes</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>VR440</td>
<td>ShortIDs</td>
<td>25</td>
<td>2</td>
<td>Relaxed</td>
<td>60</td>
<td>PB/EE</td>
<td>Yes</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>ThunderLT</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB/EE</td>
<td>Yes</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>GVGProfile</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB/EE</td>
<td>Yes</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>GVG Turbo</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB/EE</td>
<td>Yes</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>Abekas6000</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB/EE</td>
<td>Yes</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>AirSpace</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB/EE</td>
<td>Yes</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>Nexio</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB/EE</td>
<td>Yes</td>
<td>No</td>
<td>13</td>
</tr>
<tr>
<td>Omneon</td>
<td>LongIDs</td>
<td>28</td>
<td>10</td>
<td>Strict</td>
<td>60</td>
<td>PB/EE</td>
<td>Yes</td>
<td>No</td>
<td>13</td>
</tr>
</tbody>
</table>

**Note**: The Media ID Length sets the maximum character length of the Clip IDs displayed on the VTR Clips, Inpoint/Outpoint, and Remote Control Menus.
• Use the **Com Port** knob to select the Video Server you want to set the Media ID Length for.
• Use the **Option** knob to select **MediaIDLength**.
• Use the **Value** knob to select either **Short IDs** or **Long IDs**.
  ~ **Short IDs** — Select this option for devices that use ID lengths of up to 8 characters.
  ~ **Long IDs** — Select this option for devices that use ID lengths of up to 32 characters.

13. Assign a Timeout value to the selected device as follows:

   **Note**
   The Timeout value specifies the time, in fields, that the Synergy switcher will wait for a reply from the Video Server before trying to send a command again.

14. Assign a Send Tries value to the selected device as follows:

   **Note**
   The Send Tries value specifies the number of times that the Synergy switcher will try to send the same command to the Video Server if the switcher has not received a confirmation response.
15. Assign a Command Queuing value to the selected device as follows:

**Note**

The CMD Queueing value indicates whether the Synergy switcher must receive replies for every command sent to the Video Server (Strict), or not (Relaxed).

<table>
<thead>
<tr>
<th>Communications (L-2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol: VDCP</td>
</tr>
<tr>
<td>Command queuing strict or relaxed</td>
</tr>
<tr>
<td>Value:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Communications — Extra Options (Command Queuing) Menu**

- Use the **Com Port** knob to select the Video Server you want to set the Command Queuing for.
- Use the **Option** knob to select **Cmd Queuing**.
- Use the **Value** knob to select either **Strict** or **Relaxed** command queuing:
  - **Strict** — When Command Queuing is set to Strict, the Synergy switcher will keep re-sending a command, as set by the Send Tries value, until it receives a confirmation message from the Video Server.
  - **Relaxed** — When Command Queuing is set to Relaxed, the Synergy switcher does not need to receive a confirmation from the Video Server for every command.

16. Assign a Record Time to the selected device as follows:

**Note**

The Record Time value sets the maximum number of minutes that the Video Server will record for when it receives the Record transport command from a custom control. Refer to the section “Video Server Custom Controls” on page 18–37 for more information on programming custom control buttons for Video Servers.

<table>
<thead>
<tr>
<th>Communications (L-2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol: VDCP</td>
</tr>
<tr>
<td>Maximum Recording Time (minutes)</td>
</tr>
<tr>
<td>Value:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>( GB)</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Communications — Extra Options (Record Time) Menu**

- Use the **Com Port** knob to select the Video Server you want to set the Record Time for.
- Use the **Option** knob to select **Record Time**.
- Use the **Value** knob to select the maximum amount of time (in minutes) that a Video Server will record when it receives the Record command.
18–20  • Video Servers (VDCP) Synergy Series Installation Guide (v18)

~ The default time is set to 60 minutes, but you can assign any duration between 1 and 720 minutes.

17. Assign a Playback Mode to the selected device as follows:

**Note**

The Playback mode for most serial devices should already be correctly set. Use these controls only if required. Refer to the documentation for your device to verify what mode is required.

### Communications — Extra Options (Playback Mode) Menu

- Use the **Com Port** knob to select the Video Server you want to set the Playback Mode for.
- Use the **Option** knob to select **Playback Mode**.
- Use the **Value** knob to select a Playback mode. You can chose between the following:
  ~ **PB** — Use this option if your device does not go to Electronics-to-Electronics (EE) mode.
  ~ **PB/EE** — Use this option if your device does go to EE mode. By selecting this option, you enable the serial device to automatically go into PB/EE mode. If a Stop command is issued, the device will enter EE mode. If a pause command is issued, the device will stay in Playback mode.

18. Assign a Port Commands mode to the selected device as follows:

### Communications — Extra Options (Port Commands) Menu

- Use the **Com Port** knob to select the Video Server you want to set the Port Commands mode for.
- Use the **Option** knob to select **Port Cmds**.
- Use the **Value** knob to select a Port Commands mode. You can chose between the following:
  ~ **No** — Select this option if the “Open”, “Select”, and “Close” port commands are **not** used.
19. Select whether the switcher uses the extended character set for ClipIDs as follows:

- Use the **Com Port** knob to select the Video Server you want to set the Playback Mode for.
- Use the **Option** knob to select **ExtendedChar**.
- Use the **Value** knob to select whether the switcher allows non-printing characters or not.

- **Yes** — Select this option if the “Open”, “Select”, and “Close” port commands are used when entering and exiting VDCP menus.

- **No** — Use this option to have the switcher replace non-printing characters with spaces.

- **Yes** — Use this option to have the switcher use the extended character set and not replace non-printing characters with spaces.

20. For looping playback, select the amount of time before the end of the clip that the switcher sends a play command as follows:

- Use the **Com Port** knob to select the Video Server you want to set the Playback Mode for.
- Use the **Option** knob to select **LoopRecueTime**.
- Use the **Value** knob to select the amount of time, in frames, before the end of the clip that the switcher sends a loop command to the selected device.

21. Press **HOME** to display the **Installation Change Confirmation Screen**.

22. Accept or reject the changes you have made as follows:

- Press **Confirm** to accept the changes.
- Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the communications with the Video Server, next you will have finish setting up the Video Server to communicate with the Synergy switcher.

### Setting up the Video Server

In order to have the Synergy switcher communicate with a Video Server, the Video Server you are connecting to the switcher must be set up to communicate and accept commands from the switcher.

#### Avid AirSpace

This section describes the proper installation configuration required for a Synergy switcher to interface with an Avid AirSpace Video Server.
• Use the following communications settings to connect an Avid AirSpace Video Server to your Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>Generic</td>
</tr>
</tbody>
</table>

• On the Avid AirSpace you will have to set the Mode to VDCP for each individual channel you have connected to the Synergy switcher. Refer to your Avid AirSpace documentation for more information.

**Leitch ASC VR300 Video Server**

This section describes the proper installation configuration required for a Synergy switcher to interface with a Leitch ASC VR300 using version 2 or 2.7 of the Leitch software, and the Video Disk Communications Protocol (VDCP).

• Use the following communications settings when connecting the Leitch ASC VR 300 Video Server to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>V2 Value</th>
<th>V2.7 Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>ASCVR300 V2</td>
<td>ASCVR300 V2.7</td>
</tr>
</tbody>
</table>

**Leitch VR440 Video Server**

This section describes the proper installation configuration required for a Synergy switcher to interface with a Leitch VR440 using the Video Disk Communications Protocol (VDCP).

Use the following information to connect a Leitch VR440 Video Server to your Synergy switcher:

• Use the following communications settings when connecting the Leitch VR440 Video Server to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
</tbody>
</table>
This section describes the proper installation configuration required for a Synergy switcher to interface with a Pinnacle Thunder server using the Video Disk Communications Protocol (VDCP). This information is current for Synergy software version 18.0, or higher, used in conjunction with Thunder software version 5.5 and Louth Serial Protocol uVer 5.4.19.

- Use the following communications settings when connecting the Thunder Video Server to the Synergy switcher:

### Pinnacle Thunder

This section describes the proper installation configuration required for a Synergy switcher to interface with a Pinnacle Thunder server using the Video Disk Communications Protocol (VDCP). This information is current for Synergy software version 18.0, or higher, used in conjunction with Thunder software version 5.5 and Louth Serial Protocol uVer 5.4.19.

- Use the following communications settings when connecting the Thunder Video Server to the Synergy switcher:

#### Synergy-to-Thunder Communication Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>PinnacleThund</td>
</tr>
</tbody>
</table>

On the Pinnacle Thunder you will have to set up the communications parameters to allow it to properly connect to the Synergy switcher.

Use the following procedure to set up the Pinnacle Thunder:

1. On the File Menu, select Preferences and click Protocol Setup to display the Protocol Setup Menu.
2. For each channel, select LouthSerial as the protocol.
3. Ensure that both the Preset/Cue and Stop Current Clip Before Preset boxes are checked.
4. Click on the associated Restart button(s), and close the dialogue box.

This completes the procedure to set up the Pinnacle Thunder with Thunder software version 5.5 and Louth Serial Protocol uVer 5.4.19.

#### Pinnacle Thunder version 6.1

If you are setting up a Pinnacle Thunder version 6.1 with a device that includes six RS-422 ports labeled as Com 3 to 8, there are additional communications parameters to set up.

Use the following procedure to setup additional communication parameters for your Pinnacle Thunder:

1. Navigate to the Device Manager as follows:
   - Right click on the My Computer icon and select Properties.
   - Select Hardware.
Select Device Manager.

2. For each channel, set the com settings as follows:
   - Select Com Ports.
   - Select Com.
   - Select Settings.
   - Set the Baud Rate to 38,400.
   - Set the Parity to Odd.
   - Close the dialog boxes.

3. Set the Channel Configuration as follows:
   - From the File Menu, select Preferences and click Channel Configuration to display the Channel Configuration Menu.
   - Set the com ports to control the associated channel.
   - Deselect all other channels.
   - Close the dialog boxes.

This completes the procedure to setup additional communication parameters for your Pinnacle Thunder.

**Pinnacle ThunderMX**

Use the following communications settings when connecting the Pinnacle ThunderMX Video Server to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>ThunderMXe</td>
</tr>
</tbody>
</table>

**Pinnacle ThunderLT**

Use the following communications settings when connecting the Pinnacle ThunderLT Video Server to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
</tbody>
</table>
Spencer Technologies Video Server

This section describes the proper installation configuration required for a Synergy switcher to interface with a Spencer Technologies Video Server.

- Use the following communications settings when connecting the Spencer Technologies Video Server to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>Spencer</td>
</tr>
</tbody>
</table>

Gee Broadcast Systems Geevs

This section describes the proper installation configuration required for a Synergy switcher to interface with a Gee Broadcast Geevs Video Server.

- Use the following communications settings when connecting the Gee Geevs Video Server to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>GeeVS</td>
</tr>
</tbody>
</table>

- When assigning the Gee Broadcast Geevs Video Server to a specific BNC input on the Synergy switcher:
  
  ~ If you are using Channel 1 on the Gee Broadcast Geevs Video Server, you must set the Channel value to 1 on the BNC Setup Menu and set the SubAddress value to 0 on the BNC Setup Menu.
  
  ~ If you are using Channel 2 on the Gee Broadcast Geevs Video Server, you must set the Channel value to 1 on the BNC Setup Menu and set the SubAddress value to 0 on the BNC Setup Menu.
The actual selection of the channel is done by physical Com Port we are connected to on the Gee Broadcast Geevs Video Server. For example, Com Port 1 controls Channel 1 and Com Port 2 controls Channel 2.

360 Systems Image Server 2000

This section describes the proper installation configuration required for a Synergy system to interface with a 360 Systems Image Server 2000.

- Use the following communications settings when connecting the Image Server 2000 to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>360Sys IS2000</td>
</tr>
</tbody>
</table>

On the Image Server 2000 you will have to set up the communications parameters to allow it to properly connect to the Synergy switcher.

Use the following procedure to set up the Image Server 2000:

1. On the Configuration Menu click System... to open the Configuration System Window.
2. Select the Control tab.
3. In the Serial Protocol Area, select VDCP for the Channel you have connected to the Synergy switcher.
4. In the VDCP Option Area, configure the options as follows:
   - **Cue shows 1st frame** — selected (check mark)
   - **Cue w/offset (vs timestamp)** — selected (check mark)
   - **Vari-play 1x equals play** — deselected (no check mark)
   - **Var-play 0 equals pause** — deselected (no check mark)
   - **Report Play (vs still) at end** — deselected (no check mark)
   - **Ignore preroll commands** — deselected (no check mark)
   - **Auto E-E** — deselected (no check mark)

This completes the set up of the 360 Systems Image Server 2000.
**EVS Broadcast Equipment maXS Universal Production Server**

This section describes the proper installation and configuration required for a Synergy system to interface with an EVS maXS video server.

- Use the following communications settings when connecting the EVS maXS video server to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>EVS MaxS</td>
</tr>
</tbody>
</table>

You must configure the EVS maXS communications parameters to allow a proper connection to the Synergy switcher. Ross Video recommends the following settings:

- Configure the EVS maXS to record clips using the VDCP 2R+2P application.
- Set the configuration for VDCP 2R+2P to **Louth slave**.
- Set the communication parameter to channel 1 when using the Synergy switcher.

The **Remote Reset Jumper 1** on the **PC&CTRL Board** must *not* have a jumper cap on it. Ensure that the jumper cap is on a port other than 1. Refer to your EVS maXS documentation for more information on locating and setting this jumper.

This completes the set up of the EVS maXS.

**Avid AirSpeed**

This section describes the proper installation configuration required for a Synergy switcher to interface with an Avid AirSpeed Video Server.

- Use the following communications settings when connecting the AirSpeed Video Server to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>AirSpeed</td>
</tr>
</tbody>
</table>

- On the Avid AirSpeed, set the **Mode** to **VDCP** for each individual channel you have connected to the Synergy switcher. Refer to your Avid AirSpeed documentation for more information.
• It is recommended that you use Channels 2 or 3 on the Avid AirSpeed.
• Ensure that the **Playback Mode** you select on the Synergy **Communications Menu** is the same mode set on the Avid AirSpeed.

**Omneon Video Server**

This section describes the proper installation configuration required for a Synergy switcher to interface with an Omneon Video Server.

Use the following communications settings when connecting the Omneon Video Server to the Synergy switcher:

<table>
<thead>
<tr>
<th><strong>Synergy-to-Omneon Communication Settings</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Setting</strong></td>
</tr>
<tr>
<td>Transmission Standard</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
<tr>
<td>Target Machine</td>
</tr>
</tbody>
</table>

**Ross Video SoftMetal Video Server Communication**

This section describes the proper installation configuration required for a Synergy switcher to interface with a Ross Video SoftMetal Video Server.

Use the following communications settings when connecting the Ross Video SoftMetal Video Server to the Synergy switcher:

<table>
<thead>
<tr>
<th><strong>Synergy-to-SoftMetal Communication Settings</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Setting</strong></td>
</tr>
<tr>
<td>Transmission Standard</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
<tr>
<td>Target Machines</td>
</tr>
</tbody>
</table>

**Configuring the SoftMetal Remote Client Settings**

You must configure the SoftMetal Remote Client settings to enable communication between the SoftMetal Video Server and the Synergy switcher.

**Note**

If you have a non-standard SoftMetal installation, refer to your SoftMetal documentation for more detailed configuration instructions.
Use the following procedure to set the Remote Client configuration:

1. Open the SoftMetal Configuration Client as follows:
   • On the task bar, click the **Start** button.
   • Click **All Programs → Ross Video → SoftMetal → Configure SoftMetal**.
2. Click the **Remote Control** tab.
3. In the **Peripheral Port** drop-down list, select the port which you have connected to the Synergy switcher.
4. In the **Protocol** drop-down list, select **VDCP**.
5. Click **OK** to save your settings.

This completes the procedure for setting the Remote Client configuration.

**GVG M-Series iVDR Video Server Communication**

This section describes the proper installation configuration required for a Synergy switcher to interface with a GVG M-Series iVDR Video Server.

Use the following information to connect the GVG M-Series iVDR Video Server to your Synergy switcher:

- Use the following communications settings when connecting the GVG M-Series iVDR Video Server to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>GVG M-Series</td>
</tr>
</tbody>
</table>

- On the GVG M-Series iVDR, connection is made between the Remote Ports 1-8 on the Synergy control panel and the serial ports (PORT 1 through PORT 4) on the M-Series frame. Refer to the GVG M-Series documentation for information on starting a remote control protocol application and setting the control port and control mode for the video players (P1 and P2).
- On the Synergy switcher, the channel and sub-address must be set as follows:
  ~ **P1: Player** — channel 2, sub-address 0
  ~ **P2: Player** — channel 4, sub-address 0

**GVG Profile Video File Server**

This section describes the proper installation configuration required for a Synergy switcher to interface with a GVG Profile Video File Server.

- Refer to the GVG Turbo documentation for information on setting up serial control on your device.
• Use the following communications settings when connecting the GVG Profile Video File Server to the Synergy switcher:

**Synergy-to- GVG Profile Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>GVGProfile</td>
</tr>
</tbody>
</table>

**GVG Turbo iDDR**

This section describes the proper installation configuration required for a Synergy switcher to interface with a GVG Turbo iDDR.

• Refer to the GVG Turbo documentation for information on setting up serial control on your device.

• Use the following communications settings when connecting the GVG Turbo iDDR to the Synergy switcher:

**Synergy-to- GVG Turbo Communication Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>GVGTurbo</td>
</tr>
</tbody>
</table>

**Abekas6000 MultiFlex DTV Production Server**

This section describes the proper installation configuration required for a Synergy switcher to interface with an Abekas6000 MultiFlex DTV Production Server.

• Refer to the Abekas documentation for information on setting up serial control on your device.
• Use the following communications settings when connecting the Abekas6000 MultiFlex DTV Production Server to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>Abekas6000</td>
</tr>
</tbody>
</table>

**Synergy-to-Abekas6000 Communication Settings**

**Leitch Nexio Video Server**

This section describes the proper installation configuration required for a Synergy switcher to interface with a Leitch Nexio Video Server.

• Refer to the Leitch documentation for information on configuring the VDCP protocol on your Video Server.

• Use the following communications settings when connecting the Leitch Nexio Video Server to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
<tr>
<td>Target Machine</td>
<td>Nexio</td>
</tr>
</tbody>
</table>

**Synergy-to-Leitch Nexio Communication Settings**
Setting up Video Server BNCs

The Synergy switcher enables you to control multiple channels from a VDCP device through a single remote port on the Synergy control panel. You must first assign the BNC input to the remote port of the Synergy control panel. Next you can assign a VDCP device channel to the BNC input. You can repeat this procedure for as many channels you wish to control on the remote port, assigning each channel to a BNC input on the Synergy control panel.

**Important**

Software versions prior to version 16 do not support the Multi-Channel VDCP device assignment. When you are downgrading to pre-version 16 software, you must assign each VDCP device channel to a separate remote port.

Use the following procedure to assign the Video Server to a specific BNC input:

1. Navigate to the **BNC Menu 1-3** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC.
2. Press **BNC Type** to display the **BNC Type Menu**.

   ![BNC Type Menu](image)

   **BNC — Type Menu**

3. Assign a BNC to Video Server as follows:
   - Use the **BNC** knob to select the BNC that the Video Server is connected to.
   - Use the **Type** knob to select **VTR**.
   - Use the **Asp Ratio** knob to select the video aspect ratio of the Video Server output.

4. Navigate to the **VTR/VDCP Xpts Menu** as follows:
   - Press MORE ⇒ MORE ⇒ VTR/VDCP Xpts.

   ![VTR/VDCP Xpts Menu](image)

   **BNC — VTR/VDCP Xpts Menu**
5. Assign a BNC Input to your Video Server as follows:
   • Use the **BNC** knob to select the BNC to assign to your Video Server.
   • Use the **Controller** knob to select the remote port that the Video Server is connected to. The Remote ports assigned to the Video Server will be listed.

   **Note**
   If you select NONE, the BNC will not be assigned to a Video Server nor will it be displayed in other Synergy menus associated with VTR/VDCP control.

6. Select the channel and subaddress for the Video Server as follows:
   • Press **VDCP Setup** to display the **VDCP Setup Menu**.

   **BNC — VDCP Setup Menu**

   • Use the **BNC** knob to assign a BNC to your Video Server. BNCs that have been assigned to a Video Server are displayed in the list.
   • Use the **Channel** knob to select the channel on the Video Server you wish to control. For most Video Servers, you can select a channel between 0 and 8. Refer to the documentation for your device to verify its available channels.

     ~ If you are using a **360 Systems Image Server 2000**, you must select a channel between 1 and 3.
     ~ If you are using a **Pinnacle Thunder v6.1**, the channel must be set to 1.
     ~ If you are using a **Gee Broadcast Systems Geevs Video Server**, the channel must be set to 1 when using Com Port 1 on the Video Server and to 2 when using Com Port 2.
     ~ If you are using an **Avid AirSpeed**, you must select channel 2 or 3.
     ~ If you are using an **Omneon Video Server**, the channel must be set to the same value as the configured VDCP Signal Port of the Omneon.
     ~ If you are using a **Ross Video SoftMetal Video Server**, you must select a channel between 1 and 4. The SubAddress is automatically set to the same value.
     ~ If you are using a **GVG M-Series iVDR Video Server**, you must select channel 2 for player 1 or channel 4 for player 2.
     ~ If you are using a **Leitch Nexio Video Server**, you must select the channel that is controlled by the Leitch rear panel port connected to the Synergy switcher.
   • Use the **SubAddress** knob to select the subaddress, or port number, of the Video Server. For most Video Servers, you can select a SubAddress between 0 and 15. Refer to the documentation for your device for more information:
~ If you are using a **360 Systems Image Server 2000**, the SubAddress must be set to the same value as the Channel.

~ If you are using a **Pinnacle Thunder v6.1**, the SubAddress must be set to **0**.

~ If you are using a **Gee Broadcast Systems Geevs Video Server**, the SubAddress must be set to **0**.

~ If you are using an **Avid AirSpeed**, the SubAddress for the selected channel must match the physical Remote Port it is associated with on the Avid AirSpeed. For example, if Channel 2 is associated with Remote Port 1, you must set the SubAddress to **1**.

~ If you are using an **Omneon Video Server**, the SubAddress must be set to **1**.

~ If you are using a **Ross Video SoftMetal Video Server**, the SubAddress automatically follows the channel number that you set above.

~ If you are using a **GVG M-Series iVDR Video Server**, the SubAddress must be set to **0**.

7. Press **HOME** to display the **Installation Change Confirmation Screen**.

8. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up a Video Server to a BNC on the Synergy switcher. You can repeat the procedure for every Video Server channel you wish to assign to a BNC. Next you will have to set up the **Roll VTR Mode**.
Roll VTR Setup

The Roll VTR Mode determines how the ROLL VTR button behaves when a Video Server is selected. When you set the Roll VTR Mode, the setting affects all ROLL VTR buttons in all MLEs.

Use the following procedure to configure the Roll VTR Mode:

1. Navigate to the Personality Menu 1-4 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Press Roll VTR Mode to display the Roll VTR Mode Menu.

3. Use the Roll VTR Mode knob to select a mode for the Roll VTR button. You can select between the following:

   - **Play Mode** — Selecting this mode allows you to play a Video Server clip directly by pressing the ROLL VTR button. Once pressed, the clip will start to play and will have to be taken on-air manually with the Fader, a Cut or Auto Transition. This is the default setting.

   - **Arm Mode** — Selecting this mode allows you to have a Video Server clip play with the next transition that takes the MLE on-air by pressing the ROLL VTR button. This can be used to roll multiple Video Servers if they are re-entered. Once pressed, the clip will only start to play when it is taken on-air with a Cut, Auto Transition, or if you press the assigned crosspoint button.

   - **Armed Always** — Selecting this mode allows you to have a Video Server clip play with the next transition that takes the MLE on-air when you press the assigned crosspoint button.

**Important**

When the OverDrive production control system is connected to the Synergy switcher, activating the Editor button turns on all the Roll VTR buttons and sets the Roll VTR Mode to Arm, disabling the Roll VTR Mode selection in the Personality Menu.

**Note**

If an Auto Transition is performed with the ROLL VTR active, and in Arm or Armed Always Mode, the switcher will apply the Pre-Roll time for the Video Server before it takes the Video Server on-air.

**Note**

On a re-entered MLE, ROLL VTR activates only the first Video Server it finds that is about to be brought on-air. The search order is: re-entered MLE BKGD (including its own re-entry), then re-entered MLE PST, then Key 1, then Key 2 – each with its own re-entry checked.
Notes on Selecting the Play Mode

When the ROLL VTR button is in the Play Mode:

- Pressing the button immediately rolls the serial device selected on the PST bus (one device per bus, including one device from a re-entered MLE).
- The transition that brings the device to air must be initiated by the operator with the fader, CUT, or AUTO TRANS buttons.
- The button is momentary. It is lit only when pressed.

Notes on Selecting the Arm or Armed Always Modes

When the ROLL VTR button is in the Arm Mode or Armed Always Mode:

- Pressing the button arms the switcher to roll the selected serial device (one device per bus, including one device from a re-entered MLE) on the PST bus in the next transition.
- When the transition is performed by pressing the crosspoint on the PGM bus, CUT, or AUTO TRANS, the device rolls, and goes to air after the preroll interval has elapsed.
- During preroll, moving the fader, pressing CUT, or double-pressing the crosspoint on the PGM bus will override the preroll time and take the Video Server to air immediately.
- On a re-entered MLE, ROLL VTR activates only the first VTR it finds that is about to be brought on-air. The search order is: reentered MLE BKGD (including its own re-entry, if necessary), then re-entered MLE PST, then Key 1, then Key 2 – each, if necessary, with its own re-entry checked.
- If the mode is set to Arm, the button is latching. It remains lit until it is pressed again.
- If the mode is set to Armed Always, the button is always lit. Pressing the Roll VTR button does not disable it. Instead, you must configure the Roll VTR mode in the Personality Menu or in a custom control macro.
Video Server Custom Controls

A custom control button can be programmed with the transport functions that are located on the Video Server Clips Menu and the Remote Control Menu. This allows for quick access to these functions, or you can string a number of these functions together in a single custom control.

Use the following procedure to program custom control buttons that include special transport functions for Video Servers:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

3. Navigate to the Insert VTR Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ VTR.

Note: You must have the Video Server Control option installed in order to control a Video Server to the Synergy switcher. Refer to the section “Setting up the Switcher” on page 18–14 for information on setting up a Video Server.

Operating Tip: As a recommendation, keep transport control functions for similar devices grouped together on your physical custom control buttons.

Note: If an error message is displayed stating that there are no communications ports assigned to a Video Server, ensure that the Video Server you are trying to control has been properly set up. Refer to the section “Communications Setup” on page 18–14 for setup information.
4. Select a Video Server function to insert as follows:
   - Use the **Device** knob to select the Video Server that you want to assign the custom control to.
   - Use the **Function** knob to select the transport control function that you want to assign to the selected Video Server. You can chose between the following:
     ~ **Fast Forward** — Select this command to have the Video Server go into full fast forward mode.
     ~ **Frame Advance** — Select this command to have the Video Server move (jog) the video one frame forward.
     ~ **Frame Reverse** — Select this command to have the Video Server move (jog) the video one frame reverse.
     ~ **Go to Clip** — Select this command to have the Video Server cue to a selected clip.
     ~ **Rewind** — Select this command to have the Video Server go into full fast rewind mode.
     ~ **Stop** — Select this command to have the Video Server stop.
     ~ **Record** — Select this command to have the Video Server go into record mode.
     ~ **Play** — Select this command to have the Video Server go into play mode, or 1× forward.
     ~ **Pause** — Select this command to have the Video Server to into pause mode.
     ~ **Play Loop On** — Select this command to have the currently cued and playing clip loop back to the beginning when it is finished playing.

**Note**
When you select **Go To Clip**, the bottom **Go To Clip** knob appears, allowing you to select the number (00-99) for the clip you want to cue up. Most Video Servers allow you to enter a VTR Clip ID by toggling the **VTR Clip** button and using the keypad in the **Global Memory System**.

**Operating Tip**
If you are programming a **Record** custom control for a Video Server, the length of time that the Video Server will record will depend on the the value assign by the Record Time. Refer to the **Record Time Extra Option** in the section “Setting up the Switcher” on page 18–14 for more information.
~ Play Loop Off — Select this command to have a currently looping clip stop playing the next time it reaches the end.

5. Press Insert to insert the selected command into the custom control and display the Insert Special Menu 1-2.

6. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

7. Press UP ONE to display the Recording Menu.

8. Press Finish Recording or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for programming custom control buttons that include special functions for Video Servers.

Once your custom control buttons have been programmed, be sure to properly name them. Refer to the section “Naming Custom Controls” on page 8–42 for more information on naming custom control buttons. Any recorded custom control can be edited. Refer to the section “Editing Custom Control Macros” on page 8–47 for details.

Roll VTR Mode

The Roll VTR Mode determines how the ROLL VTR button behaves when a Video Server is selected. When you set the Roll VTR Mode, the setting affects all ROLL VTR buttons in all MLEs.

A custom control macro that changes the Roll VTR Mode state will disable the Roll VTR Mode selection in the Personality Menu.

Use the following procedure to change the Roll VTR Mode with a custom control macro:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.
2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) in the list have already been programmed.

As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Navigate to the Special Menu as follows
   - Press Start Recording ⇒ Insert Special ⇒ Special.
4. Change the Roll VTR Mode as follows:
   • Use the Selection knob to select Roll VTR Mode.
   • Use the Roll VTR Mode knob to select a Roll VTR Mode. You can select between the following:

   ~ **Play** — Select this option to issue a Play command to the serial device when the Roll VTR button is selected in the PST Bus. This is the default setting.
   ~ **Arm** — Select this option to enable the Synergy switcher to automatically transition the device to air after the preroll interval has lapsed.
   ~ **Armed Always** — Select this option to have the ROLL VTR always active, the button is always lit. The clip will play when it is taken on-air when you press the assigned crosspoint button.

5. Press **Insert** to enter the change in Roll VTR Mode into your custom control macro.

6. Press **UP ONE** to return to the **Custom Controls Recording Menu**.

7. Press **Finish Recording** or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure to change the Roll VTR Mode with a custom control. Any recorded custom control can be edited. Refer to the section “Editing Custom Control Macros” for details.
Video Server Clip Setup

In order to easily recall clips on the Video Server from the Synergy switcher, you will have to store the clips you want to use to **Clip Registers** on the switcher. These Clip Registers store the location, inpoint and outpoint overrides, and the name of the clip.

The **VTR Clips Menu** allows you to perform the following functions:

- Select a Video Server and a clip number.
- Grab or enter a timecode (and other device-specific data), name the clip, and store it in a clip register. Up to **100** clips can be stored (using registers **00** to **99**).
- Cue and preview each clip.
- Trim the inpoint and outpoint of a clip.

**Programming Video Server Clips**

Use the following procedure to program a Video Server clip:

1. Navigate to the **VTR Clips Menu** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Clips** ⇒ **VTR Clips**
2. Press **Clip Type** to display the **Clip Type Menu**.

<table>
<thead>
<tr>
<th>Clip Type</th>
<th>Menu Clip</th>
<th>Enter ID</th>
<th>Choose ID</th>
<th>Inpoint</th>
<th>Outpoint</th>
<th>Clip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip: 00</td>
<td>Clip Name: &quot;BG-Blue&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device: BNC 3 (R1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ID: &quot;BG-Blue Circle&quot;</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duration: 00:00:00:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. Select the Clip Register you want to store a Video Server Clip to as follows:
   - Use the **Clip** knob to select the Clip Register that you want to program (**00-99**).
   - Use the **Device** knob to select the remote port for the Video Server you want to store the clip information for.
   - Use the bottom knob to select if you want the clip to be displayed in the **Remote Control Menu** (for on-air use), or to be disabled for use later.

   **Note**

   If a clip is set to **Clip Disabled**, it will not be displayed on the **Remote Control Menu**, but you can still enter all required clip parameters. This can also be used to enable a clip that is already programmed.

4. Press **Name Clip** to display the **Clip Name Menu**.

   The **Video Server Clip** name is the one that is displayed for the Clip Register on the display in the **Global Memory System Group** and on the **Remote Control Menu**.
5. Select a clip on the Video Server as follows:

- Press **Choose ID** to display the **Choose ID Menu**.
- If you know the name of the clip, press **Enter ID** and you can enter the name of the clip directly from the **Enter Clip ID Menu**.

### Important

Do not enter a space as the first or last character of a clip name.

- Press **Accept New Name** to complete the naming procedure and return to the **VTR Clips Menu 1-2**.

### Note

If you want to refresh the list of clips returned by the Video Server, press **Refresh & Choose ID** to poll the Video Server for a current list of clips. The total number of clips returned is indicated under the **Showing**.

- Use the **×1, ×10 or ×100** knobs to select the clip on the Video Server that you want to use. In the status area, the **ID** and **Duration** fields automatically update as you scroll, and each clip’s head frame will be visible if you have the Server selected on Preset.

---

**Clip Name Menu**

- Use the **Horizontal** and **Vertical** knobs (in conjunction with the editing softkeys) to enter the desired clip name.
- A standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs. Refer to the section, “**Using The Keyboard**” in the **Synergy Series Operation Guide** for details.

**VTR Clips — Choose ID Menu**

- Press **Choose ID** to display the **Choose ID Menu**.
- If you know the name of the clip, press **Enter ID** and you can enter the name of the clip directly from the **Enter Clip ID Menu**.
6. Modify the Inpoint and Output of the Clip as follows:

- Press **Inpoint/Outpoint** to display the **Inpoint/Outpoint Menu**.

  **Note**

  If you select different start and end frames to use on air, the original inpoint and outpoint for the clip remain unchanged on the Video Server. This allows you to create sub-clips from a long master Video Server clip directly on the switcher.

<table>
<thead>
<tr>
<th>Clip: 08</th>
<th>Clip Name: &quot;BG-Blue &quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device: BNC 3 (R2)</td>
<td></td>
</tr>
</tbody>
</table>

**Inpoint/Outpoint Menu — Disabled**

- Toggle the **Enable** softkey to enable Inpoint/Outpoint Overrides as follows:
  - **No** — Select this option to use the default inpoint and outpoint of the clip on the Video Server. If you have made changes to the inpoint of outpoint of the clip, these values will be saved, but not applied to clip until you select **Yes**.
  - **Yes** — Select this option to override the inpoint and outpoint of the clip on the Video Server. When you select **Yes**, the **Inpoint/Outpoint Menu** changes to **Inpoint/Outpoint Menu — Enabled**

<table>
<thead>
<tr>
<th>Clip: 08</th>
<th>Clip Name: &quot;BG-Blue &quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device: BNC 3 (R2)</td>
<td></td>
</tr>
</tbody>
</table>

**ID: "BG-Blue Circle"**

**Duration**: 00:00:13:09

**Inpoint**: 00:00:00:00

**Outpoint**: 00:00:13:10

**Inpoint/Outpoint Menu — Enabled**

- Toggle the **Edit** softkey to **In** or **Out** to select either the Inpoint or Outpoint for editing as follows:
  - **In** — Select this option to modify the inpoint, or start position, of the clip.
  - **Out** — Select this option to modify the outpoint, or stop position, of the clip.

**Note**

If you do not know the timecode for the Inpoint or Outpoint you want to store to the Clip Register, you can manually preview the Video Server video using the command on the **Video Server Clips Menu 2-2** and grab the timecode. Refer to the section “Grabbing a Timecode” on page 18–45 for information on grabbing a timecode.

- Press **Hours Minutes** to display the **Hours Minutes Menu**.
Inpoint/Outpoint Menu — Hours Minutes Menu

• Use the Hours knob to adjust the value in the hours field of the Inpoint or Outpoint.

• Use the Minutes knob to adjust the value in the minutes field of the Inpoint or Outpoint.

• Press Seconds Frames to display the Seconds Frames Menu.

Inpoint/Outpoint Menu — Seconds Frames Menu

• Use the Seconds knob to adjust the value in the seconds field of the Inpoint or Outpoint.

• Use the Frames knob to adjust the value in the frames field of the Inpoint or Outpoint.

Operating Tip

You can preview the Timecode location by selecting the Video Server on the PST Bus and pressing Cue to Timecode.

• Press Grab Timecode to use the new timecode value for the Inpoint or Outpoint.

7. Press HOME to store your settings.

This completes the procedure for programming Video Server clips.
Grabbing a Timecode

If you do not know the timecode for the inpoint or outpoint, you can manually scan the Video Server video using the commands on the Video Server Clips Menu 2-2 and grab the timecode.

Use the following procedure to grab a timecode:

1. Navigate to the VTR Clips Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Clips ⇒ VTR Clips.
2. Select the Clip Register and Video Server that you want to store. Refer to the section “Programming Video Server Clips” on page 18–41 for more information on programming Video Server Clips.
3. Grab a timecode as follows:
   - Press MORE to display VTR Clips Menu 2-2.

   

<table>
<thead>
<tr>
<th>VTR Clips Menu 2-2 — VTR Transport Controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip: 07</td>
</tr>
<tr>
<td>Device: BNC R1 (R1)</td>
</tr>
<tr>
<td>Inpoint: 00:00:00:00</td>
</tr>
<tr>
<td>Rewind</td>
</tr>
</tbody>
</table>

   • Cue the VTR to the desired clip location using the transport controls: Rewind, Back Frame, Pause, Play, Ahead Frame and Fast Forward.
   • Press Pause to hold the Video Server at the desired timecode.
   • Press MORE to display the VTR Clips Menu 1-2.
   • Press Grab Timecode to grab the current timecode and display it in the Timecode field.
4. Press HOME to store your settings.

This completes the procedure for grabbing a Video Server timecode.
Robotic Cameras

In This Chapter

This chapter provides instructions for connecting, and setting up a Robotic Camera with your Synergy switcher. Before you begin, ensure that the Robotic Camera System Interface option is installed. If not, contact Ross Video for details. Refer to the section “Installed Options Menus” on page 2–37 for instructions on verifying the status of installed options.

The following topics are discussed:

• Supported Robotic Cameras
• Communications Connections
• Communications Setup
• Setting up Robotic Camera BNCs
• Robotic Camera Custom Controls
Supported Robotic Cameras

The Synergy Series Switcher has been tested with a number of Robotic Cameras to ensure the highest standard for compatibility and reliability. The following Robotic Cameras are currently supported by your Synergy switcher:

- AMX AXB-PT10 PosiTrack Camera Controller (using RS-232 Protocol)
- AMX AXB-PT PosiTrack Camera Controller (using RS-232 Protocol)
- AMX AXB-PT30 PosiTrack Camera Controller (using RS-232 Protocol)
- Canon NU-700N Robotic Camera
- Eagle PT-101 Pan Tilt System Robotic Camera Controller
- Panasonic AW-PH500p Pan/Tilt Head
- Parkervision CameraMan 3e 3-CCD Robotic Camera
- Radamec HK185 Robotic Camera Controller
- Radamec HK431 Robotic Camera Controller
- Shotoku TR-8S Control System (using the Shotoku RS422 TR-8 Series Interface protocol)
- Sony BRC-300/300P Robotic Camera
- Telemetrics PT-CP-S2 Robotic Camera Controller
- Telemetrics PT-HP-S2 Robotic Camera Controller
- Telemetrics PT-LP-S2 Robotic Camera Controller
- Telemetrics STS-12 Serial Control Transfer Switch
Communications Connections

You can connect a number of Robotic Cameras to your Synergy switcher. The procedure for connecting the Robotic Camera will depend on the type of Robotic Camera you have. This section will provide general instructions for connecting the Robotic Camera to one of the Remote Ports on the back of the Synergy control panel.

Note

These instructions are provided as a guide, for specific information on the Robotic Camera you are connecting to the Synergy switcher, refer to the documentation provided with the Robotic Camera.

In order to properly complete this procedure you will need the following software options, cables, and equipment:

- **Robotic Camera System Interface** — This is the software option from Ross Video that allows your Synergy switcher to control a Robotic Camera.
- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your Robotic Camera. Refer to the section “Robotic Camera Interface Cable Pinouts” on page 19–4 for information on the pin-outs and connector required for your Robotic Camera. Ross Video does not supply this cable.

Use the following procedure to connect a Robotic Camera to your Synergy switcher:

1. Connect and secure the 9-Pin, Male, end of the Interface Cable to one of the Remote Ports on the back of the Synergy control panel.

2. Connect and secure the other end of the cable to the appropriate port on the Robotic Camera. The suggested port for each supported Robotic Camera is listed below:

   - **Telemetrics Robotic Camera Controller** — Connect the Interface cable to the Serial port on the Telemetrics PT-CP-S2, PT-HP-S2 or PT-LP-S2 Robotic Camera Controller. Refer to the section “Telemetrics Robotic Camera Controller Cabling” on page 19–4 for more information.

   - **Telemetrics STS-12 Serial Control Transfer Switch** — Connect the Interface cable to the Controller (DCE) Port on the Telemetrics STS-12 Serial Control Transfer Switch. Refer to the section “Telemetrics STS-12 Serial Control Transfer Switch” on page 19–5 for more information.

   - **Radamec Robotic Camera Controller** — Connect the Interface cable to the communication port on the Radamec HK185 or HK431 Head Power Supply. Refer to the section “Radamec Robotic Camera Controller Cabling” on page 19–6 for more information.
• **Canon NU-700N Robotic Camera** — Connect the Interface cable to the serial port on the Canon NU-700N Robotic Camera. Refer to the section “**Canon Robotic Camera Cabling**” on page 19–7 for more information.

• **Sony BRC-300/300P Robotic Camera** — Connect the Interface cable to the Video Connector port on the rear of the Sony BRC-300/300P Robotic Camera Controller. Refer to the section “**Sony BRC-300/300P Robotic Camera Cabling**” on page 19–7 for more information.

• **Eagle PT-101 Pan Tilt System Robotic Camera Controller** — Connect the Interface cable to the Phoenix Connection Block on the Eagle Pan Tilt System Robotic Camera Controller. Refer to the section “**Eagle PT-101 Pan Tilt System Robotic Camera Controller Cabling**” on page 19–8 for more information.

• **Panasonic AW-PH500p Pan/Tilt Head** — Connect the Interface cable to the Remote port on the rear of the Panasonic Control Panel Main Unit. Refer to the section “**Panasonic AW-PH500p Pan/Tilt Head**” on page 19–8 for more information.

• **Parkervision CameraMan 3e 3-CCD Robotic Camera** — Connect the Interface cable to the RS-232 port on the rear panel of the Parkervision Mini Docking Station. Refer to the section “**Parkervision CameraMan 3e 3-CCD Robotic Camera**” on page 19–9 for more information.

• **Shotoku TR-8S Control System** — Connect the Interface cable to the RS422 port on the rear of the Shotoku PDU. Refer to the section “**Shotoku TR-8S Control System**” on page 19–10 for more information.

• **AMX AXB-PT PosiTrack Camera Controller** — Connect the Interface cable to the AXlink port on the AMX PosiTrack PT-10, PT-15, or PT-30 Unit. Refer to the section “**AMX AXB-PT PosiTrack Camera Controller**” on page 19–10 for more information on the cabling for this Robotic Camera.

This completes the procedure for connecting a Robotic Camera to the Synergy switcher. Refer to the section “**Communications Setup**” on page 19–11 for instructions on how to set up communications protocols on the switcher, as well as on the Robotic Camera.

### Robotic Camera Interface Cable Pinouts

Use the information in this section to connect the Interface Cable from the Synergy switcher to the Robotic Camera.

**Telemetrics Robotic Camera Controller Cabling**

<table>
<thead>
<tr>
<th>Note</th>
<th>This information applies to the Telemetrics PT-CP-S2, PT-HP-S2 and PT-LP-S2 Robotic Camera Controllers.</th>
</tr>
</thead>
</table>

The Synergy control panel connects to the Telemetrics Robotic Camera Controller via the remote ports on the Synergy control panel, and the Serial port on the rear of the Telemetrics Robotic Camera Controller.

Cable connections in the following table refer only to those between the Synergy control panel and the Telemetrics Robotic Camera Controller. Other cable connections present on the Telemetrics Robotic Camera Controller can be found in the Telemetrics documentation.
The Synergy switcher can be connected to any of the Controller (DCE) Ports of the Telemetrics STS-12 Serial Control Transfer Switch.

- The DCE Ports are always female, the same as the ports on the PT Head.
- The Telemetrics PT Head connects to a DTE Port on the Telemetrics STS-12 Serial Control Transfer Switch using a straight through DB-9, pin to pin, male to female cable.
- Ports 1 and 2 are always DCE Ports.
- The Telemetrics STS-12 may have more than two DCE Ports. Refer to your Telemetrics documentation for information on the Port configuration for your device.

Note: The ports on the Telemetrics STS-12 Serial Control Transfer Switch are always paired, with each port in the pair configured the same.

If the Telemetrics STS-12 DCE Port is configured as RS-232, the cable is a DB-9 male to male Null modem as follows:

Synergy-to-Telemetrics STS-12 RS-232 Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Telemetrics STS-12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
If the Telemetrics STS-12 DCE Port is configured as RS-422, the cable is a DB-9 custom male to male cable as follows:

**Synergy-to-Telemetrics STS-12 RS-422 Wiring Chart**

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Telemetrics STS-12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

**Radamec Robotic Camera Controller Cabling**

**Note** This information applies to the Radamec HK185 and HK431 Robotic Camera Controllers.

The Synergy control panel connects to the Radamec Robotic Camera Controller via the remote ports on the Synergy control panel, and the communication port on the Radamec Head Power Supply.

Cable connections in the following table refer only to those between the Synergy control panel and the Radamec Robotic Camera Controller. Other cable connections present on the Radamec Camera Controller can be found in the Radamec documentation.

**Synergy-to-Radamec Wiring Chart**

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Radamec Head Power Supply</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
**Canon Robotic Camera Cabling**

The Synergy control panel connects to the Canon NU-700N Robotic Camera via the remote ports on the Synergy control panel, and the serial port on the Canon NU-700N Robotic Camera.

Cable connections in the following table refer only to those between the Synergy control panel and the Canon Robotic Camera. Other cable connections present on the Canon Camera can be found in the Canon documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Canon Robotic Camera</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

**Sony BRC-300/300P Robotic Camera Cabling**

The Synergy control panel connects to the Sony BRC-300/300P Robotic Camera Controller via the remote ports on the Synergy control panel, and the Video Connector port on the rear of the Sony BRC-300/300P Robotic Camera Controller, using the Sony VISCA protocol.

Cable connections in the following table refer only to those between the Synergy control panel and the Sony Robotic Camera. Other cable connections present on the Sony Robotic Camera can be found in the Sony documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Sony Robotic Camera</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
**Eagle PT-101 Pan Tilt System Robotic Camera Controller Cabling**

The Synergy control panel connects to the Eagle PT-101 Pan Tilt System Robotic Camera Controller via the remote ports on the Synergy control panel, and the Phoenix Connection Block on the Eagle Pan Tilt System Robotic Camera Controller.

**Note**

The **Phoenix Connection Block** is provided with your Eagle Pan Tilt System. Refer to your Eagle documentation to configure your device for RS-232 serial operation.

Cable connections in the following table refer only to those between the Synergy control panel and the Eagle Pan Tilt System. Other cable connections present on the Eagle Pan Tilt System can be found in the Eagle documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Eagle Pan Tilt System</th>
<th>Phoenix Connection Block</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
<td>→</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
<td>→</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td>→</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>→</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
</tr>
</tbody>
</table>

**Panasonic AW-PH500p Pan/Tilt Head**

The Synergy control panel connects to the Panasonic AW-PH500p Pan/Tilt Head via the remote ports on the Synergy control panel, and the Remote port on the rear of the Panasonic Control Panel Main Unit.

Cable connections in the following table refer only to those between the Synergy control panel and the Panasonic Control Panel Main Unit. Other cable connections present on the Panasonic Pan/Tilt Head can be found in the Panasonic documentation.
The Synergy control panel connects to the Parkervision CameraMan 3e 3-CCD robotic camera via the remote ports on the Synergy control panel, and the RS-232 port on the rear of the Parkervision Mini Docking Station.

Cable connections in the following table refer only to those between the Synergy control panel and the Parkervision Mini Docking Station. Other cable connections present on the Parkervision CameraMan can be found in the Parkervision documentation.

**Parkervision CameraMan 3e 3-CCD Robotic Camera**

**Synergy-to-Panasonic Wiring Chart**

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>Panasonic Control Panel Main Unit</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
<td>2</td>
<td>Rx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
<td>3</td>
<td>Tx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
<td></td>
<td>n/c</td>
</tr>
</tbody>
</table>

**Synergy-to-Parkervision Wiring Chart**

<table>
<thead>
<tr>
<th>Remote Port</th>
<th>Signal</th>
<th>Parkervision Mini Docking Station</th>
<th>RS-232 Port</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
<td>2</td>
<td>Rx</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
<td>3</td>
<td>Tx</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>5</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>n/c</td>
<td></td>
<td>n/c</td>
<td></td>
</tr>
</tbody>
</table>
**Shotoku TR-8S Control System**

The Synergy control panel connects to the Shotoku TR-8S Control System via the remote ports on the Synergy control panel, and the RS422 port located below the CMC/HEAD port on the rear of the Shotoku PDU.

Cable connections in the following table refer only to those between the Synergy control panel and the Shotoku TR-8S PDU. Other cable connections present on the Shotoku TR-8S or PDU can be found in the Shotoku documentation.

### Synergy-to-Shotoku TR-8S Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Shotoku PDU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

**AMX AXB-PT PosiTrack Camera Controller**

The Synergy control panel connects to the AMX AXB-PT PosiTrack Camera Controller via the remote ports on the Synergy control panel, and the AXlink port on the AMX PosiTrack PT-10, PT-15, or PT-30 Unit.

Cable connections in the following table refer only to those between the Synergy control panel and the AMX PosiTrack PT-10, PT-15, or PT-30 Unit. Other cable connections present on the AMX AXB-PT PosiTrack Camera Controller can be found in the AMX documentation.

### Synergy-to-AMX AXB-PT PosiTrack Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>AMX AXB-PT PosiTrack</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>
Communications Setup

This section provides instructions for setting up the Robotic Camera to communicate with the Synergy switcher.

The following topics are discussed in this section:

- Setting up the Switcher
- Setting up the Robotic Camera

Setting up the Switcher

In order to have the Synergy switcher communicate with a Robotic Camera, the remote port on the control panel that the Robotic Camera is connected to must be set up to communicate with the particular Robotic Camera you have connected.

Use the following procedure to configure a Remote port on the control panel to connect with a Robotic Camera:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.
2. Press Type to display the Type Menu.

   ![Type Menu]

   Communications — Type Menu

3. Assign a com port to the Robotic Camera as follows:
   - Use the Com Port knob to select the remote port on the Synergy switcher that is connected to the Robotic Camera.
   - Use the Device knob to select Robotic Cam.
4. Press Select Device to select the Select Device Menu.

   ![Select Device Menu]

   Communications — Select Device Menu
5. Select the device you want to assign to the Robotic Camera communications port as follows:

- Use the **Com Port** knob to select the communications port you want to assign a specific Robotic Camera to.
- Use the **Device** knob to select the type of Robotic Camera that is connected to the port. You can select between the following:

  - **NONE** — Use this option to not assign a Robotic Camera to the selected port.
  - **Telemetrics** — Use this option to assign a Telemetrics PT-CP-S2, PT-HP-S2 or PT-LP-S2 Robotic Camera Controller to the selected com port. Refer to the section “Telemetrics Robotic Camera Controller” on page 19–17 for details.
  - **Radamec** — Use this option to assign a Radamec HK185 or HK431 Robotic Camera Controller to the selected com port. Refer to the section “Radamec Robotic Camera Controller” on page 19–18 for details.
  - **Canon** — Use this option to assign a Canon NU-700N Robotic Camera to the selected com port. Refer to the section “Canon NU-700N Robotic Camera” on page 19–18 for details.
  - **Sony** — Use this option to assign a Sony BRC-300/300P Robotic Camera to the selected com port. Refer to the section “Sony BRC-300/300P Robotic Camera” on page 19–18 for details.
  - **Eagle** — Use this option to assign an Eagle PT-101 Pan Tilt System to the selected com port. Refer to the section “Eagle Pan Tilt System Robotic Camera Controller” on page 19–19 for details.
  - **Panasonic** — Use this option to assign a Panasonic AW-PH500p Pan/Tilt Head to the selected com port. Refer to the section “Panasonic AW-PH500p Pan/Tilt Head” on page 19–20 for details.
  - **CameraMan** — Use this option to assign a Parkervision CameraMan 3e 3-CCD Robotic Camera to the selected com port. Refer to the section “Parkervision CameraMan 3e 3-CCD Robotic Camera” on page 19–20 for details.
  - **Shotoku** — Use this option to assign a Shotoku TR-8S Control System to the selected com port. Refer to the section “Shotoku TR-8S Control System” on page 19–10 for details.
  - **PosiTrack** — Use this option to assign an AMX AXB-PT PosiTrack Camera Controller to the selected com port. Refer to the section “AMX AXB-PT PosiTrack Camera Controller” on page 19–18 for details.

6. Press **Com Settings** to display the **Com Settings Menu**.
Communications — Com Settings Menu

7. Set the communications protocols for the Robotic Camera as follows:
   - Use the **Com Port** knob to select the Robotic Camera you are setting the communications settings for.
   - Use the **Baud** knob to select the baud rate for the Robotic Camera. Refer to the section “Setting up the Robotic Camera” on page 19–17 for the specific settings for your Robotic Camera.
   - Use the **Parity** knob to select the parity for the specific Robotic Camera. Refer to the section “Setting up the Robotic Camera” on page 19–17 for the specific settings for your Robotic Camera.

8. Press **Com Type** to display the **Com Type Menu**.

Communications — Com Type Menu

9. Select the type of serial communication that will be used to communicate with the Robotic Camera as follows:
   - Use the **Com Port** knob to select the Robotic Camera you want to set the communication type for.
   - Use the **Type** knob to select the type of serial communications for the selected port. Refer to the section “Setting up the Robotic Camera” on page 19–17 for the specific settings for your Robotic Camera.

**Note**

If you are connecting to a Telemetrics STS-12 Serial Control or a Transfer Switch, you must select the serial communication type of the Telemetrics port the Synergy switcher is connected to.
10. Press Extra Options to display the Extra Options Menu.

**Note**
The Radamec, Telemetrics and Eagle, Robotic Cameras have Extra Options that may need to be set, depending on the configuration you have. If you are not setting up one of these Robotic Cameras, proceed to step 11.

- **Radamec Robotic Camera Controller** — Refer to the section “Radamec Robotic Camera Controller Extra Options” on page 19–14 for information.
- **Telemetrics Robotic Camera Controller** — Refer to the section “Telemetrics Extra Options” on page 19–15 for information.
- **Eagle PT-101 Pan Tilt System Robotic Camera Controller** — Refer to the section “Eagle Extra Options” on page 19–16 for information.

11. Press HOME to display the Installation Change Confirmation Screen.

12. Accept or reject the changes you have made as follows:
  - Press Confirm to accept the changes.
  - Press Cancel to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for setting up the communications with the Robotic Camera, next you will have finish setting up the Robotic Camera to communicate with the Synergy switcher, and then set up the BNC inputs that you have connected to the Robotic Camera. Refer to the section “Setting up the Robotic Camera” on page 19–17 for information on how to set up the Robotic Camera you are connecting to the Synergy switcher.

**Extra Options Setup**

The Extra Options Menu for a Robotic Camera allows you to complete the communications setup for the Synergy switcher. These extra options allow you to set up multiple Robotic Cameras on the same Remote Port, the amount of time the Synergy switcher allows for a Robotic Camera to recall a shot, and the type of lens you have installed on the Robotic Camera Head.

**Radamec Robotic Camera Controller Extra Options**

The Extra Options Menu for the Radamec Robotic Camera Controller allows you to:
  - specify a unique Panel ID for the Synergy switcher
  - specify how the Synergy switcher polls the Radamec Robotic Camera Controllers.

Use the following procedure to set up the Extra Options for a Radamec Robotic Camera Controller:

1. Assign a Panel ID to the Synergy switcher as follows:
• Use the **Com Port** knob to select the remote port that the Radamec Robotic Camera Controller is connected to.

• Use the **Option** knob to select **Panel ID**.

• Use the **Value** knob to assign a unique Panel ID to the Synergy switcher. This Panel ID is used by the Radamec Robotic Camera Controllers to identify the switcher.

2. Configure how the Synergy switcher polls the Radamec Robotic Camera Controllers as follows:

• Use the **Com Port** knob to select the remote port that the Radamec Robotic Camera Controller is connected to.

• Use the **Option** knob to select **Poll**.

• Use the **Value** knob to select a poll method. You can select between the following:

  ~ **Selected** — Use this option to have the Synergy switcher poll only the camera selected on the Synergy control panel.

  ~ **All** — Use this option to enable the Synergy switcher to poll all cameras connected to the Synergy switcher.

This completes the procedure to set up the Extra Options for the Radamec Robotic Camera Controller.

**Telemetrics Extra Options**

The **Extra Options Menu** for the Telemetrics Robotic Camera Controller allows you to:

• specify the amount of time the Synergy switcher should wait before sending commands to the Robotic Camera after a Recall shot command

• specify that you are connecting to multiple cameras via a **Telemetrics STS-12 Serial Control Transfer Switch**, or a **Telemetrics CP-RMR-S Serial Receiver**

• specify an Offset value for displaying the Shot Box number on the Synergy switcher. For example, with the Offset value set to 1, Shot 2 on the Telemeters Shot Box displays as Shot 2 on the Synergy menu system

Use the following procedure to set up the Extra Options for a Telemetrics Robotic Camera Controller:

1. Assign a serial control switch to the Telemetrics Robotic Camera as follows:

   ![Communications Extra Options — Telemetrics (Serial Switch) Menu](image)

   • Use the **Com Port** knob to select the remote port that the serial switch is connected to.

   • Use the **Option** knob to select **SerialSwitch**.

   • Use the **Value** knob to select the type of serial switch that you are using. You can select between the following:

     ~ **None** — Use this option to not assign a serial switch to the selected port.
2. Set the amount of time that the switcher allows for the Robotic Camera to recall a shot as follows:

- **STS-12** — Use this option to assign an STS-12 Serial Control Transfer Switch to the selected port.
- **CP-RMR-S** — Use this option to assign a CP-RMR-S Serial Receiver to the selected port.

### Communications Extra Options — Telemetrics (RclTime) Menu

- Use the **Com Port** knob to select the Robotic Camera that you want to set the Recall Time for.
- Use the **Option** knob to select **RclTime**.
- Use the **Value** knob to select the amount of time, in seconds, you want the Synergy switcher to wait after sending a recall shot command.

3. Enable the ShotOffset feature as follows:

- Use the **Com Port** knob to select the Robotic Camera that you want to enable the ShotOffset feature for.
- Use the **Option** knob to select **ShotOffset**.
- Use the **Value** knob to select the offset value for the Synergy control panel. You can select between the following:
  - **0** — Select this option to disable the feature. The Telemetrics Shot Box number will not match the Synergy menu system. For example, Shot 2 on the Telemetrics Shot Box is now displayed as Shot 1 on the Synergy menu system. This is the default setting.
  - **1** — Select this option to offset the Shot number by 1 on the Synergy control panel. The Synergy menu system matches the Telemetrics Shot Box number.

This completes the procedure to set up the Extra Options for the Telemetrics Robotic Camera Controller.

### Eagle Extra Options

The **Extra Options Menu** for the Eagle PT-101 Pan Tilt System Robotic Camera allows you to specify that you are using a Rainbow-CCTV lens or a Fujinon/Canon telecon lens.

Use the following procedure to set up the Extra Options for an Eagle PT-101 Pan Tilt Robotic Camera Controller:
1. Assign a lens type to your Eagle Pan Tilt System as follows:
   - Use the **Com Port** knob to select the remote port that the Eagle Pan Tilt System is connected to.
   - Use the **Option** knob to select **Lens Type**.
   - Use the **Value** knob to select the type of lens that you are using. You can select between the following:
     - **Rainbow** — Use this option if you are using a Rainbow-CCTV lens.
     - **Fujinon** — Use this option if you are using a Fujinon/Canon telecon lens.

   This completes the procedure to assign a lens type to your Eagle Pan Tilt System.

### Setting up the Robotic Camera

In order to have the Synergy switcher communicate with a Robotic Camera, the Robotic Camera you are connecting to the switcher must be set up to communicate and accept commands from the switcher.

**Telemetrics Robotic Camera Controller**

Use the following communications settings when connecting a Telemetrics Robotic Camera Controller to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>
Telemetrics STS-12 Serial Control Transfer Switch

Use the following communications settings when connecting a Telemetrics STS-12 Serial Control Transfer Switch to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

Radamec Robotic Camera Controller

Use the following communications settings when connecting a Radamec Robotic Camera Controller to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>ODD</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

Canon NU-700N Robotic Camera

Use the following communications settings when connecting a Canon Robotic Camera to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

Sony BRC-300/300P Robotic Camera

The Synergy switcher can control up to 8 Sony Robotic Camera. The address for each camera is set through the jumpers on its bottom panel. Refer to the Sony documentation for more information on setting the address for your particular Robotic Camera. Use the following information to configure and connect a single Sony Robotic Camera to your Synergy switcher.
• Use the following communications settings when connecting a Sony Robotic Camera to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

• Use the following information to set the jumpers located on the bottom of the Sony Robotic Camera:

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>No connection</td>
</tr>
<tr>
<td>2</td>
<td>Set to <strong>ON</strong> for RS-422 comm.</td>
</tr>
<tr>
<td>3</td>
<td>Set to <strong>OFF</strong> for 9600 baud rate</td>
</tr>
<tr>
<td>4</td>
<td>Infra-red signal control (<strong>OFF</strong> disables the control)</td>
</tr>
<tr>
<td>5</td>
<td>Used for camera address</td>
</tr>
<tr>
<td>6</td>
<td>Used for camera address</td>
</tr>
<tr>
<td>7</td>
<td>Used for camera address</td>
</tr>
<tr>
<td>8</td>
<td>No connection</td>
</tr>
</tbody>
</table>

Refer to the Sony documentation for instructions on how to connect additional cameras.

**Eagle Pan Tilt System Robotic Camera Controller**

Use the following communications settings when connecting an Eagle Pan Tilt System to a Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>
Panasonic AW-PH500p Pan/Tilt Head

Use the following information to configure and connect a Panasonic AW-PH500p Pan/Tilt Head to your Synergy switcher:

### Synergy-to-Panasonic Communication Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

Parkervision CameraMan 3e 3-CCD Robotic Camera

The Base Address for each Parkervision CameraMan 3e 3-CCD camera is set through the Base Unit Address rotary switch on the Parkervision Configuration Panel. Refer to the Parkervision documentation for more information on configuring the switches on your device. Use the following information to configure and connect a Parkervision CameraMan 3e 3-CCD camera to your Synergy switcher:

- Use the following communication settings to configure and connect a Parkervision CameraMan 3e 3-CCD Robotic Camera to your Synergy switcher:

### Synergy-to-Parkervision Communication Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>19200</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

- Ensure that DIP switch 1 on Switch Bank B is set to the DOWN position (Basic Protocol) on the Parkervision CameraMan Configuration Panel.
- Ensure that DIP switch 7 on Switch Bank A is set to the UP position (Baud Rate of 19200) on the Parkervision CameraMan Configuration Panel.

Shotoku TR-8S Control System

Use the following information to configure and connect a Shotoku TR-8S Control System to your Synergy switcher:
• Use the following communication settings to configure and connect a Shotoku TR-8S Control System to your Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>ODD</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

• The Shotoku TR-8S predefines the ID Number of each camera connected to it.

**AMX AXB-PT PosiTrack Camera Controller**

Use the following information to configure and connect an AMX AXB-PT PosiTrack Camera Controller to your Synergy switcher:

• Use the following communications settings when connecting an AMX AXB-PT PosiTrack Camera Controller to a Synergy Switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>9600</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>
Setting up Robotic Camera BNCs

The Robotic Camera Setup Menu allows you to associate a Robotic Camera BNC input with a particular Robotic Camera communication port. In addition, you can select which one of the outputs of the Robotic Camera is feeding the input BNC on the Synergy SD frame.

**Important** You must have a Robotic Camera set up on the Synergy switcher before you can assign a BNC to that device. Refer to the section “Setting up the Switcher” on page 19–11 for more information on setting up Robotic Camera communications.

Use the following procedure to assign the Robotic Camera to a specific BNC input:

1. Navigate to the BNC Menu 1-3 as follows:
   - Press HOME ➔ MORE ➔ Setup ➔ Installation ➔ BNC.
2. Press BNC Type to display the BNC Type Menu.

   ![BNC Type Menu]

3. Assign a BNC to a Robotic Camera as follows:
   - Use the BNC knob to select the BNC that the Robotic Camera is connected to.
   - Use the Type knob to select Robotic Cam.
   - Use the Asp Ratio knob to select the video aspect ratio of the Robotic Camera output.
4. Press MORE to display the BNC Menu 2-3.
5. Press Camera Setup to display the Camera Setup Menu.

   ![BNC — Camera Setup Menu]

6. Assign a specific ganged Robotic Camera to the BNC as follows:
   - Use the BNC knob to select the BNC you want to assign the specific Robotic Camera to.
• Use the **Controller** knob to select the remote port that connects to the specific Robotic Camera you assigned to the BNC.

• Use the **Camera** knob to select the peripheral Robotic Camera that is controlled by the Synergy switcher.
  ~ For the **Radamec** Robotic Camera Controllers, the camera address is set by one of the internal DIP switches on the Radamec head unit.
  ~ For the **Telemetrics, Eagle, and Panasonic, and AMX** Robotic Camera Controllers, use the bottom **Port** knob to set the port that the specific camera is assigned to. This is the port that you set the camera to when you set up your camera hardware.
  ~ For the **Telemetrics STS-12 Serial Control Transfer Switch**, select the Controller (DTE) Port on the STS-12 that the PT Head is connected to.
  ~ For the **Parkervision CameraMan 3e 3-CCD**, select the Base Unit Address of the camera. Note that Positions O to F on the Parkervision Configuration Plate corresponds to Cameras 1 to 16, respectively, on the Synergy menu.

7. Press **HOME** to display the **Installation Change Confirmation Screen**.

8. Accept or reject the changes you have made as follows:

   • Press **Confirm** to accept the changes.
   • Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for assigning a Robotic Camera to a BNC on the Synergy switcher.
Robotic Camera Custom Controls

You can program custom control macros to recall Robotic Camera controllers from the Synergy switcher and specific shots on any Robotic Camera.

Note

You must have the Robotic Camera System Interface option installed in order to control a Robotic Camera to the Synergy switcher. Refer to the section “Setting up the Switcher” on page 19–11 for information on setting up a Robotic Camera.

The following custom controls are discussed in this section:

- Recall Camera
- Recall a Shot

Once your custom control buttons have been programmed, be sure to properly name them. Refer to the section “Naming Custom Controls” on page 8–42 for more information on naming custom control buttons.

Recall Camera

Use the Recall Camera feature to recall Robotic Camera controllers on a specific remote port. If you recall a shot using this type of custom control macro, you first select the camera crosspoint on the Synergy switcher, then play the Recall Camera custom control macro. This enables you to choose any camera on the fly and recall the specified shot as required.

Operating Tip

You can also program a custom control button to recall the crosspoint for your Robotic Camera controller. Refer to the section “Programming Control Panel Functions” on page 8–13 for more information.

Use the following procedure to recall a camera with a custom control button:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the
control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

**Operating Tip**

As a recommendation, keep custom control functions for similar devices grouped together on your physical custom control buttons.

3. Navigate to the Insert Robotic Camera Control Menu as follows:
   - Press **Start Recording** ➔ **Insert Special** ➔ **MORE** ➔ **Robotic Camera**.

   ![Insert Robotic Camera Control Menu]

   **Insert Special — Insert Robotic Camera Control**

4. Assign a shot to be recalled on a camera as follows:
   - Use the **Camera** knob to select the remote port for the camera that you want to recall the shot on.
   - Use the **Selection** knob to select **Recall Camera**.
   - Use the **Shot #** knob to select the number of the shot that you want to recall.

   ![Camera knob and Selection knob]

   **Note** If the Telemetrics **ShotOffset** feature is set to **0** on the Synergy **Extra Options Menu**, the shot number displayed on the Synergy **Recall Shot Menu** will not match the Shot Box number on the Telemeterics camera. Refer to the section “**Extra Options Setup**” on page 19–14 for information on setting this menu option.

5. Press **Insert** to enter the recalled camera into your custom control macro.

6. Press **UP ONE** to return to the Custom Controls Recording Menu.

7. Press **Finish Recording** or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure to recall a camera with a custom control button.

**Note** To edit a button with a **Recall Camera** macro, you must delete the incorrect macro and re-program the custom control button.
Recall a Shot

Use the Recall Shot feature to recall a shot that is stored on the specific Robotic Camera controller. When programming this custom control, you are recalling a specific camera on a remote port by selecting its BNC.

For example, you want to recall camera 4 on Remote Port 1. To do so, you program a Recall Shot custom control macro to recall the specified shot with camera 4 on BNC 4. When played, the custom control will always recall camera 4 on BNC 4 connected to Remote Port 1.

Use the following procedure to recall a camera shot with a custom control button:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

3. Navigate to the Insert Robotic Camera Control Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ MORE ⇒ Robotic Camera.
4. Assign a shot to be recalled on the specified camera as follows:
   - Use the **Camera** knob to select the camera that you want to recall the shot on. Note that each camera is listed with its remote port and its corresponding BNC.
   - Use the **Selection** knob to select **Recall Shot**.
   - Use the **Shot #** knob to select the number of the shot that you want to recall.

5. Press **Insert** to enter the shot recall into your custom control macro.

6. Press **UP ONE** to return to the **Custom Controls Recording Menu**.

7. Press **Finish Recording** or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure to recall a camera shot with a custom control button.

**Note** You cannot edit a **Recall Shot** macro. Instead, you must delete and re-program the macro to the selected custom control button.
Monitor Walls

In This Chapter

This chapter provides instructions for connecting, and setting up a Monitor Wall with your Synergy switcher. Before you begin, ensure that the Monitor Wall Interface option is installed. If not, contact Ross Video for details. Refer to the section “Installed Options Menus” on page 2–37 for instructions on verifying the status of installed options.

The following topics are discussed:

• Supported Monitor Walls
• Communications Connections
• Communications Setup
• Monitor Wall Under Monitor Display
• Monitor Wall Custom Controls
Supported Monitor Walls

The Synergy switcher has been tested with a number of Monitor Walls to ensure the highest standard for compatibility and reliability. The following Monitor Walls are currently supported by your Synergy switcher:

- Miranda Kaleido-K2
- Miranda Kaleido-X
Communications Connections

You can connect a number of Monitor Walls to your Synergy switcher. The procedure for connecting the Monitor Wall depends on the type of Monitor Wall you have. This section provides general instructions for connecting up to five Monitor Walls to one of the Remote Ports on the back of the Synergy control panel.

Note

These instructions are provided as a guide. For specific information on the Monitor Wall you are connecting to the Synergy switcher, refer to the documentation provided with the Monitor Wall.

In order to properly complete this procedure you need the following software options, cables, and equipment:

- **Monitor Wall Interface** — This is the software option from Ross Video that allows your Synergy switcher to control a Monitor Wall.

- **Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the remote port on the control panel, and a connector on the other end to connect to your Monitor Wall. Refer to the section “Monitor Wall Interface Cable Pinouts” on page 20–4 for information on the pin-outs and connector required for your Monitor Wall. Ross Video does not supply this cable.

Use the following procedure to connect a Monitor Wall to your Synergy switcher:

1. Connect and secure the 9-Pin, Male, end of the Interface Cable to one of the Remote Ports on the back of the Synergy control panel.

2. Connect and secure the other end of the cable to the appropriate port on the Monitor Wall. The suggested port for each supported Monitor Wall is listed below:

   - **Miranda Kaleido-K2 Monitor Wall** — Connect the Interface cable from the Synergy control panel to a COM port (1 or 2) on the computer with the Dispatcher™ software installed. Refer to the section “Miranda Cabling” on page 20–4 for more information on the cabling for this Monitor Wall.

   - **Miranda Kaleido-X Monitor Wall** — Connect the Interface cable from the Synergy control panel to a COM port (1 or 2) on the computer with the Dispatcher™ software installed. Refer to the section “Miranda Cabling” on page 20–4 for more information on the cabling for this Monitor Wall.

This completes the procedure for connecting a Monitor Wall to the Synergy switcher. Refer to the section “Communications Setup” on page 20–5 for instructions on how to set up communications protocols on the switcher, as well as on the Monitor Wall.
Monitor Wall Interface Cable Pinouts

Use the information in this section to connect the Interface Cable from the Synergy switcher to the Monitor Wall.

Miranda Cabling

The Synergy control panel connects to the computer with the Dispatcher software via the remote ports on the Synergy control panel, and the COM ports (1 or 2) on the computer with the Dispatcher software installed.

Cable connections in the following table refer only to those between the Synergy control panel and the computer with the Dispatcher software. Other cable connections present on the Miranda Monitor Wall, or the computer with the Dispatcher software, can be found in the Miranda documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Computer with Dispatcher</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>n/c</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

The Miranda Kaleido Port Number must be set to **13000** in the Synergy Communications Menu. Refer to the section “Communications Setup” on page 20–5 for the procedure to setup communications for a Monitor Wall.
Communications Setup

This section provides instructions for setting up the Monitor Wall to communicate with the Synergy switcher.

The following topics are discussed in this section:

- Setting up the Switcher
- Setting up the Monitor Wall

Setting up the Switcher

In order to have the Synergy switcher communicate with a Monitor Wall, the remote port on the control panel that the Monitor Wall is connected to must be set up to communicate with the particular Monitor Wall you have connected.

Use the following procedure to configure a Remote port on the control panel to connect with a Monitor Wall:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME  MORE  Setup  Installation  Communications.
   - Press HOME (to display the Main Menu 1-2).
   - MORE (to display the Main Menu 2-2).
   - Setup (to display the Setup Menu).
   - Installation (to display the Installation Menu 1-2).
   - Communications (to display the Communications Menu 1-2).

2. Press Type to display the Type Menu.

3. Assign a com port to the Monitor Wall as follows:
   - Use the Com Port knob to select the remote port on the Synergy switcher that is connected to the Monitor Wall.
   - Use the Device knob to select Monitor Wall.

4. Press Select Device to display the Select Device Menu.
5. Assign a specific Monitor Wall to the Remote Com Port as follows:
   - Use the **Com Port** knob to select the Remote Com Port that the desired Monitor Wall is connected to.
   - Use the **Device** knob to select the type of Monitor Wall that is connected to the port. You can select between the following:
     - **NONE** — Use this option to not assign a Monitor Wall to the selected com port.
     - **Kaleido** — Use this option to assign a **Miranda Kaleido-K2 Monitor Wall** or a **Miranda Kaleido-X Monitor Wall** to the selected com port. Refer to the section “**Miranda Kaleido-K2 Monitor Wall**” on page 20–9 for interface specifics.

6. Press **Com Settings** to display the **Com Settings Menu**.

7. Set the communications protocols for the Monitor Wall as follows:
   - Use the **Com Port** knob to select the Monitor Wall port you are setting the communications settings for.
   - Use the **Baud** knob to select the baud rate for the Monitor Wall.
   - Use the **Parity** knob to select the parity for the Monitor Wall.
8. Press **Com Type** to display the **Com Type Menu**.

   ![Com Type Menu](image)

9. Select the type of serial communications that will be used to communicate with the Monitor Wall as follows:
   - Use the **Com Port** knob to select the Monitor Wall you want to set the communications type for.
   - Use the **Type** knob to select the type of serial communications for the selected port.

10. Press **MORE** to display the **Communications Menu 2-2**.

11. Press **Mon Wall Setting** to display the **Mon Wall Setting Menu**.

   ![Mon Wall Setting Menu](image)

12. Assign the **IP Address** as follows:

   **Note**
   
   For the Miranda Monitor Walls, you must enter the **IP Address** of the Monitor Wall. Ensure that the Miranda Monitor Wall is connected to the same network as the computer with the Dispatcher software.

   - Use the **Device** knob to select the com port the Dispatcher Computer is connected to.
   - Use the **Monitor Wall** knob to select the specific Monitor Wall connected to the Dispatcher Computer that you want to control.
   - Use the bottom knob to select **IP Address**.
   - Enter the IP Address of the specific Monitor Wall you want to control from the selected Com Port. You can use the keypad in the Global Memory System or a PS/2 keyboard, to enter the IP Address.

   **Important**
   
   Do NOT place anything on your keyboard, or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably.
13. Assign the Port Number of the Monitor Wall connected to the Synergy switcher as follows:
   - Use the **Device** knob to select the com port the Dispatcher Computer is connected to.
   - Use the **Monitor Wall** knob to select the specific Monitor Wall connected to the Dispatcher Computer that you want to control.
   - Use the bottom knob to select **Port Number**.

   **Note**
   The **Port Number** is set to **13000** by default. Refer to the documentation for your specific Monitor Wall to determine the correct Port Number for your device.

   - Enter the Port Number of the specific Monitor Wall you want to control from the selected Com Port. You can enter the Port Number using the keypad in the Global Memory System, or a PS/2 keyboard.

   **Important**
   Do NOT place anything on your keyboard, or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably.

14. Press **HOME** to display the **Installation Change Confirmation Screen**.

15. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure to configure a Monitor Wall communication port for a Monitor Wall. Next you must set up the Monitor Wall to communicate with the Synergy switcher.

**Setting up the Monitor Wall**

In order to have the Synergy switcher communicate with a Monitor Wall, the Monitor Wall you are connecting to the switcher must be set up to communicate and accept commands from the switcher.
**Miranda Kaleido-K2 Monitor Wall**

Use the following information to configure and connect a Miranda Kaleido-K2 Monitor Wall to your Synergy switcher:

| Important | You must have a computer with the Dispatcher™ software properly installed in order for the Synergy switcher to communicate with the Miranda Kaleido-K2 Monitor Wall. The Dispatcher software is the gateway program that enables the serial-TCP/IP communication between the Synergy switcher and the Miranda Kaleido-K2. Refer to your Miranda documentation for more information. |

The Miranda Kaleido-K2 Monitor Wall and the computer with Dispatcher software must be connected to the same network. Refer to your Miranda documentation for more information on connecting your devices to a network.

Use the following communications settings when connecting the computer with Dispatcher software to the Synergy switcher. Ensure that the communication settings in the **SerialPort.properties** file in the Dispatcher software match those you set on the Synergy switcher.

<table>
<thead>
<tr>
<th>Synergy-to-Kaleido-K2 Communication Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Setting</strong></td>
</tr>
<tr>
<td>Transmission Standard</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Parity</td>
</tr>
<tr>
<td>Data Bits</td>
</tr>
<tr>
<td>Stop Bits</td>
</tr>
</tbody>
</table>

Use the following procedure to connect the Miranda Kaleido-K2 Monitor Wall to the Synergy switcher:

1. Ensure that the Dispatcher software is properly installed on your computer. The computer must be connected to your network.
2. Ensure the serial port parameters in the Dispatcher **SerialPort.properties** file match those of the Synergy switcher.
3. Ensure the Kaleido-K2 Layouts accept text modified using the Synergy switcher as follows:
   - Each text label you wish to modify for a Kaleido-K2 **Layout** must be set to **Dynamic** on the Kaleido-K2.
   - Each text label you wish to modify for a Kaleido-K2 **Layout** must also have its controlling source set as **Gateway** in order to accept the modified text from the Synergy switcher. Refer to the Miranda documentation for more information.
   - Set the **Text Label Address** on the Kaleido-K2 and make a note of it. This address will be required when programming Synergy switcher custom controls macros to modify text.
   - For information on changing text using the Synergy switcher, refer to the section “Modifying Dynamic Monitor Wall Text” on page 20–19.

This completes the procedure to connect the Miranda Kaleido-K2 Monitor Wall to the Synergy switcher.
Miranda Kaleido-X Monitor Wall

This section describes the proper installation configuration required for the Synergy switcher to interface with a Miranda Kaleido-X.

Use the following information to configure the Miranda Kaleido-X to communicate with the Synergy switcher:

- To send a command to Load a Layout into a Miranda Kaleido-X, ensure that the argument in the Ross command includes the Room name. Room names are displayed in the Layouts section of the Miranda XEdit window. For example, MCR/Layout3.kg2 where MCR represents the Room name, Layout3 represents the Layout name, and .kg2 is the file extension.

- Refer to the Miranda documentation for more information on configuring layouts and sending commands on your Miranda Kaleido-X.

Use the following communications settings when connecting the computer with Dispatcher software to the Synergy switcher. Ensure that the communication settings in the SerialPort.properties file in the Dispatcher software match those you set on the Synergy switcher.

### Synergy-to-Kaleido-X Communication Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-232</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>38400</td>
</tr>
<tr>
<td>Parity</td>
<td>NONE</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

### Configuring the Miranda Kaleido-X to Receive Load Layout Commands

On the computer with the Dispatcher software for the Miranda Kaleido-X, you must set up the communications parameters to allow it to properly connect to the Synergy switcher. The Miranda Kaleido-X is set up in the same way as the Miranda Kaleido-X.

Use the following procedure to configure the Miranda Kaleido-X to receive Load Layout commands from the Synergy switcher:

1. From the Miranda XEdit window, select the Systems tab.
2. Drag the Serial to TCP/IP Dispatcher icon from the Equipment List to the System List located in the System-Description tab. This creates a new icon that represents the connection between the Kaleido-X and the Synergy switcher.
3. When prompted, enter a name for the new icon. For example, Load Layout from Ross.
4. From the System area, select the Interconnects tab.
5. Drag a connection from the Kaleido-X icon to the Load Layout from Ross icon.
6. Configure the communication settings for the Kaleido-X com port connected to the Synergy switcher as follows:
   - Click the edit link located between the Kaleido-X icon and the Load Layout from Ross icon.
   - Select the com port on the Kaleido-X that is connected to the Synergy switcher.
• Click the **Load Layout from Ross** icon.
• In the **Properties** tag of the selected com port, set up the communications settings.
• Ensure the settings on the Kaleido-X match those of the Synergy switcher.

7. Ensure the physical cabling between the Kaleido-X and the Synergy switcher is correct.

This completes the procedure for configuring the Miranda Kaleido-X to receive Load Layout commands from the Synergy switcher.
Monitor Wall Under Monitor Display

The Monitor Wall Under Monitor Display (UMD) allows the Synergy switcher to send source names to the Monitor Wall via a serial tally interface.

Note

The Kaleido software must be version 5.30 or higher to support the serial tally interface. All version of the Kalypso service are supported.

In order to properly connect the Monitor Wall UMD to the switcher, you will need the following:

- **UMD Interface Cable** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end, to connect to the Serial Communications port on the Synergy switcher, and a connector on the other end to connect to your Monitor Wall. Refer to the section “Communications Connections” on page 20–3 for information on the pinouts and connector required for your Monitor Wall. Ross Video does not supply this cable.

- **Serial Tally Interface** — Ensure that the Serial Tally software option is installed. If not, contact Ross Video for details. Refer to the section “Installed Options” for instructions on verifying the status of installed options.

Monitor Wall UMD Interface Cable Pinouts

Use the information in this section to connect the UMD Interface Cable from the Synergy switcher to the Monitor Wall.

Miranda Kaleido Cabling

The Synergy switcher connects to the Miranda Kaleido-K2, and Kaleido-X, via the serial communications ports on the Synergy switcher, and the COM 1 or COM 2 port on the Kaleido.

Note

The Miranda Kaleido-K2 and Kaleido-X support both RS-422 or RS-232 communication depending on the COM port connected to your Synergy switcher. Ross Video recommends that you use the RS-232 connection on the COM 1 port to connect to your switcher.

RS-232 Cabling

Cable connections in the following table refer only to those between the Synergy switcher and the COM 1 port on the Miranda Kaleido. Other cable connections present on the Miranda Kaleido can be found in the Kaleido documentation.
RS-422 Cabling

Cable connections in the following table refer only to those between the Synergy switcher and the COM 2 port on the Kaleido. Other cable connections present on the Miranda Kaleido can be found in the Kaleido documentation.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Computer with Dispatcher</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>n/c</td>
</tr>
<tr>
<td>8</td>
<td>n/c</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

Synergy-to- Kaleido RS-422 Wiring Chart

Monitor Wall UMD Communications Setup

Use the following procedure to configure a Synergy switcher communications port to send UMD information to a Monitor Wall:

1. Navigate to the Communications Menus as follows:
   • Press HOME ⇒ More ⇒ Setup ⇒ Installation ⇒ Communications.
2. Press Type to display the Device Type Menu.
3. Assign a communications port to the Monitor Wall as follows:
   - Use the **Com Port** knob to select the communications port on the Synergy switcher that is connected, or assigned, to the Monitor Wall.
   - Use the **Device** knob to select **Serial Tally**.
4. Press **Select Device** to display the **Device Selection Menu**.

5. Use the **Device** knob to select **Contrib**.
6. Press **Com Type** to display the **Com Type Menu**.

7. Use the **Type** knob to select type of serial communications that is used to communicate with the Monitor Wall. You can choose between the following:
   - **RS-232** — Select this option if you are connecting to the COM 1 port on the Kaleido.
   - **RS-422** — Select this option if you are connecting to the COM 2 port on the Kaleido.
8. Press **Com Settings** to display the **Com Settings Menu**.
9. Set the communications protocols for the Monitor Wall as follows:
   • Use the **Baud** knob to select **38400**.
   • Use the **Parity** knob to select **NONE**.

10. Press **Extra Options** to display the **Extra Options Menu**.

11. Set the data rate for the Monitor Wall as follows:
   • Use the **Option** knob to select **Rate**.
   • Use the **Value** knob to select **26**.

12. Set the data transfer for the Monitor Wall as follows:
   • Use the **Option** knob to select **Data Txtr**.
   • Use the **Value** knob to select **Complete**.

13. Set whether the switcher includes the initialization message as follows:
   • Use the **Option** knob to select **Start**.
   • Use the **Value** knob to select **None**.

14. Set how the switcher reports being at black as follows:
   • Use the **Option** knob to select **At Black**.
   • Use the **Value** knob to select **All Off**.

15. Press **HOME** to display the **Installation Change Confirmation Screen**.

16. Accept or reject the changes you have made as follows:
   • Press **Confirm** to accept the changes.
   • Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure for configuring a Synergy switcher communications port to send UMD information to a Monitor Wall.
Monitor Wall Custom Controls

A custom control button can be programmed to load layouts, change input channels and dynamic text on a selected Monitor Wall.

Note

Ensure that the Monitor Wall Interface option is installed and that the monitor wall you want to control is properly connected and configured with the Synergy switcher.

The following custom controls are discussed in this section:

- Loading a Monitor Wall Layout
- Assigning Input Channels
- Modifying Dynamic Monitor Wall Text

Loading a Monitor Wall Layout

A Monitor Wall can have several different layouts created, each with a variety of monitors and inputs. You can create a custom control macro that enables the Synergy switcher to load a particular layout onto a selected Monitor Wall.

Use the following procedure to add a Load Layout macro to a Monitor Wall custom control:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.
   - Press HOME (to display the Main Menu 1-2).
   - Custom Controls (to display the Custom Controls Menu).

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

Operating Tip

As a recommendation, keep special functions grouped together on your physical custom control buttons.
3. Navigate to the **Insert Monitor Wall Control Menu** as follows:
   - Press **Start Recording** ⇒ **Insert Special** ⇒ **MORE** ⇒ **Monitor Wall**.
   - Press **Start Recording** (to display the **Recording Menu**).
   - **Insert Special** (to display the **Insert Special Menu 1-2**).
   - **MORE** (to display the **Insert Special Menu 2-2**).
   - **Monitor Wall** (to display the **Insert Monitor Wall Control Menu**).

4. Select the Monitor Wall you want to apply the **Load Layout** custom control to as follows:
   - Use the **Monitor Wall** knob to select the Monitor Wall.
   - Use the middle knob to select **Load Layout**.

5. Use a standard PS/2 keyboard to enter the Layout Name, including the file extension, in the **Layout** field of the **Insert Monitor Wall Control Menu**. If you do not specify a file extension, the Synergy switcher will automatically include the file extension “.kg2”.

   ![Insert Monitor Wall Control Menu]

6. Press **Insert** to add this macro into the custom control.

7. Press **UP ONE** to return to the **Custom Controls Recording Menu**.

8. Press **Finish Recording** or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This concludes the procedure to add a **Load Layout** macro to a Monitor Wall custom control.

Once your custom control buttons have been programmed, be sure to properly name them. Refer to the section “**Naming Custom Controls**” on page 8–42 for more information on naming custom control buttons. Any recorded custom control can be edited. Refer to the section “**Editing Custom Control Macros**” on page 8–47 for details.

To play back your macro, exit the **Custom Controls Menu** and press the custom control button on the control panel that you recorded the custom control macro to.

---

**Important**

Do NOT place anything on your keyboard, or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably.
Assigning Input Channels

Each monitor in a layout requires an input channel. The Synergy switcher allows you to assign input channels to any monitor by adding an Assign Channel macro to a Monitor Wall custom control.

Use the following procedure to add an Assign Channel macro to a Monitor Wall custom control:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.
   - Press HOME (to display the Main Menu 1-2).
   - Custom Controls (to display the Custom Controls Menu).

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

   Operating Tip
   As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Navigate to the Insert Monitor Wall Control Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ MORE ⇒ Monitor Wall.
   - Press Start Recording (to display the Recording Menu).
   - Insert Special (to display the Insert Special Menu 1-2).
   - MORE (to display the Insert Special Menu 2-2).
   - Monitor Wall (to display the Insert Monitor Wall Control Menu).
4. Select the Monitor Wall you want to apply the Assign Channel custom control to as follows:
   - Use the Monitor Wall knob to select the Monitor Wall.
   - Use the middle knob to select Assign Chan.

5. Select the Monitor you want to assign the input channel to as follows:
   - Use the Monitor Wall knob to select the Monitor Wall.
   - Use the bottom knob to select Mon Number.
   - Use a standard PS/2 keyboard to enter the Monitor Number in the Monitor Number Field of the Insert Monitor Wall Control Menu.

6. Assign the input channel for the selected Monitor as follows:
   - Use the Monitor Wall knob to select the Monitor Wall.
   - Use the bottom knob to select Chan Name.
   - Ensure the Monitor Number is correct.
   - Use a standard PS/2 keyboard to enter the Input Channel Name in the Name Field of the Insert Monitor Wall Control Menu.

7. Press Insert to add this macro into the custom control.

8. Press UP ONE to return to the Custom Controls Recording Menu.

9. Press Finish Recording or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This concludes the procedure to add an Assign Channel macro to a Monitor Wall custom control.

Once your custom control buttons have been programmed, be sure to properly name them. Refer to the section “Naming Custom Controls” on page 8–42 for more information on naming custom control buttons.

To play back your macro, exit the Custom Controls Menu and press the custom control button on the control panel that you recorded the custom control macro to. Any recorded custom control can be edited. Refer to the section “Editing Custom Control Macros” on page 8–47 for details.

**Modifying Dynamic Monitor Wall Text**

There are two types of Monitor Wall Text Labels: Static and Dynamic. The Static Text Label is set during the creation of the Monitor Wall Layout on the device and can only be modified using the editware supplied with your device. The Dynamic Text Label is modified by the Synergy switcher using a custom control macro.

<table>
<thead>
<tr>
<th>Note</th>
<th>Ensure the parameters on your Monitor Wall are configured to accept Dynamic Text set by the Synergy switcher. Refer to your device documentation for more information.</th>
</tr>
</thead>
</table>

**Important**

Do NOT place anything on your keyboard, or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably.

**Note**

On the Miranda Kaleido-K2, this is the number assigned to a particular monitor in the currently loaded Layout. Refer to the Miranda documentation for more information.
Use the following procedure to add a Modify Text macro to a Monitor Wall custom control:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.
   - Press HOME (to display the Main Menu 1-2).
   - Custom Controls (to display the Custom Controls Menu).

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or the “at sign” (@) in the list have already been programmed.

   ![Custom Controls Menu]

3. Navigate to the Insert Monitor Wall Control Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ MORE ⇒ Monitor Wall.
   - Press Start Recording (to display the Recording Menu).
   - Insert Special (to display the Insert Special Menu 1-2).
   - MORE (to display the Insert Special Menu 2-2).
   - Monitor Wall (to display the Insert Monitor Wall Control Menu).

   ![Insert Monitor Wall Control Menu]

4. Select the Monitor Wall you want to apply the Modify Text macro to as follows:
   - Use the Monitor Wall knob to select the Monitor Wall.
   - Use the middle knob to select Modify Text.
5. Select the text address on the specified Monitor Wall as follows:
   • Use the **Monitor Wall** knob to select the Monitor Wall.
   • Use the bottom knob to select **Text Address**.
   • Use a standard PS/2 keyboard to enter the Text Address in the **Text Address Field** of the **Insert Monitor Wall Control Menu**.

<table>
<thead>
<tr>
<th>Note</th>
<th>The <strong>Text Address</strong> is assigned to a Text Label when creating a Monitor Wall Layout. Refer to the documentation for your Monitor Wall for information on adding Text Labels to your specific Layout.</th>
</tr>
</thead>
</table>

| Important | Do NOT place anything on your keyboard, or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably. |

6. Modify the Dynamic Text Label on the selected Monitor Wall as follows:
   • Use the bottom knob to select **Text Entry**.
   • Use a standard PS/2 keyboard to enter the new text you wish to have displayed in the selected Text Label.

| Important | Do NOT place anything on your keyboard, or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the switcher acting unpredictably. |

7. Press **Insert** to add this macro into the custom control.
8. Press **UP ONE** to return to the **Custom Controls Recording Menu**.
9. Press **Finish Recording** or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This concludes the procedure to create a custom control macro to modify dynamic Monitor Wall text.

Once your custom control buttons have been programmed, be sure to properly name them. Refer to the section “**Naming Custom Controls**” on page 8–42 for more information on naming custom control buttons.

To play back your macro, exit the **Custom Controls Menu** and press the custom control button on the control panel that you recorded the custom control macro to. Any recorded custom control can be edited. Refer to the section “**Editing Custom Control Macros**” on page 8–47 for details.
Monitor Wall Operation

The Monitor Wall custom controls allow you to control various aspects of the Monitor Wall from the Synergy switcher. Refer to the section “Monitor Wall Custom Controls” on page 20–16 for more information on programming a Monitor Wall custom control. The basic function of these custom controls is outlined below:

Layouts

The Layout Custom Control allows you to program a custom control to load a specific layout on the Monitor Wall. A different Custom Control must be created for each layout you want to load on the Monitor Wall using the Synergy switcher.

Input Channels

The Assign Channels Custom Control allows you to program a custom control to assign a specific input channel to a particular monitor on the Monitor Wall. A different Custom Control will have to be created for each channel you want to assign to a different monitor using the Synergy switcher.

Dynamic Text

The Modify Text Custom Control allows you to program a custom control to assign specific, pre-defined text to a particular text address. You can create a different Custom Control for each text change you want to make using the Synergy switcher. You can also program multiple text changes in a single custom control by adding pauses. Refer to the section “Custom Control Pauses” information on inserting a pause within a custom control.
Audio Mixers

In This Chapter

This chapter provides instructions for connecting, setting up and operating an Audio Mixer with your Synergy switcher. Before you begin, ensure that the Small Audio Mixer Interface (16 or fewer inputs) or Large Audio Mixer Interface (more than 16 inputs) software option is installed. If not, contact Ross Video for details.

The following topics are discussed:

- Supported Remote Audio Mixers
- Communication Connections
- Setting up the Switcher
- Setting up the Remote Audio Mixer
- Audio Channel/Group Setup
- Audio Channel Assignment
- Audio Override Setup
- Audio Modes
- Operation Overview
- Audio Specific Functions
Supported Remote Audio Mixers

The Synergy Series Switcher has been tested with a number of Audio Mixers to ensure the highest possible standard for compatibility and reliability. The following Audio Mixers are currently supported by your Synergy switcher:

- **Calrec Sigma Digital Audio Mixing System** — Requires an RS-422 serial connection and the Large Audio Mixer Interface option.
- **Studer On-Air Audio Mixers** — Requires an RS-232 serial connection and the Large Audio Mixer Interface option.
- **Yamaha 01V** — Requires a MIDIator and the Small Audio Mixer Interface option.
- **Yamaha 01V96** — Requires a MIDIator and the Small Audio Mixer Interface option.
- **Yamaha 02R96** — Requires an RS-422 serial connection and the Large Audio Mixer Interface option.
- **Yamaha DM2000** — Requires an RS-422 serial connection and the Large Audio Mixer Interface option.
- **Yamaha DM1000** — Requires a MIDIator and the Large Audio Mixer Interface option.
- **Yamaha PM5D** — Requires a MIDIator and the Large Audio Mixer Interface option.
- **Yamaha M7CL-48** — Requires a MIDIator and the Large Audio Mixer Interface option.
Communication Connections

You can connect up to two Remote Audio Mixers to your Synergy switcher. The procedure for connecting the Audio Mixers will depend on the type of Audio Mixer you have and whether a MIDIator (MS-124W) is required to communicate with the Synergy switcher. Refer to the section “Supported Remote Audio Mixers” on page 21–2 for details about which Audio Mixer Interface option and connection is required for your particular Remote Audio Mixer.

This section will identify how to make the communication connections between the Remote Audio Mixers and the Synergy switcher. The following topics are discussed:

- Connecting to a Remote Audio Mixer without a MIDIator
- Connecting to a Remote Audio Mixer with a MIDIator
- Connecting Multiple Remote Audio Mixers

Note
These instructions are provided as a guide, for specific information on the Audio Mixer you are connecting to the Synergy switcher, refer to the documentation provided with your Audio Mixer.

Connecting to a Remote Audio Mixer without a MIDIator

This section includes information to connect a single Audio Mixer without using a MIDIator. In order to properly complete this procedure, you will need the following software options, cables, and equipment:

- **Software Interface** — This is the software option from Ross Video that allows your Synergy switcher to control the Audio Mixer. You must have one of the following software options:
  - **Small Audio Mixer Interface** — This is the software option that allows your Synergy switcher to control up to 16 audio channels on an Audio Mixer.
  - **Large Audio Mixer Interface** — This is the software option that allows your Synergy switcher to control up to 240 audio channels on an Audio Mixer.

Note
A single Remote Audio Mixer may not be able to support 240 audio channels. Multiple Audio Mixers can be ganged together to increase the number of audio channels your Audio Mixers can support. Refer to the section “Connecting Multiple Remote Audio Mixers” on page 21–7 for more information on connecting multiple Audio Mixers together.

- **Interface Cable** — This is a 15 foot serial cable that connects the 9-Pin, D-Type port on the Synergy control panel to the Audio Mixer.
- **Interface Cable** — This is a serial cable that connects the Synergy control panel to the Audio Mixer. You must have one of the following cables depending on the type of Audio Mixer you are connecting to:
  - **Yamaha Audio Mixers** — This is a 15 foot serial cable that connects the 9-Pin, D-Type port on the Synergy control panel to the 8-Pin, mini DIN port on the Audio Mixer.
  - **Calrec Sigma Digital Audio Mixing System** — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on one end to connect to the Synergy...
control panel, and a connector on the other end to connect to your Calrec Sigma System.

~ Studer On-Air Audio Mixers — This is a 9-Pin cable with a 9-Pin, D-Type (DB9) male connector on each end to connect the Synergy control panel to your Studer On-Air Audio Mixers.

**Connecting without a MIDLator**

The following diagram and procedure describe the basic physical connection of an Audio Mixer to your Synergy switcher. The locations or names of ports may vary with your Audio Mixer.

Use the following procedure to connect a single Remote Audio Mixer without a MIDLator to your Synergy switcher:

1. Connect and secure the 9-Pin D-Type end of the Interface Cable to one of the Remote Ports on the back of the Synergy control panel.

![Synergy Series Control Panel — Rear View, Remote Control Ports](image)

2. Connect and secure the 8-Pin mini DIN end of the Interface Cable to the appropriate port on the Audio Mixer. If you are connecting a Calrec Sigma Digital Audio Mixing System, proceed to step 3.

The suggested port for each supported Audio Mixer is as follows:

- **Yamaha 02R96** — Connect the Interface Cable to the TO HOST SERIAL port on the Yamaha 02R96 panel. Refer to the section “Yamaha 02R96 Control Cable Specifications” on page 21–10 for more information on cabling for this Audio Mixer.

- **Yamaha DM2000** — Connect the Interface Cable to the TO HOST SERIAL port on the Yamaha 02R96 panel. Refer to the section “Yamaha DM2000 Control Cable Specifications” on page 21–11 for more information on cabling for this Audio Mixer.

- **Studer On-Air Audio Mixers** — Connect the Interface Cable to the serial port on the Studer On-Air Audio Mixers panel. Refer to the section “Studer On-Air Audio Mixers Interface Cable Specifications” on page 21–11 for more information on cabling for this Audio Mixer.

3. If you are connecting a Calrec Sigma Digital Audio Mixing System to the Synergy switcher:

   - Connect and secure the Interface Cable to the one of the Remote Ports on the back of the Synergy control panel.

   - Ensure the RS422 port on the Calrec Sigma panel is configured for RS422 communications.
• Connect and secure the **Interface Cable** to the **RS422** port on the Calrec Sigma panel. Refer to the section “**Calrec Sigma Interface Cable Specifications**” on page 21–12 for cabling information for this Audio Mixer.

This completes the procedure for connecting a single Remote Audio Mixer to a Synergy switcher without a MIDIator. Refer to the section “**Setting up the Switcher**” on page 21–13 for instructions on how to set up the communications protocols on the switcher, as well as the Remote Audio Mixer.

### Connecting to a Remote Audio Mixer with a MIDIator

This section provides basic instructions for connecting a single Audio Mixer using a MIDIator (MS-124W). In order to properly complete the procedure, you will need the following software options, cables, and equipment:

- **Software Interface** — This is the software option from Ross Video that allows your Synergy switcher to control the Audio Mixer. You must have one of the following options:
  - **Small Audio Mixer Interface** — This is the software option that allows your Synergy switcher to control up to 16 audio channels on an Audio Mixer.
  - **Large Audio Mixer Interface** — This is the software option that allows your Synergy switcher to control up to 240 audio channels on an Audio Mixer.

- **MIDIator (MS-124W)** — This device converts the serial interface from the Synergy control panel to a MIDI format.

- **MIDIator Interface Cable** — This is a null modem cable with a DB9 to DB25 converter at one end. This cable connects the 9-Pin, D-Type port on the Synergy control panel to the 25-Pin, D-Type port on the MIDIator. Refer to the section “**MIDIator Interface Cable Specifications**” on page 21–10 for information on this cable. You will need to supply one of these cables. The converter is supplied by Ross Video.

- **MIDI Cable** — This is a MIDI cable that connects the 5-Pin, DIN port on the MIDIator to the 5-Pin, DIN port on the Remote Audio Mixer. You will need two of these cables.

### Connecting with a MIDIator

The following diagram and procedure describe the basic physical connection of an Audio Mixer to your Synergy switcher. The locations or names of ports may vary with your Audio Mixer.

Use the following procedure to connect a **MIDIator** and a single Remote Audio Mixer to your Synergy switcher:

1. Connect and secure the **9-Pin** end of the **MIDIator Interface Cable** to one of the **Remote Ports** on the back of the Synergy control panel.

2. Connect and secure the **25-Pin** end of the **MIDIator Interface Cable** to the **Serial Port** on the MIDIator.

---

**Note**

A single Remote Audio Mixer may not be able to support 240 audio channels. Multiple Audio Mixers can be ganged together to increase the number of audio channels your Audio Mixers can support. Refer to the section “**Connecting Multiple Remote Audio Mixers**” on page 21–7 for more information on connecting multiple Audio Mixers together.
3. Install the first **MIDI Cable** connecting the **MIDIator** to the Remote Audio Mixer as follows:
   - Connect one end of a **MIDI Cable** to the **OUT 1** port on the **MIDIator**.
   - Connect the other end of the **MIDI Cable** to the appropriate port on the Remote Audio Mixer. The suggested port for each supported Audio Mixer is as follows:
     - Yamaha 01V — Connect the first **MIDI Cable** to the **MIDI IN** port on the Yamaha 01V panel.
     - Yamaha 01V96 — Connect the first **MIDI Cable** to the **MIDI IN** port on the Yamaha 01V96 panel.
     - Yamaha DM1000 — Connect the first **MIDI Cable** to the **MIDI IN** port on the Yamaha DM1000 panel.
     - Yamaha PM5D — Connect the first **MIDI Cable** to the **MIDI IN** port on the Yamaha PM5D panel.
     - Yamaha M7CL-48 — Connect the first **MIDI Cable** to the **MIDI IN** port on the Yamaha M7CL-48 panel.

4. Install the second **MIDI Cable** connecting the **MIDIator** to the Remote Audio Mixer as follows:
   - Connect one end of a **MIDI Cable** to the **IN** port on the **MIDIator**.
   - Connect the other end of the **MIDI Cable** to the appropriate port on the Remote Audio Mixer. The suggested port for each supported Audio Mixer is as follows:
     - Yamaha 01V — Connect the second **MIDI Cable** to the **MIDI OUT** port on the Yamaha 01V panel.
     - Yamaha 01V96 — Connect the second **MIDI Cable** to the **MIDI OUT** port on the Yamaha 01V96 panel.
     - Yamaha DM1000 — Connect the second **MIDI Cable** to the **MIDI OUT** port on the Yamaha DM1000 panel.
     - Yamaha PM5D — Connect the second **MIDI Cable** to the **MIDI OUT** port on the Yamaha PM5D panel.
     - Yamaha M7CL-48 — Connect the second **MIDI Cable** to the **MIDI OUT** port on the Yamaha M7CL-48 panel.

5. Set up the **MIDIator** to **Multiple Burst** as follows:
   - Set the **B–A** switch to **B**.
   - Set the **S–M** switch to **M**.
Connecting a MIDIator and a Single Remote Audio Mixer to the Synergy Switcher

This completes the procedure for connecting a single Remote Audio Mixer to the Synergy switcher using a MIDIator. Refer to the section “Setting up the Switcher” on page 21–13 for instructions on how to set up the communications protocols on the switcher, as well as the Remote Audio Mixer.

Connecting Multiple Remote Audio Mixers

When connecting multiple Audio Mixers together you are telling the two Audio Mixers to act as one larger Audio Mixer. The total number of audio channels available will depend on the Audio Mixer you have, as well as the Audio Mixer Interface option you have.

**Note**

If you have the **Small Audio Mixer Interface** option, you can control up to **16** audio channels. You must purchase the **Large Audio Mixer Interface** if you want to control more.

**Note**

You can not gang multiple 01V Audio Mixers together.

In order to properly complete this procedure you will need the following software options, cables and equipment:

- **Audio Mixer Interface** — This is the software option, either the Large Audio Mixer Interface or Small Audio Mixer Interface, from Ross Video that allows your Synergy switcher to control Audio Mixers.

- **Audio Mixer Ganging** — This is the hardware option from Ross Video that supplies a MIDIator and a MIDI Solutions Merger.

- **MIDIator** (MS-124W) — This device converts the serial interface from the Synergy control panel to a MIDI format.

- **MIDIator Interface Cable** — This is a null modem cable with a DB9 to DB25 converter at one end. This cable connects the 9-Pin, D-Type port on the Synergy control panel to the MIDI IN of the MIDIator.
panel to the 25-Pin, D-Type port on the MIDIator. Refer to the section “MIDIator Interface Cable Specifications” on page 21–10 for information on this cable. You will need to supply one of these cables. The converter is supplied by Ross Video.

- **MIDI Solutions Merger** — This device allows you to connect two Remote Audio Mixers and control them from the Synergy control panel. The Merger is MIDI-powered from the Out MIDI cable. When the Merger is powered and operating normally, the red MIDI LED will illuminate. This MIDI LED will flash when the Merger is passing information.

  **Note**
  
  If the MIDI LED on the MIDI Solutions Merger goes out, and the MIDI cables are still properly connected to it, the Synergy switcher is no longer receiving information from the Audio Mixers. Normal control of the Audio Mixers is still possible, but any manual level adjustment on the mixers will not be recorded by the switcher. To regain full communication between the Synergy switcher and the Merger, cycle the power on the Merger by unplugging and reconnecting the Out MIDI cable.

- **MIDI Cables** — This is a MIDI cable that connects the 5-Pin, DIN port on the MIDIator to the 5-Pin, DIN port on the Remote Audio Mixer. You will need at least two of these cables, plus one for the MIDI Solutions Merger.

### Connecting Multiple Remote Audio Mixers

The diagram and procedure includes in this section describe the basic physical connection of two Audio Mixers to your Synergy switcher. The locations or names of ports may vary with your Audio Mixers.

  **Note**
  
  When connecting multiple Remote Audio Mixers together, you must set the first Audio Mixer to Channel 1 and the second to Channel 2 on the Audio Mixers themselves. Refer to the section “Setting up the Remote Audio Mixer” on page 21–17 for more information.

Use the following procedure to connect multiple Remote Audio Mixers to your Synergy switcher:

1. Connect and secure the 9-Pin end of the MIDIator Interface Cable to one of the Remote Ports on the back of the Synergy control panel.
2. Connect and secure the 25-Pin end of the MIDIator Interface Cable to the Serial Port on the MIDIator.
3. Connect the MIDI Solutions Merger to the MIDIator as follows:
   - Connect one end of a MIDI Cable to the IN port on the MIDIator.
   - Connect the other end of the MIDI Cable to the Out port of the Merger.
4. Install the first MIDI Cable connecting the MIDIator to Remote Audio Mixer 1 as follows:
   - Connect one end of a MIDI Cable to the OUT 1 port on the MIDIator.
   - Connect the other end of the MIDI Cable to the MIDI IN port on Remote Audio Mixer 1.
5. Install the second MIDI Cable connecting the MIDIator to Remote Audio Mixer 2 as follows:
   - Connect one end of a MIDI Cable to the OUT 2 port on the MIDIator.
• Connect the other end of the MIDI Cable to the MIDI IN port on Remote Audio Mixer 2.

6. Install the first cable connecting the MIDI Solutions Merger to Remote Audio Mixer 1 as follows:
   • Connect one end of a MIDI Cable to the In 1 port on the Merger.
   • Connect the other end of the MIDI Cable to MIDI OUT port on Remote Audio Mixer 1.

7. Install the second cable connecting the MIDI Solutions Merger to Remote Audio Mixer 2 as follows:
   • Connect one end of a MIDI Cable to the In 2 port on the Merger.
   • Connect the other end of the MIDI Cable to MIDI OUT port on Remote Audio Mixer 2.

8. Set up the MIDIator to Multiple Burst as follows:
   • Set the B–A switch to B.
   • Set the S–M switch to M.

---

**Note**

On the Remote Audio Mixers you must set each one up so that the first Audio Mixer controls the first set of channels and the second one the second set of channels. Refer to the section “Setting up the Remote Audio Mixer” on page 21–17 for more information on setting up multiple Audio Mixers.
This completes the basic procedure for connecting multiple Remote Audio Mixers to a Synergy switcher. Refer to the section “Setting up the Switcher” on page 21–13 for instructions on how to set up the communications protocols on the switcher, as well as the Remote Audio Mixers.

Remote Audio Mixer Interface Cable Pinouts

Use the information in this section to connect the Synergy switcher to the Audio Mixer.

MIDIator Interface Cable Specifications

The serial cable that connects the MIDIator to the Remote Port on the Synergy switcher has the following pinouts.

<table>
<thead>
<tr>
<th>Synergy-to-MIDIator MS-124 Wiring Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synergy Control Panel</td>
</tr>
<tr>
<td>Remote Port</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
</tbody>
</table>

Yamaha 02R96 Control Cable Specifications

The serial cable that connects the Yamaha 02R96 Remote Audio Mixer to the Remote Port on the Synergy switcher has the following pinouts.

<table>
<thead>
<tr>
<th>Synergy-to-Yamaha 02R96 Audio Mixer Wiring Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synergy Control Panel</td>
</tr>
<tr>
<td>Remote Port</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
</tbody>
</table>
Yamaha DM2000 Control Cable Specifications

The serial cable that connects the Yamaha DM2000 Remote Audio Mixer to the Remote Port on the Synergy switcher has the following pinouts.

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Yamaha DM2000 Audio Mixer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>6</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>9</td>
<td>Chassis</td>
</tr>
</tbody>
</table>

Studer On-Air Audio Mixers Interface Cable Specifications

The serial cable that connects the Studer On-Air Audio Mixers to the Remote Port on the Synergy switcher has the following pinouts.

<table>
<thead>
<tr>
<th>Synergy-to-Studer On-Air Audio Mixers Wiring Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synergy Control Panel</td>
</tr>
<tr>
<td>Remote Port</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
</tbody>
</table>
**Calrec Sigma Interface Cable Specifications**

The serial cable that connects the Calrec Sigma Digital Audio Mixing System to the Remote Port on the Synergy switcher has the following pinouts.

### Synergy-to-Calrec Sigma Audio System Wiring Chart

<table>
<thead>
<tr>
<th>Synergy Control Panel</th>
<th>Calrec Sigma Audio System</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Remote Port</strong></td>
<td><strong>Signal</strong></td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2 RxA (Rx-)</td>
<td>→</td>
</tr>
<tr>
<td>3 TxB (Tx+)</td>
<td>→</td>
</tr>
<tr>
<td>4 n/c</td>
<td></td>
</tr>
<tr>
<td>5 Ground</td>
<td></td>
</tr>
<tr>
<td>6 Ground</td>
<td></td>
</tr>
<tr>
<td>7 RxB (Rx+)</td>
<td>→</td>
</tr>
<tr>
<td>8 TxA (Tx-)</td>
<td>→</td>
</tr>
<tr>
<td>9 Chassis</td>
<td></td>
</tr>
</tbody>
</table>
Setting up the Switcher

This section provides instructions for setting up the Synergy switcher to communicate with the Audio Mixer.

In order to have the Synergy switcher communicate with a Remote Audio Mixer, the remote port on the control panel that the Audio Mixer is connected to must be setup to communicate with the particular Remote Audio Mixer you have connected. Refer to the section “Supported Remote Audio Mixers” on page 21–2 for a list of supported Audio Mixers.

When configured, a Remote Audio Mixer channel (or group of channels) will follow a crosspoint when that button is selected and taken to air. Channels will be brought up as the crosspoint is taken to air and unused channels will be brought down on the same transition.

Setting up the Switcher

Use the following procedure to configure the Remote port on the control panel to connect with an Audio Mixer:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.
2. Press Type to display the Type Menu.

   ![Communications Menu 1-2]

3. Assign a Remote Com Port to Audio Mixer as follows:
   - Use the Com Port knob to select the Synergy remote port that is connected to the Audio Mixer.
   - Use the Device knob to select Audio Mixer.
4. Press Select Device to display the Select Device Menu.

   ![Select Device Menu]

5. Assign a specific Audio Mixer to the Remote Com Port as follows:
• Use the **Com Port** knob to select the Remote Com Port that the desired Audio Mixer is connected to.

• Use the **Device** knob to select the specific Remote Audio Mixer that is connected to the selected Remote Com Port. The following Audio Mixers are currently supported:
  ~ **NONE** — Use this option to not assign a Remote Audio Mixer to the selected Remote Com Port.
  ~ **Ya 01V** — Use this option to assign a **Yamaha 01V Audio Mixer**.
  ~ **Ya 01V96** — Use this option to assign a **Yamaha 01V96 Audio Mixer**.
  ~ **Ya 02R96** — Use this option to assign a **Yamaha 02R96 Audio Mixer**.
  ~ **Ya DM2000** — Use this option to assign a **Yamaha DM2000 Audio Mixer**.
  ~ **Ya DM1000** — Use this option to assign a **Yamaha DM1000 Audio Mixer**.
  ~ **Ya PM5D** — Use this option to assign a **Yamaha PM5D Audio Mixer**.
  ~ **Ya M7CL** — Use this option to assign a **Yamaha M7CL-48 Audio Mixer**.
  ~ **RAP** — Use this option to assign a **Calrec Sigma Digital Audio Mixing System** to the selected communications port.
  ~ **Studer** — Use this option to assign a **Studer On-Air Audio Mixers** to the selected communications port.

6. Press **Com Settings** to display the **Com Settings Menu**.

7. Set up the communications parameters for the specific Remote Audio Mixer as follows:
   • Use the **Com Port** knob to select the Remote Com Port that the desired Audio Mixer is connected to.
   • Use the **Baud** knob to select **38400**.
   • Use the **Parity** knob to select **NONE**.

**Note**

The baud rate and parity for most remote Audio Mixers should already be correctly set. Use these controls only if required.
8. Press **Com Type** to display the **Com Type Menu**.

9. Select the serial communications protocol for the Com Port as follows:
   - Use the **Com Port** knob to select the Remote Com Port that the desired Audio Mixer is connected to.
   - Use the **Type** knob to select either RS-232 or RS-422.
     - **RS-232** — Select this option when you are using the MIDIator to connect an Audio Mixer, or multiple Audio Mixers, to the Synergy switcher.
     - **RS-422** — Select this option when you are using an RS-422 Interface Cable to connect an Audio Mixer to the Synergy switcher.

10. Press **Extra Options** to display the **Extra Options Menu**.
11. Set the Converter used to connect the Remote Audio Mixers to your Synergy switcher as follows:
   - Use the **Com Port** knob to select the Remote Com Port that the desired Audio Mixer is connected to.
   - Use the **Option** knob to **Converter**.
     - Use the **Value** knob to select the converter. You can select from the following:
       - **None** — Select this option when you are using an RS-422 Interface Cable to connect an Audio Mixer to the Synergy switcher.
       - **MIDIator** — Select this option when you are using a MIDIator to connect an Audio Mixer, or multiple Audio Mixers, to the Synergy switcher.
12. Set the number of Remote Audio Mixers you want to connect to your Synergy switcher as follows:

**Important**

You will need to use a **MIDI Solutions Merger** to combine the inputs from the multiple Audio Mixers to a single input for the **MIDIator** that connects to your Synergy switcher. Refer to the section “**Connecting Multiple Remote Audio Mixers**” on page 21–7 for information on connecting multiple Remote Audio Mixers.

- Use the **Com Port** knob to select the Remote Com Port that the desired Audio Mixers are connected to.
- Use the **Option** knob to select **Mixers**.

![Communications — Extra Options Menu (Mixers)](image)

- Use the **Value** knob to select the number of Remote Audio Mixers, to a maximum of 2, you have connected.

**Note**

When connecting multiple Remote Audio Mixers, *both* must be of the type specified in the **Select Device Menu**. You cannot gang multiple Yamaha 01V Audio Mixers.

13. Press **HOME** to display the **Installation Change Confirmation Screen**.

14. Accept or reject the changes you have made as follows:

- Press **Confirm** to accept the changes.
- Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedures for basic communication setup of the Synergy switcher. Next you will set up the Remote Audio Mixer to communicate with the Synergy switcher.
Setting up the Remote Audio Mixer

In order to complete the communications setup, you must configure the Remote Audio Mixer to accept commands and communicate with the Synergy switcher.

Yamaha 01V

In order to allow the Synergy switcher to communicate with this Audio Mixer, you must configure it as described in this section.

Use the following procedure to set up your Yamaha 01V Audio Mixer:

1. Press the **MIDI** function button to display the **MIDI SETUP Menu**. You may have to press the MIDI button several times to cycle through the MIDI menus.

2. Use the **Cursor** buttons to navigate to the following:
   - **Tx PORT** — Use the Parameter Dial to set this to **MIDI**.
   - **Rx PORT** — Use the Parameter Dial to set this to **MIDI**.
   - **Tx CH** — Use the Parameter Dial to set this to **1**.
   - **Rx CH** — Use the Parameter Dial to set this to **1**.

3. Use the following table to set the indicated parameters:

<table>
<thead>
<tr>
<th>Yamaha 01V Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Program Change</strong></td>
</tr>
<tr>
<td><strong>Control Change</strong></td>
</tr>
<tr>
<td><strong>Param Change</strong></td>
</tr>
<tr>
<td><strong>Bulk</strong></td>
</tr>
</tbody>
</table>

4. Press **ENTER** to save your changes.

This completes the procedure for setting up the Yamaha 01V Audio Mixer to communicate with the Synergy switcher.
Yamaha 01V96

In order to allow the Synergy switcher to communicate with this Audio Mixer, you must configure it as described in this section.

**Note**  For information on the Function Buttons and navigating the menu system on your Remote Audio Mixer, refer to the documentation that came with your Audio Mixer.

Use the following procedure to set up your Yamaha 01V96 Audio Mixer:

1. Press the **DIO/SETUP** function button in the **Display Access Group** to display the **DIO/SETUP Menu**.
2. Press the **MIDI/HOST** tab to display the **MIDI I/O HOST SETUP Menu**.
3. Use the **Cursor** buttons to navigate to the following (you must press **ENTER** after each selection):
   - **Tx PORT** — Use the Parameter Dial to set this to **MIDI**.
   - **Rx PORT** — Use the Parameter Dial to set this to **MIDI**.
4. Press the **MIDI** function button in the **Display Access Group** to display the **MIDI Menu**.
5. Press the **SETUP** tab to display the **MIDI SETUP Menu**.
6. Use the **Cursor** buttons to navigate to the following (you must press **ENTER** after each selection):
   - **Tx CH** — Use the Parameter Dial to set this to **1**.
   - **Rx CH** — Use the Parameter Dial to set this to **1**.

**Note**  If you are ganging multiple Audio Mixers, you must set the second Remote Audio Mixer to **Tx CH 2** and **Rx CH 2**.

7. Use the following table to set the indicated parameters:

<table>
<thead>
<tr>
<th>Yamaha 01V96 Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Tx</strong></td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td><strong>Program Change</strong></td>
</tr>
<tr>
<td><strong>Control Change</strong></td>
</tr>
<tr>
<td><strong>Param Change</strong></td>
</tr>
<tr>
<td><strong>Bulk</strong></td>
</tr>
<tr>
<td><strong>Other Commands</strong></td>
</tr>
</tbody>
</table>

8. Use the **Parameter** Dial to set the **Fader Resolution** to **LOW**.

This completes the procedure for setting up the Yamaha 01V96 Audio Mixer to communicate with the Synergy switcher.
Yamaha 02R96

In order to allow the Synergy switcher to communicate with this Audio Mixer, you must configure it as described in this section.

**Note**
For information on the Function Buttons and navigating the menu system on your Remote Audio Mixer, refer to the documentation that came with your Audio Mixer.

Use the following procedure to set up your Yamaha 02R96 Audio Mixer:

1. Press the **SETUP** function button in the **Display Access Group** to display the **SETUP Menu**.
2. Press the **MIDI/HOST** tab to display the **MIDI/HOST SETUP Menu**.
3. Use the **Cursor** buttons to navigate to the following (you must press **ENTER** after each selection):
   - **TO SERIAL HOST** — Use the Parameter Dial to set this to **PC-2**.

   **Note**
   If you are ganging multiple Audio Mixers, you must set the **Rx PORT** and **Tx PORT** values to **MIDI**, to connect to the MIDIator.

   - **Rx PORT** — Use the Parameter Dial to set this to **SERIAL**.
   - **Tx PORT** — Use the Parameter Dial to set this to **SERIAL**.
4. Press the **MIDI** function button in the **Display Access Group** to display the **MIDI Menu**.
5. Press the **SETUP** tab to display the **MIDI SETUP Menu**.
6. Use the **Cursor** buttons to navigate to the **RECEIVE Section** and select the following, all other parameters should be deselected (you must press **ENTER** after each selection):
   - **Channel 1**
   - **PROGRAM CHANGE**
   - **PARAMETER CHG**

   **Note**
   If you are ganging multiple Audio Mixers, you must set the second Remote Audio Mixer to **Channel 2**.
7. Use the **Cursor** buttons to navigate to the **TRANSMIT Section** and select the following, all other parameters should be deselected (you must press **ENTER** after each selection):
   - **Channel 1**
   - **PROGRAM CHANGE**
   - **PARAMETER CHG**

   **Note**
   If you are ganging multiple Audio Mixers, you must set the second Remote Audio Mixer to **Channel 2**.
8. Deselect all items in the **OMNI Section**.
9. Press **ENTER** to save your changes.
10. Deselect all items in the **ECHO Section**.
11. Press **ENTER** to save your changes.

This completes the procedure for setting up the Yamaha 02R96 Audio Mixer to communicate with the Synergy switcher.

**Yamaha DM2000**

In order to allow the Synergy switcher to communicate with this Audio Mixer, you must configure it as described in this section.

| Note | For information on the Function Buttons and navigating the menu system on your Remote Audio Mixer, refer to the documentation that came with your Audio Mixer. |

Use the following procedure to set up your Yamaha DM2000 Audio Mixer:

1. Press the **SETUP** function button in the **Display Access Group** to display the **SETUP Menu**.
2. Press the **MIDI/HOST** tab to display the **MIDI/HOST SETUP Menu**.
3. Use the **Cursor** buttons to navigate to the following (you must press **ENTER** after each selection):
   - **TO SERIAL HOST** — Use the Parameter Dial to set this to **PC-2**.

| Note | If you are ganging multiple Audio Mixers, you must set the **Rx PORT** and **Tx PORT** values to **MIDI**, to connect to the MIDIator. |

   - **Rx PORT** — Use the Parameter Dial to set this to **SERIAL**.
   - **Tx PORT** — Use the Parameter Dial to set this to **SERIAL**.
4. Press the **MIDI** function button in the **Display Access Group** to display the **MIDI Menu**.
5. Press the **SETUP** tab to display the **MIDI SETUP Menu**.
6. Use the **Cursor** buttons to navigate to the **RECEIVE Section** and select the following, all other parameters should be deselected (you must press **ENTER** after each selection):
   - **Channel 1**
   - **PROGRAM CHANGE**
   - **PARAMETER CHG**

| Note | If you are ganging multiple Audio Mixers, you must set the second Remote Audio Mixer to **Channel 2**. |

7. Use the **Cursor** buttons to navigate to the **TRANSMIT Section** and select the following, all other parameters should be deselected (you must press **ENTER** after each selection):
   - **Channel 1**
• PROGRAM CHANGE
• PARAMETER CHG

Note If you are ganging multiple Audio Mixers, you must set the second Remote Audio Mixer to Channel 2.

8. Deselect all items in the OMNI Section.
9. Press ENTER to save your changes.
10. Deselect all items in the ECHO Section.
11. Press ENTER to save your changes.

This completes the procedure for setting up the Yamaha DM2000 Remote Audio Mixer to communicate with the Synergy switcher.

**Yamaha DM1000**

In order to allow the Synergy switcher to communicate with this Audio Mixer, you must configure it as described in this section.

Use the following procedure to set up your Yamaha DM1000 Audio Mixer:

1. Press the SETUP function button in the Display Access Group to display the SETUP Menu.
2. Press the MIDI/HOST tab to display the MIDI/HOST SETUP Menu.
3. Use the Cursor buttons to navigate to the following (you must press ENTER after each selection):
   • TO SERIAL HOST — Use the Parameter Dial to set this to PC-2.
   • Rx PORT — Use the Parameter Dial to set this to SERIAL.
   • Tx PORT — Use the Parameter Dial to set this to SERIAL.
4. Press the MIDI function button in the Display Access Group to display the MIDI Menu.
5. Press the SETUP tab to display the MIDI SETUP Menu.
6. Use the Cursor buttons to navigate to the RECEIVE Section and select the following, all other parameters should be deselected (you must press ENTER after each selection):

<table>
<thead>
<tr>
<th>Yamaha DM1000 Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Channel</strong></td>
</tr>
<tr>
<td>Channel</td>
</tr>
<tr>
<td>Program Change</td>
</tr>
</tbody>
</table>

Note For information on the Function Buttons and navigating the menu system on your Remote Audio Mixer, refer to the documentation that came with your Audio Mixer.

Note If you are ganging multiple Audio Mixers, you must set the Rx PORT and Tx PORT values to MIDI, to connect to the MIDIator.
7. Use the Parameter Dial to set the Fader Resolution to LOW.

This completes the procedure for setting up the Yamaha DM1000 Audio Mixer to communicate with the Synergy switcher.

**Yamaha PM5D**

In order to allow the Synergy switcher to communicate with this Audio Mixer, you must configure it as described in this section.

Use the following procedure to setup your Yamaha PM5D Audio Mixer:

1. Press the MIDI/Remote function button in the Display Access Group to display the MIDI/Remote Menu.
2. Press the MIDI/Remote function button to display the MIDI SETUP Screen.
3. In the MIDI Port row of the MIDI SETUP Screen, select the following values, pressing ENTER after each selection:
   - In the Tx column — Use the Track Pad buttons to set this field to MIDI.
   - In the Rx column — Use the Track Pad buttons to set this field to MIDI.
4. In the Single Mode MIDI CH row of the MIDI SETUP Screen, select the following values, pressing ENTER after each selection:
   - In the Tx column — Use the Track Pad buttons to set this to 1.
   - In the Rx column — Use the Track Pad buttons to set this to 1.

**Note** If you are ganging multiple Audio Mixers, you must set the second Remote Audio Mixer to Tx CH 2 and Rx CH 2. You will also need to set the MIDI Thru value to MIDI in the Rx Column for all the Audio Mixers you are connecting.

5. Use the following table to set the indicated parameters:

<table>
<thead>
<tr>
<th></th>
<th>Tx</th>
<th>Rx</th>
<th>OMNI</th>
<th>ECHO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Change</td>
<td>ON</td>
<td>ON</td>
<td>--</td>
<td>OFF</td>
</tr>
<tr>
<td>Param Change</td>
<td>ON</td>
<td>ON</td>
<td>--</td>
<td>OFF</td>
</tr>
<tr>
<td>Bulk</td>
<td>--</td>
<td>OFF</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Other Commands</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

**Yamaha DM1000 Setup**

<table>
<thead>
<tr>
<th></th>
<th>Tx</th>
<th>Rx</th>
<th>OMNI</th>
<th>ECHO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Change</td>
<td>ON</td>
<td>ON</td>
<td>--</td>
<td>OFF</td>
</tr>
<tr>
<td>Param Change</td>
<td>ON</td>
<td>ON</td>
<td>--</td>
<td>OFF</td>
</tr>
<tr>
<td>Bulk</td>
<td>--</td>
<td>OFF</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Other Commands</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>
This completes the procedure for setting up the Yamaha PM5D Remote Audio Mixer to communicate with the Synergy switcher.

**Yamaha M7CL-48**

In order to allow the Synergy switcher to communicate with this Audio Mixer, you must configure it as described in this section. For information on the Function Buttons and navigating the menu system on your Audio Mixer, refer to the documentation that came with your device.

Use the following procedure to set up your Yamaha M7CL-48 Audio Mixer:

1. Press the **MIDI/Remote** function button in the **Display Access Group** to display the **MIDI/Remote Menu**.
2. Press the **MIDI/Remote** function button to display the **MIDI SETUP Screen**.
3. In the **MIDI Port** row of the **MIDI SETUP Screen**, select the following values, pressing **ENTER** after each selection:
   - In the **Tx column** — Use the **Track Pad** buttons to set this field to **MIDI**.
   - In the **Rx column** — Use the **Track Pad** buttons to set this field to **MIDI**.
4. In the **Single Mode MIDI CH** row of the **MIDI SETUP Screen**, select the following values, pressing **ENTER** after each selection:
   - In the **Tx column** — Use the **Track Pad** buttons to set this to **1**.
   - In the **Rx column** — Use the **Track Pad** buttons to set this to **1**.

   **Note**
   If you are ganging multiple Audio Mixers, you will have to set the second Audio Mixer to **Tx CH 2** and **Rx CH 2**. You will also need to set the **MIDI Thru** value to **MIDI** in the **Rx Column** for all the Audio Mixers you are connecting.

This completes the procedure for setting up the Yamaha M7CL-48 Audio Mixer to communicate with the Synergy switcher.
Calrec Sigma Digital Audio Mixing System

Use the following information when setting up your Calrec Sigma Digital Audio Mixing System with the Synergy switcher.

- Ensure the port on the Calrec Sigma panel, that is connected to the Synergy switcher, is configured for RS422 communications.
- Use the following communications settings when connecting a Calrec Sigma Digital Audio Mixing System to the Synergy switcher:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transmission Standard</td>
<td>RS-422</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>115200</td>
</tr>
<tr>
<td>Parity</td>
<td>Odd</td>
</tr>
<tr>
<td>Data Bits</td>
<td>8</td>
</tr>
<tr>
<td>Stop Bits</td>
<td>1</td>
</tr>
</tbody>
</table>

Calrec Sigma Digital Audio Mixing System Extra Options

The Synergy Extra Options Menu allows you to select the master level on the Calrec Digital Audio Mixing System that the OverDrive Production Control System will use.

Use the following procedure to configure Extra Options for a Calrec Digital Audio Mixing System:

1. Press Extra Options on the Communications Menu 1-2.
2. Set the master level on the Calrec Digital Audio Mixing System that the OverDrive Production Control System will use as follows:
   - Use the Option knob to select OD Master.
   - Use the Value knob to select master level that you want to control.

This completes the procedure for setting up the Extra Options for the Calrec Digital Audio Mixing System.

Studer On-Air Audio Mixers

Use the following information when setting up your Studer On-Air Audio Mixers with the Synergy switcher.

The Studer On-Air Audio Mixers can have a variable number of input channels and has two program output channels. You must specify the number of input channels on your audio mixer as well as which output channel you wish to control with your Synergy switcher.

Use the following procedure to configure your Synergy switcher to control the Studer On-Air Audio Mixers:

1. Navigate to the Communications Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.
2. Press Extra Options to display the Extra Options Menu.
3. Set the number of input channels on the Studer On-Air Audio Mixers as follows:
• Use the **Com Port** knob to select the communications port that the desired Audio Mixer is assigned to.

• Use the **Option** knob to select **Max Channels**.

<table>
<thead>
<tr>
<th>Communications (1-2)</th>
<th>Com Port: Studer (R4)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Communications – Extra Options Menu (Max Channels)**

• Use the **Value** knob to set the number of input channels on your Studer On-Air Audio Mixers. Values increase and decrease in multiples of 3.

4. Set the program output channel you wish to control as follows:

• Use the **Option** knob to select **PGM Output**.

• Use the **Value** knob to select which program output you wish to control. You can select between the following:
  ~ **PGM A** — Select this option to control program output A.
  ~ **PGM B** — Select this option to control program output B.

5. Press **HOME** to display the **Installation Change Confirmation Screen**.

6. Accept or reject the changes you have made as follows:

• Press **Confirm** to accept the changes.

• Press **Cancel** to exit the menus safely, without making any changes. The switcher returns to the previously stored settings.

This completes the procedure for configuring your Synergy switcher to control the Studer On-Air Audio Mixers.
Audio Channel/Group Setup

Audio from a remote mixer can be configured as individual channels or grouped together, with up to three channels per group. When you set up the audio channels, you also set the Default Levels for the individual channels. These default levels are the ones that the switcher will set the channels to when you perform an audio reset custom control. Refer to the section “Audio Override Setup” on page 21–32 for more information on audio custom controls.

Setting Up Audio Sources

For the Studer Audio Mixer, each audio source needs to be assigned to an audio channel that is controlled by the switcher. This allows you to select specific audio sources to be controlled when there are more audio sources than input channels on the audio mixer.

Use the following procedure to assign an audio source to an audio channel:

1. Navigate to the Audio Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Audio.
2. Press Assign Audio Source ⇒ Select Source to display the Assign Audio Source Menu.

   Assign Audio Source Menu

3. Assign an audio source to an audio channel as follows:
   • Use the Audio Channel knob to select the input audio channel you want to assign an audio source to. The number of channels listed is the number of channels you selected when setting the Max Channels extra options for your audio mixer.
   • Use the Audio Source knob to select the audio source that you want to assign to the selected input audio channel.
4. Name an audio source as follows:
   • Press Name Channel on the Assign Audio Source Menu.
   • Use the Audio Src knob to select the audio source you want to name.
   • Enter the new name you want to use in the New Name field.
   • Press Accept New Name to assign the name to the audio source.
   • Press Assign All to send the audio input channel to audio source assignments to the Audio Mixer.

This completes the procedure for assigning an audio source to an audio channel.
Setting Up Audio Channels

Each Audio Channel can be set with a custom audio level that is used when the channel is taken on-air. This level can be adjusted manually using the sliders on the Audio Mixer, or using by selected the level on the menu. The default audio level for each channel is 75%.

Specific Audio channels can be removed from the control of the switcher. These channels are not controlled by the switcher and cannot have their levels adjusted from the switcher.

Use the following procedure to setup the default audio level for a channel:

1. Navigate to the Audio Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Audio.

2. Press Audio Level to display the Audio Level Menu.

   ![Audio Level Menu]

3. Include audio channels from the control of the switcher as follows:
   - Use the Audio Channel knob to select the audio channel that you want to remove from the control of the switcher. All channels are included by default.

4. Set the level for each audio channel as follows:
   - Use the Audio Channel knob to select the default audio level for.
   - Use the Level knob to select the default audio level for the selected channel. All channels are initially set at 75%.

This completes the procedure for setting up the default audio levels for audio channels.
**Setting Up Audio Groups**

Up to three audio channels, or groups, can be grouped together. This allows you to assign multiple audio channels to a single Input BNC. Assigning audio channels will not change the default audio levels that have been set for each of the channels. When the group is taken on-air, each audio channel is taken up to the level set for that particular channel.

**Note**

Assigning audio channels to groups does not alter the default or custom audio levels that you have set for them.

Use the following procedure to assign audio channels to groups:

1. Navigate to the **Audio Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Audio.
2. Press **Audio Groups** to display the **Audio Group Menu**.
3. Press **Group 1** to assign audio channels to that group. There are a total of six audio groups you can assign audio channels to.
4. Assign up to 3 audio channels to the selected group as follows:
   - Use the **Audio Channel 1** knob to select the first audio channel that you want to assign to the group.
   - Use the **Audio Channel 2** knob to select the second audio channel that you want to assign to the group.
   - Use the **Audio Channel 3** knob to select the third audio channel that you want to assign to the group.

This completes the procedure for assigning audio channels to groups.

**Note**

If you have programmed **Audio Assign Custom Controls**, the **Audio Channel** knob will display the **Custom##** for the custom control that you assigned the channel to.

- Use the **Audio Channel 1** knob to select the first audio channel that you want to assign to the group.
- Use the **Audio Channel 2** knob to select the second audio channel that you want to assign to the group.
- Use the **Audio Channel 3** knob to select the third audio channel that you want to assign to the group.

This completes the procedure for assigning audio channels to groups.
Audio Channel Assignment

You can assign up to two audio sources to each BNC. Each source can be a channel or a group of channels. Channels and groups that are assigned to BNC inputs follow the BNC inputs to air on a transition. This Audio-Follow-Video (AFV) is the normal interaction of an Audio Mixer and the Synergy switcher. You can alter this normal AFV operation at any time by applying an Audio Override. Refer to the section “Audio Override Setup” on page 21–32 for more information on applying an audio override.

Note
When the OverDrive Editor is active (the EDITOR button in the Remote Section of the Global Memory System Group is lit) the audio channel overrides cannot be set from the Synergy control panel.

Assigning Audio Channels to a BNC

Use the following procedure to assign audio channels, or groups, to a BNC:

1. Navigate to the BNC Menu 2-3 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC ⇒ MORE.
2. Press Audio to display the Audio Setup Menu.

   BNC — Audio Setup Menu

3. Assign audio channels, or groups, to your BNCs as follows:

   Note
   The total number of channels that you have available to assign to the BNCs will depend on the Audio Mixer Interface Option you have and the number of audio channels your Audio Mixer can control.

   - Use the BNC knob to select the BNC, or video, that the Audio Mixer will follow for normal AFV operation.
   - Use the Audio 1 knob to select a channel or group you want to assign to the selected BNC.
   - Use the Audio 2 knob to select another channel or group you want to assign to the selected BNC.

   Note
   If you have programmed Audio Assign Custom Controls, the audio channels may display Custom## rather than Channel ##.

Your configured Audio Mixer channels will now follow crosspoint transitions for normal AFV operation.
Audio Personality Setup

The Audio Personality settings allow you to set how the switcher performs audio transitions, and on which MLEs they are performed. These settings are stored in the personality register.

Audio Transition MLE Assignment

Depending on how you want audio transitions to be performed, you can set up the switcher so that it will either perform an audio transition when a transition is performed in any MLE, or only when a transition is performed in the PGM/PST MLE.

Use the following procedure to set up when your audio transitions are performed:

1. Navigate to the Personality Menu 3-4 as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality ⇒ MORE ⇒ MORE.

2. Toggle AudioTrans to select between Pgm or All for when an audio transition is performed.
   • Pgm — This option tells the switcher to perform an audio transition only when a Program MLE is transitioned.
   • All — This option tells the switcher to perform an audio transition when any MLE is transitioned.

This completes the procedure set up when your audio transitions are performed.

Audio Cut Only

The Audio Cut Only features sets whether audio transitions occur at the same rate as the video transition, or whether the audio transitions cut. Note that this is not a true cut as the speed that one channel is taken off-air and the next channel is take on-air depends on the Audio Mixer.

**Note**

When the OverDrive Editor is active (the EDITOR button in the Global Memory System Group is lit), and OverDrive is controlling the switcher, the audio transition rate for the PGM MLE is set from OverDrive.

Use the following procedure to set up the Audio Cut Only feature:

1. Navigate to the Personality Menus as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality ⇒ MORE ⇒ MORE.
2. Use the **Option** knob on the **Personality Menu** to select **AudioCutOnly**.

![Personality Menu]

3. Use the **Value** knob on the **Personality Menu** to toggle this feature **On** or **Off**.
   - **On** — Select this option to have audio transition cut, regardless of the type or rate of the video transition.
   - **Off** — Select this option to have audio transition at the same rate as the video transition.

This completes the procedure for setting up the Audio Cut Only feature.
Audio Override Setup

If you are using the OverDrive production control system, you do not need to setup the Synergy switcher for AFV Overrides. However, setting up the same functionality on your Synergy switcher gives you an extra layer of redundancy, should your OverDrive system fail.

In normal operation, the switcher works in an Audio-Follow-Video (AFV) mode. In this mode, the audio channels, or groups, are faded on and off automatically following each video transition. In more complex audio situations, the AFV mode can be overridden, allowing audio to be transitioned independently, or multiple audio channels to be taken to air without their associated video. This override mode is useful if, for example, you are producing an interview, or debate, and you want to keep several audio channels on-air, even when the associated video signals are not.

In order to perform an audio override, you must set up an Audio Custom Control Bank and a number of audio specific custom controls. These custom controls will allow you to have the PGM/PST MLE (the bottom MLE) act as an Audio Mixer, turning the buttons on each bus into audio crosspoints.

Audio Custom Control Bank Setup

Audio banks are used to store audio custom controls, like normal custom control banks, as well as put the PGM/PST MLE into Audio Mixer Mode. When held, the Audio Bank button will allow you to perform overrides on the AFV settings, as well as perform audio only transitions. Refer to section “Audio Only Transitions” on page 21–47 for more information.

Use the following procedure to set up an Audio Custom Control Bank:

1. Navigate to the Installation Menu 2-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE.
2. Press Custom Controls to display the Setup Banks Menu.
3. Assign a custom control button to an audio bank as follows:
   - Use the Bank knob to select the bank that you want to assign to Audio.
   - Use the Button knob to select the desired custom control button that you want to assign as the Audio Bank.

Note

In this example we use Button # 1 because the corresponding video crosspoint (the crosspoint directly below it) is usually set to BLACK and will not have any associated audio. You can use any button you like.
• Use the **Type** knob to select **Audio**.

4. Press **Modify Bank Name** to display the **Custom Control Bank Names Menu 1-2**.

<table>
<thead>
<tr>
<th>Current Name</th>
<th>Aud</th>
<th>New Name</th>
<th>Aud</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audio 2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5. Use the knobs and softkeys to name your audio bank as follows:

- Use the **Horizontal** knob to move the cursor horizontally.
- Use the **Vertical** knob to move the cursor vertically.
- Use the **Bank number** knob if you want to name a different bank.
- Use the **Space** button to insert a space in the **New Name** field.
- Use the **Prev Letter** button to select the previous letter in the **New Name** field.
- Use the **Next Letter** button to select the next letter in the **New Name** field.
- A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs.

**Important**  
Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

6. Press **Accept New Name** when you are done naming the Audio bank. If the Mnemonic Display option is purchased and installed, the **Mnemonic** field displays the bank name as it will appear in the associated mnemonic display.

7. Press **HOME** and **Confirm** to save the new settings.

This completes the procedure set up an Audio Custom Control Bank. Next you will create custom controls with audio commands.

**Audio Custom Controls**

When an audio source is assigned as a single channel (or in a group) in an **Audio Assign** custom control, that channel can be controlled and brought to air independently, without being associated with any video input. In this way, audio output from microphones, audio servers, and other devices can be brought to air without associated video.

**Assign Audio**

The **Assign Audio** custom control has two roles when working with audio. In normal mode, it allows you to access the levels for the audio channel or group you have assigned to that button. When the **Audio Bank Custom Control** button is pressed and held, the audio channel or group that is assigned to that custom control will be mapped onto the **PGM** and **PST** buses of the bottom MLE. This allows you to change the audio channels that are on-air, by selecting them on the **PGM** bus, or
they will be taken to air during the next transition, by selecting them on the PST bus. Refer to the section “Audio Modes” on page 21–45 for more information.

Use the following procedure to create an Assign Audio custom control:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.

<table>
<thead>
<tr>
<th>Custom Controls Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Control buffers 1.53% full</td>
</tr>
<tr>
<td>Selected: Bank 1 Button 2 [Custom02]</td>
</tr>
<tr>
<td>Button: *Custom01 + 1</td>
</tr>
<tr>
<td>Custom Control Legend:</td>
</tr>
<tr>
<td>* = custom control contains macro</td>
</tr>
<tr>
<td>II = normal custom control button</td>
</tr>
</tbody>
</table>

2. Select the custom control button you want to record as follows:
   - Use the Bank knob to select the Audio bank you created.
   - Use the Button knob to select the custom control button that you want to program.

   **Note** If you have assigned Custom01 button as your Audio Bank, you will not be able to press it to access the Audio Level Menu.

3. Navigate to the Special Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ Special.

<table>
<thead>
<tr>
<th>Insert Special — Special Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger GPI</td>
</tr>
<tr>
<td>Assign Audio</td>
</tr>
<tr>
<td>Audio All Off</td>
</tr>
<tr>
<td>Channel 1</td>
</tr>
<tr>
<td>Channel 2</td>
</tr>
</tbody>
</table>

4. Select the audio channel you want to assign to the selected custom control as follows:
   - Use the Function knob to select Assign Audio.
   - Use the Channel knob to select the channel, or group, you wish to assign to the custom control.

   **Operating Tip** The Audio Channel that you assign to this custom control will be the channel that is mapped down to the PGM and PST buses when you are in Audio Mixer mode. You should assign the same audio channel that is assigned to the BNC crosspoint to the corresponding custom control. For example, if you have Channel 01 assigned to BNC crosspoint 4, you should assign Channel 01 to Custom04. This way, as you go back and forth to Audio Mixer Mode, the audio channels that are assigned to the video channels for AFV will be the same crosspoint buttons.
5. Press **Insert** to enter the command in your custom control macro and display the **Audio Level Menu**.

**Note**

Note that the name of the selected channel or group changes to **Custom##** when you press **Insert**.

When you press this custom control this **Audio Level Menu** is displayed. Each menu allows you to adjust the level for the channel, as well as the Master Audio Level. Refer to section “**Audio Levels and Pan Settings**” on page 21–47 for more information.

6. Press **HOME** to display the **Main Menu 1-2**.
7. Press **Custom Controls** to return to the **Custom Controls Menu**.
8. Press **Finish Recording**, or the flashing custom control button.

This completes the procedure for creating an **Assign Audio** custom control. You will need to repeat this procedure for each audio channel you want to be able to override.

**Reset Audio**

The **Reset Audio** custom control allows you to return to the normal AVF mode and remove all currently selected overrides. This can be performed for either the **PGM** bus or the **PST** bus. You must set up two custom controls if you want to be able to perform for both buses.

Use the following procedure to program a **Reset Audio** custom control:

1. Navigate to the **Custom Controls Menu** as follows:
   - Press **HOME ⇒ Custom Controls**.

   **Custom Controls Menu**

   **Bank:**
   
   **Audio (1)**

   **Selected:**
   
   Bank 1 Button 32 [Custom32]

   **Legend:**
   
   - custom control contains macro
   
   - normal custom control button

   **Start Recording**
   
   **Modify Name**
   
   **Edit**
   
   **Default**
   
   **All Names**
   
   **Delete Macro**

   **Note**

   If you do not have any available custom control buttons on your **Audio Bank**, you can create a second **Normal Bank**.
2. Select the custom control button you want to assign the **Audio All Off** to as follows:
   - Use the **Bank** knob to select the Audio Bank you created.
   - Use the **Button** knob to select the custom control button that you wish to program.
3. Navigate to the **Special Menu** as follows:
   - Press **Start Recording** ⇒ **Insert Special** ⇒ **Special**.

4. Assign **Reset Audio** to the selected custom control button as follows:
   - Use the **Function** knob to select **Reset Audio**.
   - Use the **Audio Bus** knob to select the bus that you want to assign the **Reset Audio** to as follows:
     - **Program** — This function will restore all AFV for the on-air audio. All audio channels that are associated with a BNC that is on-air will be turned on at the level they were last on at, and all other audio channels will be turned off.
     - **Preset** — This function will restore all Audio-Follow-Video and levels for the next transition. At the next audio transition, all audio channels and levels associated with a BNC on the PST bus will be turned on at their default levels during the transition.

   ![Insert Special — Special Menu](image)

   **Note**

   A **Reset Audio** for the Preset bus will not change the **Preset** audio values for the audio channels, or groups, that are currently on-air. When this channel, or group, is taken off-air, the custom control button that is assigned to the **Reset Audio** for the PST bus must be pressed **again** in order to set these channels, or groups, to their default values.

5. Press **Insert** to enter the command in your custom control.
6. Press **HOME** to display the **Main Menu 1-2**.
7. Press **Custom Controls** to return to the **Custom Controls Menu**.
8. Press **Finish Recording**, or the flashing custom control button.

This completes the procedure for creating a **Reset Audio** custom control.

**Audio All Off**

The **Audio All Off** custom control will fade all audio channels on either the PGM bus or the PST bus off. This can be useful for quickly removing all audio from either bus or taking all audio channels off-air after you have performed an Audio Memory Recall. Refer to the section “**Audio Memory**” on page 21–38 for more details.
Use the following procedure to create an Audio All Off custom control:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to assign the Audio All Off to as follows:
   - Use the Bank knob to select the Audio Bank you created.
   - Use the Button knob to select the custom control button that you wish to program.

3. Navigate to the Special Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ Special.

4. Assign Audio All Off to the selected custom control button as follows:
   - Use the Function knob to select Audio All Off.
   - Use the Audio Bus knob to select the bus that you want to assign the Audio All Off to:
     - Program — This option will fade off all audio channels on the Program bus.
     - Preset — This option will fade off all audio channels on the Preset bus.

5. Press Insert to enter the command in your custom control macro.

Note: This custom control functions as an override and will take all audio channels, including AFV off. In order to reinstate AFV you must run a Reset Audio custom control. Refer to the section “Reset Audio” on page 21–35 for more details.

Note: If you do not have any available custom control buttons on your Audio Bank, you can create a second Normal Bank.
6. Press HOME to display the Main Menu 1-2.
7. Press Custom Controls to return to the Custom Controls Menu.
8. Press Finish Recording, or the flashing custom control button.

This completes the procedure for creating an Audio All Off custom control.

Audio Memory

Important

During audio memory recalls, the Synergy switcher sends a MIDI Program Change Event command to the Audio Mixer. You must ensure that the Remote Audio Mixer is setup to recall the proper scene when the Program Change Event command is executed. Refer to the documentation for your device for setup details.

The Audio Memory custom control will recall a memory that has been stored on the Remote Audio Mixer. This can be useful to take a number of channels to air at different levels all at once.

The Memory numbers on the Insert Special Menu correspond to the memories that are stored on the Remote Audio Mixer. For example, memory 02 on the Yamaha 02R96 Audio Mixer will be accessed by selecting 2 with the Memory knob. Refer to the documentation for your Audio Mixer for information on storing audio memories.

Important

When an Audio Memory is recalled, the only way to take the audio channels off-air is to run an Audio All Off PGM/Reset PGM sequence, refer to section “Audio All Off” on page 21–36 for more details. The on-air channels will not appear on the PGM/PST buses.

Use the following procedure to create an Audio Memory custom control:

1. Navigate to the Custom Controls Menu as follows:
   • Press HOME ⇒ Custom Controls.
   ![Custom Controls Menu]

2. Select the custom control button you want to assign the Audio Memory to as follows:

   Note
   If you do not have any available custom control buttons on your Audio Bank, you can create a second Normal Bank.
   • Use the Bank knob to select the Audio Bank you created.
   • Use the Button knob to select the custom control button that you wish to program.
3. Navigate to the **Special Menu** as follows:
   
   - Press **Start Recording** ➔ **Insert Special** ➔ **Special**.

   ![Special Menu](image)

   **Insert Special — Special Menu**

4. Assign a particular **Audio Memory** to the selected custom control button as follows:
   
   - Use the **Function** knob to select **Audio Memory**.
   - Use the **Memory** knob to select the memory, or event, that you want to recall from the Remote Audio Mixer.

5. Press **Insert** to enter the command in your custom control.

6. Press **HOME** to display the **Main Menu 1-2**.

7. Press **Custom Controls** to return to the **Custom Controls Menu**.

8. Press **Finish Recording**, or the flashing custom control button.

This completes the procedure for creating an **Audio Memory** custom control.

**Audio CH On**

The **Audio CH On** custom control will turn a channel, or group, on at the level it was last on at, or leave it unchanged if the channel is already on. This can be useful if you want to take a channel, or group, to air at once. You can use the **Audio CH On** for either the **PGM** or **PST** bus.

![Custom Controls Menu](image)

**Note**

You can assign multiple **Audio CH On** macros to the same custom control, allowing you to turn a number of channels, or groups, on for either the **PGM** or **PST** bus. Unlike the Audio Memory function, **Reset Audio** will return the switcher to AFV mode.

Use the following procedure to create an **Audio CH On** custom control:

1. Navigate to the **Custom Controls Menu** as follows:
   
   - Press **HOME** ➔ **Custom Controls**.
2. Select the custom control button you want to assign the Audio CH On to as follows:
   - Use the Bank knob to select the Audio Bank you created.
   - Use the Button knob to select the custom control button that you wish to program.
3. Navigate to the Special Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ Special.

4. Assign Audio CH On to the selected custom control button as follows:
   - Use the Function knob to select Audio CH On.
   - Use the Channel knob to select the audio channel you want to turn on.
   - Use the Audio Bus knob to select which bus, PGM or PST, the audio channels will be turned on for.

   **Note**  
   If you select Preset, the audio channels will turn on for the PST bus and will be taken to air during the next transition. If you select Program, the audio channels will be taken to air immediately.

5. Press Insert to enter the command in your custom control.
6. Press HOME to display the Main Menu 1-2.
7. Press Custom Controls to return to the Custom Controls Menu.
8. Press Finish Recording, or the flashing custom control button.

This completes the procedure for creating an Audio CH On custom control.

**Audio CH Off**

The Audio CH Off custom control will turn a channel or group off. This can be useful if you want to turn a specific channel, or group, off while not affecting the other channels. You can use the Audio CH Off for either the PGM or PST bus.

**Note**  
You can assign multiple Audio CH Off macros to the same custom control, allowing you to turn a number of channels or groups off on either the PGM or PST bus.
Use the following procedure to create an **Audio CH Off** custom control:

1. Navigate to the **Custom Controls Menu** as follows:
   - Press **HOME** ⇒ **Custom Controls**.

   ![Custom Controls Menu]

   **Note** If you do not have any available custom control buttons on your **Audio Bank**, you can create a second **Normal Bank**.

2. Select the custom control button you want to assign the **Audio CH Off** to as follows:
   - Use the **Bank** knob to select the Audio Bank you created.
   - Use the **Button** knob to select the custom control button that you wish to program.

3. Navigate to the **Special Menu** as follows:
   - Press **Start Recording** ⇒ **Insert Special** ⇒ **Special**.

   ![Insert Special — Special Menu]

4. Assign **Audio CH Off** to the selected custom control button as follows:
   - Use the **Function** knob to select **Audio CH Off**.
   - Use the **Channel** knob to select the audio channel you want to turn off.
   - Use the **Audio Bus** knob to select the which bus, **PGM** or **PST**, the audio channels will be turned off for.

   **Note** If you select **Preset**, the audio channels will turn off for the **PST** bus. If you select **Program**, the audio channels will be taken off air immediately.

5. Press **Insert** to enter the command in your custom control.

6. Press **HOME** to display the **Main Menu 1-2**.

7. Press **Custom Controls** to return to the **Custom Controls Menu**.

8. Press **Finish Recording**, or the flashing custom control button.
This completes the procedure for creating an Audio CH Off custom control.

**PGM Audio Level**

The PGM Audio Level custom control will set the PGM bus level for an audio channel or group. If the Channel is on-air, this will alter the level for the channel. If the Channel is not on air, this will take it to air as an override. PGM Audio Level differs from Audio CH On in that you select the level that you want the channel to be set to. When run, the custom control will alter the level of the channel, even if it is on. Audio CH On will only turn the channel on if it is off and will not change the level. This could be useful when you want to alter the levels of a number of channels, or groups, at the same time.

**Note**

You can assign multiple PGM Audio Level macros to the same custom control, allowing you to alter the levels for a number of channels at the same time.

Use the following procedure to create a PGM Audio Level custom control:

1. Navigate to the Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to assign the PGM Audio Level to as follows:
   - Use the Bank knob to select the Audio Bank you created.
   - Use the Button knob to select the custom control button that you wish to program.

3. Navigate to the Special Menu as follows:
   - Press Start Recording ⇒ Insert Special ⇒ Special.

**Note**

If you do not have any available custom control buttons on your Audio Bank, you can create a second Normal Bank.
4. Assign **PGM Audio Level** to the selected custom control button as follows:
   - Use the **Function** knob to select **PGM Audio Lvl**.
   - Use the **Channel** knob to select the audio channel you want to change the level for.
   - Use the **Level** knob to select the level you want to set the channel to.
5. Press **Insert** to enter the command in your custom control.
6. Press **HOME** to display the **Main Menu 1-2**.
7. Press **Custom Controls** to return to the **Custom Controls Menu**.
8. Press **Finish Recording** or the flashing custom control button.

This completes the procedure for creating an **PGM Audio Level** custom control.

**PST Audio Level**

The **PST Audio Level** custom control will set the **PST** bus level for an audio channel or group. If the channel is **on-air**, this will create an override that will take the channel to the new level during the next transition. If the channel is **off-air**, this will create an override that will take the channel to air at the new level on the next transition. This could be useful if you want to prepare a number of channels or groups at a set level to be taken to air on the next transition.

**Note**

You can assign multiple **PST Audio Level** macros to the same custom control, allowing you to alter the levels for a number of channels at the same time.

Use the following procedure to create an **PST Audio Level** custom control:

1. Navigate to the **Custom Controls Menu** as follows:
   - Press **HOME ⇒ Custom Controls**.

2. Select the custom control button you want to assign the **PST Audio Level** to as follows:
   - Use the **Bank** knob to select the Audio Bank you created.
   - Use the **Button** knob to select the custom control button that you wish to program.

**Note**

If you do not have any available custom control buttons on your **Audio Bank**, you can create a second **Normal Bank**.
3. Navigate to the Special Menu as follows:
   • Press Start Recording ⇒ Insert Special ⇒ Special.

4. Assign PST Audio Level to the selected custom control button as follows:
   • Use the Function knob to select PST Audio Lvl.
   • Use the Channel knob to select the audio channel you want to change the level for.
   • Use the Level knob to select the level you want to set the channel to.

5. Press Insert to enter the command in your custom control.

6. Press HOME to display the Main Menu 1-2.

7. Press Custom Controls to return to the Custom Controls Menu.

8. Press Finish Recording, or the flashing custom control button.

This completes the procedure for creating an PST Audio Level custom control.
Audio Modes

When a Remote Audio Mixer is connected to the Synergy switcher, it can be operated in one of three modes: normal Audio-Follow-Video (AFV) mode, Override mode, and Editor mode.

Audio-Follow-Video Mode

The AFV mode is where an audio channel is taken to air when the video BNC it is assigned to is taken to air. The audio will follow the video on and off air like this for all transitions on the PGM/PST MLE, unless the Audio Transitions Personality has been set to All. Refer to the section “Audio Transitions Personality” on page 21–46 for more information on setting the Audio Transitions Personality.

For example, there may be a number of camera setups in the studio, each one focusing on a different talent. When a particular camera is taken to air, you also want the audio from the talent’s microphone to be taken to air. When that camera is taken off air, you also want the corresponding audio channel to be taken off air. This is the normal AFV mode of operation.

Note

Remember that if you Fly a Key and then expand it to full frame, the underlying video is still on-air, even though you cannot see it. The audio for both video sources will still be on-air. This is also important to remember if you are running shots from memories where you bring a Key full frame from an over the shoulder shot.

Override Mode

The Override mode is when the normal AFV mode has been altered, either by changing the levels, taking more or less channels to air, or altering the channels that will be taken to air on the next transition. Overrides are applied by using one of the custom controls discussed in the section “Audio Override Setup” on page 21–32. For example, if you have an over the shoulder shot, the audio channels for both the talent and the Key would be on-air as per normal AFV. If you transition to a shot with only the VTR clip, then the audio from the talent would be taken off. If you wanted both audio channels to remain, you would have to set up an override by turning on the audio crosspoint for the talent on the PST bus. When you make the transition, the switcher will take the video off air, but will keep the audio on.

Editor Mode

The Editor mode is when the switcher is being remotely operated by the OverDrive production control system. OverDrive will perform both AFV and overrides without having to setup any override custom controls. For more information on OverDrive, contact Ross Video.
Operation Overview

This section will provide a brief overview of the operation of the switcher when performing audio transitions.

During all audio transitions, the switcher keeps track of three separate levels for each audio channel, or group:

- **Current** — The Current level is the level of the channel, or group, that is currently on-air. This level can be adjusted using the PGM Audio Lvl custom control that is assigned to that channel, or group.

- **Preset** — The Preset level is the level of the channel, or group, that will take effect during the next transition of the audio. This level can be adjusted using the PST Audio Lvl custom control that is assigned to that channel, or group.

- **Default** — The Default level is the level that the channel, or group, was set to originally from the Audio Installation Menu. When you perform an Audio Reset, all off-air audio channels will have their preset levels changed to the default level. This will not change the Preset values for the audio channels that are on-air.

**Note** Preset Levels only take effect when an audio channel, or group, is transitioned to air, and do not take affect during cuts or crosspoint changes.

**Note** The Synergy switcher keeps track of all three of these audio levels for each channel, or group, and will use them when that channel, or group, is transitioned.

Audio Transitions

During an audio transition, the Synergy switcher prepares to take the Preset audio channels to air as follows:

1. The switcher applies the normal Audio-Follow-Video rules to select which channels, or groups, will be taken to air.

2. The switcher checks for preset overrides that will turn channels, or groups, off or on, depending on how they are set in the Audio PST Bus.

3. The switcher performs the audio transition by fading the PST channels to their Preset audio levels. These levels then become the Current levels for those channels, or groups.

**Note** When an audio channel is faded off by dragging the level to zero on the Remote Audio Mixer, that channel will return to the default level the next time it is taken to air.

4. The switcher then saves the Current levels of the audio channels that were taken off-air as the Preset levels for those channels, or groups. These levels will be used as the Preset levels for the next transition.
Audio Specific Functions

This section will describe a number of audio only functions that can be performed on the switcher to adjust the audio setting of the Remote Audio Mixer.

Audio Only Transitions

With the audio override custom controls properly set up, it is possible to perform an audio only transition. This transition will not alter the video signals on the PGM or PST bus, but will transition the audio crosspoints on those buses.

Use the following procedure to perform an Audio Only Transition:

1. Press and **hold** the Bank Custom Control button to place the PGM/PST MLE into Audio Mixer mode.

2. Select the audio crosspoints that you want to take to air on the PST bus.

3. Press **Auto Trans** in the PGM/PST MLE Transition Group to perform the audio only transition.

**Important**

Audio Only Transitions should only be performed once as they will create an audio override. In order to properly perform your next transition, you should check the audio crosspoints and run as Audio Reset PST to return to AFV, if needed.

This completes the procedure for performing an Audio Only Transition.

Audio Levels and Pan Settings

You can adjust the Audio Level for a particular channel, or the Master Level, and the pan settings using the Assign Audio custom control. Refer to the section “Assign Audio” on page 21–33 for more information.

Use the following procedure to adjust volume and pan settings of a selected audio channel or group:

1. Press the Custom Control button that has been assigned to the channel, or group, that you want to adjust to display the Audio Level Menu.
2. Adjust the Audio Level for the selected channel as follows:
   - Press the F1 softkey. In the above example, the softkey is Custom02, but this label changes depending on what you have named your audio channels.
   - Use the Channel knob to select the audio channel you want to adjust.
   - Use the Level knob to adjust the level of the channel. Note that a value of 0.0% sets the channel to Off.
   - Use the Pan knob to adjust the Pan Settings left or right. Turning the knob to the right will pan right and turning it left will pan left.

3. Adjust the Master Level as follows:
   - Press Master Level.
   - Use the Level knob to adjust the mixer level.

This completes the procedure for adjusting the pan and level settings for individual channels and the master.
Appendix A. Specifications

In this Appendix

This appendix provides technical specifications and connector pinout diagrams. In addition, a comprehensive table is provided that lists all normal, GPI, and special diagnostic Aux panel programming modes. The following sections are provided:

- Standard Components
- Physical Characteristics
- General Specifications
- Control Panel Specifications
- Rack Frame
- Rack Frame Connector Types
- Control Panel Connector Types
- Power Consumption
- Environmental
- Video Characteristics
- Video Processing
- System Timing
- Video Inputs
- Video Outputs
- Output Characteristics
- Frame Pinouts
- Control Panel Pinouts
- Remote Aux Panel Pinouts
- Aux Panel Programming Mode Summary

Note

All specifications are subject to change without notice.
Standard Components

The following components are standard on all models:

- Complete Control Panel
- Chroma Keying in Every Keyer
- 2 Pattern Generators per MLE
- Wipes in Program/Preset
- 12 Untimed Aux Buses
- Disk Drive and System Control Area
- Custom Control Macro Buttons
- 100 Event Memory System
- 12 GPI Inputs and 12 GPI Outputs
- 36 Tally Outputs
- 10 Meter (33 feet) Control Cable
- System Manuals
- 3 Year Transferable Warranty
## Physical Characteristics

### General Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Synergy 2</th>
<th>Synergy 3</th>
<th>Synergy 4</th>
</tr>
</thead>
<tbody>
<tr>
<td># MLE Systems</td>
<td>2</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td># Serial Digital Inputs *</td>
<td>16</td>
<td>24</td>
<td>32</td>
</tr>
<tr>
<td># Crosspoint Buttons</td>
<td>17</td>
<td>30</td>
<td>35</td>
</tr>
<tr>
<td># Serial Digital Outputs</td>
<td>18</td>
<td>20</td>
<td>22</td>
</tr>
<tr>
<td># Matte Generators</td>
<td>10</td>
<td>15</td>
<td>20</td>
</tr>
</tbody>
</table>

* Card expandable to 64

### Control Panel Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Synergy 2</th>
<th>Synergy 3</th>
<th>Synergy 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>36.875&quot; (93.8 cm)</td>
<td>51.75&quot; (131.4 cm)</td>
<td>56.25&quot; (143.9 cm)</td>
</tr>
<tr>
<td>Height</td>
<td>11.25&quot; (28.6 cm)</td>
<td>11.625&quot; (29.5 cm)</td>
<td>12.5&quot; (31.8 cm)</td>
</tr>
<tr>
<td>Depth</td>
<td>22.375&quot; (56.8 cm)</td>
<td>24.125&quot; (61.3 cm)</td>
<td>29.0&quot; (73.7 cm)</td>
</tr>
<tr>
<td>Height above desktop</td>
<td>9.0&quot; (22.9 cm)</td>
<td>9.25&quot; (23.5 cm)</td>
<td>10.0&quot; (25.4 cm)</td>
</tr>
<tr>
<td>Desk cutout width</td>
<td>35.5&quot; (90.2 cm)</td>
<td>50.25&quot; (127.6 cm)</td>
<td>54.75&quot; (146.7 cm)</td>
</tr>
<tr>
<td>Desk cutout depth</td>
<td>21.25&quot; (54.0 cm)</td>
<td>23.0&quot; (58.4 cm)</td>
<td>28.0&quot; (70.5 cm)</td>
</tr>
</tbody>
</table>

### Rack Frame

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td># Rack Units (RU)</td>
<td>11</td>
</tr>
<tr>
<td>Width</td>
<td>19.00&quot; (48.3 cm)</td>
</tr>
<tr>
<td>Height</td>
<td>19.5&quot; (49.5 cm)</td>
</tr>
<tr>
<td>Depth</td>
<td>19.25&quot; (48.9 cm)</td>
</tr>
</tbody>
</table>
Rack Frame Connector Types

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video</td>
<td>BNC Type</td>
</tr>
<tr>
<td>Editor</td>
<td>D type, 9 pin</td>
</tr>
<tr>
<td>Peripheral 1 and 2</td>
<td>D type, 9 pin</td>
</tr>
<tr>
<td>DVE 1 and 2</td>
<td>D type, 9 pin</td>
</tr>
<tr>
<td>GPI I/O</td>
<td>D type, 25 pin</td>
</tr>
<tr>
<td>To control panel</td>
<td>8 pin shielded Telco</td>
</tr>
<tr>
<td>AC power (primary, redundant)</td>
<td>3 pin IEC</td>
</tr>
</tbody>
</table>

Important

The cable connecting the Synergy Control Panel to the Synergy Frame is not wired as a standard CAT5 ethernet cable. If you need a cable of a specific length, contact your Ross Video Representative for ordering information.

Control Panel Connector Types

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote 1 through 8</td>
<td>D type, 9 pin</td>
</tr>
<tr>
<td>Tally out 1 through 4</td>
<td>D type, 25 pin</td>
</tr>
<tr>
<td>To rack frame</td>
<td>8 pin shielded Telco</td>
</tr>
<tr>
<td>AUX 1, 2, 3</td>
<td>6 pin shielded Telco</td>
</tr>
<tr>
<td>AC power 1 and 2</td>
<td>3 pin IEC</td>
</tr>
</tbody>
</table>

Power Consumption

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input voltage</td>
<td>90V<del>250 VAC, 47</del>63 Hz</td>
</tr>
<tr>
<td>Frame (with no options)</td>
<td>Synergy 4: 300 W</td>
</tr>
<tr>
<td>Frame (with all options)</td>
<td>TBD</td>
</tr>
<tr>
<td>Control panel</td>
<td>Synergy 2: 100 W</td>
</tr>
<tr>
<td></td>
<td>Synergy 3: 110 W</td>
</tr>
<tr>
<td></td>
<td>Synergy 4: 175 W</td>
</tr>
</tbody>
</table>
Power Rating - Tallies

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input voltage</td>
<td>24V AC (rms) / 40V DC</td>
</tr>
<tr>
<td>Maximum current</td>
<td>170mA</td>
</tr>
<tr>
<td>Impedance</td>
<td>&lt;15 ohms</td>
</tr>
</tbody>
</table>

Environmental

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel and rack frame separation</td>
<td>1000 ft (305m) max.</td>
</tr>
<tr>
<td>Ambient temperature range</td>
<td>0 - 40 degrees C</td>
</tr>
</tbody>
</table>

Please note:

- The video processing circuitry is cooled by three fans using side-to-side airflow. The power supplies have independent fan cooling using bottom-to-top airflow with intakes and vents at the side.
- The control panel is convection cooled (no fans) for silent operation.
Video Characteristics

Video Processing

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital video and key processing</td>
<td>10-bit 4:2:2 component</td>
</tr>
<tr>
<td>Key transparency</td>
<td>256 levels</td>
</tr>
<tr>
<td>Video standards</td>
<td>525/625 line support, auto detect</td>
</tr>
<tr>
<td>Aspect Ratio</td>
<td>4:3 and anamorphic 16:9 switchable</td>
</tr>
</tbody>
</table>

System Timing

- All video inputs are zero-time relative to reference input. Auto timing corrects for inputs out of time by up to ± ¼ line (16us).
- Refer to the section “System Timing” on page 9–56 for a complete technical overview of Synergy auto-timing.

Video Inputs

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of inputs:</td>
<td>Up to 64 (any model), upgradable in groups of 8:</td>
</tr>
<tr>
<td>Synergy 2:</td>
<td>16*, 24, 32, 40, 48, 56, or 64</td>
</tr>
<tr>
<td>Synergy 3:</td>
<td>24*, 32, 40, 48, 56, or 64</td>
</tr>
<tr>
<td>Synergy 4:</td>
<td>32*, 40, 48, 56, or 64</td>
</tr>
<tr>
<td>Equalization</td>
<td>&gt;150m to 270 MHz</td>
</tr>
<tr>
<td>Impedance</td>
<td>75 ohm, terminating</td>
</tr>
<tr>
<td>Return loss</td>
<td>&gt;20 dB</td>
</tr>
</tbody>
</table>

* Standard

Please note:

- All 64 inputs are BNC Male, SMPTE 259M-C serial digital, non-looping.
- Inputs can be used for either key or video.
- The reference input is SMPTE 259M-C and is chosen as one of the standard inputs. External A-D conversion is required for analog references.
### Video Outputs

<table>
<thead>
<tr>
<th>Output Type</th>
<th>Quantity</th>
<th>Synergy 2</th>
<th>Synergy 3</th>
<th>Synergy 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main PGM</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Preview Matrix (no overlay)</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>MLE 1 PGM (BKGID)</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>MLE 1 PV (PST)</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>MLE 2 PGM (BKGID)</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>MLE 2 PV (PST)</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>MLE 3 PGM (BKGID)</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>MLE 3 PV (PST)</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>MLE 4 PGM (BKGID)</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>MLE 4 PV (PST)</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Aux Bus</td>
<td>12</td>
<td>12</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>Clean Feed</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Total Outputs</td>
<td>19</td>
<td>21</td>
<td>23</td>
<td></td>
</tr>
</tbody>
</table>

Please note:

- All outputs are BNC Male, 75 ohm.
- Preview Matrix output (PV) is selectable.
- Four Expansion outputs are provided for future use.

### Output Characteristics

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return loss</td>
<td>&gt;18 dB @ 270 MHz</td>
</tr>
<tr>
<td>Rise time</td>
<td>800ps +/- 10%</td>
</tr>
<tr>
<td>Signal level</td>
<td>800 mV +/- 10%</td>
</tr>
<tr>
<td>DC offset</td>
<td>0 volts</td>
</tr>
<tr>
<td>Rise &amp; fall time</td>
<td>1 ns (20 - 80%)</td>
</tr>
<tr>
<td>Overshoot</td>
<td>&lt;8%</td>
</tr>
</tbody>
</table>

Please note:

- All video outputs are 10-bit SMPTE 259M-C serial digital.
- EDH is inserted into all video outputs except untimed Aux Buses, and can be disabled (via jumper) on a per-output basis.
Pinouts

The following sections provide tables of frame and control panel pinouts.

Frame Pinouts

This section provides pinouts for the following frame connectors:

- DVE 2
- Editor Connector
- DVE 1
- Peripheral 1A
- Peripheral 2A
- Peripheral 1B
- Peripheral 2B
- Panel Connector
- Standard GPI I/O Connector
- AC POWER

DVE 2, Editor Connector Pinouts

The table below lists pinouts for the DVE 2 and EDITOR connectors.

- Connector type: 9-pin “D” SUB Female
- Format: software selectable between RS-232 and RS-422

<table>
<thead>
<tr>
<th>Pin #</th>
<th>RS-232</th>
<th>RS-422</th>
<th>Pin #</th>
<th>RS-232</th>
<th>RS-422</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>n/c</td>
<td>n/c</td>
<td>6</td>
<td>n/c</td>
<td>n/c</td>
</tr>
<tr>
<td>2</td>
<td>Rx</td>
<td>TxA (Tx-)</td>
<td>7</td>
<td>n/c</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>3</td>
<td>Tx</td>
<td>RxB (Rx+)</td>
<td>8</td>
<td>n/c</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
<td>Ground</td>
<td>9</td>
<td>n/c</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>Ground</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

n/c = not connected
**DVE 1, Peripheral 1A, Peripheral 2A Connector Pinouts**

The table below lists pinouts for the DVE 1, PERIPHERAL 1A, and PERIPHERAL 2A connectors.

- Connector type: 9-pin “D” SUB Female
- Format: RS-422 Serial

**Peripheral 1B, Peripheral 2B, Panel Connector Pinouts**

The table below lists pinouts for the PERIPHERAL 1B, PERIPHERAL 2B and PANEL connectors.

- Connector type: 8-pin RJ-45 Telco Jack, Shielded
- Format (PERIPHERAL 1B, 2B): RS-422, shares the same internal circuitry as PERIPHERAL 1A, 2A connectors.
- Format (PANEL): RS-422 Data Link to Control Panel

---

### DVE 1, PERIPHERAL 1A, PERIPHERAL 2A Connector Pinouts

<table>
<thead>
<tr>
<th>Pin #</th>
<th>RS-422</th>
<th>Pin #</th>
<th>RS-422</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>n/c</td>
<td>6</td>
<td>n/c</td>
</tr>
<tr>
<td>2</td>
<td>TxA (Tx-)</td>
<td>7</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>3</td>
<td>RxB (Rx+)</td>
<td>8</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
<td>9</td>
<td>n/c</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

n/c = not connected

### PANEL Connector Pinouts

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TxB (Tx+)</td>
<td>5</td>
<td>ODD/EVEN+ (Transmit)</td>
</tr>
<tr>
<td>2</td>
<td>TxA (Tx-)</td>
<td>6</td>
<td>ODD/EVEN- (Transmit)</td>
</tr>
<tr>
<td>3</td>
<td>RxB (Rx+)</td>
<td>7</td>
<td>Ground (AC coupled)</td>
</tr>
<tr>
<td>4</td>
<td>RxA (Rx-)</td>
<td>8</td>
<td>Ground (AC coupled)</td>
</tr>
</tbody>
</table>
**Standard GPI I/O Connector Pinouts**

The table below lists pinouts for the GPI I/O connector.

- Connector type: 25-pin “D” SUB Female
- GPI Out 1-12: 0 ~ +5V swing (TTL-compatible) outputs
- GPI In 1-12: TTL-compatible inputs

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ground</td>
<td>14</td>
<td>GPI Out 12</td>
</tr>
<tr>
<td>2</td>
<td>GPI In 12</td>
<td>15</td>
<td>GPI Out 11</td>
</tr>
<tr>
<td>3</td>
<td>GPI In 11</td>
<td>16</td>
<td>GPI Out 10</td>
</tr>
<tr>
<td>4</td>
<td>GPI In 10</td>
<td>17</td>
<td>GPI Out 9</td>
</tr>
<tr>
<td>5</td>
<td>GPI In 9</td>
<td>18</td>
<td>GPI Out 8</td>
</tr>
<tr>
<td>6</td>
<td>GPI In 8</td>
<td>19</td>
<td>GPI Out 7</td>
</tr>
<tr>
<td>7</td>
<td>GPI In 7</td>
<td>20</td>
<td>GPI Out 6</td>
</tr>
<tr>
<td>8</td>
<td>GPI In 6</td>
<td>21</td>
<td>GPI Out 5</td>
</tr>
<tr>
<td>9</td>
<td>GPI In 5</td>
<td>22</td>
<td>GPI Out 4</td>
</tr>
<tr>
<td>10</td>
<td>GPI In 4</td>
<td>23</td>
<td>GPI Out 3</td>
</tr>
<tr>
<td>11</td>
<td>GPI In 3</td>
<td>24</td>
<td>GPI Out 2</td>
</tr>
<tr>
<td>12</td>
<td>GPI In 2</td>
<td>25</td>
<td>GPI Out 1</td>
</tr>
<tr>
<td>13</td>
<td>GPI In 1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**AC POWER Connector Pinouts**

The table below lists pinouts for the AC POWER connector.

- Connector type: 3-Pin IEC Male
Control Panel Pinouts

This section provides pinouts for the following control panel connectors:

- REMOTE 1-8
- FRAME
- AUX 1-3
- TALLY 1
- TALLY 2
- TALLY 3
- TALLY 4
- LINE 1, LINE 2 POWER

Remote 1-8 Connector Pinouts

The table below lists pinouts for the REMOTE 1-8 (VTR Port) connectors.

- Connector type: 9-pin “D” SUB Female
- Format: software selectable between RS-232 and RS-422

<table>
<thead>
<tr>
<th>Pin #</th>
<th>RS-232</th>
<th>RS-422</th>
<th>Pin #</th>
<th>RS-232</th>
<th>RS-422</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis</td>
<td>Chassis</td>
<td>6</td>
<td>Ground</td>
<td>Ground</td>
</tr>
<tr>
<td>2</td>
<td>Tx</td>
<td>RxA (Rx-)</td>
<td>7</td>
<td>n/c</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>3</td>
<td>Rx</td>
<td>TxB (Tx+)</td>
<td>8</td>
<td>n/c</td>
<td>TxA (Tx-)</td>
</tr>
<tr>
<td>4</td>
<td>n/c</td>
<td>n/c</td>
<td>9</td>
<td>Chassis</td>
<td>Chassis</td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>Ground</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

n/c = not connected
**Frame Connector Pinouts**

The table below lists pinouts for the **FRAME** connector.

- Connector type: 8-pin RJ-45 Telco Jack, Shielded
- Format: RS-422 Data Link to Frame

![Male on Cable](image1)

![Female on Control Panel](image2)

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RxB (Rx+)</td>
<td>5</td>
<td>ODD/EVEN+ (Receive)</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
<td>6</td>
<td>ODD/EVEN- (Receive)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
<td>7</td>
<td>Ground</td>
</tr>
<tr>
<td>4</td>
<td>TxA (Tx-)</td>
<td>8</td>
<td>Ground</td>
</tr>
</tbody>
</table>

**Aux 1-3 Connector Pinouts**

The table below lists pinouts for the **AUX 1-3** connector.

- Connector type: 6-pin RJ-12 Telco Jack, Shielded
- Format: RS-422 Data Link to Remote Aux Panels

![Male on Cable](image3)

![Female on Control Panel](image4)

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RxA (Rx-)</td>
<td>4</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>2</td>
<td>RxB (Rx+)</td>
<td>5</td>
<td>RESET (Transmit)</td>
</tr>
<tr>
<td>3</td>
<td>TxA (Tx-)</td>
<td>6</td>
<td>Ground</td>
</tr>
</tbody>
</table>
**Tally 1 Connector Pinouts**

The table below lists pinouts for the TALLY 1 connector.

- Connector type: 25-pin “D” SUB Female
- Format: Relay contact closure to TALLY COMMON
- Diagram for all four tally connectors:

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TALLY 1</td>
<td>14</td>
<td>TALLY 2</td>
</tr>
<tr>
<td>2</td>
<td>TALLY 3</td>
<td>15</td>
<td>TALLY 4</td>
</tr>
<tr>
<td>3</td>
<td>TALLY 5</td>
<td>16</td>
<td>TALLY 6</td>
</tr>
<tr>
<td>4</td>
<td>TALLY 7</td>
<td>17</td>
<td>TALLY 8</td>
</tr>
<tr>
<td>5</td>
<td>TALLY 9</td>
<td>18</td>
<td>TALLY 10</td>
</tr>
<tr>
<td>6</td>
<td>TALLY 11</td>
<td>19</td>
<td>TALLY 12</td>
</tr>
<tr>
<td>7</td>
<td>TALLY 13</td>
<td>20</td>
<td>TALLY 14</td>
</tr>
<tr>
<td>8</td>
<td>TALLY 15</td>
<td>21</td>
<td>TALLY 16</td>
</tr>
<tr>
<td>9</td>
<td>TALLY 17</td>
<td>22</td>
<td>TALLY 18</td>
</tr>
<tr>
<td>10</td>
<td>TALLY COMMON</td>
<td>23</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>11</td>
<td>TALLY COMMON</td>
<td>24</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>12</td>
<td>TALLY COMMON</td>
<td>25</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>13</td>
<td>TALLY COMMON</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Tally 2 Connector Pinouts**

The table below lists pinouts for the **TALLY 2** connector.

- Connector type: 25-pin “D” SUB Female
- Format: Relay contact closure to TALLY COMMON

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TALLY 19</td>
<td>14</td>
<td>TALLY 20</td>
</tr>
<tr>
<td>2</td>
<td>TALLY 21</td>
<td>15</td>
<td>TALLY 22</td>
</tr>
<tr>
<td>3</td>
<td>TALLY 23</td>
<td>16</td>
<td>TALLY 24</td>
</tr>
<tr>
<td>4</td>
<td>TALLY 25</td>
<td>17</td>
<td>TALLY 26</td>
</tr>
<tr>
<td>5</td>
<td>TALLY 27</td>
<td>18</td>
<td>TALLY 28</td>
</tr>
<tr>
<td>6</td>
<td>TALLY 29</td>
<td>19</td>
<td>TALLY 30</td>
</tr>
<tr>
<td>7</td>
<td>TALLY 31</td>
<td>20</td>
<td>TALLY 32</td>
</tr>
<tr>
<td>8</td>
<td>TALLY 33</td>
<td>21</td>
<td>TALLY 34</td>
</tr>
<tr>
<td>9</td>
<td>TALLY 35</td>
<td>22</td>
<td>TALLY 36</td>
</tr>
<tr>
<td>10</td>
<td>TALLY COMMON</td>
<td>23</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>11</td>
<td>TALLY COMMON</td>
<td>24</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>12</td>
<td>TALLY COMMON</td>
<td>25</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>13</td>
<td>TALLY COMMON</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Tally 3 Connector Pinouts (Option)**

The table below lists pinouts for the optional **TALLY 3** connector.

- Connector type: 25-pin “D” SUB Female
- Format: Relay contact closure to TALLY COMMON

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TALLY 37</td>
<td>14</td>
<td>TALLY 38</td>
</tr>
<tr>
<td>2</td>
<td>TALLY 39</td>
<td>15</td>
<td>TALLY 40</td>
</tr>
<tr>
<td>3</td>
<td>TALLY 41</td>
<td>16</td>
<td>TALLY 42</td>
</tr>
<tr>
<td>4</td>
<td>TALLY 43</td>
<td>17</td>
<td>TALLY 44</td>
</tr>
<tr>
<td>5</td>
<td>TALLY 45</td>
<td>18</td>
<td>TALLY 46</td>
</tr>
<tr>
<td>6</td>
<td>TALLY 47</td>
<td>19</td>
<td>TALLY 48</td>
</tr>
<tr>
<td>7</td>
<td>TALLY 49</td>
<td>20</td>
<td>TALLY 50</td>
</tr>
<tr>
<td>8</td>
<td>TALLY 51</td>
<td>21</td>
<td>TALLY 52</td>
</tr>
<tr>
<td>9</td>
<td>TALLY 53</td>
<td>22</td>
<td>TALLY 54</td>
</tr>
<tr>
<td>10</td>
<td>TALLY COMMON</td>
<td>23</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>11</td>
<td>TALLY COMMON</td>
<td>24</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>12</td>
<td>TALLY COMMON</td>
<td>25</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>13</td>
<td>TALLY COMMON</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Tally 4 Connector Pinouts (Option)**

The table below lists pinouts for the optional TALLY 4 connector.

- Connector type: 25-pin “D” SUB Female
- Format: Relay contact closure to TALLY COMMON

### TALLY 4 Connector Pinouts

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TALLY 55</td>
<td>14</td>
<td>TALLY 56</td>
</tr>
<tr>
<td>2</td>
<td>TALLY 57</td>
<td>15</td>
<td>TALLY 58</td>
</tr>
<tr>
<td>3</td>
<td>TALLY 59</td>
<td>16</td>
<td>TALLY 60</td>
</tr>
<tr>
<td>4</td>
<td>TALLY 61</td>
<td>17</td>
<td>TALLY 62</td>
</tr>
<tr>
<td>5</td>
<td>TALLY 63</td>
<td>18</td>
<td>TALLY 64</td>
</tr>
<tr>
<td>6</td>
<td>TALLY 65</td>
<td>19</td>
<td>TALLY 66</td>
</tr>
<tr>
<td>7</td>
<td>TALLY 67</td>
<td>20</td>
<td>TALLY 68</td>
</tr>
<tr>
<td>8</td>
<td>TALLY 69</td>
<td>21</td>
<td>TALLY 70</td>
</tr>
<tr>
<td>9</td>
<td>TALLY 71</td>
<td>22</td>
<td>TALLY 72</td>
</tr>
<tr>
<td>10</td>
<td>TALLY COMMON</td>
<td>23</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>11</td>
<td>TALLY COMMON</td>
<td>24</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>12</td>
<td>TALLY COMMON</td>
<td>25</td>
<td>TALLY COMMON</td>
</tr>
<tr>
<td>13</td>
<td>TALLY COMMON</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Line 1, Line 2 Power Connector Pinouts

The table below lists pinouts for the AC POWER connector.

- Connector type: 3-Pin IEC Male

#### AC POWER Connector Pinouts

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Neutral/Line 2</td>
<td>3</td>
<td>Ground</td>
</tr>
<tr>
<td>2</td>
<td>Line</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Remote Aux Panel Pinouts

This section provides pinouts for the following remote Aux panel connectors:

- Aux Panel GPI Connector (new version panels only)
- Aux Panel J1 Connector
- Aux Panel J5 Connector

**Aux Panel GPI Connector**

The table below lists pinouts for the Remote Aux Panel GPI connector.

---

**Note**

These specifications apply to *[new version]* remote Aux panels only. Old version panels do not include the GPI connector.

- Connector type: 9-pin “D” SUB Female
- Format: Active low, short-to-ground to activate

---

**Remote Aux Panel GPI Connector Pinouts**

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function *</th>
<th>GPI</th>
<th>Pin #</th>
<th>Function *</th>
<th>GPI</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Input 1</td>
<td>GPI</td>
<td>6</td>
<td>Input 6</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Input 2</td>
<td></td>
<td>7</td>
<td>Input 7</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Input 3</td>
<td></td>
<td>8</td>
<td>Input 8</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Input 4</td>
<td></td>
<td>9</td>
<td>n/a</td>
<td>Ground (common)</td>
</tr>
<tr>
<td>5</td>
<td>Input 5</td>
<td>Programmed Group #</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Copy this page for each Remote Panel. Fill in the intended function (in the Function column), and fill in the Programmed Group number in the space provided. Store each sheet in a safe place for reference.

**Caution**

GPI inputs are only intended for connection to “dry contact”, open collector type transistor outputs, or 5 VDC signals. Application of any negative voltages or voltages in excess of 5 VDC may permanently damage the GPI inputs.
Aux Panel J1 Connector Pinouts

The table below lists pinouts for the Remote Aux Panel J1 connector.

- Connector type: 6-pin RJ-12 Telco Jack, Shielded
- Format: RS-422 Data Link from Remote Aux Panel to Panel

Note

These specifications apply to both old version panels (J1, Extension) and new version panels (J1, Echo).

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RxA (Rx-)</td>
<td>4</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>2</td>
<td>RxB (Rx+)</td>
<td>5</td>
<td>RESET (Out)</td>
</tr>
<tr>
<td>3</td>
<td>TxA (Tx-)</td>
<td>6</td>
<td>Ground</td>
</tr>
</tbody>
</table>

Aux Panel J5 Connector Pinouts

The table below lists pinouts for the Remote Aux Panel J5 connector.

- Connector type: 6-pin RJ-12 Telco Jack, Shielded
- Format: RS-422 Data Link from Switcher to Remote Aux Panel

Note

These specifications apply to both old version panels (J5, Control) and new version panels (J5, Main).

<table>
<thead>
<tr>
<th>Pin #</th>
<th>Function</th>
<th>Pin #</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TxA (Tx-)</td>
<td>4</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>2</td>
<td>TxB (Tx+)</td>
<td>5</td>
<td>RESET (In)</td>
</tr>
<tr>
<td>3</td>
<td>RxA (Rx-)</td>
<td>6</td>
<td>Ground</td>
</tr>
</tbody>
</table>
## Aux Panel Programming Mode Summary

The table below summarizes all normal, GPI, and special diagnostic Aux panel programming modes for new generation remote Aux panels.

### Aux Panel Programming Mode Button Assignment

<table>
<thead>
<tr>
<th>Button / LED</th>
<th>Normal Mode</th>
<th>Program Mode Bus Assignment (*1)</th>
<th>Program Mode GPI Offset</th>
<th>Power Up Diagnostic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (Black)</td>
<td>Select Xpt 1</td>
<td>Display/modify this panel’s rights to Aux Bus 1</td>
<td>Set GPI to group 1 (offset 0) (*2)</td>
<td>Start Walking LED Test (*6)</td>
</tr>
<tr>
<td>2</td>
<td>Select Xpt 2</td>
<td>Display/modify this panel’s rights to Aux Bus 2</td>
<td>Set GPI to group 2 (offset 1)</td>
<td>Start Pushbutton LED test</td>
</tr>
<tr>
<td>3</td>
<td>Select Xpt 3</td>
<td>Display/modify this panel’s rights to Aux Bus 3</td>
<td>Set GPI to group 3 (offset 2)</td>
<td>Start DUART Test (*3)</td>
</tr>
<tr>
<td>4</td>
<td>Select Xpt 4</td>
<td>Display/modify this panel’s rights to Aux Bus 4</td>
<td>Set GPI to group 4 (offset 3)</td>
<td>Start EEPROM Test</td>
</tr>
<tr>
<td>5</td>
<td>Select Xpt 5</td>
<td>Display/modify this panel’s rights to Aux Bus 5</td>
<td>Set GPI to group 5 (offset 4)</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Select Xpt 6</td>
<td>Display/modify this panel’s rights to Aux Bus 6</td>
<td>Set GPI to group 6 (offset 5)</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Select Xpt 7</td>
<td>Display/modify this panel’s rights to Aux Bus 7</td>
<td>Set GPI to group 7 (offset 6)</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Select Xpt 8</td>
<td>Display/modify this panel’s rights to Aux Bus 8</td>
<td>Set GPI to group 8 (offset 7)</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Select Xpt 9</td>
<td>Display/modify this panel’s rights to Aux Bus 9</td>
<td>GPI 8 Status (ON = shorted to ground)</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Select Xpt 10</td>
<td>Display/modify this panel’s rights to Aux Bus 10</td>
<td>GPI 7 Status (ON = shorted to ground)</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Select Xpt 11</td>
<td>Display/modify this panel’s rights to Aux Bus 11</td>
<td>GPI 6 Status (ON = shorted to ground)</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Select Xpt 12</td>
<td>Display/modify this panel’s rights to Aux Bus 12</td>
<td>GPI 5 Status (ON = shorted to ground)</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Select Xpt 13</td>
<td></td>
<td>GPI 4 Status (ON = shorted to ground)</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Select Xpt 13</td>
<td></td>
<td>GPI 3 Status (ON = shorted to ground)</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Select Xpt 15</td>
<td></td>
<td>GPI 2 Status (ON = shorted to ground)</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Select Xpt 16</td>
<td></td>
<td>GPI 1 Status (ON = shorted to ground)</td>
<td>LED used in EEPROM test</td>
</tr>
<tr>
<td>17 (Shift) (*5)</td>
<td>Select Xpt 17 or Shift</td>
<td>Toggle between allowing Shifted Xpts or allowing only simple Xpts (*4)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### AUX CLEAN FEED

- **Switch to GPI program mode. LED flashes.**
- **Switch to Assignment Program mode.**

### AUX PROGRAM

- **Send software version message to main panel**
- **Send software version message to main panel**

### AUX ACTIVE LED

- **Indicates selected Aux Xpt is used in Program output:**
  - **Flashing**
  - **Flashing (along with Clean Feed)**
  - **Test Fail Status (*6)**

---

22–18 • Appendix A. Specifications Synergy Series Installation Guide (v18)
Please note:

(*1) For the first 12 LEDs in this column, information applies to the Synergy 3 and 4 assignable panels only. On the Synergy 2 assignable panels, use the 12 assignment buttons on the bottom row of the panel.

(*2) LED indicates the current group setting. Only one LED in the first eight switches can be ON at a time. A panel that has never been programmed may have all eight LEDs OFF, until it is programmed to one of the eight possible GPI groups.

(*3) Requires special loop-back tester cables. Contact Technical Support for details.

(*4) Only used on older version main panel software. New main panel software sets this value automatically to be the same as the panel during normal operation. The LED displays the state of this option. The Panel does not support special modes of shifted crosspoints (such as Reverse Shift, etc.).

(*5) On the Synergy 3 panel, the LED is located at Shift/30, on Synergy 4, the LED is located at Shift/35.

(*6) In the EEPROM and DUART tests, the “Active” LED indicates Test Failed if the “Active” LED remains lit. In the same tests, the Xpt 1 (Black) LED indicates Test Passed when lit.
Appendix B. Diagnostics

In this Appendix

This appendix provides information on the full array of Synergy diagnostic tools. The following topics are discussed:

• Synergy Diagnostic Tools
• Displaying Panel Information
• Potentiometer Test
• Fader Test
• Joystick Test
• Button Test
• Lamp Test
• Memory Test
• Display Test
• Disk Test
• TX/RX Test
• Tally Test
• DIP/Jump Test
• Frame Diagnostic Tools
• TX/RX Test
• DIP/Jump Test
• GPI Test
• Internal Video Test
Synergy Diagnostic Tools

All Synergy switchers provide a full array of panel diagnostic tools. Each diagnostic function is discussed in the following sections:

- Displaying Panel Information
- Potentiometer Test
- Fader Test
- Joystick Test
- Button Test
- Lamp Test
- Memory Test
- Display Test
- Disk Test
- TX/RX Test
- Tally Test
- DIP/Jump Test

Displaying Panel Information

Note

The following menus are for reference only. No action can be taken.

Use the following procedure to display panel information:

1. Navigate to the Panel Diagnostics Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics.
2. Press Information to display the Panel Information Menu, a sample of which is shown below. Information is provided for both the panel and the frame.

<table>
<thead>
<tr>
<th>Panel Info</th>
<th>Frame Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dec 17 2006</td>
<td>Dec 17 2006</td>
</tr>
<tr>
<td>10:20:34</td>
<td>10:20:15</td>
</tr>
<tr>
<td>Synergy 10.00</td>
<td>Synergy 10.00</td>
</tr>
<tr>
<td>Stack:456789</td>
<td>Stack:890123</td>
</tr>
</tbody>
</table>

   Information Menu — System Display

3. Press Errors to display a list of Errors. Information is provided for the Synergy control panel and frame.
4. Use the Panel knob to scroll through a list of individual panel ports, with the communication errors for the selected port being displayed in the main area of the display. If Total Errors is selected, the displayed information will include all communication errors for the entire panel.

5. Use the Frame knob to scroll through a list of individual frame ports, with the communication errors for the selected port being displayed in the main area of the display. If Total Errors is selected, the displayed information will include all communication errors for the entire frame.

6. Press Reset Count to manually reset the error counts. Please note, however, that all counts are automatically reset on power up.

This completes the procedure to display panel information.

**Potentiometer Test**

The Pots Test Menu allows you to test the response of all potentiometers on the Synergy panel.

Use the following procedure to test the potentiometers:

1. Navigate to the Panel Diagnostics Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics.
2. Press Pots Test to display the Pots Test Menu.

3. Test the three knobs to the right of the display as follows:
   - Press Normal.
   - Turn each knob clockwise and counterclockwise.

   The display indicates the rate at which you are turning the knob with a numeric display and bar graph.
4. Test all other knobs as follows:
   - Press **Scaled**.
   - Turning the knob will display the absolute position of the knob both numerically and graphically. The number (displayed in hexadecimal) should range from **0** (full counter-clockwise) to **FFF** (full clockwise). The number should be stable and jitter-free.

   **Note**  
   Contact Technical Support for details on each display value, or if a problem with a potentiometer is suspected.

This completes the procedure to test the potentiometers.

**Fader Test**

The **Fader Test Menu** allows you to test all the MLE faders on the Synergy control panel.

Use the following procedure to test the faders:

1. Navigate to the **Panel Diagnostics Menu 1-2** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics.
2. Press **Fader Test** to display the **Fader Test Menu**.

3. Test the fader as follows:
   - Press **Normal**.
   - Move the fader up and down.
   - The position of the fader is shown both numerically (in hexadecimal) and graphically. The number should range from **000** (up) to **FFF** (down), and the number should be stable and jitter-free.

   **Note**  
   Contact Technical Support for details on each display value, or if a problem with the fader is suspected.

This concludes the procedure to test the faders.

**Synergy Slots**

The Synergy control panel incorporates a special mode in which pseudo-random information is statistically measured on a cumulative basis.
Use the following procedure to play the Synergy Slots:

1. Navigate to the **Fader Test Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics ⇒ Fader Test.
2. Press the F6 softkey to display the **Synergy Slots Menu**.

This action causes all button LEDs to turn off, with only the F1 and MORE softkeys, and the Fader in the Transition Area of MLE 1 remaining active. The Fader serves as a “slot machine arm”.

3. Move the fader in the Transition Area of MLE 1 first to the upper limit and then to the lower limit. This will cause the Synergy Slots to cycle for several seconds, and then settle on various pay line symbols.
   - When a winning combination of pay line symbols occurs, the panel reacts as follows:
     - the button LEDs on the lower area of the control panel flash randomly
     - the number of credits won flashes with the new total number of credits on the Synergy Slots Menu
   - Winning pay line symbol combinations award credits as per the payout table entitled “Pay Line Payout Table”. The average payoff rate is approximately 239.4 percent. You can also press MORE to display the Pay Line Payout Table.

<table>
<thead>
<tr>
<th>Pay Line Symbols</th>
<th>Credit Payout</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 Ross Logos</td>
<td>1000</td>
</tr>
<tr>
<td>3 Lucky 7s</td>
<td>250</td>
</tr>
<tr>
<td>3 Oranges</td>
<td>30</td>
</tr>
<tr>
<td>3 Lemons</td>
<td>25</td>
</tr>
<tr>
<td>3 Apples</td>
<td>20</td>
</tr>
<tr>
<td>3 Cherries</td>
<td>20</td>
</tr>
<tr>
<td>3 Bells</td>
<td>15</td>
</tr>
<tr>
<td>3 Bars</td>
<td>15</td>
</tr>
<tr>
<td>3 Stars</td>
<td>10</td>
</tr>
<tr>
<td>3 Diamonds</td>
<td>10</td>
</tr>
<tr>
<td>2 Ross Logos</td>
<td>10</td>
</tr>
<tr>
<td>1 Ross Logo</td>
<td>3</td>
</tr>
</tbody>
</table>
• The amount of credits won on any one pull of the arm will determine the number of flashing buttons on the panel. There are three “levels” of a “win”. Refer to the “LED Illumination Levels Table” for detailed information.
• The highest number of credits you can accumulate is 9999, and the lowest is 0.

<table>
<thead>
<tr>
<th>Level</th>
<th>% of LEDs Illuminated</th>
<th>Credits Won</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>6.25%</td>
<td>&lt; 10</td>
</tr>
<tr>
<td>2</td>
<td>12.5%</td>
<td>10 to 100</td>
</tr>
<tr>
<td>3</td>
<td>25%</td>
<td>&gt; 100</td>
</tr>
</tbody>
</table>

4. To exit the Synergy Slots, press HOME to display the Main Menu 1-2; or press UP ONE to display the Fader Test Menu.

This concludes the procedure to play the Synergy Slots.

**Joystick Test**

The Joystick Test Menu allows you to test all three axes of the Joystick.

Use the following procedure to test the Joystick:

1. Navigate to Panel Diagnostics Menu 1-2 as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics.
2. Press Joystick Test to display the Joystick Test Menu.
3. Select Normal, Scaled or Raw values for the menu display, and test each Joystick axis as required.

**Note**

Contact Technical Support for details on each display value.

This completes the procedure to test the Joystick.
Button Test

The **Button Test Menu** allows you to test all pushbuttons on the Synergy control panel.

Use the following procedure to test the buttons:

1. Navigate to **Panel Diagnostics Menu 1-2** as follows:
   - Press HOME ⇄ MORE ⇄ Setup ⇄ Panel Diagnostics.

2. Press **Button Test** to display the **Button Test Menu**.

<table>
<thead>
<tr>
<th>Button Test</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Button</td>
<td>67</td>
</tr>
<tr>
<td>Area</td>
<td>88</td>
</tr>
<tr>
<td>Mode</td>
<td>01</td>
</tr>
<tr>
<td>Last action</td>
<td>Button Up</td>
</tr>
</tbody>
</table>

3. Press each button as required.

4. To exit the menu, press both **Exit** buttons beneath the display.

This completes the procedure to test the buttons.

Lamp Test

The **Lamp Test Menu** allows you to test large groups of buttons on the Synergy control panel.

Use the following procedure to test the lamps:

1. Navigate to the **Panel Diagnostics Menu 1-2** as follows:
   - Press HOME ⇄ MORE ⇄ Setup ⇄ Panel Diagnostics.

2. Press **Lamp Test** to display the **Lamp Test Menu**.

<table>
<thead>
<tr>
<th>Lamp Test</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold down F5 and F6, then release them to exit lamp test mode</td>
<td></td>
</tr>
</tbody>
</table>

3. Press buttons in selected panel regions, to test all lamps in those regions as required.

4. To exit the menu, press both **Exit** buttons beneath the display.

This completes the procedure to test the lamps.
Memory Test

The Memory Test Menu allows you to test various system EPROMs.

Use the following procedure to test the memory:

1. Navigate to the Panel Diagnostics Menu 2-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics⇒ MORE.
2. Press Memory Test to display the Memory Test Menu.

   Memory Test Menu

3. Test the EPROMs as follows:
   - Press Test to initiate the test of the first EPROM.
   - Press Test again to continue testing each EPROM in succession.
   - The menu will report Pass or Fail per the results of each test.

This completes the procedure to test the memory.

Display Test

The Display Test Menu allows you to test the display of the Global Memory System Group.

Use the following procedure to test the display:

1. Navigate to the Panel Diagnostics Menu 2-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics⇒ MORE.
2. Press Display Test to display the Display Test Menu and test the mnemonics displays.

   Display Test Menu

3. Press any button below the display to advance to the next in the series of display tests. A variety of tests are available.

This completes the procedure to test the display.
**Disk Test**

The **Disk Test Menu** allows you to test the floppy disk drive or USB port of the Synergy switcher.

**Caution**

| The contents of the floppy disk, or USB key, will be lost when you perform this test. |

Use the following procedure to test the floppy disk drive or USB port:

1. Navigate to the **Panel Diagnostics Menu 2-2** as follows:
   * Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics ⇒ MORE.
2. Press **Disk Test** to display the **Disk Test Menu**.

   ![Disk Test Menu]

   **Disk Test Menu**

3. Test the floppy disk drive or USB port as follows:
   * Insert a blank disk or a pre-formatted disk into the drive. If you have a USB port, insert a blank USB key.
   * Press **Test** to begin the read/write test.
   * The menu will report Pass or Fail per the results of the test.

This completes the procedure to test the floppy disk drive or USB port of the Synergy switcher.

**TX/RX Test**

The **TX/RX Test Menu** allows you to test communications with various remote control and communications ports. The internal test checks the UART which generates the serial data stream. The external test additionally tests the line drivers and receivers.

**Note**

| A proper loop-back connector is required to conduct the external test |

Use the following procedure to test TX/RX functions:

1. Navigate to **Panel Diagnostics Menu 2-2** as follows:
   * Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics ⇒ MORE.
2. Press **TX/RX Test** to display the **Panel TX/RX Test Menu**.
3. Test a communication port as follows:

**Note** Peripheral equipment should be disconnected from the port while running the test.

- Use the **Com Port** knob to select the port that you wish to test.
- If available, attach an appropriate loop-back connector to the port that you wish to test.
- If a loop-back connector is not available, the system will only be able to perform a partial test (the UART will be tested, however, the line drivers and receivers will not).
- Press **Test** to begin the TX/RX test. The menu will report Pass or Fail per the results of the test.

This completes the procedure to test TX/RX functions. Repeat the procedure for each additional port that you wish to test.

**Monitoring TX/FX Functions**

You can also monitor the traffic on a selected communications port.

**Important** This option is used primarily for troubleshooting and diagnostic purposes. Therefore, you should not need to use this menu unless advised by Ross Video Technical Support.

Use the following procedure to monitor the traffic on a selected communications port:

1. Navigate to **Panel Diagnostics Menu 2-2** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Panel Diagnostics ⇒ MORE.
2. Press **TX/RX Test** to display the Panel TX/RX Test Menu.
3. Use the **Com Port** knob to select the port that you wish to monitor.

4. Press **Monitor** to display the **Com Port Monitor Menu**. This menu monitors the traffic on the port selected in step 3.

5. Press **Format** to toggle between **Hex** and **ASCII** to select how information is displayed:
   - **Hex** — Use this option to display the raw data as Hexadecimal numbers.
   - **ASCII** — Use this option to display the data as printed characters.

6. Press **View** to toggle between **Tx** and **Rx** as follows:
   - **Tx** — Use this option to display the traffic being transmitted from the panel.
   - **Rx** — Use this option to display the traffic being received by the panel.

7. Press **Freeze** to toggle between **Yes** and **No** as follows:
   - **Yes** — Use this option to freeze the current data on the display. New traffic data is not recorded.
   - **No** — Use this option to have old traffic data is continuously cycled out to allow space for the newest traffic data to be displayed.

8. Press **Clear** to clear all recorded data for the selected Tx or Rx traffic.

This completes the procedure to monitor the traffic on a selected communications port. Repeat this procedure for every communications port you wish to monitor.

**Tally Test**

The **Tally Test Menu** allows you to test all tally relays.

Use the following procedure to test tally relays:

1. Navigate to the **Panel Diagnostics Menu 2-2** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Panel Diagnostics** ⇒ **MORE**.

2. Press **Tally Test** to display the **Tally Test Menu**.
3. Select the desired tally function as follows:
   - **Prev** — Press this button to test the previous relay (as indicated on the menu).
   - **Next** — Press this button to test the next relay (as indicated on the menu).
   - **All On** — Press this button to turn all tally relays on.
   - **All Off** — Press this button to turn all tally relays off.

This completes the procedure to test tally relays.

**DIP/Jump Test**

The **DIP/Jump Test** allows you to test the DIP and jumper switches in the panel with the aid of a graphical representation on the display. The graphical representation runs in real time, meaning any changes made to the physical state of the panel DIP or jumper switches will be displayed instantly.

> **Important**
> As the switches are located within the electronics bay inside the Synergy control panel and covered with a protective plate, we do not advise accessing these switches without first contacting Ross Video Technical Support for assistance.

Use the following procedure to test the panel DIP and jumper switches:

1. Navigate to the **Panel Diagnostics Menu 2-2** as follows:
   - Press **HOME**, **MORE**, **Setup**, **Panel Diagnostics**, **MORE**.
2. Press **DIP/Jump Test** to display the **DIP/Jump Test Menu**.

This concludes the procedure to test the panel DIP and jumper switches.
Frame Diagnostic Tools

All Synergy switchers provide several frame diagnostic tools. Each diagnostic function is discussed in the following sections:

- TX/RX Test
- Monitoring the Frame TX/RX Functions
- DIP/Jump Test
- GPI Test
- Internal Video Test

TX/RX Test

The TX/RX Test Menu allows you to test frame communications with various remote control and communications ports. You can also monitor the traffic on the selected port.

Testing Frame TX/RX Functions

Use the following procedure to test frame TX/RX functions:

1. Navigate to the Frame Diagnostics Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Frame Diagnostics.
2. Press TX/RX Test to display the Frame TX/RX Test Menu.

   ![Frame TX/RX Test Menu]

3. Test a communications port on the Synergy frame as follows:
   - Use the Com Port knob to select the port that you wish to test.
   - Press Test to begin the Frame TX/RX test. The menu will report Pass or Fail per the results of the test.

This concludes the procedure to test frame TX/RX functions. Repeat the procedure for additional ports that you wish to test.

Monitoring the Frame TX/RX Functions

You can also monitor the traffic on a selected communications port of the frame.

Important

This option is used primarily for troubleshooting and diagnostic purposes. You should not need to use this option unless advised by Ross Video Technical Support.
Use the following procedure to monitor frame TX/RX functions:

1. Navigate to the Frame Diagnostics Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Frame Diagnostics.
2. Press TX/RX Test to display the Frame TX/RX Test Menu.

3. Use the Com Port knob to select the port that you wish to monitor.
4. Press Monitor to display the Com Port Monitor Menu.

5. Toggle the Format button between Hex and ASCII to set how the information is displayed.
   - Hex — Use this option to display the raw data as Hexadecimal numbers.
   - ASCII — Use this option to display the data as printed characters.
6. Toggle the View button between Tx and Rx to display traffic flow.
   - Tx — Use this option to display the traffic being transmitted from the frame.
   - Rx — Use this option to display the traffic being received by the frame.
7. Toggle the Freeze button between Yes and No.
   - Yes — Use this option to freeze the current data on the display and not record any new traffic data.
   - No — Use this option to continuously cycle traffic data to allow for the newest data to be displayed.
8. Press Clear to clear all recorded data for the selected traffic flow.

This concludes the procedure to monitor frame TX/RX functions.
DIP/Jump Test

The DIP/Jump Test allows you to test the DIP and jumper switches in the frame with the aid of a graphical representation on the display.

The graphical representation runs in real time, meaning any changes made to the physical state of the frame DIP or jumper switches will be displayed instantly.

**Important**

The majority of these switches are for factory use only, we do not advise accessing these switches without first contacting Technical Support for assistance.

Use the following procedure to test the frame DIP and jumper switches:

1. Navigate to the Frame Diagnostics Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Frame Diagnostics.
2. Press DIP/Jump Test to display the Frame DIP/Jump Test Menu.

This concludes the procedure to test the frame DIP and jumper switches.

GPI Test

The GPI Test uses a graphical display of light bulbs to indicate to the user which GPI inputs and outputs are On or Off.

Use the following procedure to test the GPI inputs and outputs:

1. Navigate to the Frame Diagnostics Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Frame Diagnostics.
2. Press GPI Test to display the GPI Test Menu.

This concludes the procedure to test the GPI inputs and outputs.
3. Select the desired GPI function as follows:
   • **Prev** — Press this button to test the previous input or output, as indicated on the menu.
   • **Next** — Press this button to test the next input or output, as indicated on the menu.
   • **All On** — Press this button to turn all GPI inputs and outputs on.
   • **All Off** — Press this button to turn all GPI inputs and outputs off.

This concludes the procedure to test the GPI inputs and outputs.

**Internal Video Test**

The **Internal Video Test** allows you to test the video paths within the Synergy frame.

![Important]

**Important** To perform this test, you will need a test file, which is provided by Ross Video Technical Support. This file contains stored memories, which were created using the Synergy switcher’s internally generated video sources, namely color backgrounds and washes. Contact Ross Video Technical Support before proceeding with this test.

When any memory is stored, the system does a video checksum and saves the information. Then, when the memory is recalled from the provided file, it compares the checksum with the one in the memory and gives a Pass or Fail result.

Use the following procedure to test the internal video paths:

1. Navigate to the **Frame Diagnostics Menu** as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Frame Diagnostics.

2. Press **Internal Video Test** to display the **Internal Video Test Menu**.

   ![Internal Video Test Menu]

3. Select an internal video test option as follows:
   • Press **Test All** to test all of the memory registers at once. This is the switcher default option.
   • Press **Test Single** to test a selected memory register only. The following menu is displayed.
• Use the Select memory knob to choose the memory you wish to test.

4. Press Run Test to begin the internal video test. The menu will report Pass or Fail per the results of the test.

This concludes the procedure to test the internal video paths.
Appendix C. Hardware Options

In This Appendix

This appendix provides instruction for installing a variety of hardware options. The following topics are discussed:

- Hardware Option Overview
- Clean Feed Installation
- Dual Aspectizer Option and Overview
- Dual Aspectizer Board Installation
- Upgrading Dual Aspectizer Boards
- Dual Aspectizer Setup
- Dual Aspectizer Mode Setups
- Dual Border Generator Installation
- DVE Send Installation
- Input Carrier Board Installation
- Mnemonics Display Installation
- Squeeze & Tease 2D Installation
- Squeeze & Tease 3D Installation
- Timed Aux Bus Installation
- Remote Port Expander Cabling (BSS4)
- Ultimatte Insider Option

Note

If you wish to add any of these options to your switcher, please contact Ross Video Technical Support for ordering information.

Important

For all installation procedures, avoid handling the switcher circuit boards in high static environments such as carpeted areas, and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from the frame, and exercise proper grounding precautions when working on circuit boards.
Hardware Option Overview

The following option cards and modules may be installed in the Synergy frame:

- **Clean Feed Option**
  The Clean Feed option provides an additional “program” output that is derived from a different location in the flow of video than the standard program output. This option requires a Serializer Module (p/n 4000A-062).

- **Dual Aspectizer Option**
  The Dual Aspectizer option allows you to perform live, dual aspect ratio DTV production from the Synergy panel. This option requires the following:
  - the Dual Aspectizer Board (p/n 4000A-050)
  - an Input Carrier Board (p/n 4000A-005)

- **Dual Border Generator Option**
  The Dual Border Generator option provides visually dynamic border, shadow and outline effects to both linear MLE keyers, with either hard or “glowing” edges. This option requires the following:
  - the Dual Border Generator Board (p/n 4000A-049)
  - the MLE Board (p/n 4000A-140)

- **DVE Send Option**
  The DVE Send option provides the capability to control a DVE with the fader bar. This option requires the following:
  - a Serializer Module (p/n 4000A-062)
  - two Deserializer Modules (p/n 4000A-061)
  - a Clean Feed option installed
  - recommended: 2 Timed Aux Bus options installed

- **Input Carrier Board Option**
  The Input Carrier Board option can take up to 4 Dual Aspectizer and/or Ultimatte Insider option cards. This option requires an Input Carrier Board (p/n 4000A-005).

- **Squeeze & Tease Options**
  The Squeeze & Tease option puts the power of a 2D or 3D DVE into both MLE keyers. The 2D option requires the S&T 2D Board. The 3D option requires the S&T 3D Board (p/n 4000A-148).

- **Timed Aux Bus Option**
  The Timed Aux Bus option converts an untimed Aux Bus output to a timed Aux Bus output. This option requires the following:
  - a Serializer Module (p/n 4000A-062)
  - a Deserializer Module (p/n 4000A-061)

- **Ultimatte Insider Option**
  The Ultimatte Insider option adds true Ultimatte capability — directly inside your Synergy switcher. This option requires an Ultimatte Insider Board and an Input Carrier Board (p/n 4000A-005).
Clean Feed Installation

The **Clean Feed** option provides a second “program” output that is derived from a different location than the standard program output. This output can be generated before or after the keyers. The point from which the feed is derived is software-configurable. The output itself is labeled **CLEAN** on the rear chassis panel.

Use the following procedure to install the **Clean Feed** option:

1. Power down the Synergy frame.
2. Carefully remove the **MLE Carrier Board** from the Synergy frame, and set it on a clean, flat, static free surface, with the rear of the board away from you.
3. Unpack the **Clean Feed** kit, which consists of one **Serializer Module** (4000A-062).
4. Locate the socket labeled “**CLEAN FEED**”, second from the right at the back end of the **MLE Carrier Board**.
   - Carefully align the module over the socket.
   - Ensure that the Serializer Module board’s components are facing to the left.
   - Use your fingers to “feel” for the proper pin-to-socket alignment.
   - While applying downward pressure, slowly rock the module vertically (top to bottom), until the module is fully seated. Avoid flexing the board — so as not to bend the pins.
   - After installation, “sight” down the board at the connector level, to make sure that there are no exposed pins. It is recommended that you rotate the board 360 degrees to check all planes.
5. When complete, carefully replace the **MLE Carrier Board** into the frame, and secure with the outer latches on the board edges.
6. Using the menu system, set the point from which the clean feed signal is derived. Refer to the section “**Clean Feed Setup**” on page 9–16 for instructions.

Once complete, the selected signal appears on the **CLEAN** output connector on the rear of the chassis.

**Caution**

Observe all static discharge precautions throughout the procedure.

**Caution**

Failure to reinstall a module with a precise 1:1 pin-to-socket orientation will damage the MLE Carrier Board, the selected module — or both! Double check your work!
Dual Aspectizer Option and Overview

**Dual Aspectizer** is a hardware option that allows the user to perform live, dual aspect ratio, DTV production from a Synergy family panel. The **Aspectizer**, as it is more commonly referred to, dynamically converts the aspect ratio of a video signal in real time, within the switcher itself. Conversions can occur from 4:3 to 16:9 and vice versa.

Please note the following important points:

- As a prerequisite, one or more (up to a maximum of eight) **Input Carrier Boards** (p/n 4000A-005) must be installed in the Synergy switcher — replacing the standard **Input Board** (p/n 4000A-238) for a selected set of eight BNC inputs. Please note:
  - Each **Input Carrier Board** is a full-length card (the standard **Input Boards** are half-length cards).
  - Each **Input Carrier Board** provides four slots or **sockets** for hardware options — any of which will accept a **Dual Aspectizer Board** (p/n 4000A-050).
- Any two of the eight physical BNC inputs on the associated **Input Carrier Board** can be defined as an input into the **Dual Aspectizer Board**

Dual Aspect Ratio Production Overview

Now that DTV has become a reality, we have begun the transition from the traditional 4:3 world of production to the innovative 16:9 wide-screen world. Television can now take its rightful place beside motion picture film as an equal visual partner.

What is the best path to follow during the transition? Is it merely a question of continuing to produce with a 4:3 mindset and simply converting the picture to a 16:9 format or should we look at this as an opportunity to rethink our production concepts in general and explore how to best take advantage of the additional visual real estate?

Ultimately this is a production issue, not just a conversion issue. It will be management and the production people, from network executives, to station managers, to news directors, to senior producers who will decide how this new 16:9 “look” will be handled. And as always has been the case in the past, the station engineers and technical personnel will be assigned the task of getting it to air.

If we chart the transition from one aspect ratio to the other, starting in today’s predominantly 4:3 production world and finishing several years from now as a predominantly 16:9 production world, the graph would look something like this:
In the next few years, market and legislative pressures will drive the transition and compel the facilities to accelerate the change. Most places will phase in 16:9 production over a few years by first introducing a few 16:9 inputs into the production mix and converting them to 4:3. Then in a year or so, having the benefit of some experience with dual aspect ratio production, they will make a major change over to the 16:9 world.

However, some facilities will no doubt make the change all at once, changing from a 4:3 to a 16:9 production capability in one fell swoop. Some will offer dual aspect ratio outputs to feed separate transmitters, some will not. It will depend upon many factors, but however your facility decides to effect the change, we do know that the next few years of transition will be as exciting as they are challenging.

In order to make the transition as smooth as possible, each facility should begin the process by having a clearly defined vision of where they want to go in terms of the 16:9 world. Defining that vision has to start with the most important question of all:

**Question**

**What are your production goals?**

You have to have a strong, clear understanding of where you want to end up, so that you can develop a well thought out plan to get there. As part of defining your overall production goals, you’ll have to answer questions like:

- What are management’s expectations?
- How do they want you to operate?
- What do you want your “look” to be?
- Are you an affiliate?
- Do you have to fit into a network’s style?
- How long do you have to make the transition?
- Will you be feeding one transmitter or two?

And once some of these big picture questions have been asked, you’ll have to get into the more subtle technical questions like:

- How many inputs are there with a different aspect ratio?
- Do you want to do memory recalls that involve aspect ratio manipulation?
- Should I operate in Input Mode or Bus Mode or Downstream Mode?

The answers to these and a host of other questions will provide you with a framework to plan a cost effective and orderly transition into a new era of production.
Dual Aspectizer Mode Descriptions

Each facility has its own unique set of parameters that will dictate its method of operation in the dual aspect ratio world. Although there are as many different ways to operate with dual aspect ratios as there are facilities, for the sake of this discussion, we have grouped them into four main categories:

1. Single Output Production – Input Mode
2. Single Output Production – Bus Mode
3. Dual Output Production – Downstream Mode
4. Dual Output Production – With Extra Content

The following examples use a Synergy 4 to illustrate the different configurations, however, each of the setups described can be applied to any one of the Synergy family of switchers. As well, the words *primary* and *secondary* are used to describe the two outputs when a dual output situation is illustrated. These words are for description purposes only and are not meant to represent a priority of one over the other. Likewise, whenever an aspect ratio is defined, it is used as an example to illustrate one situation. The example would be just as appropriate if the aspect ratios were reversed.

Finally, the term *Aspectizer look* or simply *look* is used to describe the different visual possibilities available when 4:3 video is converted to 16:9 or vise versa (i.e. Letterbox, Pillarbox, etc.). A full description of the different *looks* follow later in the chapter.

If your situation does not fit exactly into one of our examples and you have questions about how you would like your facility to operate, please call your Ross Video service representative for assistance.

**Single Output Production – Input Mode**

This method of operation is characterized by a single PGM output, which is the same aspect ratio as the MLEs and most of the inputs. However, one or two of the inputs have a different aspect ratio from the rest. These are sent to the Aspectizer, converted to the aspect ratio of the output, given an aspectized *look* and then typically, but not always, remain unchanged during the course of the production.

In the above configuration, the Aspectizer would be setup in Input Mode.

A complete description of how to setup and operate your switcher in Input Mode is discussed later on in this chapter.
Single Output Production – Bus Mode

This method of operation is characterized by a single PGM output, which is the same aspect ratio as the MLEs. However, in this example, a number of inputs have aspect ratios that are different from the MLEs. In this case, each bus-pair (usually the BKGD and PST bus) on each MLE is sent to an Aspectizer in what is called Bus Mode. Then whenever a crosspoint is selected on any MLE, a comparison of the aspect ratio of the input and the MLE is done and if they are the same, the signal is passed through the Aspectizer without any change. Subsequently, if the aspect ratios are different, the Aspectizer becomes active and the signal is aspectized as per the predetermined look selected.

A complete description of how to setup and operate your switcher in Bus Mode is discussed later on in this chapter.

Dual Output Production – Downstream Mode

This method of operation is characterized by dual outputs – the primary (4:3) from the PGM out and the secondary (16:9) from an Aux Bus out. However, like the first example, the MLEs and the inputs have the same aspect ratios for the most part, with the exception of one or two inputs that are different. These are sent to the Aspectizer, converted to the aspect ratio of the primary output, given an aspectized look and then typically, but not always, remain unchanged during the course of the production.

The secondary output (16:9) on the other hand, is simply an aspectized version of the primary. This is accomplished by using the second PGM output from the bottom MLE of your switcher, feeding it back in via an input BNC, which in turn is directed to an Aspectizer in Downstream Mode. The output of this Aspectizer is subsequently selected on an Aux Bus, which is then used as a 16:9 PGM output. In effect, it could be thought of as aspectizing the primary PGM output downstream.

One of the main advantages of this mode is that the TD has complete internal control over the aspectized look of the output, since like the other modes, all of the aspectizing is being done inside the switcher.
A complete description of how to setup and operate your switcher in **Downstream Mode** is discussed later on in this chapter.

**Dual Output Production – With Extra Content**

This method of operation is also characterized by dual outputs. In this case we have defined MLE3 out as the primary (4:3) and the MLE4 out (PGM) as the secondary (16:9). MLEs 1, 2 and 3 would use either **Input** or **Bus Mode** to aspectize the inputs, depending upon the number that required aspectization. MLE4 is then aspectized in **Bus Mode** and the **Aspectizer look** is set to **Pillarbox**. The remainder of the frame, the two side panels, are filled with additional information such as weather reports, or station ID, or sports scores, or advertisements, or some other extra content. In this configuration, the **Aspectizer** for MLE4 would be set and not changed during production. The program would be switched on MLE3, which would then be selected as a re-entry on MLE4. The additional content would be added as a downstream key and fed from a computer or some other similar device.

A complete description of how to setup and operate your switcher in **Bus Mode** is discussed later on in this chapter.
Dual Aspectizer Mode Comparisons

As part of the planning process for dual aspect ratio production, there are several other questions that need to be addressed in order to decide whether your facility should operate in **Input Mode**, **Bus Mode** or **Downstream Mode**. The right choice will ultimately depend upon your particular set of circumstances.

The following points will not make the choice for you but will outline some of the considerations that should be taken into account as you go through the decision making process.

**Input Mode**

- Each input that is assigned to an **Aspectizer** is aspectized on each bus of each MLE – in other words, *vertically*.
- Used for both single and dual aspect ratio output production.
- Each **Aspectizer** will aspectize two inputs independently, on two separate channels.
- Each aspectized input retains its own unique characteristics.
- Individual **Aspectizer** settings do not follow in **Memory Recalls**.
- The inputs that are assigned to the Aspectizer in Input Mode must come from one of the eight BNC inputs associated with the **Input Carrier Board** on which that particular **Aspectizer** is installed.
- **Aux Buses** are *not* required for **Input Mode**.
- Additional cabling is *not* required for **Input Mode**.
- **Input Mode** is usually used when the number of inputs requiring aspectization is less than 2 times the number of MLEs on your switcher. In other words, **Input Mode** is usually used when there are less than 4 inputs requiring aspectization for a Synergy 2, less that 6 inputs for a Synergy 3 and less than 8 inputs for a Synergy 4.
**Bus Mode**

- Each input on a bus-pair that is assigned to an Aspectizer is aspectized along one MLE – in other words, horizontally.
- Used for both single and dual aspect ratio output production.
- **Bus Mode** links two buses together on an MLE to create a bus-pair.
- Each bus-pair shares the same Aspectizer characteristics.
- Since the Aspectizer settings are stored to Memories in Bus Mode, the setups can be used in Memory Recalls.
- Any bus-pair on any MLE can be assigned to an Aspectizer in Bus Mode.
- Two Aux Buses are required for each MLE that is aspectized in Bus Mode.
- Two inputs are required from the eight associated with the Input Carrier Board on which the Aspectizer is installed.
- Additional cabling is required to feed back the Aux Buses into the Input Carrier Board.
- **Bus Mode** is usually used when the number of inputs requiring aspectization is greater than two times the number of MLEs on your switcher. In other words, **Bus Mode** is usually used when there are more than 4 inputs requiring aspectization for a Synergy 2, more that 6 inputs for a Synergy 3 and more than 8 inputs for a Synergy 4.
Downstream Mode

- Only used for dual aspect ratio output configurations.
- Can be used in conjunction with either Input or Bus Mode.
- In effect, aspectizes a PGM output downstream of the switcher.
- Has no effect on any input or any MLE during the production process.
- One Aux Bus and one input BNC is required.
- Additional cabling is required to feed back the bottom MLE PGM output into a BNC input.

The rest of this chapter deals with the installation of your Aspectizer. However, before you continue, do yourself a favor and make sure that everyone in your production facility truly understands the benefits that can be gained with a well thought out transition plan. Take the time to think about tomorrow’s requirements. Make an informed decision as to which of the output production formats will best serve your operational requirements in the years to come, because if you are not sure today where you are going, you’ll never know when you get there.
Dual Aspectizer Board Installation

This section provides instructions for installing a Dual Aspectizer Board on the host Input Carrier Board. Refer to section “Upgrading Dual Aspectizer Boards” on page 24–13 for the procedure to upgrade the software on your Dual Aspectizer Boards.

Use the following procedure to install a Dual Aspectizer Board:

1. Ensure that the Synergy switcher is powered down.

2. If you have not already done so, carefully remove the Input Carrier Board on which you want to install one or more Dual Aspectizer Boards, and set it on a clean, flat, static free surface. Note that four sockets are available for installing optional boards.

3. Unpack the new Dual Aspectizer Board. Note that it has two 50-pin dual row connectors. Note also that there are no jumpers, LEDs, or other adjustments present on the board.

4. Identify the socket(s) on the Input Carrier Board in which you want to install the Dual Aspectizer Board(s). For ease of accessibility, it is recommended that you use the sockets closest to the front edge of the Input Carrier Board.

5. To install the Dual Aspectizer Board:
   • Carefully align the board over the host socket. Ensure that the Dual Aspectizer Board’s components are facing up.
   • Use your fingers to “feel” for the proper pin-to-socket alignment.
   • While applying downward pressure, slowly rock the board until it is fully seated. Avoid flexing the board so as not to bend the pins.
   • After installation, “sight” down the board at the connector level, to make sure that there are no exposed pins. It is recommended that you rotate the board 360 degrees to check all planes.

6. Repeat the steps for each Dual Aspectizer Board that you wish to install.

7. When you have finished installing the Dual Aspectizer Board(s) on the Input Carrier Board, reinstall the Input Carrier Board using the instructions later in this chapter.

This completes the procedure to install a Dual Aspectizer Board.
Upgrading Dual Aspectizer Boards

Use the following procedure to prepare the Dual Aspectizer Boards for the software upgrade:

1. Power Off the Synergy frame and control panel.

2. Identify the location of your Dual Aspectizer Boards on the Input Carrier Boards.

3. Remove all Input Carrier Boards that have Dual Aspectizer Boards installed on them and place them on a clean, flat, static free surface.

4. Remove any Input Carrier Boards or Input Crosspoint Boards that are installed in Input Slot One (the second slot from the top) of the Synergy frame.

5. If necessary, remove and install a Dual Aspectizer Board as follows:
   - Carefully remove the Dual Aspectizer Board from the current location on the Input Carrier Board by applying upward pressure and slowly rocking the board until it is fully unseated. Avoid flexing the board so as not to bend the pins.
   - Identify the socket on the Input Carrier Board in which you want to install the Dual Aspectizer Board.
   - Carefully align the Dual Aspectizer Board over the host socket. Ensure that the component side of the Dual Aspectizer Board is facing up.
   - Use your fingers to feel for the proper pin-to-socket alignment.
   - While applying downward pressure, slowly rock the Dual Aspectizer Board until it is fully seated. Avoid flexing the board so as not to bend the pins.
   - After installation, sight down the board at the connector level to make sure that there are no exposed pins. It is recommended that you rotate the board 360 degrees to check all angles.

Caution: Failure to install a board with a precise 1:1 pin-to-socket orientation will damage the Input Carrier Board, the Dual Aspectizer Board — or both! Double-check your work!

Note: There can be a maximum of two Dual Aspectizer Boards on the Input Carrier Board in order to perform the upgrade. If there are more than two Dual Aspectizer Boards on the Input Carrier Board you will have to remove the excess Dual Aspectizer Boards.

Caution: Static discharge can cause serious damage to sensitive semiconductor devices. Avoid handling the switcher circuit boards in high static environments such as carpeted areas and when synthetic fiber clothing is worn. Use of a grounding strap is strongly recommended. Touch the frame to dissipate static charge before removing boards from the frame and exercise proper grounding precautions when working on circuit boards.

Note: The software upgrade procedure will allow you to upgrade a maximum of two Dual Aspectizer Boards. If you have additional boards you want to upgrade you will have to repeat the procedure for the preparation and upgrade for each set.

Caution: Failure to install a board with a precise 1:1 pin-to-socket orientation will damage the Input Carrier Board, the Dual Aspectizer Board — or both! Double-check your work!
6. Install the **Input Carrier Board**, with the **Dual Aspectizer Boards**, into Input Slot One (the second slot from the top) of the Synergy frame.

**Important**

Any **Dual Aspectizer Boards** installed on **Input Carrier Boards** not in Input Slots One and Two must be removed for the upgrade or they will have their current software deleted.

This completes the procedure to prepare the **Dual Aspectizer Boards** for the software upgrade. Now that the **Dual Aspectizer Boards** are prepared, you can proceed to install the software.

### Upgrading the Dual Aspectizer Software

Use the following procedure to upgrade the Dual Aspectizer Software:

**Note**

The software upgrade process takes approximately 10 minutes per **Dual Aspectizer Board**, so this could take 20 minutes if you are upgrading both boards. You can choose to perform the upgrade at a later time, if you wish.

1. Power on the Synergy frame.
2. Power on the Synergy control panel.

**Important**

After restoring power to the control panel, you may receive the error message, “USB Upgrade Failed”, if you have the **USB Removable Media Drive** option installed. Contact Ross Video Technical Support for more information on correcting the error.

The control panel display will indicate that the Aspectizer should be upgraded.

<table>
<thead>
<tr>
<th>Main Menu 1-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>System information</td>
</tr>
<tr>
<td>Please upgrade Aspectizer or contact Ross Technical Support.</td>
</tr>
</tbody>
</table>

**Main Menu — Aspectizer Upgrade Required Message**

3. Access the Aspectizer Upgrade software as follows:
   - Insert the **Aspectizer Upgrade Floppy Disk** into the disk drive on the control panel.
   - **OR**
   - Insert the USB key with the **Aspectizer Upgrade Software** into the USB port on the control panel. You must wait 5 seconds after inserting the USB key into the USB port before you can access the upgrade software.

**Note**

You must have the **USB Removable Media Drive** option installed in order to use a USB key.
4. Navigate to the **Option Cards Menu** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Installation** ⇒ **MORE** ⇒ **Option Cards**.

5. Press **Upgrade Aspectizer** to start the upgrade process.

<table>
<thead>
<tr>
<th>Option Cards Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ultinette Aspectizer</td>
</tr>
</tbody>
</table>

### Caution

Do NOT remove the floppy disk or USB key from the switcher before the LED on the disk drive or USB port goes out. Doing so may destroy the data on your floppy disk or USB key, as well as the data on the next one you insert into the switcher.

6. If you have additional **Dual Aspectizer Boards** that you wish to upgrade, you will have to repeat the Preparation and Software Upgrade procedures for each set of two before proceeding to the last step.

7. If you have relocated **Dual Aspectizer Boards** for the upgrade process, you can now return the newly upgraded cards to their original locations.

This completes the procedures for upgrading your Dual Aspectizer Board and software.
Dual Aspectizer Setup

The following steps are required before the Dual Aspectizer option can function properly:

- Connect and verify the physical switcher inputs, including reference, video, and alpha. Refer to the section “Connecting and Verifying Outputs” on page 4–15 for instructions.
- Set up the physical BNC connector with an input type. Refer to the section “Setting Up BNC Types” on page 6–9 for instructions.
- Map each BNC connector to a physical button on the control panel. Refer to the section “Setting Up Panel Buttons” on page 6–15 for instructions.
- Set up the native aspect ratios of a BNC input and an MLE output. Refer to the section “Aspect Ratio” on page 9–61 for instructions.

Aspectizer Setup Menu

The Aspectizer Setup Menu allows you to configure your Aspectizer and define where the Aspectizer Board is physically located, which mode it is in, and which BNCs or buses you wish to aspectize. Each mode is discussed in detail in the section “Dual Aspectizer Mode Setups” on page 24–17.

Use the following procedure to navigate to the Aspectizer Setup Menu:

1. Ensure that the Aspectizer is properly installed and recognized by the system.
2. Navigate to the Option Cards Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Option Cards.
3. Press Aspectizer to display the Aspectizer Setup Menu.

4. Set up an Aspectizer as follows:
   - Use the Aspectizer Channel knob to select the Aspectizer Board that you want to define.
   - Use the Mode knob to select an operational mode.

This completes the procedure to navigate to the Aspectizer Setup Menu.
Dual Aspectizer Mode Setups

The following topics are discussed in this section:

- Input Mode Setup
- Bus Mode Setup
- Downstream Mode Setup

Input Mode Setup

In **Input Mode**, you can assign two input BNCs to the dual channel Aspectizer. The BNCs are treated independently throughout the switcher. When either of these inputs is selected on any bus of any MLE, its aspect ratio is compared to that of the MLE, and if different, is sent through the Aspectizer. In other words, in **Input Mode** an input is aspectized vertically through all buses.

**Note**

All information and values associated with an Aspectizer in **Input Mode** are stored in the switcher’s Personality Registers.

Use the following procedure to configure the Aspectizer in **Input Mode**:

1. Navigate to the **Option Cards Menu** as follows:
   
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Option Cards.

2. Press **Aspectizer** to display the Aspectizer Setup Menu.

[Diagram of Aspectizer Setup Menu – Input Mode]

Aspectizer Menu – Input Mode
In this example, note that the Aspectizer is installed on Input Carrier Board #3, Socket #2 and that Film (BNC 17), has been assigned to channel A.

3. Configure an Aspectizer for Input Mode as follows:
   - Use the Aspectizer Channel knob to select the Aspectizer Board that you want to define. Each channel of the Aspectizer Board is defined by its host Input Carrier Board number – Carr# and Socket number – Sock#A and Sock#B.
   - Use the Mode knob to select Input.
   - Use the BNC knob to assign a BNC to the selected channel.

   **Note**
   The BNC inputs associated with the selected Input Carrier Board are listed.

4. Repeat step 3 for the second channel (Sock#B) of the Aspectizer.

This completes the procedure to configure an Aspectizer for Input Mode. If you are installing more than one Aspectizer in Input Mode, you must repeat the procedure for each board.

Refer to Chapter 13, “Dual Aspectizer” of the Synergy Series Operation Guide, for additional notes on Input Mode operational examples.

**Bus Mode Setup**

In Bus Mode, you can assign a bus-pair on a specified MLE to the Aspectizer. Each bus of the pair feeds an Aspectizer channel. Usually it is the BKGD and PST buses (the PGM and PST buses on the bottom MLE). However, the respective fill and alpha channels of Key1 or Key2 also constitute a bus-pair and can be assigned as the two inputs. The most important thing to remember when operating in Bus Mode is that every crosspoint on the designated bus-pair is being sent to the Aspectizer. In other words, you can think of Bus Mode as being horizontal in nature.

   **Note**
   All information and values associated with an Aspectizer in Bus Mode are stored in the switcher’s Memory Registers, with the exception of the 16:9/4:3 toggle information, which is stored in the Personality Registers.

Use the following procedure to configure the Aspectizer in Bus Mode:

1. Ensure that the Aspectizer is properly installed and recognized by the system.
2. Navigate to the **Option Cards Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Option Cards.
3. Press **Aspectizer** to display the **Aspectizer Setup Menu**.

<table>
<thead>
<tr>
<th>Option Cards</th>
<th>Aspectizer Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>This menu lets you decide how your aspectizer will work.</td>
<td>aspectizer Channel:</td>
</tr>
<tr>
<td>Mode:</td>
<td>Carr3, Sock52</td>
</tr>
<tr>
<td>Input Dut</td>
<td>Carr5, Sock88</td>
</tr>
<tr>
<td>Not in Use</td>
<td>Carr8, Sock52</td>
</tr>
<tr>
<td>Bus: MLE1 BKGD+PST</td>
<td>Bus: MLE1 BKGD+PST</td>
</tr>
<tr>
<td>MLE1 Key1</td>
<td>MLE1 Key1</td>
</tr>
<tr>
<td>Upgrade</td>
<td>Aspectizer</td>
</tr>
</tbody>
</table>

**Aspectizer Installation Menu – Bus Mode**

4. Configure the **Aspectizer** for **Bus Mode** as follows:
   - Use the **Aspectizer Channel** knob to select the channel that you want to define. Each channel of the Aspectizer is defined by its host **Input Carrier Board** number – Carr#, and **Socket** number – Sock#A and Sock#B.
   - Use the **Mode** knob to select **Bus**. The bottom knob changes to **Bus**.
   - Use the **Bus** knob to select the **MLE** and the bus-pair that you wish to aspectize. For each MLE there are three bus-pairs as setup choices for channel A and B of the Aspectizer as follows:
     - **BKGD+PST** buses (PGM+PST on the bottom MLE)
     - **Key1**, which includes both the fill and alpha channels, and
     - **Key2**, which includes both the fill and alpha channels.

This completes the procedure to configure the Aspectizer in **Bus Mode**. In the previous example, note that the Aspectizer is installed on **Input Carrier Board #8**, *Socket #4* and that the **BKGD** and **PST** buses on **MLE1** have been assigned to channel A and B.

**Note**

At this point, you have completed a *partial Bus Mode* setup. The 8 inputs associated with the **Input Carrier Board** (in this example BNC 57 – BNC 64) are being routed through the Aspectizer and when selected on either the **BKGD** or **PST** buses of **MLE1** will be aspectized. However, it is more common to continue and complete the **Bus Mode** setup as follows.

Two **Aux Buses** are required for **Bus Mode** operation. These **Aux Buses** must be “fed back” into *any* two of the BNC inputs associated with the **Input Carrier Board** on which the Aspectizer is installed. In turn, these **Aux Buses** become unavailable for any other use. As an example, the figure below illustrates the connection. For a comprehensive explanation of **Aux Bus Setup** parameters and options, refer to the section “**Aux Bus Setup**” on page 9–3.
Assigning the Aux Bus Feed

Use the following procedure to assign the **Aux Buses** feed back into the switcher:

1. On the rear of the Synergy frame, connect two *untimed* **Aux Bus** outputs to the two **BNC** inputs using industry standard coaxial cable.

2. Navigate to the **Aux Bus Menu 1-2** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Installation** ⇒ **Aux Bus**.

3. Press **Local Panel** to display the **Local Panel Setup Menu**.

   This menu allows you to assign specific switching parameters or “rights” for each of the **12 Aux Buses** that are accessible in the **Aux Bus Assign Group**. Each **Aux Bus** can be set up individually.

4. Assign an **Aux Bus** as follows:
   - Use the **Aux Bus** knob to select the **Aux Bus** number that you wish to assign.
   - Use the **Mode** knob to select **Bus Follow**. This mode directs the **Aux Bus** to follow the user’s selections on a specified MLE and bus.

   **Note**
   - In **Bus Follow** mode, the user is “locked out” of the designated Aux Bus and cannot make selections on the **Aux Bus** panel itself.

5. Repeat steps 3 and 4 for the second **Aux Bus** that you wish to assign.
This completes the procedure to assign the Aux Buses feed back into the switcher. Next, you must tell the switcher which bus, on which MLE, you want the Aux Bus to follow.

**Setting Up the Bus Follow Feature**

Use the following procedure to setup the Bus Follow feature:

1. Navigate to the Bus Follow Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Aux Bus ⇒ Bus Follow Assign.
2. Press Bus Assign to display the Bus Assign Menu. The Bus Assign Menu displays the Aux Buses that are configured in Bus Follow mode. In keeping with our example, we have assigned Aux 2 and Aux 6 to Bus Follow.

   ![Bus Follow Menu — Bus Assign](image)

3. Assign a Bus for the Aux Bus to follow:
   - Use the Aux Bus knob to select the Aux Bus number that you wish to assign to an MLE.
   - Use the MLE knob to select the MLE. Only the MLE numbers associated with your particular switcher will be displayed.
   - Use the Bus knob to select the actual Bus that you want the Aux Bus to follow.
4. Repeat steps 2 through 4 for the second Aux Bus number.

This completes the procedure to setup the Bus Follow feature. Next, you must route the Aux Bus back into the appropriate BNC input.

**Assigning the Aux Bus to a BNC Input**

Use the following procedure to assign the Aux Bus to a BNC input:

1. Navigate to the BNC Assign Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Aux Bus ⇒ Bus Follow Assign ⇒ BNC Assign.

   ![Bus Follow Menu — BNC Assign](image)
2. Assign the Aux Bus to a BNC input as follows:
   - Use the **Aux Bus** knob to select the **Aux Bus** that you wish to route back into an input. Only the previously assigned **Aux Buses** will be available for selection.
   - Use the **BNC** knob to select the **BNC** input, that will accept the **Aux Bus** as its source.

   In the case of our example, we chose **Aux Bus #2** to feed back into **BNC 63** and **Aux Bus #6** to feed back into **BNC 64**.

3. Repeat for the other **Aux Bus**.

This completes the **Aspectizer** setup procedures for **Bus Mode**. Refer to Chapter 13, “Dual Aspectizer” in the **Synergy Series Operation Guide** for additional notes on **Bus Mode** operational examples.

**Downstream Mode Setup**

**Downstream Mode** is only used when you require two **PGM** outputs with different aspect ratios. It is the easiest and most economical way to have dual aspect ratio outputs.

**Setting Up the Aspectizer in Downstream Mode**

Use the following procedure to setup the **Aspectizer** in **Downstream Mode**:

1. Locate the **MLE PGM** output from the **bottom MLE** of your switcher on the rear of the Synergy frame.

2. Connect a cable from the bottom **MLE PGM** output to a BNC input that is one of the eight inputs on the **Input Carrier Board** on which the **Aspectizer** is installed. The following diagram illustrates the cable connections:
3. Ensure that the **Aspectizer** is properly installed and recognized by the system.

4. Navigate to the **Option Cards Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Option Cards.

5. Press **Aspectizer** to display the **Aspectizer Setup Options Menu**.

6. Configure the Aspectizer for Downstream Mode as follows:
   - Use the **Aspectizer Channel** knob to select the **Channel** that you want to define. Each channel of the **Aspectizer** is defined by its host **Input Carrier Board** number – **Carr#**, and **Socket** number – **Sock#A** and **Sock#B**.
   - Use the **Mode** knob to select **Downstream**. Note that the bottom knob is now labeled as **BNC**.
   - Use the **BNC** knob to assign a BNC to the selected channel. Note that only the BNC inputs associated with the particular **Input Carrier Board** upon which the **Aspectizer** is installed will be available for selection. In the above example, note that the **Aspectizer** is installed on **Input Carrier Board #1, Socket #10** and that channel **A** is receiving its input feed from **BNC 3**.
This completes the procedure to setup the Aspectizer in Downstream Mode. Next you must assign the Aspectizer output to a crosspoint.

**Assigning the Output to a Crosspoint**

Use the following procedure to assign the output of the Aspectizer to a panel crosspoint:

1. Navigate to the **Panel Button Setup Menu** as follows:
   - Press HOME → MORE → Setup → Installation → BNC → Panel.

2. Assign the output of the Aspectizer to a panel crosspoint as follows:
   - Use the **Crosspoint** knob to select the button number that you wish to assign.
   - Use the BNC knob to scroll the selection down past input 64. Note that the label BNC changes to OPT – indicating that this region of the menu is reserved for **internally generated signals** from any installed option boards on the Input Carrier Board.
   - Select the desired internal Aspectizer signal – in this case Aspt12 A. Note that in the **Status Box**, the system identifies the internal source (Aspectizer Video A), the Type (Other), the Auto Key (Black), the location of the optional Aspectizer board (i.e. carrier 1, socket 2) and its aspect ratio (4:3).

3. Press **HOME** to display the **Installation Change Confirmation Screen**.

4. Accept or reject the changes you have made as follows:
   - Press **Confirm** to accept the changes.
   - Press **Cancel** to exit the menus safely, without making any changes. The system returns to the previously stored settings.

This completes the procedure to assign the output of the Aspectizer to a panel crosspoint. Next you must set the output aspect ratio. In **Downstream Mode**, the Aspectizer uses the aspect ratio of the bottom MLE PGM to determine which way to do the conversion.

---

**Note**

Only one channel, either A or B of the Aspectizer is required for Downstream Mode. The other channel is available for use with an input in **Input Mode**.

When working in Downstream Mode, the possibility exists to **double aspectize** an input(s) on the Downstream Aux Bus output. This situation will occur if an input has already been aspectized somewhere else in the switcher and on air.
**Setting the Output Aspect Ratio**

Use the following procedure to set the output aspect ratio of the MLE:

1. Navigate to the **MLE Aspect Ratio Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Output ⇒ MLE Aspect Ratio.

   ![MLE Aspect Ratio Menu](image)

2. Assign the output aspect ratio of the MLE as follows:
   - Use the **MLE** knob to select the bottom MLE number of your switcher.
   - Use the **Aspect** knob to the appropriate aspect ratio – either 4:3 or 16:9.
     The **Aspectizer** will use this aspect ratio to set itself to the opposite one.

This completes the procedure to set the output aspect ratio of the MLE. Next you must assign the output of the **Aspectizer** to the **Aux Bus**. This is accomplished by selecting the **Aux Bus** number on the panel and pressing the previously assigned crosspoint – in our example, **BNC 3**.

This completes the **Aspectizer** setup procedure for **Downstream Mode**. Refer to Chapter 13, “**Dual Aspectizer**” of the **Synergy Series Operation Guide** for additional notes on **Downstream Mode** operational examples.
Dual Border Generator Installation

This section provides instructions for installing the Dual Border Generator option on the MLE Carrier Board.

Use the following procedure to install the Dual Border Generator option.

**Caution**

Observe all static discharge precautions throughout the procedure.

1. Power down the Synergy switcher frame.
2. Carefully remove the MLE Carrier Board from the chassis, and set it on a clean, flat, static free surface, with the rear of the board away from you.
3. On the MLE Board that you wish to install the Dual Border Generator Module onto, set jumper JP2, labeled “BORDER”, to IN.
4. Unpack the Dual Border Generator kit, which consists of one Dual Border Generator Module (4000A-049).
5. On the Dual Border Generator Module, locate the 2 sockets labeled “J4” and “J5” and align them over the corresponding headers on the right side of the MLE Board.
   - Ensure that the components of the Dual Border Generator Module board are facing up.
   - Use your fingers to “feel” for the proper pin-to-socket alignment.
   - While applying downward pressure, slowly rock the module until the module is fully seated. Avoid flexing the board — so as not to bend the pins.
   - After installation, “sight” down the board at the connector level, to make sure that there are no exposed pins. It is recommended that you rotate the board 360 degrees to check all planes.
6. When complete, carefully replace the MLE Carrier Board into the chassis, and secure with the outer latches on the board edges.

This completes the installation for the Dual Border Generator option.
DVE Send Installation

This section provides instructions for installing a DVE Send option on the MLE Carrier Board. Use the following procedure to install the DVE Send option:

**Caution**

Observe all static discharge precautions throughout the procedure.

1. Power down the Synergy switcher frame.
2. Carefully remove the MLE Carrier Board from the Synergy frame, and set it on a clean, flat, static free surface, with the rear of the board away from you.
3. Unpack the DVE Send kit, which consists of two Deserializer Modules (p/n 4000A-061) and one Serializer Module (p/n 4000A-062).

**Caution**

In the following steps, failure to reinstall a module with a precise 1:1 pin-to-socket orientation will damage the MLE Carrier Board, the selected module — or both! Double check your work!

4. Locate the socket labeled DVE SEND, third from the right at the back end of the MLE Carrier Board.
   - Carefully align the Serializer Module (p/n 4000A-062) over the socket.
   - Ensure that the module components are facing to the left.
   - Use your fingers to “feel” for the proper pin-to-socket alignment.
   - While applying downward pressure, slowly rock the module vertically (top to bottom), until the module is fully seated. Avoid flexing the board — so as not to bend the pins.
   - After installation, “sight” down the board at the connector level, to make sure that there are no exposed pins. It is recommended that you rotate the board 360 degrees to check all planes.
5. Locate the following two sockets on the left side at the back end of the MLE Carrier Board:
   - J501, labeled DVE VIDEO RETURN.
   - J502, labeled DVE ALPHA RETURN.
6. For each socket, install a Deserializer Module (p/n 4000A-061) as follows:
   - Carefully align the Deserializer Module (p/n 4000A-062) over the socket.
   - Ensure that the module components are facing to the left.
   - Use your fingers to “feel” for the proper pin-to-socket alignment.
   - While applying downward pressure, slowly rock the module vertically (top to bottom), until the module is fully seated. Avoid flexing the board — so as not to bend the pins.
   - After installation, “sight” down the board at the connector level, to make sure that there are no exposed pins. It is recommended that you rotate the board 360 degrees to check all planes.
7. When complete, carefully replace the **MLE Carrier Board** into the frame, and secure with the outer latches on the board edges.

8. Using the menu system, set the point from which the clean feed signal is derived. Refer to the section “**Setting Up Clean Feed Output**” for instructions.

This completes the procedure to install the **DVE Send** option. The selected signal appears on the designated output connector on the rear of the frame.
Input Carrier Board Installation

The Input Carrier Boards must be installed in the eight input slots in the rack frame in one of the two following configurations:

- **Configuration 1** — Install the Input Carrier Board in the top slot of the frame followed below by all input/crosspoint boards, without leaving any open slots between.

- **Configuration 2** — Install all input/crosspoint boards above all Input Carrier Boards, without leaving any open slots between. In this case, there is a maximum of four Input Carrier Boards allowed in the frame. As well, there can be no Input Carrier Board in the bottom input board slot (slot 8).

Other configurations may be possible. If either of the above does not meet your requirements, please contact Ross Video Technical Support.

Installing an Input Carrier Board

Use the following procedure to install an Input Carrier Board.

1. Power down the Synergy frame.

2. Identify the group of eight physical inputs for which you want to provide “option” capability, such as inputs 1-8, 9-16.

3. Identify the frame slot associated with this group.

4. If you are replacing a standard Input Board with an Input Carrier Board containing a Dual Aspectizer Board, or an Ultimatte Insider™ Board:
   - Carefully remove the selected Input Board from the frame slot that you identified in step 3.
   - You can store the board for future use, or you can install it in an appropriate open slot in the chassis.
   - Ensure sure you adhere to the configuration outlines stated in the introduction of this section. This will provide an additional 8-input capability.

5. Carefully install the new Input Carrier Board in the frame and secure it with the outer latches on the board edges.

6. Repeat for each Input Carrier Board that you want to install.

7. Power on the Synergy frame.

8. Navigate to the Option Cards Menu and verify that each new Input Carrier Board is properly recognized by the system. Refer to Chapter 2 “Installation” for instructions.

This completes the procedure to install an Input Carrier Board.
Mnemonics Display Installation

The Mnemonics Display option is available for field installation on the Synergy Series 2003 edition panels. Mnemonics Display modules are available for the PGM bus, the Custom Control bus, and each MLE on your switcher.

Installing the mnemonics display option is a three part process:

1. Removing Cover Plates
2. Installing Mnemonics Display Modules
3. Installing Mnemonic Controller Board(s)

Removing Cover Plates

Use the following procedure to remove cover plates from Synergy Series 2003 edition panels.

Caution

Observe all static discharge precautions throughout the procedure.

1. Power down the Synergy control panel.
2. Open the panel top as wide as possible.
3. Locate the Crosspoint (or XPT) Switch circuit board. This board is on the left side of the panel top as you view it from the inside.
4. On the Crosspoint (XPT) Switch circuit board, locate the bolt positions for the cover plates you are removing. The positions are marked with a bolt icon and an arrow head on the silk screening. See the figure and table below for bolt position icons and labels.

![Typical Mnemonics Display Silk Screening on Crosspoint (XPT) Switch Board](image)

<table>
<thead>
<tr>
<th>1) Bolt Icon</th>
<th>2) Bolt Position</th>
<th>3) Display Module Pin Socket</th>
</tr>
</thead>
</table>

Typical Mnemonics Display Silk Screening on Crosspoint (XPT) Switch Board
5. Using a Phillips #1 screwdriver, remove the slot cover plate screws and place them in a handy spot. You will need these screws to install the mnemonic display components.

6. On the top side of the panel, lift the unscrewed cover plate away, and store it in a safe place with your Synergy hardware accessories.

7. Repeat for each display row you wish to install.

8. Once all the required cover plates have been removed, close the panel top.

This completes the procedure to remove cover plates from Synergy Series 2003 edition panels.

**Installing Mnemonics Display Modules**

Use the following procedure to install mnemonic display modules in Synergy Series 2003 edition panels.

<table>
<thead>
<tr>
<th>Mnemonics Display Row</th>
<th>Synergy 2</th>
<th>Synergy 3 (on Lower &amp; Upper XPT boards)</th>
<th>Synergy 4 (on Left &amp; Right XPT boards)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PGM</td>
<td>MP 38-44</td>
<td>MP 55-68</td>
<td>MP 63, 64, 66-69, 65, 30, 72-76, 78,77</td>
</tr>
<tr>
<td>Cust Ctrl</td>
<td>MP 45-51</td>
<td>MP 69-82</td>
<td>MP 76, 75, 73-70, 74, 36, 80,79, 83-81, 56, 31</td>
</tr>
<tr>
<td>MLE 1</td>
<td>MP 52-58</td>
<td>MP 43-51, 61, 52, 9, 60, 28</td>
<td>MP 91, 92, 94-97, 93, 34, 20, 100, 7, 8, 19, 106, 105</td>
</tr>
<tr>
<td>MLE 2</td>
<td></td>
<td>MP 83-96</td>
<td>MP 84, 85, 87-90, 86, 32, 94, 93, 97-95, 99, 98</td>
</tr>
<tr>
<td>MLE 3</td>
<td></td>
<td></td>
<td>MP 83, 82, 80-77, 81, 38, 87, 86, 90-88, 92, 91</td>
</tr>
</tbody>
</table>

1. Carefully remove the mnemonic display modules from their shipping packages.

   - Depending on which switcher you have, and how many rows of mnemonics you are installing, you will have a corresponding amount of mnemonics display modules to install based on the configuration groupings listed below.
     - **Synergy 2** — uses modules with 5, 5, and 7 displays each, per row, from left to right, to fill 17 row spaces.
     - **Synergy 3** — uses modules with 8, 7, 8, and 7 displays each, per row, from left to right, to fill 30 row spaces.
     - **Synergy 4** — uses modules with 5, 5, 8, 5, 7, and 5 displays each, per row, from left to right, to fill 35 row spaces.

   - The **Crosspoint (XPT) Switch** boards are all silk-screened with outlines and text indicating which type of modules fit in each slot.

   **Caution**

   In the following steps, failure to reinstall a module with a precise 1:1 pin-to-socket orientation will damage the **Crosspoint (XPT) Switch** board, the selected module — or both! Double check your work!
2. Based on the configurations described above, select the leftmost display module and align it over the slot with the pin headers over the pin sockets. When properly aligned, the arrows above the standoff labels (MP 1, etc.) on the underside of the module will point upward.

3. Gently press the module pins onto the pin sockets on the Crosspoint (XPT) Switch circuit board.

4. Working from left to right, repeat steps 2 and 3 to align and insert each module into each row socket until all modules are installed on the panel.

5. Open the panel top as wide as possible.

6. Using a Phillips #1 screwdriver, fasten the bolts (from the cover plate removal procedure) to their corresponding positions as outlined in the following table.

---

### Mnemonics Display Bolt Position Labels (from left to right)

<table>
<thead>
<tr>
<th>Mnemonics Display Row</th>
<th>Synergy 2</th>
<th>Synergy 3 (on Lower &amp; Upper XPT boards)</th>
<th>Synergy 4 (on Left &amp; Right XPT boards)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PGM</td>
<td>MP 38-44</td>
<td>MP 55-68</td>
<td>MP 63, 64, 66-69, 65, 30, 72-76, 78,77</td>
</tr>
<tr>
<td>Cust Ctrl</td>
<td>MP 45-51</td>
<td>MP 69-82</td>
<td>MP 76, 75, 73-70, 74, 36, 80,79, 83-81, 56, 31</td>
</tr>
<tr>
<td>MLE 1</td>
<td>MP 52-58</td>
<td>MP 43-51, 61, 52, 9, 60, 28</td>
<td>MP 91, 92, 94-97, 93, 34, 20, 100, 7, 8, 19, 106, 105</td>
</tr>
<tr>
<td>MLE 2</td>
<td></td>
<td>MP 83-96</td>
<td>MP 84, 85, 87-90, 86, 32, 94, 93, 97-95, 99, 98</td>
</tr>
<tr>
<td>MLE 3</td>
<td></td>
<td></td>
<td>MP 83, 82, 80-77, 81, 38, 87, 86, 90-88, 92, 91</td>
</tr>
</tbody>
</table>

---

**Caution**

Do not over tighten the bolts. Over tightening the bolts will damage the **Crosspoint (XPT) Switch** board, the selected module — or both! Double check your work!

This completes the procedure to install mnemonic display modules. When all bolts are inserted, you will install the Mnemonic Controller Board(s).

### Installing Mnemonic Controller Board(s)

Use the following procedure to install Mnemonic Controller Board(s) in the Synergy Series 2003 edition panel.

---

**Caution**

Observe all static discharge precautions throughout the procedure.

---

1. Carefully remove the Mnemonic Controller board(s) from the shipping package.

2. Depending on which switcher you have, you will have 1 or 2 Mnemonic Controller boards to install, as outlined in the configuration groupings listed below:
   - **Synergy 2** — uses one Mnemonic Controller board, p/n 4000A-430A.
   - **Synergy 3** — uses two Mnemonic Controller boards, p/n 4000A-430B.
• **Synergy 4** — uses two Mnemonic Controller boards, p/n 4000A-430B.

**Caution**
In the following steps, failure to reinstall a Mnemonic Controller board with a precise 1:1 pin-to-socket orientation will damage the Crosspoint (XPT) Switch board, the Mnemonic Controller board — or both! Double check your work!

3. With the panel top still open, locate the three light gray socket rows on the Crosspoint (XPT) Switch circuit board(s).
   - **Synergy 2** — The input sockets are on the lower right edge of the Crosspoint Switch board. The Mnemonic Controller board installs edge to edge with the Crosspoint Switch board.
   - **Synergy 3** — The input sockets for the two cards are on the upper left edge of the Lower XPT Switch board and the lower left edge of the Upper XPT Switch board. The Mnemonic Controller boards install piggy-back on top of the Crosspoint (XPT) Switch boards, resting fully over each XPT board in both cases.
   - **Synergy 4** — The input sockets for the two cards are on the lower left edge of both the Left and the Right XPT Switch boards. The Mnemonic Controller boards install piggy-back on top of the Crosspoint (XPT) Switch boards, resting fully over each XPT board in both cases.

4. On the Crosspoint (XPT) or (Synergy 2 only) Key circuit boards, locate the standoffs which correspond to the mounting holes labeled on the solder side of the Mnemonic Controller boards, and remove any bolts from the standoffs if there are any present.

5. Based on the configurations described in step 3, hold the Mnemonic Controller board with the component side away from you and align it over the slots with the pin groupings over the pin sockets.

6. Gently press the Mnemonic Controller board pins onto the pin sockets on the Crosspoint (XPT) Switch circuit board.

7. Using a Phillips #1 screwdriver and the supplied mounting bolts, fasten the Mnemonic Controller board(s) to the host Crosspoint (XPT) Switch board at the standoff positions.

**Caution**
Do not over tighten the bolts. Over tightening the bolts will damage the Crosspoint (XPT) Switch board, the Mnemonic Controller board — or both! Double check your work!

This completes the installation of the Mnemones Display option.

For configuration information, refer to Chapter 8 “Memory Functions and More” in the *Synergy Series Operation Guide*. For information on BNC and Custom Control names in mnemonics displays, refer to the section “Setting Up Mnemones Displays for BNC Names” on page 6–7.
Squeeze & Tease 2D Installation

This section provides instructions for installing the Squeeze & Tease 2D option on the Synergy Series MLE Board.

The Squeeze & Tease 2D board installs on the left side of the MLE Board, as indicated in the figure below. The Squeeze & Tease 2D board mates with three sockets (connectors) and two mounting standoffs, as shown.

The standoff location labeled (2) secures the MLE Board to the base level MLE Carrier Board and continues up to the Squeeze & Tease 2D board.

Use the following procedure to install the Squeeze & Tease 2D option.

Caution

Observe all static discharge precautions throughout the procedure.

1. Power down the Synergy frame.
2. Carefully remove the MLE Carrier Board from the frame chassis, and set it on a clean, flat, static-free surface.
3. If there is a mounting hole at position (1) on the MLE Board and no standoff is installed:
   • Remove the MLE Board.
   • Install a standoff at position (1) and secure it with a nut on the bottom of the MLE Board.
   • Return the MLE Board to the MLE Carrier Board.
4. Unpack the Squeeze & Tease 2D kit, which consists of one Squeeze & Tease 2D Module (4000A-048).
5. The three MLE Board headers, J6, J7, and J8 (shown above) will mate with the three sockets on the Squeeze & Tease 2D board. The Squeeze & Tease 2D sockets are also labeled J6, J7, and J8. The header-to-socket mating pattern is J6 → J6, J7 → J7, and J8 → J8.
6. Carefully align the **Squeeze & Tease 2D** board sockets over the headers on the **MLE Board**. Use your fingers to “feel” for the proper header-to-socket alignment. In addition, check that the standoff(s) align with the mounting holes.

7. Once aligned, push down on either side of each connector, until the board is fully seated.

8. Double check the alignment of the **Squeeze & Tease 2D** board by sighting down the connectors.

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failure to install the <strong>Squeeze &amp; Tease 2D</strong> board with a precise 1:1 header-to-socket orientation will damage the <strong>Synergy MLE Board</strong>, the <strong>Squeeze &amp; Tease 2D</strong> board — or both! Double-check your work!</td>
</tr>
</tbody>
</table>

9. Install a mounting screw to secure the **Squeeze & Tease 2D** board to standoff (1). Do not over tighten the screw.

10. Reinstall the **MLE Carrier Board** to the Synergy Frame slot it was removed from.


This completes the installation for the **Squeeze & Tease 2D** option on the **Synergy MLE Board**.
Squeeze & Tease 3D Installation

The Squeeze & Tease 3D (S&T 3D) option is the most advanced single-card 3D DVE available on the market today. The Squeeze & Tease 3D card mounts right on your MLE Board and becomes an integrated feature of the Synergy Series line of switchers.

**Note**

Refer to the *Squeeze & Tease 3D/WARP Owner’s Guide* for this option’s complete installation and operation instructions.

The Squeeze & Tease 3D card utilizes the latest digital processing technologies, accepting 2 independent channels of component digital video in parallel form and outputs 2 independent video and alpha channels – for a total of 4 outputs.

As well, the card features 10-bit, field based processing, two channels of planar processing for 3D rotation with perspective, sub-pixel motion, and scaling.

Finally, all of the Squeeze & Tease 3D feature set and functionality is available to the operator through our easy-to-use interface on the control panel’s LCD screen.
Timed Aux Bus Installation

This section provides instructions for installing the **Timed Aux Bus** option on the **Aux Bus Carrier Board** (p/n 4000-064).

Use the following procedure to install the **Timed Aux Bus** module.

---

**Caution**

Observe all static discharge precautions throughout the procedure.

---

1. Power down the Synergy frame.
2. Check that you received the following components in your **Timed Aux Bus** kit:
   - One **Deserializer Module** (4000A-061). This module installs in a socket on the **Aux Bus Module**.
   - One **Serializer Module** (4000A-062). This module installs in a socket on the **Aux Bus Module**.
3. The **Aux Bus Carrier Board** is installed in the back end of the **Frame Processor Module**. Carefully remove the **Frame Processor Module** from the chassis, and set it on a clean, flat, static-free surface, with the rear of the board away from you.
4. Install the **Deserializer Module** on the **Aux Bus Carrier Board** as follows:
   - Read the **Aux Bus** slot labels closely. On the left hand side of the board, locate one of up to 12 available “**AUX IN**” slots for the Aux Bus that you want to “time”.
   - Carefully align the module over the socket.
   - Ensure the board’s components are facing to the left of the Frame Board.
   - Use your fingers to “feel” for the proper pin-to-socket alignment.
   - While applying downward pressure, slowly rock the module vertically (top to bottom), until the module is fully seated. Avoid flexing the board – so as not to bend the pins.
   - After installation, “sight” down the board at the connector level, to make sure that there are no exposed pins. It is recommended that you rotate the board 360 degrees to check all planes.
5. Each slot has a corresponding jumper, located in rows parallel to the module socket rows. Set the corresponding **AUX IN** jumper to “**TIMED**”.
6. **Caution**

   Failure to install the module with a precise 1:1 pin-to-socket orientation will damage the Aux Bus Carrier Board, the selected module — or both! Double check your work!

---

6. Install the **Serializer Module** on the **Aux Bus Carrier Board** as follows:
   - Read the **Aux Bus** slot labels closely. On the right hand side of the board, locate one of up to 12 available “**AUX OUT**” slots for the Aux Bus that you want to “time”.
   - Carefully align the module over the socket.
   - Ensure the board’s components are facing to the left of the Frame Board.
   - Use your fingers to “feel” for the proper pin-to-socket alignment.
• While applying downward pressure, slowly rock the module vertically (top to bottom), until the module is fully seated. Avoid flexing the board – so as not to bend the pins.

• After installation, “sight” down the board at the connector level, to make sure that there are no exposed pins. It is recommended that you rotate the board 360 degrees to check all planes.

7. Each slot has a corresponding jumper, located in rows parallel to the module socket rows. Set the corresponding **AUX OUT** jumper to “**TIMED**”.

8. Replace the **Frame Processor Module** assembly in the chassis and power up the Synergy switcher chassis.

This completes the installation procedure. Note that there is no software installation required for this option.

**Testing the Aux Bus Output**

You can now test the Aux Bus output in several ways.

• Route the selected Aux Bus output to a monitor, and switch between two signals on the Aux Bus – for example, a primary input and a program signal that you know may *not* be perfectly timed. The signals should now switch seamlessly.

• Route the selected Aux Bus output to a DVE, and switch between two or more signals. While monitoring the DVE’s output, there should be no green flashes on the monitor (flashes that are typically associated with untimed sources).
Remote Port Expander Cabling (BSS4)

To connect the BSS4 Remote Port Expander to the Synergy switcher, you will have to make a connection from one of the Remote Ports on the back of the control panel to the Master Port on the BSS4.

In order to properly complete this procedure you will need the following:

- **BSS4 Interface Cable** — An RS-422 cable with a male 9-pin, D-type connector on one end, and a female 9-pin, D-type connector on the other end. Refer to the table below for wiring information.

  ![Note]

  The BSS4 will only support RS-422 communication. Any device using RS-232 communication will require a RS-422 to RS-232 converter.

- **BSS4 Power Supply** — The 5 Volt, 100mA power supply that was supplied with your BSS4 switch.

The Synergy switcher connects to the BSS4 Remote Port Expander via the remote ports (1-8) on the back of the Synergy control panel, and the Master Port on the BSS4.

- The Synergy control panel remote port requires a 9-Pin, D-Type RS-422 connector.
- The BSS4 Master Port requires a 9-Pin, D-Type RS-422 connector.

<table>
<thead>
<tr>
<th>Synergy Panel</th>
<th>BSS4 Remote Port Switch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Port</td>
<td>Signal</td>
</tr>
<tr>
<td>1</td>
<td>Chassis</td>
</tr>
<tr>
<td>2</td>
<td>RxA (Rx-)</td>
</tr>
<tr>
<td>3</td>
<td>TxB (Tx+)</td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
</tr>
<tr>
<td>7</td>
<td>RxB (Rx+)</td>
</tr>
<tr>
<td>8</td>
<td>TxA (Tx-)</td>
</tr>
</tbody>
</table>

Use the following procedure to connect a BSS4 Remote Port Switch to your Synergy switcher:

1. Connect and secure the male end of the **BSS4 Interface Cable** to one of the **Remote Ports** (1-8) on the back of the Synergy control panel.

2. Connect and secure the female end of the **BSS4 Interface Cable** to the **Master Port** on the BSS4. Refer to the illustration “Connecting the BSS4 Remote Port Expander to the Synergy Control Panel” on page 24–40.

![Caution]

*Ensure that you have the correct power supply for your type of power before you attempt to plug the BSS4 Power Supply in a power socket.*
3. Connect the **BSS4 Power Supply** to the **BSS4** and plug into an appropriate AC outlet.

**Synergy Control Panel**

---

**RS-422 Four Port Buffered Smart Switch (BSS4)**

*Connecting the BSS4 Remote Port Expander to the Synergy Control Panel*

This completes the procedure for connecting the BSS4 Remote Port Switch to the Synergy switcher. Next you will have to set up the communications protocols in order to use the Extended Remote Ports on the BSS4. Refer to Chapter 7, “**Basic Communications Setup**” for information on setting up the communications protocols for the BSS4.
Ultimatte Insider™ is a hardware option that adds true Ultimatte capability — directly inside the Synergy switcher. The option is comprised of hardware boards designed by Ultimatte (the Oscar-winning industry leader in composition technology), plus Ultimatte-specific menus for controlling the chroma key.

Please note the following important points:

- **Ultimatte Insider Boards** can be configured to operate in **Carrier** mode or in **Bus** mode.
  - In **Carrier** mode, users can apply the Ultimatte feature to any of the eight inputs associated with the host **Input Carrier Board**.
  - In **Bus** mode, users can apply the Ultimatte feature to any BNC input (crosspoint) on a selected MLE Key bus.
- Up to two **Ultimatte Insider** boards can be assigned to an MLE — one for each keyer. Each board creates one processed foreground and one processed key signal from a selected input video source. In total, on a Synergy 4, you can have eight Ultimatte keys running simultaneously — six on a Synergy 3, four on a Synergy 2.
- As a prerequisite, one or more **Input Carrier Boards** (4000A-005) must be installed in the Synergy switcher — replacing the standard **Input Board** for a selected set of eight BNC inputs. Please note:
  - Each **Input Carrier Board** is a full-length card (the standard **Input Boards** are half-length cards).
  - Each board provides four slots for hardware options — any of which can be assigned to the **Ultimatte Insider**.
  - Each board has eight inputs and 16 outputs. The 16 outputs are comprised of the eight original inputs, plus eight modified outputs that are generated from the installed option boards (two outputs per option board).
  - Each **Ultimatte Insider** board generates two signals — a processed fill and a processed alpha signal.

**Ultimatte Carrier Mode Overview**

In **Carrier** mode, by selecting **Chroma Key** as the key type and selecting one of the eight associated inputs as the source on the configured MLE’s **Key Bus**, the **Ultimatte Insider Menu** is automatically displayed. If you select any other input, a standard Synergy **Chroma Key Setup Menu** appears.

- An **Aux Bus** is not required for **Carrier Mode**.
- Additional cabling is not required for **Carrier Mode**.
- **Carrier Mode** is usually used when the number of inputs requiring Ultimatte keying is eight or less.
**Ultimatte Bus Mode Overview**

In **Bus** mode, selecting **Chroma Key** as the key type and selecting *any* of the inputs as the source on the selected MLE’s **Key Bus** automatically displays the **Ultimatte Insider Menu**. In other words, you can think of **Bus Mode** as being *horizontal* in nature.

To set up **Bus** mode, the user assigns an **Ultimatte Insider** to one or both of the keyers on a specified MLE.

The **Ultimatte Insider Board** in **Bus** mode takes advantage of the **Bus Follow** capability in Synergy’s Aux Buses. When an MLE Key is assigned to an Aux Bus in **Bus Follow** mode, any BNC input crosspoint selected on the Key Bus for that keyer, with the Chroma Key button selected, is routed through the Aux Bus back to the Ultimatte Insider card for processing.

- **Bus** Mode: BNC input crosspoints on the Key Bus are available to the Ultimatte option.

- One **Aux Bus** is required for each keyer on an MLE that has access to the Ultimatte option in **Bus Mode**.
- One BNC input is required, from the eight associated with the **Input Carrier Board**, on which the **Ultimatte Insider Board** is installed.
- Additional cabling is required to feed back each required **Aux Bus** into the **Input Carrier Board**.
- **Bus Mode** is usually used when BNC inputs along the *entire* key bus may require Ultimatte keying.
Ultimatte Insider Board Installation

This section provides instructions for installing an Ultimatte Insider Board in the Synergy frame. A host Input Carrier Board is required. For information on installing the Input Carrier Board, refer to the section, “Input Carrier Board Installation” of the Synergy Series Maintenance Guide.

Use the following procedure to install an Ultimatte Insider Board.

1. Ensure that the Synergy switcher is powered down.

2. If you have not already done so, remove the Input Carrier Board on which you want to install one or more Ultimatte Insider options, and set it on a clean, flat, static-free surface. Note that four sockets are available for installing option boards.

3. Unpack the new Ultimatte Insider Board. Note that it has two 50-pin dual row connectors.

4. Identify the socket(s) on the Input Carrier Board in which you want to install the Ultimatte Insider Board(s). For ease of accessibility, it is recommended that you use the sockets closest to the front edge of the Input Carrier Board.

5. Use the following table for Ultimatte Insider Board locations:

<table>
<thead>
<tr>
<th>For an Ultimatte Insider Board installed in:</th>
<th>Align Ultimatte Insider Sockets J1 and J2 with the following positions on the Input Carrier Board:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Socket 1</td>
<td>J103, J104</td>
</tr>
<tr>
<td>Socket 2</td>
<td>J203, J204</td>
</tr>
<tr>
<td>Socket 3</td>
<td>J303, J304</td>
</tr>
<tr>
<td>Socket 4</td>
<td>J403, J404</td>
</tr>
</tbody>
</table>

6. To install the Ultimatte Insider Board:
   - Verify that the text markings on the Ultimatte Insider Board will be upside down in relation to the front of the Input Carrier Board.
   - Use your fingers to “feel” for the proper pin-to-socket alignment.
   - While applying downward pressure, slowly rock the board until it is fully seated. Avoid flexing the board so as not to bend the pins.

Caution

Observe all static discharge precautions throughout the procedure.

Important

Ensure that the MLE Carrier Board is Issue 5 or higher. Otherwise, the Ultimatte Insider Board will generate invalid output.
7. Secure the board in five locations (one on each corner and one in the center) using ¼” 4-40 screws.

Note
When installing an Ultimatte Insider Board in Socket 1 of the Input Carrier Board, note that it does not have a screw in the upper right hand corner.

8. Repeat for each Ultimatte Insider Board that you wish to install.

9. Carefully replace each Input Carrier Board in the chassis, and secure each one with the outer latches on the board edges.


This completes the procedure to install an Ultimatte Insider Board. Next you can verify that the Ultimatte Insider Board is recognized by the Synergy switcher.

Verifying the Ultimatte Insider Board

Use the following procedure to verify that each installed Ultimatte Insider Board is recognized by the Synergy switcher:

1. Navigate to the Option Boards Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installed Options.
2. Press Option Boards to display the Option Boards Menu.

3. Use the middle knob to scroll the list to verify the Ultimatte Insider Board is recognized by the Synergy system.

This completes the procedure to verify that each new Ultimatte Insider Board is properly recognized by the system. For information on setting up the Ultimatte Insider Board for Bus Mode or Carrier Mode, refer to the “Ultimatte Insider Carrier Mode Setup”, or “Ultimatte Insider Bus Mode Setup” sections for instructions.
Ultimatte Insider Setup – Carrier Mode

You can use the Ultimatte Option Card Menu to verify the following:

- where the Ultimatte Insider Board is physically located;
- which mode it is in; and
- which MLE Key has an Ultimatte assigned.

Use the following procedure to set up an Ultimatte Insider Board in Carrier mode for chroma key operation:

1. Ensure that the Ultimatte is properly installed and recognized by the system. Refer to the “Input Carrier Board Installation” and “Ultimatte Insider Board Installation” sections for instructions.

2. Navigate to the Option Cards Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Option Cards.

3. Press Ultimatte to display the Ultimatte Option Card Menu.

4. Use the Ultimatte Card knob to select the available host Input Carrier Board – Carr#1-8, and Socket number – Sock#1-4.

5. Use the Mode knob to select the mode you wish to make active – in this case Carrier. When selecting a mode, the bottom MLE-Key knob title and selections become available.

6. Use the MLE-Key knob to select the MLE – 1-4 and the Key – 1-2 that you wish to associate with the Ultimatte.

In the above example, note that the Ultimatte is installed on Input Carrier Board #2, Socket #2 and that Key1 on MLE2 has been assigned to the Ultimatte in Carrier mode.
The association is between the **MLE keyer** and the host **Input Carrier Board**. Any of the eight BNC inputs for the specific **Input Carrier Board** (in this example BNC 9 – BNC 16) can be assigned as a chroma key source.

7. Repeat for each **Ultimatte Insider Board** you wish to set up in **Carrier** mode.

This completes the procedure for setting up an Ultimatte key for use in **Carrier** mode. Refer to Chapter 12, “**Ultimatte Insider**”, in the **Synergy Series Operation Guide**, for operating instructions.

**Important**

The source that you select on the **Key Bus** activates the Ultimatte menus and internally calls up the Ultimatte’s processed alpha and fill signals. The selected source’s panel button on the **Program** and **Preset** buses remains the original **unprocessed** video signal. To place the Ultimatte’s **processed** signals on the **Program** and **Preset** buses, refer to the section “**Ultimatte Auto Select Key Setup**” on page 24–50.

**Ultimatte Insider Setup – Bus Mode**

The **Ultimatte Option Card Menu** enables you to verify:

- where the **Ultimatte Insider Board** is physically located;
- which mode it is in; and
- which MLE Key has an **Ultimatte** assigned.

Use the following procedure to configure the **Ultimatte Insider** in Bus Mode for chroma key operation:

1. Ensure that the **Ultimatte** is properly installed and recognized by the system. Refer to the section “**Input Carrier Board Installation**” on page 24–29 and the section “**Ultimatte Insider Board Installation**” on page 24–43 for instructions.

2. Navigate to the **Option Cards Menu** as follows:
   - Press **HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ MORE ⇒ Option Cards**.
3. Press **Ultimatte** to display the **Ultimatte Option Card Menu**.

4. Use the **Ultimatte Card** knob to select the *available* host **Input Carrier Board** – Carr#1-8, and **Socket** number – Sock#1-4.

5. Use the **Mode** knob to choose the mode you wish to make active – in this case **Bus**. When selecting a mode, the bottom **MLE-Key** knob title and selections become available.

6. Use the **MLE-Key** knob to select the **MLE – 1-4** and the **Key – 1-2** that you wish to associate with the Ultimatte.

7. You may receive one of the following messages:
   - If you have previously associated an **Ultimatte card** with a specified MLE keyer, and you try to associate another **Ultimatte card** with the same MLE keyer, an error message is displayed.

   **Important**

   If you exit the **Ultimatte Option Cards Menu** with the selected Ultimatte card associated with the selected MLE keyer, the previous settings are overwritten.

   - If you have previously associated an **Aspectizer card** with an MLE keyer, and you try to associate an **Ultimatte card** with the same MLE keyer, an error message is displayed.

   **Important**

   If you exit the **Ultimatte Option Cards Menu** with an Aspectizer and an Ultimatte Insider set to the same MLE keyer, the switcher may generate invalid output from that MLE keyer.

In the above example, note that the **Ultimatte** is installed on **Input Carrier Board #2, Socket #2** and that **Key2** on **MLE2** has been assigned to the **Ultimatte** in **Bus** mode.
At this point, we have completed a *partial Bus Mode* setup. Any of the 8 inputs associated with the specific Input Carrier Board (in this example BNC 9 – BNC 16) are available to be routed through an Aux Bus.

**Setting Up an Untimed Aux Bus**

One *untimed* Aux Bus is required for each Ultimatte card running in Bus Mode operation. The Aux Bus must be “fed back” into *any* one of the BNC inputs associated with the Input Carrier Board on which the Ultimatte is installed. In turn, this Aux Bus becomes unavailable for any other use. Continue with the procedure below to connect an Aux Bus to the Ultimatte.

On the rear of the Synergy frame, use industry standard coaxial cable to connect an *untimed* Aux Bus BNC to one of the BNC inputs available to the Input Carrier Board with the Ultimatte Insider Board on it. The following diagram indicates the cabling connections used in this procedure.

**Selecting an Aux Bus**

The Local Panel Setup Menu defines the mode for the Aux Bus and allows you to assign specific switching parameters or “rights” to the Aux Bus. For more information on Aux Bus Setup parameters and options, refer to Chapter 9, “Additional Installation Setups”.

Use the following procedure to tell the system which Aux Bus feeds back into the switcher:

1. Navigate to the Aux Bus Menu 1-2 as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Aux Bus.

Note: Remember that the association is between the MLE keyer and the host Input Carrier Board. Any of the eight BNC inputs for the Input Carrier Board can be assigned as an Aux Bus re-entry source.
2. Press **Local Panel** to display the **Local Panel Setup Menu**.

```plaintext
<table>
<thead>
<tr>
<th>Aux Bus (1-2)</th>
<th>Mode</th>
<th>Bus Follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aux 1 (GR 1)</td>
<td>Bus Follow</td>
<td>Bus follow</td>
</tr>
<tr>
<td>Aux 2 (MR 2)</td>
<td>#Follow</td>
<td>#Follow</td>
</tr>
<tr>
<td>Xpt mapping:</td>
<td></td>
<td>NLE Xpt</td>
</tr>
</tbody>
</table>
```

**Aux Bus — Local Panel Setup Menu**

3. Use the **Aux Bus** knob to select the **Aux Bus** output you have connected (fed back) to the **Input Carrier Board**.

4. Use the **Mode** knob to select **Bus Follow**. The **Bus Follow Mode** directs the **Aux Bus** to follow the user’s selections on a specified MLE and bus.

![Note]

```
**Note**
In **Bus Follow Mode**, the user is “locked out” of the designated Aux Bus and **cannot** make selections on the **Aux Bus** panel itself.
```

This completes the procedure to select which **Aux Bus** feeds back into the switcher. Now you must tell the switcher which bus, on which MLE, you want the **Aux Bus** to follow.

### Selecting an MLE Bus

Use the following procedure to select which MLE Bus you want the Aux Bus to follow:

1. In the **Local Panel Setup Menu**, press **Bus Follow Assign**.
2. Press **Bus Assign** to display the **Bus Follow Bus Assign Menu**.

```
<table>
<thead>
<tr>
<th>Bus Follow</th>
<th>Aux Bus:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus</td>
<td>Aux 1 (GR 1)</td>
</tr>
<tr>
<td>Bus</td>
<td>Aux 2 (MR 2)</td>
</tr>
<tr>
<td>Bus</td>
<td>#Follow</td>
</tr>
<tr>
<td>Bus</td>
<td>#Follow</td>
</tr>
<tr>
<td>Xpt mapping:</td>
<td>NLE Xpt</td>
</tr>
</tbody>
</table>
```

**Bus Follow — Bus Assign Menu**

3. Use the **Aux Bus** knob to choose the Aux Bus you connected to the **Input Carrier Board**.
4. Use the **MLE** knob to select the MLE you assigned to the **Ultimatte Board**.
5. Use the **Bus** knob to select the **Key # (not a Key # Alpha)** you assigned with the MLE.

This completes the procedure to select which MLE Bus you want the Aux Bus to follow. Next you will assign the Aux Bus back into a selected BNC input.
Assigning the Aux Bus to a BNC Input

The final step in configuring your Ultimatte in Bus Mode involves assigning or routing the Aux Bus back into the appropriate BNC input.

**Important**

The source that you select on the Key Bus activates the Ultimatte menus and internally calls up the Ultimatte’s processed alpha and fill signals. The selected source’s panel button on the Program and Preset buses remains the original unprocessed video signal. To place the Ultimatte’s processed signals on the Program and Preset buses, refer to the “Ultimatte Auto Select Key Setup” section below.

Use the following procedure to assign the Aux Bus to a BNC input:

1. In the Bus Assign Menu, press the BNC Assign to display the Bus Follow BNC Assign Menu.

2. Use the Aux Bus knob to select the Aux Bus connected to the Input Carrier Board.

3. Use the BNC knob to assign the Input Carrier Board BNC you connected to the Aux Bus.

This completes the procedure to assign the Aux Bus to a BNC input.

This concludes the procedures for setting up an Ultimatte key for use in Bus mode. Repeat the Ultimatte Insider Setup – Bus Mode procedures for each Ultimatte Insider Board you wish to set up in Bus mode. Refer to Chapter 12 “Ultimatte Insider” in the Synergy Series Operation Guide, for operating instructions.

Ultimatte Auto Select Key Setup

Each Ultimatte Insider Board automatically produces processed alpha and fill signals. These signals are used internally to produce the Ultimatte key in the associated MLE, but they can also be placed elsewhere on the Synergy panel for use as Auto Select sources in the normal way.

In practice, this means that if you have an Ultimatte key enabled on MLE 1, you can use the same video and alpha sources elsewhere on the switcher, as a normal Auto Select key. If you change the base Ultimatte key source, or change its clip parameters, each associated Auto Select key changes accordingly.

Use the following procedure to set up the Ultimatte’s alpha and fill signals as Auto Select sources:

1. Ensure that each Ultimatte Insider board is properly associated to an MLE and a keyer. If not, refer to the section “Ultimatte Insider Board Installation” on page 24–43.

2. Navigate to the Panel Button Setup Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ BNC ⇒ Panel.
3. Use the Crosspoint knob to select the button on which you want to associate the Ultimatte’s processed fill (video) signal.

4. Use the BNC knob to scroll the selection down past input 64. Note that the label BNC changes to OPT — indicating that this region of the menu is reserved for internally generated signals from the optional boards on the Input Carrier Board.

5. Select the desired internal Ultimatte video signal (e.g., Ultm13 v). Note that the suffix “v” indicates video (fill). Additionally, the internal Ultimatte alpha signal, such as Ultm13 a, is automatically associated with the video as the Auto Key alpha. Note that the suffix “a” indicates alpha. In the Status Box, the system identifies:
   - the internal source (Ultimatte Video);
   - the type (Other);
   - the location of the optional board (e.g., carrier 1, socket 3); and
   - the native aspect ratio (4x3).

6. Repeat for each Ultimatte processed video signal that you want to place on the panel.

7. When all buttons are programmed as desired:
   - Press HOME to exit the installation menus.
   - Press Confirm to confirm your changes.

This completes the procedure for setting up a panel button to use as an Ultimatte Auto Select key. Refer to the Synergy Series Operation Guide for operating instructions and additional operational notes.
In This Appendix

This appendix details how to modify the Synergy Frame Processor Module (4000A-003) for boards prior to issue 2C to work with the CDK-111A-M downstream keyer card option.

The following topics are discussed:

- Frame CPU Modification
- Instructions

Additional information on the CDK-111A-M and its interface with Synergy switchers can be found in the Synergy Series Installation Guide:
  - Chapter 2 – Preliminary Cabling and Check
  - Chapter 7 – Basic Communications Setup
  - Chapter 9 – Additional Installation Setups

In the Synergy Series Operation Guide, refer to Chapter 14 “External DSK 3/4 (CDK-111A-M)”.
Frame CPU Modification

Synergy Frame Processor Module (4000A-003) for boards prior to issue 2C must be modified to work with the external downstream keyer (CDK-111A-M).

When removing or modifying the board you must follow the warnings and safety instructions found in Chapters 1 through 4 of the *Synergy Series Installation Guide*.

**Instructions**

This procedure allows the Synergy switcher to communicate with the (two maximum) external downstream keyers.

With reference to the following block diagram graphic representation of the Synergy Frame Processor Module component layout:

1. Remove the resistors R17, R18, R19, R28, R31, and R32 as shown in ②, below.
2. Replace resistors R17 and R32 with 120 Ohm resistors of the same rating (¼ Watt) or greater.
3. Replace resistors R28 and R31 with 300 Ohm resistors of the same rating (¼ Watt) or greater.
4. Install two, 200 Ohm resistors (rated at ¼ Watt or greater) in the location shown as ③ in the following block diagram.
Appendix E. Switcher Installation Worksheets

In This Appendix

This appendix provides worksheet tables to help plan and record switcher installation settings and wiring connections. The following worksheets are included:

- Input Worksheet
- Primary Output Worksheet
- Auxiliary Output Worksheet
- Special Output Worksheet
- Remote Control Worksheet
- Standard GPI Input Worksheet
- Standard GPI Output Worksheet
- Remote Aux Panel GPI Input Worksheet
- Custom Control Worksheet
# Input Worksheet

Make copies of this blank worksheet for use as required. Complete the following worksheet for all of your video inputs, including primary sources, keys and fills.

The optional **Ultimatte Insider Board** is installed on an **Input Carrier Board**. Only BNCs attached to that Input Carrier Board can be fed to the Ultimatte. Verify that any inputs that you wish to Chroma key (like cameras) are fed to the appropriate Input Carrier Board BNCs.

<table>
<thead>
<tr>
<th>BNC #</th>
<th>Actual Source</th>
<th>Remote Port</th>
<th>Device Address</th>
<th>Input Name</th>
<th>Input Type</th>
<th>Tally Number</th>
<th>Alpha Type</th>
<th>Auto Key</th>
<th>Audio Channel</th>
<th>Physical Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample 1</td>
<td>VTR 1</td>
<td>Remote 1</td>
<td>VTR Blue</td>
<td>VTR</td>
<td>12</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Sample 2</td>
<td>CG Alpha</td>
<td>Remote 2</td>
<td>CG Alpha</td>
<td>Alpha</td>
<td>—</td>
<td>S, Off</td>
<td>25</td>
<td>—</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### BNC Input Worksheet

<table>
<thead>
<tr>
<th>BNC #</th>
<th>Actual Source</th>
<th>Remote Port</th>
<th>Device Address</th>
<th>Input Name</th>
<th>Input Type</th>
<th>Tally Number</th>
<th>Alpha Type</th>
<th>Auto Key</th>
<th>Audio Channel</th>
<th>Physical Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>23</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>52</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>53</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>54</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>56</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>57</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>58</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
For further details, refer to the section “Connecting and Verifying Inputs”.

<table>
<thead>
<tr>
<th>BNC #</th>
<th>Actual Source</th>
<th>Remote Port</th>
<th>Device Address</th>
<th>Input Name</th>
<th>Input Type</th>
<th>Tally Number</th>
<th>Alpha Type</th>
<th>Auto Key</th>
<th>Audio Channel</th>
<th>Physical Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>59</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>61</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>62</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>63</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>64</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Primary Output Worksheet

Make copies of this blank worksheet for use as required. Complete the following primary output worksheet. Use the figure below for reference (note that only primary outputs are shown).

Fill in the desired destination for each output signal. See the DSK 3/4 (CDK-111A-M) Cabling Connections section at the end of this chapter for details on DSK BNC assignment for this worksheet.

<table>
<thead>
<tr>
<th>Output Connector</th>
<th>Synergy 2 Destination</th>
<th>Synergy 3 Destination</th>
<th>Synergy 4 Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAIN PGM</td>
<td>(MLE 2 PGM)</td>
<td>(MLE 3 PGM)</td>
<td>(MLE 4 PGM)</td>
</tr>
<tr>
<td>MLE 1 PGM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MLE 1 PV</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MLE 2 PGM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MLE 2 PV</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MLE 3 PGM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MLE 3 PV</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MLE 4 PGM</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MLE 4 PV</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For further details, refer to Chapter 4, “Preliminary Video Installation”.

Primary Output BNC Connections

![Primary Output BNC Connections Diagram]
Auxiliary Output Worksheet

Make copies of the following worksheet for use as required. Complete the following auxiliary output worksheet. Use the figure below for reference (note that only auxiliary outputs are shown).

![Auxiliary Output BNC Connectors]

Fill in the desired destination for each output signal. Refer to the **DSK 3/4 (CDK-111A-M) Cabling Connections** section in this chapter for details on DSK BNC assignment for this worksheet.

<table>
<thead>
<tr>
<th>Output Connector</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUX 1</td>
<td></td>
</tr>
<tr>
<td>AUX 2</td>
<td></td>
</tr>
<tr>
<td>AUX 3</td>
<td></td>
</tr>
<tr>
<td>AUX 4</td>
<td></td>
</tr>
<tr>
<td>AUX 5</td>
<td></td>
</tr>
<tr>
<td>AUX 6</td>
<td></td>
</tr>
<tr>
<td>AUX 7</td>
<td></td>
</tr>
<tr>
<td>AUX 8</td>
<td></td>
</tr>
<tr>
<td>AUX 9</td>
<td></td>
</tr>
<tr>
<td>AUX 10</td>
<td></td>
</tr>
<tr>
<td>AUX 11</td>
<td></td>
</tr>
<tr>
<td>AUX 12</td>
<td></td>
</tr>
</tbody>
</table>

For further details, refer to the section “**Output Connection**” on page 4–12.
Special Output Worksheet

Make copies of the following worksheet for use as required. Complete the following special output worksheet. Use the figure below for reference (note that only special outputs are shown).

Special Output BNC Connections

Fill in the desired destination for each special output signal. Outputs serve the same function on all three switchers.

<table>
<thead>
<tr>
<th>Output Connector</th>
<th>Note</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLEAN</td>
<td>Standard. Provides clean feed output (software configurable).</td>
<td></td>
</tr>
<tr>
<td>PV</td>
<td>Standard. Provides main output of the preview matrix.</td>
<td></td>
</tr>
<tr>
<td>OVL</td>
<td>Option. Preview overlay must be installed for a signal to be present.</td>
<td></td>
</tr>
<tr>
<td>SPARE</td>
<td>The output is currently not implemented.</td>
<td></td>
</tr>
<tr>
<td>EXP 1</td>
<td>The output is currently not implemented.</td>
<td></td>
</tr>
<tr>
<td>EXP 2</td>
<td>The output is currently not implemented.</td>
<td></td>
</tr>
<tr>
<td>EXP 3</td>
<td>The output is currently not implemented.</td>
<td></td>
</tr>
<tr>
<td>EXP 4</td>
<td>The output is currently not implemented.</td>
<td></td>
</tr>
</tbody>
</table>

For further details, refer to the section, “Connecting and Verifying Outputs”.

Remote Control Worksheet

Using the figure below for reference, complete the following remote control worksheet. Copy the worksheet as required. Fill in the serial controlled device and the remote control port (on the device) that is used for serial control.

If you have installed a Remote Port Expander (BSS4) to the Synergy switcher, there are four additional remote ports labelled A, B, C and D, corresponding to the Slave Ports on the BSS4 that will start with the number of the remote port that the BSS4 is connected to.

The following figure illustrates the location of the eight remote control connectors on the rear of the control panel.

![Remote Control Connections](image_url)

### Remote Control Worksheet

<table>
<thead>
<tr>
<th>Remote Connector</th>
<th>Serial Controlled Device</th>
<th>Device Serial Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 1A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 1B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 1C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 1D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 2D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 3D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 4D</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Remote Control Worksheet

<table>
<thead>
<tr>
<th>Remote Connector</th>
<th>Serial Controlled Device</th>
<th>Device Serial Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 5A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 5B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 5C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 5D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 6D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 7D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote 8D</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For further details on setting up a Remote Port Expander (BSS4), refer to the section “Remote Port Expander (BSS4) Setup”.
Standard GPI Input Worksheet

Make copies of this blank worksheet for use as required. Complete the following Standard GPI Input worksheet.

<table>
<thead>
<tr>
<th>Standard GPI Input #</th>
<th>Transition Type</th>
<th>Transition Area</th>
<th>Polarity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample GPI Input #1</td>
<td>Auto</td>
<td>MLE 1</td>
<td>Low</td>
</tr>
<tr>
<td>Sample GPI Input #2</td>
<td>Cut</td>
<td>Fade to black</td>
<td>High</td>
</tr>
</tbody>
</table>

For further details, refer to the section “Standard GPI Setup”.

# Standard GPI Output Worksheet

Make copies of this blank worksheet for use as required. Complete the following Standard GPI Output worksheet.

<table>
<thead>
<tr>
<th>Standard GPI Output #</th>
<th>Output Name</th>
<th>Trigger Type</th>
<th>Trigger Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>sample GPI Output #1</td>
<td>PrevStill</td>
<td>Edge</td>
<td>Low</td>
</tr>
<tr>
<td>sample GPI Output #2</td>
<td>Roll VTR</td>
<td>Level</td>
<td>High</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For further details, refer to the section “Standard GPI Setup”.
Remote Aux Panel GPI Input Worksheet

Make copies and complete the following blank 2-page Remote Aux Panel GPI Input worksheet. Note on the worksheet the remote GPI numbers, group numbers, offset numbers, and physical panel GPI numbers have already been filled in.

<table>
<thead>
<tr>
<th>Remote GPI</th>
<th>Group / Offset / Physical GPI</th>
<th>Assigned Aux Bus</th>
<th>Assigned BNC</th>
<th>Type/Edge</th>
<th>Physical Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Aux GPI 5</td>
<td>Group 1, Offset 0, GPI 5</td>
<td>Aux Bus 1</td>
<td>5 (Cam 4)</td>
<td>Cam 4 Joystick</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Group 1, Offset 0, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Group 1, Offset 0, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Group 1, Offset 0, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Group 1, Offset 0, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Group 1, Offset 0, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Group 1, Offset 0, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Group 1, Offset 0, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Group 1, Offset 0, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Group 2, Offset 1, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Group 2, Offset 1, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Group 2, Offset 1, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Group 2, Offset 1, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Group 2, Offset 1, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Group 2, Offset 1, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Group 2, Offset 1, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Group 2, Offset 1, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Group 3, Offset 2, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Group 3, Offset 2, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Group 3, Offset 2, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Group 3, Offset 2, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Group 3, Offset 2, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Group 3, Offset 2, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Group 3, Offset 2, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Group 3, Offset 2, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Group 4, Offset 3, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Group 4, Offset 3, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>Group 4, Offset 3, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>Group 4, Offset 3, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>Group 4, Offset 3, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Group 4, Offset 3, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>Group 4, Offset 3, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>Group 4, Offset 4, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
For further details, refer to the section “Remote Aux Panel GPI Setup”.

<table>
<thead>
<tr>
<th>Remote GPI</th>
<th>Group / Offset / Physical GPI</th>
<th>Assigned Aux Bus</th>
<th>Assigned BNC</th>
<th>Type/Edge</th>
<th>Physical Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>33</td>
<td>Group 5, Offset 4, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>Group 5, Offset 4, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>Group 5, Offset 4, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Group 5, Offset 4, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Group 5, Offset 4, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>Group 5, Offset 4, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>Group 5, Offset 4, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>Group 5, Offset 4, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>Group 6, Offset 5, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>Group 6, Offset 5, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>Group 6, Offset 5, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>Group 6, Offset 5, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>Group 6, Offset 5, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>Group 6, Offset 5, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>Group 6, Offset 5, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>Group 6, Offset 5, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>Group 7, Offset 6, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>Group 7, Offset 6, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>Group 7, Offset 6, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>Group 7, Offset 6, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>Group 7, Offset 6, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>54</td>
<td>Group 7, Offset 6, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>Group 7, Offset 6, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>56</td>
<td>Group 7, Offset 6, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>Group 8, Offset 7, GPI 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>58</td>
<td>Group 8, Offset 7, GPI 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>59</td>
<td>Group 8, Offset 7, GPI 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>Group 8, Offset 7, GPI 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>61</td>
<td>Group 8, Offset 7, GPI 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>62</td>
<td>Group 8, Offset 7, GPI 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>63</td>
<td>Group 8, Offset 7, GPI 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>Group 8, Offset 7, GPI 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Custom Control Worksheet

Complete the following custom control worksheet. Make copies of this blank worksheet as required.

Note that functions marked “Not Implemented” are not currently available, and should not be used for a custom control button at this time.

Operating Tip

Keep custom control functions such as time clock, VTR, and DVE physically grouped together on your custom control buttons.
### Custom Control Worksheet

**Custom Control Bank Name/Number:**

<table>
<thead>
<tr>
<th>Custom Control Button Name</th>
<th>Custom Control Function(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td></td>
</tr>
<tr>
<td>34</td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
</tr>
</tbody>
</table>
Appendix F. Custom Device Serial Protocols

In This Appendix

This appendix provides information and procedures for setting up a custom device and programming a serial protocol to communicate with said device from a Synergy remote port. The following sections are provided and discussed:

- Custom Devices – Uses and Limitations
- Custom Devices Modify Menu
- Programming Commands
- Programming Worksheets
- Advanced Topics and Tables
Custom Devices – Uses and Limitations

The Custom Devices Setup Menu allows the user to program serial command protocols for controlling external devices not otherwise supported by Synergy. Custom Devices are also useful in testing out currently unsupported commands to external devices, as well as other general communications testing.

There are two user-programmable custom device protocols available, these being CUSTOM0 and CUSTOM1. Ports on both the panel and the frame can be used, with the following limitations and requirements.

- To use custom devices on the panel, you must have purchased and installed the VTR Remote Control option. Refer to Chapters 2 and 7 of this guide for details on installing and configuring this option.
- Any data received back from the external device is ignored. Therefore, queries for Current-time-sense (e.g. grab timecode), Inpoint, Outpoint and Clip-ID-names are not supported.
- If suitable commands are programmed (e.g., command tag PLAY, etc.), VTRs and VTR-like devices can be controlled via custom control buttons or by remote menus and ROLL VTR transitions.
- You can control other non-VTR devices (e.g., CCUs, CGs, etc.) by substituting their commands for those in the Command-tag list of the Custom Device Menu. Refer to the section “Advanced Topics and Tables” on page 27–9 for a list of available command tags. This list also appears (for applicable commands) in the VTR Functions and DVE Functions, refer to Chapter 8 “Memory Functions and More” of the Synergy Series Operation Guide.

When substituting for other commands, record these substitutions on the worksheet provided in this appendix. As an aid, we recommend that the custom control used to perform the command be suitably named. As a rule, these devices will have no BNC association, and consequently will not be accessed by ROLL VTR or by any remote menus.

- Custom Devices can use any of the panel’s remote ports and any of the frame DVE ports. However, custom devices protocols cannot be used on the Aux, Peripheral and Editor ports.
- To use custom devices on the frame, you must have purchased the DVE Send and Remote Control option.
- DVE Send is not supported at this time. Therefore, DVE ports using custom devices can only be accessed via Custom Controls.
- Some protocol usage may exceed the maximum number of bytes (19) allocated per command. In cases where a custom control is used, 2 command slots (and 2 tags) can be used and a custom control programmed to invoke them in immediate succession. Each user-programmed device supports a maximum of 10 command slots. There may be other practical problems with the protocol you are trying to reproduce that may render custom devices unsuitable. Please do not hesitate to contact Ross Video technical support for assistance in using this feature.
Custom Devices Modify Menu

The **Custom Devices Modify** menu is divided into five main areas.

In the upper right-hand corner (below the title), line numbers (or byte numbers) are displayed, followed by the hexadecimal representation of the data byte at that location.

To the right of these line numbers and data values, under the heading Ascii/Param., are the ASCII text characters equivalent to the data values. Refer to the table at the end of this appendix for converting decimal to hexadecimal to ASCII text. These two areas can also show special option values. Refer to the section “**Advanced Topics and Tables**” on page 27–9 for more information.

As with all other Synergy menus, the far right of the LCD lists the options modified by the three optical knobs, and the bottom label area allows for menu selection using the **F1** to **F6** soft keys.

Just above the label area is a line of single characters from 0 to 9 and A to F. This line is the hexadecimal number line. This line is where the cursor (controlled by the middle **Set Nybble** knob) indicates the value of the currently selected nybble of the byte being edited. The top knob determines which line to edit and the **F2** soft key button determines which nybble to edit (upper most significant nybble or lower least significant nybble).

The following section provides procedures for programming your custom devices.
Programming Commands

Use the following procedure to navigate through the Custom Devices Menus:

1. Navigate to the Communications Menu 1-2 as follows:
   
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ Communications.

2. Press Custom Devices to display the Custom Devices Menu.

3. Use the middle scroll knob to select the custom device that you wish to modify.

4. Press Modify to display the Custom Devices Modify Menu.

5. Below are some examples of programming simple commands in a Custom Device Protocol. The first example demonstrates how to set the PLAY Command Tag to send the Sony Betacam play message, as shown here.

6. Start the first line by pressing Insert Line, and dialing the middle knob (Set Nybble) until the first nybble of the first line (00) indicates a 2. This will also be highlighted on the Hex digit number line to the left of the Command Tag.
7. Use **Insert Line** again to add a second byte to the command as shown here.

8. Use the **Toggle Nybble** soft key to move to the lower nybble of the byte, and dial the middle knob to set the second byte to 01.

9. Press **Insert Line** to add the final line.

10. Use the **Set Nybble** knob to set the first nybble to 2.

11. Press **Toggle Nybble**, and set the lower nybble to 1.
12. In a similar fashion the Stop tag can be set to hex values of **20, 00 20** as shown here.

![Custom Devices Modify Menu – Stop Tag](image)

Program your custom devices in accordance with the information and tables attached.
Programming Worksheets

Use the following Programming Worksheets to record your substituted commands.

### First Custom Device Protocol CUSTOM0 – Programming sheet

<table>
<thead>
<tr>
<th>#</th>
<th>Description:</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#2</td>
<td>Description:</td>
<td>Tag:</td>
</tr>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#3</td>
<td>Description:</td>
<td>Tag:</td>
</tr>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#4</td>
<td>Description:</td>
<td>Tag:</td>
</tr>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#5</td>
<td>Description:</td>
<td>Tag:</td>
</tr>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#6</td>
<td>Description:</td>
<td>Tag:</td>
</tr>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#7</td>
<td>Description:</td>
<td>Tag:</td>
</tr>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#8</td>
<td>Description:</td>
<td>Tag:</td>
</tr>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#9</td>
<td>Description:</td>
<td>Tag:</td>
</tr>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#10</td>
<td>Description:</td>
<td>Tag:</td>
</tr>
<tr>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Suggested abbreviations for parameter flags notation:** H – Hex, B– BCD, AH – ASCII Hex, AB – ASCII BCD / 1-8 (digits) or 4,8..32 (bits) / M – Mot, I – Int. / S – Sca, E – Ext, + – Sign.

**Example:** B4/ M/+ would be a signed 4 digit BCD with Motorola ordering
**Programming Worksheets**

**Second Custom Device Protocol CUSTOM1 – Programming sheet**

<table>
<thead>
<tr>
<th>#1</th>
<th>Description:</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bytes</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#2</th>
<th>Description:</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bytes</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#3</th>
<th>Description:</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bytes</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#4</th>
<th>Description:</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bytes</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#5</th>
<th>Description:</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bytes</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#6</th>
<th>Description:</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bytes</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#7</th>
<th>Description:</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bytes</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#8</th>
<th>Description:</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bytes</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#9</th>
<th>Description:</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bytes</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#10</th>
<th>Description:</th>
<th>Tag:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bytes</td>
<td></td>
</tr>
</tbody>
</table>


**Example:** B4/ M/+ would be a signed 4 digit BCD with Motorola ordering
Advanced Topics and Tables

Besides strings of constant Hex values (bytes), commands can be programmed with special characters and with converted parameter values. Examples of the special characters include the two special values to perform a communications break. The communications break is formed by a data zero event that extends beyond the normal data bit length permitted in the serial data word (e.g., serial word length of 8-Odd-1Stop bit is 1+8+1+1 = 11 bits long). The commonly used minimum length for break is 17 bits long or one and a half to two data-words. To implement a break in custom devices, there needs to be a [Break On], a [Break Off], and an optional delay in between.

Certain commands pass a parameter to the custom device driver that can be converted into a string of bytes using a special packed command in place of a single byte. Only one of these special command lines may appear in any given command slot (since only one parameter is ever passed). This command line is converted during runtime into the specified one to four bytes of parameter data, and included at that location in the command string. One command tag that gets a parameter is the Cue to Clip command. The value passed when a Cue to Clip command is triggered is the desired cue time as represented in a packed word timecode format. Typically, this value must then be converted into some representation of packed timecode bytes to be sent to the external device. The packed command flags are described in the following table. You may want to use the Panel Diagnostic\RX/TX\Monitor to view the results when using parameters in commands.

### Packed Command Flags

<table>
<thead>
<tr>
<th>Special Names</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Break On]</td>
<td>Force the outputs to data low value (for RS232 data low is a positive voltage)</td>
</tr>
<tr>
<td>[Break Off]</td>
<td>Release the outputs from a forced data low</td>
</tr>
<tr>
<td>[Checksum]</td>
<td>Insert the checksum byte (currently supports only simple 8-bit additive checksum)</td>
</tr>
<tr>
<td>[Posn X]</td>
<td>Not currently supported</td>
</tr>
<tr>
<td>[Posn Y]</td>
<td>Not currently supported</td>
</tr>
<tr>
<td>[Posn Z]</td>
<td>Not currently supported</td>
</tr>
<tr>
<td>[Param...]</td>
<td>Parameter (see parameter formatting flags below)</td>
</tr>
</tbody>
</table>

### Parameter Formatting Flags

<table>
<thead>
<tr>
<th>Special Formats</th>
<th>Description</th>
</tr>
</thead>
</table>
| Hex             | Parameter take as is and converted into string of bytes (1-4)  
  **Note**: if the parameter is already in a packed BCD format then using Hex format will preserve the BCD format of the parameter |
| ASCII Hex       | Text representation of above “Hex” format. |
| BCD             | Binary Coded Decimal (each nybble represents 1 digit 0-9)  Converts a parameter that is in non-BCD format to a BCD format |
| ASCII BCD       | Text representation of above “BCD” format.  Converts a parameter from a non-BCD format to a text representation of the equivalent BCD format. |

### Byte Format Ordering

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Mot</td>
<td>Motorola ordering. Most Significant Byte (MSB) first, LSB last.</td>
</tr>
<tr>
<td>Int</td>
<td>Intel ordering. Least Significant Byte (LSB) first, MSB last.</td>
</tr>
</tbody>
</table>
### Parameter Formatting Tags (cont.)

<table>
<thead>
<tr>
<th>Special buttons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scaled (Sca)</td>
<td>Re-scales a 12-bit parameter to fit output range</td>
</tr>
<tr>
<td>ASCII Extended (Ext)</td>
<td>Extends up the output to an even number of digits/characters without changing the output range</td>
</tr>
<tr>
<td>Signed (Sign)</td>
<td>Internal use - sign conversion</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BCDWidths</th>
<th>(examples in Motorola ordering)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Digit</td>
<td>1 byte of 1 digit, [00] to max [09]</td>
</tr>
<tr>
<td>2 Digits</td>
<td>1 bytes of 2 packed digits each, [00] to max [99]</td>
</tr>
<tr>
<td>3 Digits</td>
<td>1 bytes of 2 packed digits and 1 byte of 1 digit, [00][00] to max[09][99]</td>
</tr>
<tr>
<td>4 Digits</td>
<td>2 bytes of 2 packed digits each, [00][00] to max[99][99]</td>
</tr>
<tr>
<td>5 Digits</td>
<td>2 bytes of 2 packed digits and 1 byte of 1 digit, max [09][99][99]</td>
</tr>
<tr>
<td>6 Digits</td>
<td>3 bytes of 2 packed digits each, max [99][99][99]</td>
</tr>
<tr>
<td>7 Digits</td>
<td>3 bytes of 2 packed digits and 1 byte of 1 digit, max [09][99][99][99]</td>
</tr>
<tr>
<td>8 Digits</td>
<td>4 bytes of 2 packed digits each, max [99][99][99][99]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HexWidths</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>4 Bits</td>
<td>[00] to [0F]</td>
</tr>
<tr>
<td>8 Bits</td>
<td>[00] to [FF]</td>
</tr>
<tr>
<td>12 Bits</td>
<td>[00][00] to [0F][FF] (or Intel [FF][0F])</td>
</tr>
<tr>
<td>14 Bits</td>
<td>[00][00] to [3F][FF] (or Intel [FF][3F])</td>
</tr>
<tr>
<td>15 Bits</td>
<td>[00][00] to [7F][FF] (or Intel [FF][7F])</td>
</tr>
<tr>
<td>16 Bits</td>
<td>[00][00] to [FF][FF]</td>
</tr>
<tr>
<td>24 Bits</td>
<td>[00][00][00] to [FF][FF][FF]</td>
</tr>
<tr>
<td>32 Bits</td>
<td>[00][00][00][00] to [FF][FF][FF][FF]</td>
</tr>
</tbody>
</table>
### List of available Custom Device Commands

<table>
<thead>
<tr>
<th>Tag</th>
<th>Available to VTR/DVE</th>
<th>Parameter</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEEK TIMECODE (use Goto Clip in Custom Controls)</td>
<td>VTR</td>
<td>VTRClip Time as a packed BCD HHMMSSFF</td>
<td>VTR remote menus, Custom controls, VTR Clips. Use Hex to output BCD</td>
</tr>
<tr>
<td>REWIND</td>
<td>VTR</td>
<td>None</td>
<td>VTR remote menus, Custom controls</td>
</tr>
<tr>
<td>FRAME REVERSE</td>
<td>VTR / DVE</td>
<td>None</td>
<td>VTR remote menus, Custom controls</td>
</tr>
<tr>
<td>PLAY REVERSE</td>
<td>DVE</td>
<td>None</td>
<td>Custom controls only.</td>
</tr>
<tr>
<td>PAUSE</td>
<td>VTR / DVE</td>
<td>None</td>
<td>VTR remote menus, Custom controls</td>
</tr>
<tr>
<td>STOP</td>
<td>VTR / DVE</td>
<td>None</td>
<td>VTR remote menus, Custom controls</td>
</tr>
<tr>
<td>PLAY</td>
<td>VTR / DVE</td>
<td>None</td>
<td>Needed for ROLL VTR, VTR remote menus. Also custom controls (VTR and DVE)</td>
</tr>
<tr>
<td>FRAME ADVANCE</td>
<td>VTR / DVE</td>
<td>None</td>
<td>VTR remote menus, Custom controls</td>
</tr>
<tr>
<td>FAST FORWARD</td>
<td>VTR / DVE</td>
<td>None</td>
<td>VTR remote menus, Custom controls</td>
</tr>
<tr>
<td>RECORD</td>
<td>VTR</td>
<td>None</td>
<td>Custom controls only.</td>
</tr>
<tr>
<td>DVE RECALL</td>
<td>DVE</td>
<td>Effect Number</td>
<td>Custom controls and DVE shot-box (pattern area) only.</td>
</tr>
<tr>
<td>FADER POSITION</td>
<td>Future DVE</td>
<td>Position 0-4095</td>
<td>DVESEND - Not enabled currently</td>
</tr>
<tr>
<td>DIAGNOSTIC 1</td>
<td>VTR / DVE</td>
<td>None</td>
<td>Custom controls only.</td>
</tr>
<tr>
<td>DIAGNOSTIC 2</td>
<td>VTR / DVE</td>
<td>None</td>
<td>Custom controls only.</td>
</tr>
<tr>
<td>DIAGNOSTIC 3</td>
<td>VTR / DVE</td>
<td>None</td>
<td>Custom controls only.</td>
</tr>
</tbody>
</table>
### Note:
7-bit printable ASCII range from 32 to 126 decimal. The Custom device menus represent text values outside that range with a period ‘.’.
Glossary of Terms

Active Video Lines — All video lines not occurring in the vertical blanking interval. The portion of the video signal that contains picture information.

Aspect Ratio — The numerical ratio of picture width to height, for example, 4:3 or 16:9.

Auto Transition — An automatic transition that electronically simulates the manual movement of the fader handle. The transition starts when the AUTO TRANS button is pressed and takes place over a pre-selected time period, measured in frames.

Border — Effects created around the edges of a pattern or on a keyer. If an optional dual border generator card is installed, several border, shadow, and outline effects are available on that keyer as well.

Border Generator — Circuitry that generates various border effects on keys created by the switcher.

Chroma Key — An effect where video from one source replaces video of a specific hue in a second video source. The blue and green hues are most commonly used for chroma keying.

Chrominance — The “depth” or saturation of a color. The three characteristics of a TV color signal are chrominance, luminance and hue.

Cut — An instantaneous switch from one video signal to another.

Dissolve — A transition from one video signal to another where one signal is faded down while the other is simultaneously faded up. The term “mix” is often used interchangeably with “dissolve”.

Downstream Keyer (DSK) — A keyer that places a key “downstream” of the MLE effects system output. This “top level” effect usually consists of a character generator title.

External Key — A video input (non-primary video) used to produce a key effect. Examples of external key sources are character generators and cameras.

Fade-to-Black — A controlled change of the on-air picture signal level down to black level.

Field — One half of a complete picture (or frame) interval containing all of the odd, or all of the even lines in interlaced scanning. One scan of a TV screen is called a “field”; two fields are required to make a complete picture (which is a “frame”).
**Field Frequency** — The rate at which one complete field is scanned, approximately 50 times per second in 625 video, or 60 times per second in 525 video.

**Frame** — One complete picture consisting of two fields of interlaced scanning lines.

**GPI** — An abbreviation for General Purpose Interface, a device that typically allows remote control of the switcher’s automatic transition functions.

**Hue** — The characteristic of a color signal that determines whether the color is red, yellow, green, blue, purple, etc. (the three characteristics of a TV color signal are chrominance, luminance, and hue). White, black, and gray are not considered hues.

**Internal Key** — The use of a primary input to produce a key effect.

**Key** — An effect produced by “cutting a hole” in background video, then filling the hole with video or matte from another source. Key source video cuts the hole, key fill video fills the hole. The video signal used for cut and fill can come from the same or separate sources.

**Key Fill** — A video input which is timed to “fill the hole” provided by the key source video. An example of key fill is the video output of a character generator.

**Key Invert** — An effect that reverses the polarity of the key source so that the holes in the background are cut by dark areas of the key source instead of bright areas. The **KEY INV** push-button selects this effect.

**Key Mask** — A keying technique in which a pattern is combined with the key source to block out unwanted portions of the key source.

**Key Source** — The video signal which “cuts a hole” in the background video to make a key effect possible. Also called “Key Video”. In practice, this signal controls when a video mixer circuit will switch from background to key fill video.

**Key Video** — See Key Source.

**Linear Keys** — Linear keys make it possible to fully specify the transparency of a key from opaque, through transparent, to fully off. The transparency is specified by the key signal (also known as the “hole cutter” or “alpha channel”) that is associated with the key fill. A keyer capable of a linear key converts the key signal voltage directly to the transparency effect on the screen. Our switcher’s **KEY MEM** button allows the user to store the CLIP and GAIN settings required to match the incoming key signal to the keyer’s requirements.

**Line Frequency** — The number of horizontal scans per second. For 525 line 60 Hz systems, this is approximately 15734 scans per second.

**Luminance Key** — An effect in which video from one source is replaced by video that exceeds a set level in a second video source.

**Mask** — See Key Mask.

**Matte** — A solid color signal that is generated by the switcher and can be adjusted for hue, saturation, and luminance levels.

**Matte Key** — A key effect in which the fill video is matte, provided by one of the switcher’s matte generators.

**Memory** — The memory feature provides storage and recall of complete switcher setups.
**MIX** — See Dissolve.

**MLE** — An abbreviation for multi-level effects.

**PGM Output** — The on-air video output of the system.

**Primary Input** — Video sources selected by the control panel push-buttons for the crosspoint buses. These buses are normally labeled “KEY”, “PGM”, and “PST”.

**PV Output** — A switcher output that shows the scene that will go on-air when the next automatic or manual transition takes place.

**Self Key** — A key effect in which the same video signal serves as both the key signal and key fill.

**Soft Edge** — A pattern edge effect produced by mixing key source and key fill signals in such a way that the edge of the pattern is not sharp.

**Split Screen** — An effect in which a wipe pattern provides the key source signal. This is known as a “preset pattern” key.

**Tally** — An indicator which illuminates when the associated push-button or control is selected or is on-air.

**Termination** — A means of closing a circuit by connecting a resistive load to it. In video systems, a termination is typically a 75 ohm resistive load.

**Transition** — A controlled change from one video input to another video input or black. The change can occur through a wipe, cut, dissolve or “DVE Send” effect.

**Transition Preview** — A transition seen only on the preview monitor. It may be observed and adjusted without disturbing the program or “on-air” output.

**Video** — The electrical signal produced by a television camera, character generator or other image source. The signal amplitude varies in relation to the tonal scale from black to white presented at the source. White produces the highest amplitude; black produces the lowest signal amplitude.

**Wipe** — A transition from one video signal to another, in which the change proceeds according to the shape of a specific pattern. A moving transition line separates the two picture signals.
Index

Numerics

16x9/4x3 toggle aspect ....................................... 24-18
360 Systems Digicart
  communications setup .................................. 17-8
360 Systems Digicart, setup .................................. 17-10
360 Systems Digicart/E, setup .................................. 17-10
360 Systems Image Server 2000, setup ............. 18-26

A

Abekas6000
  communication settings .................................. 18-30
Accom APR Clipstore
  cabling .......................................................... 16-5
  communication settings .................................. 16-12
  communications connections .................................. 16-3
  extra options .................................................. 16-9
  Roll VTR setup .................................. 16-15, 16-19, 18-39
  setting up BNCs .................................................. 16-13
AFV, see Audio-Follow-Video
Alcorn McBride DVM2
  cabling .......................................................... 16-4
  communication settings .................................. 16-11
  extra options .................................................. 16-9
  port .......................................................... 16-3
Always Armed mode, ROLL VTR16-15, 18-35, 18-39
AMX Pan/Tilt
  cabling .......................................................... 19-10
AMX Pan/Tilt Head
  communication settings .................................. 19-21
Arm mode, ROLL VTR .. 16-15, 16-19, 18-35, 18-39
Aspect ratio, setup .............................................. 24-16
Aspect Toggle 16x9/4x3 .................................... 24-18
Aspectizer
  board .......................................................... 24-19
  bus mode setup .................................................. 24-18
  double aspectizing in downstream mode ........... 24-24
  downstream mode setup .................................. 24-22
  input mode setup .............................................. 24-17
  look .......................................................... 24-6
  main menu ............................................. 24-16, 24-23
  modes, input vs. bus vs. downstream .......... 24-9
  operating modes ........................................... 24-16
Aspectizer board
  description .................................................. 24-4
  dual channel .................................................. 24-18
  installation .................................................. 24-12
  setup .................................................. 24-16
  socket number .............................................. 24-18
Assign Audio, custom control ......................... 21-33
Audio
  Audio Cut Only feature ................................ 21-30
  Calrec interface cable .................................. 21-3
  Communications ........................................... 21-3
  ganging mixers ........................................... 21-7
  Large interface ........................................... 21-3, 21-5, 21-7
  Merger .................................................. 21-8
  MIDIator .................................................. 21-5, 21-7
  Operational Overview .................................. 21-46
  Small interface ........................................... 21-3, 21-5
  Studer On-Air interface cable ...................... 21-4
  supported Audio Mixers .................................. 21-2
  Yamaha Control Cable .................................. 21-3
  Audio All Off, custom control ....................... 21-36
  Audio Bank setup ........................................... 21-32
  Audio CH Off, custom control ......................... 21-40
  Audio CH On, custom control ......................... 21-39
  Audio channel assignment ......................... 21-29
  Audio Cut Only feature ................................ 21-30
  Audio levels, adjusting .................................. 21-47
  Audio Memory, custom control ....................... 21-38
  Audio mixer .................................................. 21-1
    audio transition MLE assignment ........... 21-30
    channel and group setup during installation . 21-26
    channel assignment .................................. 21-29
    connecting .................................................. 21-3
    Ganging .................................................. 21-7
    Interface Options ...................................... 21-1
    local control ........................................... 21-32
    port baud rate ........................................... 21-14
    remote control setup .................................. 21-13
Audio Mixer Configuration
  Calrec Sigma .................................................. 21-24
  multiple .............................................. 21-16
  Studer .................................................. 21-24
  Yamaha 01V .................................................. 21-17
Audio Source Assignment .................................. 21-26
Audio only transitions ........................................ 21-47
Audio Modes
    audio-follow-video ........................................... 21-45
    Editor .................................................................. 21-45
    override .................................................................. 21-45
    overview .................................................................. 21-45
Audio only transitions ........................................ 21-47
Audio Overrides ....................................................... 21-45
Audio Pan settings, adjusting .................................. 21-47
Audio Remote Control Setup .................................... 21-26
Audio Servers ....................................................... 17-1
    360 Systems Digicart
    cabling .............................................................. 17-4
    communication settings ...................................... 17-10
    port ...................................................................... 17-3
    360 Systems Digicart/E
    cabling .............................................................. 17-4
    communication settings ...................................... 17-10
    port ...................................................................... 17-3
    BNC Setup .......................................................... 17-12
    clip (cut) registers .................................................. 17-14
    clip name .................................................................. 17-20
    clip registers .......................................................... 17-20
    Communication Setup ...................................... 17-7, 17-10
    communications connections .................................. 17-3
    custom controls .................................................... 17-16
    custom controls, functions ..................................... 17-18
    Cut ID .................................................................. 17-14, 17-16, 17-20
    Cut Name .................................................................. 17-14, 17-16, 17-20
    Cut Time .............................................................. 17-14, 17-16, 17-20
    Enco DAD .............................................................. 17-11
    cabling .............................................................. 17-6
    port .................................................................. 17-4
    extra options .......................................................... 17-9
    Sony MiniDisc ........................................................ 17-11
    cabling .............................................................. 17-5
    port ................................................................ 17-4
    supported ............................................................. 17-2
Audio Source Assignment ........................................ 21-26
Audio Transitions
    Audio Cut Only feature ........................................... 21-30
    Audio Only .......................................................... 21-47
    MLE Assignment .................................................. 21-30
    overview ............................................................. 21-46
Audio-Follow-Video ............................................... 21-45
Aux
    1-3 connector pinouts ............................................. 22-12
    panel J1, J5 connector pinouts .................................. 22-17
    remote panel connector pinouts .................................. 22-16
Aux Bus
    bus follow mode, Aspectizer .................................. 24-20
    bus follow mode, Ultimatte .................................... 24-48
    bus mode, Aspectizer ............................................. 24-19, 24-48
    remote panel programming summary ...................... 22-18
Avid AirSpace
    cable pinouts ........................................................ 18-5
    cabling .............................................................. 18-3
    communication settings ........................................ 18-21
Avid AirSpeed
    cabling .............................................................. 18-4
    Video Server ........................................................ 18-27

B
Base Extra Option .................................................. 14-23
Baud rate, audio mixer port ...................................... 21-14
Betacam
    Accom APR Clipstore .......................................... 16-12
    Alcorn McBride DVM2 ........................................ 16-11
    BitCentral Précis .................................................. 16-12
    Fast Forward Video Omega ................................... 16-11
    NPlay Retries ........................................................ 16-10
    protocol setup ...................................................... 16-7
    Target Machine .................................................... 16-9
    Wait nFields.......................................................... 16-10
BitCentral Précis
    cabling .............................................................. 16-5
    communication settings ........................................ 16-12
    communications connections .................................. 16-3
BNC
    input worksheet .................................................... 26-2
    setup types, Dual Aspectizer .................................. 24-16
BNC Setup
    audio servers ...................................................... 17-12
    character generators ............................................ 15-14
    robotic camera .................................................... 19-22
    router ................................................................. 14-34
video servers .................................................. 18-32
VTR ........................................................ 16-13
BSS4, see Remote Port Switch (BSS4)
Bus assign, Aspectizer ........................................ 24-21
Bus Follow
  aux bus, Aspectizer ........................................ 24-20
  aux bus, Ultimatte ....................................... 24-48
  bus mode, Aspectizer .................................. 24-20
  bus mode, Ultimatte .................................... 24-49
Bus mode, Aspectizer
  aux bus ..................................................... 24-19
  bus assign ................................................ 24-21
  bus follow ............................................... 24-20
  bus follow assign ...................................... 24-21
  bus-pair selection .................................... 24-19, 24-47
  definition ................................................ 24-18
  dual aspect production .................................. 24-18
  memory registers ...................................... 24-18
  MLE selection ......................................... 24-19
  mode selection ........................................ 24-19
  partial ................................................... 24-19
  setup ..................................................... 24-18
  single output production .................................. 24-6, 24-7
Bus mode, Ultimatte
  aux bus ..................................................... 24-48
  bus follow ............................................... 24-49
  bus follow assign ...................................... 24-49
  bus-pair selection ..................................... 24-45
  definition ................................................ 24-42
  MLE selection ......................................... 24-45, 24-47
  mode selection ........................................ 24-45, 24-47
  partial ................................................... 24-48
  setup ..................................................... 24-42, 24-46
Bus-pair
  BKGD+PST ............................................... 24-4
  Key1 fill and alpha .................................... 24-18
  Key2 fill and alpha .................................... 24-18
Button test menu ........................................... 23-7

Cabling
  Audio, Small ............................................. 21-5, 21-7
  Calrec Sigma Digital Audio Mixer .................. 21-3
  Studer On-Air Audio Mixer ................................ 21-4
  Yamaha Control Cable .................................. 21-3

Calrec Sigma Audio System
  interface cable ........................................ 21-3
  port ....................................................... 21-5
  serial connections .................................... 21-4
  settings ................................................ 21-24
  wiring chart ........................................... 21-12
Canon Robotic Camera
  cabling .................................................. 19-7
  communication settings ................................ 19-7
  port connection ........................................ 19-4
Carrier mode
  Setup, Ultimatte Insider ................................ 24-45
  Ultimatte Insider ........................................ 24-41
Character Generators
  Alpha BNC ............................................... 15-15
  Auto Key Setup ......................................... 15-16
  BNC Setup ............................................... 15-14
  Chyron Duet LEX
    cabling .................................................. 15-4
    communication settings ................................ 15-11
    Lyric software setup ................................ 15-12, 15-13
    port ..................................................... 15-3
  Chyron HyperX
    cabling .................................................. 15-4
    communication settings ................................ 15-11
    Lyric software setup ................................ 15-12, 15-13
    port ..................................................... 15-3
  Communication Setup
    character generator .................................... 15-10
    switcher ................................................ 15-7
  Communications connections ................................ 15-3
  Custom Control .......................................... 15-18
  Leitch Inca
    cabling .................................................. 15-4
    communication settings ................................ 15-10
    port ..................................................... 15-3
  Miranda Kaleido-K2
    cabling .................................................. 20-12
  Miranda Kaleido-X
    cabling .................................................. 20-12
  Pinnacle FXDeko II
    cabling .................................................. 15-5
    communication settings ................................ 15-12
    port ..................................................... 15-4
    supported .............................................. 15-2

Synergy Series Installation Guide (v18)  Index • IX–3
Roll VTR Mode..............................16-20, 18-40
Router..............................................14-37
  fire salvo ....................................14-39
  Source/BNC Crosspoint pair ..........14-37
  video server ...............................18-37, 18-38
VTR, functions ..................................16-17, 16-18
worksheet ......................................26-14
Custom device
  advanced topics and tables ...........27-9
  menu ...........................................27-4
  modify device menu ......................27-4
  Modify Menu .................................27-3
  programming worksheets ...............27-7
  protocol uses and limitations .......27-2
Cut ID, Audio Server ...............17-14, 17-16, 17-20
Cut Name, Audio Server ...............17-14, 17-16, 17-20
Cut Time, Audio Servers ...............17-14, 17-16, 17-20
Cuts, Audio Servers .........................17-14

D

DDRs, Betacam ...............................16-1, 18-1
Default Audio Level, setting ...........21-26
Default Audio Levels .......................21-27
Diagnostics ..................................23-2, 23-13
  button test ..................................23-7
  disk test ....................................23-9
  display test ..................................23-8
  fader test ....................................23-4
  frame .........................................23-16
  information menu ..........................23-2
  joystick test ...............................23-6
  lamp test ....................................23-7
  memory test ..................................23-8
  menu .......................................23-13, 23-14
  panel .........................................23-2, 23-15
  potentiometer test .........................23-3
  tally relay test ............................23-11
  tools .........................................23-1
  TX/RX test ..................................23-9, 23-13
DIP/Jump Test menu ..........................23-12, 23-15
Disk Test menu ..............................23-9
Dispatcher setup, Miranda Kaleido-K2 ....20-9
Display Test menu ............................23-8
Downstream mode, Aspectizer
  double aspectizing ........................24-24
  dual output production .................24-7
MLE PGM ........................................24-22
  setup .......................................24-22
  uses .........................................24-11
Dual Aspectizer Boards
  setup .......................................24-16
  upgrading ..................................24-13
Dual Aspectizer See Aspectizer
Dual Border Generator
  installing ..................................24-26
  option .....................................24-2, 24-26
Dual output production, Aspectizer
  downstream mode ......................24-6, 24-7, 24-22
  extra content .............................24-6, 24-8
DVE 1 connector pinouts ..................22-9
DVE 2 connector pinouts ..................22-8
DVE Send option, installation ..........24-27
Dynamic text, monitor wall ...............20-19

E

Eagle PT-101 Pan Tilt System
  communication settings .................19-19
  Extra Options ..............................19-16
Phoenix Connection Block .................19-8
Editors, connector pinouts ..............22-8
Enco DAD
  communication settings .................17-11
  setup .......................................17-11
Enter Clip ID, video servers ............19-8
Environmental Information ...............18-42
Environmental specifications ...........18-42
Errors, panel and frame ..................23-2
EVS Broadcast Equipment maXS
  cabling ....................................18-8
  communication settings .................18-27
  port .......................................18-4
External Device
  Audio Servers ..............................17-1
  Character Generators ....................15-1
  DDRs (Betacam) ...........................16-1, 18-1
  Monitor Walls .............................20-1
  Robotic Camera ............................19-1
  Routers ....................................14-1
  Video Servers (Betacam) ...............16-1, 18-1
  VTRs (Betacam) ...........................16-1, 18-1
Extra content, dual output production ....24-8
Extra Options
  audio servers .............................17-9
Chyron Duet LEX......................................... 15-11
Chyron HyperX............................................ 15-11
Eagle PT-101 Pan Tilt System ...................... 19-16
multiple remote audio mixer ....................... 21-16
remote audio mixer ..................................... 21-15
robotic cameras ........................................... 19-14
routers ...................................................... 14-22
Studer Audio Mixer ...................................... 21-24
Telemetrics CP-RMR-S ................................ 19-15
Telemetrics Device Server DS-4 ................. 19-15
Telemetrics STS-12 Switch . . . . . . . . . . . . . . 19-15
Telemetrics, RclTime .................................... 19-16
Telemetrics, ShotOffset .............................. 19-16
Video Servers ........................................... 18-16
VTR .................................................................. 18-9
Extron System 8/10 Router
  cabling ..................................................... 14-16
  communication settings ......................... 14-32
  port.......................................................... 14-4
F
  Fader test menu ........................................ 23-4
    Synergy Slots ........................................ 23-4
Fast Forward Video Omega
  cabling .................................................... 16-4
  communication settings ......................... 16-11
  port.......................................................... 16-3
Frame
  connector pinouts ..................................... 22-12
  connector types ....................................... 22-4
  diagnostics menu ................................... 23-14, 23-15, 23-16
  errors ..................................................... 23-2
  information ............................................. 23-2
  pinouts ................................................... 22-8
  specifications ......................................... 22-3
G
  Ganging, audio mixers ................................ 21-7
Gee Broadcast Systems Geevs
  cabling .................................................... 18-7
  communication settings ......................... 18-25
  port.......................................................... 18-4
General Specifications ................................ 22-3
GPI
  input worksheet, standard ...................... 26-11
  output worksheet, standard ................... 26-11
  remote aux panel connector pinouts ......... 22-16
  remote aux panel input worksheet .......... 26-12
  standard I/O connector pinouts .............. 22-10
  Test, menu ............................................ 23-15
  Grab a Timecode
    Video Server ........................................ 18-45
    VTR ..................................................... 16-23
Grass Valley Router, see GVG SMS 7000
GVG Encore Control System
  communication settings ......................... 14-28
  fire a router salvo custom control ............ 14-39
  pinouts ................................................ 14-11
  port.......................................................... 14-4
GVG M-Series iVDR
  cabling .................................................. 18-4
GVG M-Series iVDR Server
  communication settings ......................... 18-29
GVG Profile
  communication settings ......................... 18-29
GVG SMS 7000 Router
  communication settings ......................... 18-27
  fire a router salvo custom control ............ 14-39
  pinouts ................................................ 14-10
  port.......................................................... 14-4
GVG Turbo
  communication settings ......................... 18-30
I
  Information menu ..................................... 23-2
Inpoint, Video Server Clip ......................... 18-43
Input
  board, option ......................................... 24-4
  name BNC ............................................... 24-16
  specifications ........................................ 22-6
  worksheet ............................................. 26-2
Input Carrier Board
  installation .......................................... 24-29
  installation configurations .................. 24-29
  number ................................................ 24-18
  option ................................................... 24-4, 24-41
  re-entry slot ......................................... 24-29
  removal ................................................ 24-12, 24-13
  socket .................................................. 24-4
Input channels, monitor wall ..................... 20-18
Input mode, Aspectizer
  assigning inputs .................................. 24-18
  definition ............................................. 24-17
  mode selection ....................................... 24-18
personality registers................................. 24-17
setup ............................................................. 24-17
single output production............................... 24-6
uses ................................................................... 24-9
with downstream mode ................................ 24-24
Input vs. Bus vs. Downstream, Aspectizer ...... 24-9
Insert Special
Audio Server functions................................. 17-18
Recall Camera .............................................. 19-25
Recall Shot .................................................. 19-27
Roll VTR Mode............................................. 16-20, 18-40
VTR functions ............................................... 16-18
Install
clean feed option ............................................ 24-3
DVE Send option ............................................ 24-27
Installation
configurations, input carrier board .......... 24-29
Dual Aspectizer board................................. 24-12
Dual Border Generator ................................. 24-26
Input Carrier board ....................................... 24-29
Ultimatte Insider Board.............................. 24-43
Interface
Audio Server .............................................. 17-1
Character Generator ...................................... 15-1
Large Audio Mixer ........................................ 21-1
Monitor Wall .................................................. 20-1
Robotic Camera System .............................. 19-1
Routers ........................................................... 14-1
Small Audio Mixer ........................................ 21-1
Video Server Control (VDCP) .............. 18-1
VTRs (Betacam) ............................................ 16-1
Internal Video Test menu ......................... 23-16

J
Joystick test menu ........................................... 23-6
Jupiter Router .............................................. 14-23
Jupiter router
Base Extra Option ......................................... 14-23

K
Key1 bus-pair ................................................ 24-19
Key2 bus-pair ................................................ 24-19

L
Lamp test menu ............................................... 23-7

Large Audio Mixer Interface ............ 21-3, 21-5, 21-7
Layout, monitor wall ................. 20-16
Leitch ASC VR300
version 2 ....................................................... 18-22
version 2.7 ..................................................... 18-22
Video Server .............................................. 18-22
Leitch Inca Character Generator
cabling .......................................................... 15-4
communication settings ....................... 15-10
port ................................................................. 15-3
Leitch Nexio
communication settings ....................... 18-31
Leitch VIA 32 Router
cabling .......................................................... 14-9
communication settings ....................... 14-27
port ................................................................. 14-4
Leitch VIA32 Router
fire a router salvo custom control .......... 14-39
Leitch VR440
Video Server .............................................. 18-22
Levels
default levels ............................................. 21-27
Lyric software, setup .................... 15-12, 15-13

M
Media ID Length, VDCP ..................... 18-17
Memory
registers, aspectizer, bus mode ...... 24-18
test menu ..................................................... 23-8
Menu
button test .................................................... 23-7
communications .......................................... 27-4
custom device ............................................ 27-4
DIP/Jump Test ........................................ 23-12, 23-15
disk test.......................................................... 23-9
display test .................................................... 23-8
fader test ....................................................... 23-4
frame diagnostics ...................... 23-14, 23-15, 23-16
Internal Video Test ......................... 23-16
joystick test ................................................. 23-6
lamp test ....................................................... 23-7
memory test .................................................. 23-8
modify custom device ....................... 27-4
option cards ............................................. 24-45, 24-46
panel diagnostics .................. 23-2, 23-13, 23-15
panel information ....................... 23-2
pots test......................................................... 23-3
Output
characteristics ................................................. 22-7
connection ...................................................... 26-5
specifications ................................................. 22-7
worksheet, auxiliary .................................... 26-6
worksheet, special ......................................... 26-7
OverDrive
audio mode .................................................... 21-45
Roll VTR ...................................................... 16-15, 18-35
Overrides, audio ........................................... 21-32, 21-45

P
Pan settings, adjusting ..................................... 21-47
Panasonic AW-PH500p Pan/Tilt Head
cabling ........................................................... 19-8
communication settings ................................... 19-20
port ................................................................... 19-4
Panel
diagnostics menu ........................................... 23-2, 23-13
ers ................................................................. 23-2
information ...................................................... 23-2
remote control worksheet ............................... 26-8
Parkervision CameraMan 3e 3-CCD camera
BNC setup ....................................................... 19-23
cabling ............................................................ 19-9
communication settings ................................... 19-20
communications settings ................................ 19-20
communications setup ................................... 19-12
port ................................................................... 19-4
Partial bus mode
Aspectizer ......................................................... 24-19
Ultimatte ......................................................... 24-48
Peripheral
1 A connector pinouts ..................................... 22-9
1 B connector pinouts ..................................... 22-9
2 A connector pinouts ..................................... 22-9
2 B connector pinouts ..................................... 22-9
Personality
registers, aspectizer input mode ....................... 24-17
roll VTR mode .................................................. 16-15, 16-19, 18-35, 18-39
PESA Cougar Router
cabling ............................................................ 14-5
communication settings .................................. 14-24
fire a router salvo custom control .................... 14-39
port ................................................................... 14-3
PGM Audio Level ............................................. 21-42
custom control ............................................... 21-42
Philips Jupiter Router
cabling ............................................................ 14-5
port ................................................................... 14-3
Phoenix Connection Block, cabling to .............. 19-8
Pinnacle FXDeko II Character Generator
cabling ............................................................ 15-5
communication settings .................................. 15-12
communications ............................................. 15-8
custom controls .............................................. 15-19
port ................................................................... 15-4
Pinnacle Thunder server
communication settings .................................. 18-23
port ................................................................... 18-4
Pinouts
AC Power ........................................................ 22-10
Aux 1-3 connectors ......................................... 22-12
Aux panel J1 connector .................................. 22-17
Aux panel J5 connector .................................. 22-17
control panel .................................................... 22-11
DVE 1 connector ............................................. 22-9
DVE 2 connector ............................................. 22-8
Editor connector ............................................. 22-8
frame ................................................................. 22-8
frame connector .............................................. 22-12
Peripheral 1 A connector ............................... 22-9
Peripheral 1 B connector ............................... 22-9
Peripheral 2 A connector ............................... 22-9
Peripheral 2 B connector ............................... 22-9
power, line 1 and 2 .......................................... 22-15
Remote 1-8 ....................................................... 22-11
remote Aux panel ............................................ 22-16
remote panel GPI connector ............................ 22-16
standard GPI I/O connector ............................ 22-10
tally 1 connector .............................................. 22-13
tally 2 connector .............................................. 22-14
tally 3 connector .............................................. 22-14
tally 4 connector .............................................. 22-15
Play mode, ROLL VTR ........................................ 16-15, 16-19, 18-35, 18-39
Playback Mode, VDCP ................................... 18-20
Port Commands, VDCP .................................. 18-20
Pots test menu .................................................. 23-3
Power
connector pinouts ................................. 22-10
consumption specifications ......................... 22-4, 22-5
line 1 connector pinouts ............................... 22-15
line 2 connector pinouts ............................... 22-15
tally ratings ..................................................... 22-5
Pre-Roll
  Video Server .................................................. 18-15
  VTR ............... 16-8, 16-15, 16-20, 18-35, 18-40
Pro-Bel Halo Router
  cabling ....................................................... 14-7
  communication settings ................................ 14-25
  fire a router salvo custom control ............... 14-39
  port ................................................................ 14-4
PST Audio Level, custom control .................. 21-43

R

Rack frame
  connector types ............................................. 22-4
  specifications .............................................. 22-3
Radamec Robotic Camera
  cabling ....................................................... 19-6
  communication settings ................................ 19-18
  ports ....................................................... 19-3
RclTime, Telemetrics .................................. 19-16
Record Time, VDCP ........................................ 18-19
Remote
  1-8 connector pinouts ................................... 22-11
  aux panel connector pinouts ......................... 22-16
  aux panel programming summary .................. 22-18
Remote audio mixer control
  audio transition on MLE ................................ 21-30
  overrides .................................................. 21-32
  setup channels and groups ......................... 21-26
  setup communications ................................ 21-13
  source assignment .................................... 21-26
Remote Port Switch (BSS4)
  cabling ..................................................... 24-39
  connecting to the switcher ......................... 24-39
Repair policy ................................................. 1-7
Reset Audio, custom control ......................... 21-35
Robotic Cameras .............................................. 19-1
  AMX Pan/Tilt
    cabling .................................................. 19-10
  AMX Pan/Tilt Head
    communication settings ......................... 19-21
  BNC Setup ................................................. 19-22
  Canon ....................................................... 19-18
  NU-700N, cabling ...................................... 19-7
  NU-700N, port ........................................... 19-4
  Communication Setup
    robotic camera ......................................... 19-17
    switcher ............................................... 19-11
    communications connections .................... 19-3
  custom controls ....................................... 19-24
  recall camera .......................................... 19-24
  recall shot ............................................. 19-26
Eagle PT-101 Pan Tilt
  communication settings ............................... 19-19
  extra options ........................................... 19-16
  Phoenix connection block, cabling ............... 19-8
  port ....................................................... 19-4
  extra options .......................................... 19-14
Panasonic AW-PH500p Pan/Tilt Head
  cabling .................................................. 19-8
  communication settings .............................. 19-20
  port ....................................................... 19-4
Parkervision CameraMan 3e 3-CCD
  cabling .................................................. 19-4
  communication settings .............................. 19-20
  pinouts .................................................. 19-9
Radamec ...................................................... 19-18
  HK185 cabling ......................................... 19-6
  HK185, port ............................................ 19-3
  HK431 cabling ......................................... 19-6
  HK431, port ............................................ 19-3
Shotoku TR-8S
  cabling .................................................. 19-4
  pinouts .................................................. 19-10
Sony .......................................................... 19-18
  BRC-300/300P, cabling ................................ 19-7
  BRC-300/300P, port .................................... 19-4
  supported ................................................ 19-2
Telemetrics ..................................................... 19-17
  extra options .......................................... 19-15
  PT-CP-S2, cabling .................................... 19-4
  PT-CP-S2, port ......................................... 19-3
  PT-HP-S2, cabling .................................... 19-4
  PT-HP-S2, port ......................................... 19-3
  PT-LP-S2, cabling .................................... 19-4
  PT-LP-S2, port ......................................... 19-3
  RclTime .................................................. 19-16
  serial switch ......................................... 19-15
  ShotOffset ............................................... 19-16
  STS-12, port ........................................... 19-3
  STS-12, settings ...................................... 19-18
ROLL VTR
  always armed mode .... 16-15, 16-19, 18-35, 18-39
  arm mode ................................................. 16-15, 16-19, 18-35, 18-39
  OverDrive .............................................. 16-15, 18-35
  play mode .............................................. 16-15, 16-19, 18-35, 18-39
Roll VTR Mode, custom controls for .... 16-20, 18-40
Ross Video SoftMetal Server
  communication settings .............................. 18-28
  Ross Video SoftMetal server
    cable pinouts ........................................ 18-10
cabling .......................................................... 18-4
Routers
BNC Setup .................................................. 14-34
Codan Kondor (ASCII) ................................. 14-28
    cabling .................................................. 14-13
    port ..................................................... 14-4
Codan Kondor (EOS), port .......................... 14-4
Codan Kondor (Geneos), cabling .............. 14-7, 14-25
Codan NK
    communications connections ................. 14-13
    Codan NK (ASCII)
        port .................................................. 14-4
Communication Setup
    router .................................................. 14-22
    switcher .............................................. 14-19
communications connections .............. 14-3, 20-3
custom controls ........................................ 14-37
    fire salvo ............................................ 14-39
Source/BNC crosspoint pair .................. 14-37
extra options ............................................. 14-22
Extron .................................................... 14-32
    cabling .............................................. 14-16
    port ..................................................... 14-4
GVG Encore Control System ..................... 14-28
    cabling .............................................. 14-11
    port ..................................................... 14-4
GVG SMS 7000 .......................................... 14-27
    cabling .............................................. 14-10
    port ..................................................... 14-4
Jupiter .................................................... 14-23
    communications connections .................. 14-3
    GVG SMS 7000 ....................................... 14-27
    cabling .............................................. 14-10
    port ..................................................... 14-4
    Network VikinX ........................................ 14-33
    cabling .............................................. 14-18
    port ..................................................... 14-4
    NVISION ............................................... 14-29
    cabling .............................................. 14-15
    port ..................................................... 14-4
    NVISION 9000 ......................................... 14-29
    port ..................................................... 14-4
    Other Menu ............................................ 14-34
    overview .............................................. 14-1
Philips Chyron Freeway ......................... 14-24
    cabling .............................................. 14-6
    port ..................................................... 14-4
Philips Jupiter
    cabling .............................................. 14-5
    port ..................................................... 14-3
Philips PESA Cougar
    cabling .............................................. 14-5
communication settings ................................ 14-24
    port ..................................................... 14-3
    Pro-Bel Halo ........................................ 14-25
    cabling .............................................. 14-7
    port ..................................................... 14-4
    Router Setup Menu .................................. 14-34
    Sierra Yosemite .................................... 14-29
    cabling .............................................. 14-14
    port ..................................................... 14-4
    supported ............................................ 14-2
    Utah Scientific ...................................... 14-33
    cabling .............................................. 14-17
    port ..................................................... 14-4
Routing Switchers, see Routers

S
Salvo, custom controls ................................ 14-39
Selecting Video Servers Clips .................. 18-42
Send Tries, VDCP ....................................... 18-18
Serial Switch, Telemetrics ....................... 19-15
Setup
    BNC types for Dual Aspectizer .................. 24-16
    MLE aspect ratio .................................. 24-16
    Ultimatte auto select key ....................... 24-50
    ShotOffset, Telemetrics .......................... 19-16
    Shotoku Serial TR-8 Series Interface
        communication settings ...................... 19-21
    Shotoku TR-8S
        cabling .............................................. 19-10
        communications setup ....................... 19-12
        port .................................................. 19-4
    Sierra Yosemite Router
        communication connection .................... 14-4
        communication settings .................... 14-29
        fire a router salvo custom control ........ 14-39
Single output production, Aspectizer
    bus mode ............................................. 24-6, 24-7
    input mode .......................................... 24-6
Slots, Synergy ........................................... 23-4
Small Audio Mixer Interface .................... 21-3, 21-5
Socket, input carrier board ..................... 24-4
Sony MiniDisc
    communication settings ......................... 17-11
    setup .................................................. 17-11
Sony Robotic Camera
    cabling .............................................. 19-7
    communications settings ...................... 19-18
    communications setup ......................... 19-12
Specifications
control panel ................................................. 22-3
environmental .............................................. 22-5
frame pinouts .............................................. 22-8
general ....................................................... 22-3
power consumption ............... 22-4, 22-5
rack frame ................................................. 22-3
rack frame connector types ........ 22-4
standard components ................. 22-2
system ......................................................... 22-1
system timing ............................................. 22-6
tally power ratings ................................. 22-5
video inputs ................................................ 22-6
video output characteristics ........ 22-7

Spencer Technologies Video Server
cabling ........................................ 18-4, 18-7
communication settings .............. 18-25

Squeeze & Tease
2D option, installation ......................... 24-34
3D option, installation ......................... 24-36
option ...................................................... 24-2

Static discharge ...................................... 1-6

Studer Audio Mixer
extra options ........................................... 21-24
port .......................................................... 21-4
settings .................................................... 21-24
wiring chart .............................................. 21-11

Studer On-Air Audio Mixer
interface cable ......................................... 21-4

Summary, remote aux programming ........ 22-18

Switcher Communication Setup
audio server ............................................ 17-7
carrier mode features ............... 24-42, 24-46
display ...................................................... 23-8
disk .......................................................... 23-9
GPI .............................................................. 23-15
joystick ...................................................... 23-6
lamps .......................................................... 23-7
memory ...................................................... 23-8
potentiometers ......................................... 23-3
tally relays .............................................. 23-11
test menu .................................................. 23-10

Telemetrics Robotic Camera Controller
carrier mode features .......... 24-41
communications settings ...... 19-17
Extra Options ......................................... 19-15
Extra Options, RclTime ................ 19-16
Extra Options, ShotOffset .......... 19-16

Telemetrics STS-12 Switch
communications settings ...... 19-18
test menu .................................................. 19-15

Test
buttons ...................................................... 23-7
DIP/Jump switches .................... 23-12, 23-15
disk .......................................................... 23-9
display ...................................................... 23-8
fader ......................................................... 23-4
GPI .............................................................. 23-15
Internal Video ....................................... 23-16
joystick ...................................................... 23-6
lamps .......................................................... 23-7
memory ...................................................... 23-8
potentiometers ......................................... 23-3
VTR .............................................................. 23-7

Ultimatte Bus Mode, overview .......... 24-42
Ultimatte Insider
auto select key setup .............. 24-50
board ......................................................... 24-41
board installation ..................... 24-43
bus mode setup ............................. 24-42, 24-46
carrier mode features .......... 24-41
carrier mode setup ......................................... 24-45
main menu .............................................. 24-45, 24-46
option .................................................. 24-2, 24-41
Upgrading, Dual Aspectizer Boards .............. 24-14
Utah Scientific 400/64 Router
  cabling .............................................. 14-17
  communication settings ......................... 14-33
  port ............................................... 14-4
V
VDCP ...................................................... 18-1
  360 Image Server 2000 ............................ 18-26
  Abekas6000 ....................................... 18-30
  Avid AirSpace .................................... 18-21
  Avid AirSpeed .................................... 18-27
  Clip ID Extended Character Set ................ 18-21
  Command Queuing ................................ 18-19
  EVS Broadcast Equipment maXS
    communication settings ....................... 18-27
  Gee Broadcast Systems Geevs .................. 18-25
  GVG M-Series iVDR Server...................... 18-29
  GVG Profile ..................................... 18-29
  GVG Turbo ...................................... 18-30
  Leitch ASC VR300 ................................ 18-22
  Leitch Nexio ..................................... 18-31
  Leitch VR440 ..................................... 18-22
  Media ID Length .................................. 18-17
  Omneon Video Server ............................. 18-28
  Pinnacle Thunder ................................ 18-23
  Playback Mode ................................... 18-20
  Port Commands ................................... 18-20
  protocol setup ................................... 18-14
  Record Time .................................... 18-19
  Ross Video SoftMetal Server ................... 18-28
  Send Tries ....................................... 18-18
  Spencer Technologies ............................ 18-25
  Target Machine .................................. 18-16
  Timeout .......................................... 18-18
Video
  input specifications ............................. 22-6
  output characteristics .......................... 22-7
  output specifications ........................... 22-7
  system timing specifications ................... 22-6
Video Servers
  360 Systems Image Server 2000 ................... 18-26
    cabling ....................................... 18-8
  Abekas6000 ....................................... 18-30
  Abekas6000, cabling ............................. 18-12
  Abekas6000, port .................................. 18-4
  Avid AirSpace .................................... 18-21
    cabling ....................................... 18-5
    port ........................................... 18-3
  Avid AirSpeed .................................... 18-27
    cabling ....................................... 18-9
    port ........................................... 18-4
  Betacam ........................................... 16-1, 18-1
  BNC Setup ........................................ 18-32
  choose clip ID ................................... 18-42
  Clip ID Extended Character Set ............... 18-21
  clip name ....................................... 18-41
  clip registers ................................... 18-41
  clip selection ................................... 18-42
  clip setup ....................................... 18-41
  clip timecode, grab ............................. 18-45
  Command Queuing ................................ 18-19
  Communication Setup
    switcher ........................................ 18-14
    Video Server .................................. 18-21
  communications connections ................... 18-3
  custom controls ................................ 18-37
  custom controls, functions .................... 18-38
  enter clip ID .................................... 18-42
  EVS Broadcast Equipment maXS ................ 18-27
    cabling ....................................... 18-8
    port ........................................... 18-4
  Gee Broadcast Systems Geevs .................. 18-25
    cabling ....................................... 18-7
    port ........................................... 18-4
  Generic
    cabling ....................................... 18-13
    port ........................................... 18-4
  GVG M-Series iVDR
    port ........................................... 18-4
  GVG M-Series iVDR Server ...................... 18-29
  GVG Profile ..................................... 18-29
  GVG Profile, cabling ............................ 18-11
  GVG Profile, port ................................ 18-4
  GVG Turbo ...................................... 18-30
  GVG Turbo, port .................................. 18-4
  inpoint/outpoint .................................. 18-43
  Leitch ASC VR300
    cabling ....................................... 18-5
    communication settings ....................... 18-22
    port ........................................... 18-3
IX-14 • Index

Synergy Series Installation Guide (v18)
settings .......................................................... 21-18
Yamaha 02R6 Audio Mixer
  port ................................................................. 21-4
Yamaha 02R96 Audio Mixer
  settings .......................................................... 21-19
  wiring chart .................................................. 21-10
Yamaha Control Cable ........................................ 21-3
Yamaha DM1000 Audio Mixer
  extra options ................................................. 21-15
  port ................................................................. 21-6
  settings .......................................................... 21-21
Yamaha DM2000 Audio Mixer
  port ................................................................. 21-4
  settings .......................................................... 21-20
  wiring chart .................................................. 21-11
Yamaha Interface Cable ....................................... 21-3
Yamaha M7CL-48 Audio Mixer
  settings .......................................................... 21-23
Yamaha PM5D Audio Mixer
  port ................................................................. 21-6
  settings .......................................................... 21-22